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Cobalt Help System 8.1 

 

Hold ? and press any key to get a short help. To exit press ESC. 

 

Options 

News in this software version 

Workflow in Cobalt 

This Manual - Using The Help System 

Keyboard Hotkeys 

Troubleshooting and support 

Help Companion - scan the QR code (below) in your online help system  

This revision: 20181029 
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COBALT HELP SYSTEM 
This is the manual for the Cobalt Family.  
 
This manual covers Cobalt20, Cobalt10, Cobalt Nomad Cobalt Lightserver, 
Congo Jr, Congo Kid, Client and Offline editor. 

 

The introduction contains the following sections 

• This Manual - Using the Help System  
• ***News In This Version***  
• This Manual - Terminology  
• Disclaimer 

There is an appendix for running Cobalt in Congo hardware.  
(See Cobalt in Congo) 
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This Manual - Using the Help system 
To open the help system, press the HELP key in the Programming Section. Hold help key and press 
any other key for quick help.  

 

 

1. Previous/Next visited page  
2. Home  
3. Previous/Next chronological page  
4. Search Function  
5. Set Favorite  
6. Set to Normal or to auto-follow Keys or Tabs 

In the Browser you can display the table of contents. The right arrow expands a topic and the left 
arrow jumps to the parent and closes. Press MODIFY or tap to open a topic.  

You can set up a Help Tab (see Tab - Help) If there is a help dock available, using HELP would open 
content. 
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Help System - Change Language 

The help system is available in a number of languages.  

The displayed language is selected in the System Settings. 

Help - Search Function 

Click on the magnifying glass in HELP or press FIND in the console to get the search function.. 

 

Tap to go to to a link.  
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Help System - Favourites 

Tap on the NOTE symbol in the Help tab. A dialog allows you to enter a descriptive text for the 
chapter you are tagging as a favourite.  

 

To delete a Note - focus it in the Browser and press DELETE. 
(See The Browser) 

Help System - Console Keys 

Navigating in the help can be done as a paper manual (next or last page) and as a web browser 
(previous page). 

Action Key Feedback 

Next  [Down_Arrow] Steps to the next page. 

Previous [Up_Arrow] Steps to the previous page. 

Last visited page [Left_Arrow] Steps to the last visited 
page. 
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Help Companion over WIFI  

If you have a console and a touch pad or smartphone connected on the same wireless network, from 
7.3 you can browse to an external help system web page that can be completely synchronized with key 
presses or selected screens in the software. You can activate it by scanning the QR code in the first 
help page. 
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News In This Version 
This chapter presents the news and changes in new versions of the software. Here are a few sections 
that may be of help and interest for you, depending on where you are coming from.  

News in Cobalt 8.1 

These are the Key Enhancements in v8.1. Search for "8.1" in the Help system to find all changes and 
updates. 

• New Tab - Direct Selects Flow  
• New Soft Key Pages S1-S3 with 10 user definable console functions in each.  
• New Palette times in Magic Sheets   
• New way of loading Magic Sheets from the Browser list   
• New functionality of CITP with Media Servers. 

News in Cobalt 8.0 
These are the Key Enhancements in v8.0. Search for "8.0" in the Help system to find all changes and 
updates. 

• New Screen Areas  
• New Tab Selector  
• New Magic Sheets  
• New Networking and multiple console architecture  
• New Clone function in the Patch Wizard 

News in Cobalt 7.3 
These are the Key Enhancements in v7.3. Search for "7.3" in the Help system to find all changes and 
updates. 

• New and expanded OSC commands. See Receive OSC Input.  
• Expanded columns in Track List to 100. See Track List.  
• Select master range for master #. See Masters - Select Playback Range. See Console Key - 

Range.  
• Master Flash Solo mode can include Main Playback. See Flash Settings.  
• New Help Companion. See Help Companion over Wifi. 

News in Cobalt 7.2 
These are the Key Enhancements in v7.2. Search for "7.2" in the Help system to find all changes and 
updates.  



Cobalt 8.1 - 20181029 

40 

 

• Cue sequences. Read here >>  
• Setting a Record Target other than the Main Playback. Read here >>   
• Direct Selects and console keys. Read here >>  
• Beat Boss function for chase and content effects. Read here >>  
• Find highest level for a channel. Read here >>  
• The new help dock. Read here >>  
• New Action Macros. Read here >>  
• Up to four DMX ports. Read here >>  
• Action Macros in the Direct Selects dock. Read here >>  
• Examples in the help system. Read here >>  
• Device Mode Pages. Read here >>  
• Arrange functions in the DS dock. Read here >>  
• Cobalt Programming Wing. Read here >> 

News in Cobalt 7.1 
These are the Key Enhancements in v7.1. Search for "7.1" in the Help system to find all changes and 
updates.  

• Improved Import Template Wizard with search filter. Read here >>  
• Flexible Patching. Read here >>   
• DMX Settings moved into Browser. Read here >>  
• A User Library for collecting often-used, new or modified device templates. Read here >>  
• Improved handling of multi-cell and compound devices. Read here >>   
• Arrange function in the direct selects dock (copy/move). Read more >>  
• Content and Dynamic effects now use the group numbers as index number.  
• There is a new chapter about how to try the effects in the Demo Plays.  Read more >>  
• Improved Mark performance on sensitive devices (LEDs lit at DMX 1)  
• Updated Extended Library  
• Support of Cobalt 10 hardware  
• Support of Nomad universal dongle on Macintosh computers (Intel only)  
• Bug Fixes 
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Coming to Cobalt from Congo 
Your main difference will be that Cobalt is so much faster. Making a transition from Congo to Cobalt 
is simple. All of your old shows are compatible, and 100% of the functionality you are used to. 
However, you will find that some things are handled differently by the hardware, and in ways that 
eliminate hundreds of key presses in a session.  

Two big differences are the Direct Select Tab that replaces the Direct Select key sections in Congo 
with many more options and built in screen faders, and the Device Control Tab that provides you with 
direct access to every parameter in a device. From version 8.0 and forward also all the Networking 
and multiple console architecture is different. There are a lot of brand new features such as the Magic 
Sheets  that bring the former Channel Layouts to a new level. The Screen Areas that allow you to store 
complex and useful screen setups and the new Tab Selector system that comes with this. Keep most of 
your muscle memory and system architecture intact and explore these new and powerful features with 
an open mind.  
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This Manual - Terminology 
This manual is intended for use with the Cobalt lighting control system by ETC. 
 
The on-line manual and the paper manual are the exact same document. 

In order to be specific about where features and commands are found, the following naming and text 
conventions will be used 

• Cobalt processor (hardware): the computer used to run the Cobalt applications.  
• Cobalt Facepanel (hardware): the control console hardware. This is also referred to simply as 

the "Facepanel".  
• Cobalt software: the application that gives you the functionality of the Cobalt system 

controlled from the Facepanel.  
• Commands in the Browser Tab are indicated like this: Browser >Files >New.  
• Console keys in general are indicated in all CAPS. For example RECORD.  
• Console keys in tables are have a button outline like this: 

[RECORD] 

• When a key is held and another key is pressed at the same time is written like this: RECORD 
& MASTER  

• References to other parts of the manual are indicated as underlined hyperlinks. When 
viewing this manual electronically, click on the reference to jump to that section of the 
manual. 
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Disclaimer 
We do everything possible to guarantee the reliability of this system. 

Please don't load other software onto your Cobalt lighting console. ETC has 
tested the configuration of this system to guarantee its best performance. 
Additional software or unauthorized changes within the operating system 
may significantly affect the performance of this lighting control system. In 
the worst case, ETC may require that the hard disk be reimaged back to 
factory default settings to return a system to an operational state. 

We highly recommend that you save your play data frequently while 
programming and that you back up important data to portable media often.  

Please contact your ETC representative with questions or concerns. 

See Troubleshooting. 
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GETTING STARTED 
Getting Started is about understanding the basic terminology and workflow.  

• General Info  
• Workflow In Cobalt  
• Troubleshooting  

NOTE 
If you are new to Cobalt, we recommend you spend half an hour on the 
Workflow in Cobalt.  
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General Info 
This chapter describes the key syntaxes, basic software and 
control terminology. 

This chapter contains the following sections 

• System Overview  
• Setup Guide  
• Installation Guidelines  
• Key Syntaxes  
• Cobalt Terminology  
• Control Hierarchy  
• Software & Update 

  

Interface Specification 

For more information, see the Setup Guide >> 

• Two individually configurable ethernet ports, 802.3 af-compliant POE  
• ETCNet2™, Net3™ (powered by ACN), sACN and Artnet output protocols  
• Two DMX512a/RDM ports  
• Contact closure triggers via D-Sub connector  
• Three female IEC connectors  
• Three active Display Port-to-DVI adapters. If passive adapters are used, only two may be 

used at a single time. A third adapter must be an active adapter. Displays using an active 
adapter have a max resolution of 1920x1200. Optional single- or multi-touch screen control  

• USB 2.0 multipurpose (11 ports)  
• Client PC via ethernet (requires Client Dongle)  
• Net3 radio focus remote (rfr) via USB or ethernet  
• Phone remote  
• OSC open Sound Control via ethernet  
• UDP event triggering via ethernet  
• ARFR for android devices and irfr for apple iOS devices via wireless ethernet  
• MIDI in/out (MIDI timecode, MIDI notes, MIDI Show Control (MSC))  
• MIDI timecode, MIDI Show Control through Net3 Show Control Gateway  
• SMPTE timecode through net3 Show Control Gateway  
• Contact closure (12 analog inputs, 12 SPDT contact outputs, RS-232) through Net3 I/o 

Gateway 
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ELECTRICAL  

• AC input (100 - 240V at 50/60 Hz)  
• Maximum power consumption (including external monitors) approximately 6.3A 120/240V  

DIMENSIONS 
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Setup Guide 
This setup guide provides identification of the inputs and outputs on the Cobalt 10 and Cobalt 20 
control desks and related hardware systems, as well as provides important information regarding 
initial setup and use. 

Cobalt 20 

 

1. Desk Lamp  
2. Vents: Make sure to keep these vents clear of any obstructions.  
3. Switched Outlets  
4. Hard Power Switch (I = on, O = off)  
5. Desk Lamp  
6. Desk lamp controls  
7. DMX512A/RDM ports  
8. MIDI Ports (1x In, 1x Out)  
9. Remote Trigger  
10. Phone Remote  
11. Dual-Mode Display Port Output. There are three ‘active’ Display Port-to-DVI adapters. If 

‘passive’ adapters are used, only two may be used at a single time. A third adapter must be an 
‘active’ adapter. Displays using an ‘active’ adapter have a max resolution of 1920x1200  

12. Audio Line Out (Audio Line In reserved for future development)  
13. USB ports. These ports cannot be used for charging devices such as cell phones.  
14. Ethernet IEEE 802.3af (compatible power sourcing ports)  
15. IEC Power Input and fuse. For continued protection against risk of fire, replace only with 

same type and rating of fuse. 

For connector pins, see Connectors >> 

Cobalt 10 
The Cobalt 10 has the same connectors and specifications, except there are no switched outlets (3). 
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Cobalt Light Server, Congo Kid & Congo Jr 
The Cobalt Light Server, Congo Kid & Congo Jr have the same connectors for everything except 
monitors, and there are two ethernet connectors instead of three.  

  

These systems support up to 2 monitors using the following combinations: 
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Installation guidelines 
Equipment required to run this system 

• Cobalt20, Cobalt10, Cobalt Nomad, Net3 RVI, Client software  
• Power cables  
• Up to three external DVI multi touch monitors.  
• DMX512 or Ethernet cable(s) to external equipment  

Connect the monitor signal cable(s) from the back of the console to the monitor(s), and then connect 
the power cables to a 230/110V outlet and start all units. After approximately 30 seconds Cobalt 
should be running. 

See Power-up Procedure. 
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Key Syntaxes 
There are mainly two kinds of keys in the console: keys with a fixed function, and softkeys in the 
screens. 

Keys in the Cobalt can behave in the following ways 

Function   Description   Example 

Direct  Will perform a function directly 
when it is pressed. 

GO and PAUSE in the Main 
Playback 

Numerical 
Prefix 

Requires a numerical entry (0-
9) before it is pressed. 

(#) RECORD to store a 
preset with that number 

Combination Will change the function of another 
key if it is held down while 
pressing that key. 

Hold C/Alt and press 
PLAYBACK to clear the 
Main Playback 

Some keys can combine all three ways of working. An example of this is the PRESET key 

• Pressing PRESET with no numerical prefix opens the Preset List with all presets.  
• A number and PRESET selects the channels of that specific preset.  
• A number and holding PRESET while pressing a Master Key will load preset (#) to that 

Master. 

NOTE 
Hold down the ? (HELP) key, and press any key to get help on it. 
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Cobalt Terminology 
It can be easier to understand Cobalt if you are familiar with the basic terminology. 

Channels (terminology) 

A Channel is the control handle used to call anything controlled by Cobalt. Regardless if it is a 
dimmer channel, a moving device, a smoke machine or something else it will always correspond to a 
channel number in the Patch. A channel will control nothing unless it is patched. You can start with a 
patch 1:1.  

To select a channel and set a level, enter the number and move the level wheel. 

See Channels  

Attributes (terminology) 

Any type of device that has more than intensity (color, movement etc) is called a device and the 
control of non-intensity parameters, for example a moving device or a scroller, are called attributes. 
These are patched to the controls of Cobalt when the Template corresponding to that device is 
assigned to a control channel in the Patch. 

See Moving Devices 

Patch (terminology) 

Patch is where outputs are assigned to channels, either directly in the case of dimmers or using a 
Template in the case of devices. All settings pertaining to outputs, channels and devices are also 
adjusted within the patch. 

See Patch 

Groups (terminology) 

Frequently used combinations of channels can be stored in up to 999 Groups, for quick recall from the 
keypad or a remote focusing system.  

See Groups 
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Presets (terminology) 

The basic building block combining channel intensities, device parameters and referenced data such as 
palettes is stored in a Preset. The combination of a Preset and a Sequence Step is the equivalent of a 
"Cue" in many other systems. The advantage here is that Presets can be reused in any Sequence, with 
different times. A Preset can be played back from any of the 80 Master Playbacks as well. 

See Presets 

Sequences (terminology) 

Lists of Presets are called Sequences, that can be crossfaded, move faded or lock faded in consecutive 
order from a Master or Crossfade Playback. A Sequence can be played back in Chase mode. 

See Sequences 

Effects (terminology) 

An effect is a repetitive content that runs in a loop and where you can affect speed of playback and 
other things. Effects are run in effect playbacks, very similar to channel handles for moving devices.  

There are four types of effects. 

• Chase Effects - intensity only, step based with tap tempo.  
• Content Effects - very powerful content based effects that can be reused with new data.  
• Dynamic Effects - Wave-form effects to provide movements.  
• Image Effects - a text or an image source is mapped to a channel layout. 

There is a backwards compatible older style of chase effect which is a mode for a sequence. 

See Effects 
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Control Hierarchy 
The control hierarchy is this 

• Intensity is handled with highest-takes-precedence (HTP) logic, meaning the highest output 
level will be the "winner" and have control of those channels.  

• Attributes are handled using last-takes-precedence (LTP) logic, meaning the last instruction 
given to the attribute will be the winner. 

• There is a Grand Master and Inhibit Masters that can subtract from the output.  
• There is a Capture mode which can override HTP control of intensities. 
• Masters can be set to "own" attributes of devices, overriding all other LTP controls. 
• Masters can be set to an Exclusive Mode, which takes the content of the master out of 

"normal" control in the rest of the system.  

Playbacks - Introduction 

Intensities and parameters can be played back from the following playbacks. 

• The main playback (A/B) and Live field  
• The 80 master playbacks  
• The Independents  
• The Blind field  
• The Freeze field 

The following functions can affect the playback of an intensity or parameter 

• Capture Mode  
• Exclusive Mode  
• Inhibit Mode  
• Balance Mode  
• Park  
• Scale  
• Mute  
• Solo 

SUMMARY 
Cobalt has a main theatrical playback, plus 80 Master Playbacks. All of them are capable of running a 
sequence or chase. The main difference is that the theatrical playback has a large amount of different 
manual controls for crossfades. 

• The Live and Blind fields are central to the concept of Cobalt - being able to work in both at 
the same time.  

• The Independents are a special set of masters, designed for control of special channels you 
want to keep separate from the rest of the system.  

• The Direct Selects are used for quick selection and assignment of data suitable for single-
button action like group selects, palettes, screen layouts and such. They are extremely 
powerful. 



Cobalt 8.1 - 20181029 

54 

 

  

Control Hierarchy - Master Playbacks 

Light output from the Masters is added to the output on a Highest Takes Precedence basis. Device 
attributes are controlled by Last Takes Precedence.  

• Any master set to Inhibit Mode will subtract the assigned channels from the output similar to 
the function of the Grand Master. 

• Any master set to Exclusive Mode will be the only master controlling the assigned channels, 
and they are masked from recording. 

See Master Playbacks 

Control Hierarchy - Main Playback 

Light output from the Main Playback is added to the output on a Highest Takes Precedence basis. 
Device attributes are controlled by Last Takes Precedence. 

The Main Playback consists of two faders, one for the active channels (A), and one for the channels in 
the next step (B). A and B also interact on a Highest Takes Precedence basis, with the addition that 
channels that exist in both faders are calculated so all crossfades are dipless. As a result, even if both 
faders are at 0%, common channels will remain on stage.  

From 8.0 there is an option of choosing one of 9 additional multi-user Main Playback's to facilitate 
networking with different sequence content in the Main Playback. 

See Main Playbacks 

Control Hierarchy - Highest Takes Precedence 

You can output light from all Masters and the Main Playback at the same time. But what happens if 
you have faded in Preset 1 on the Main Playback and it's up on a Master too?  

- The answer is that the highest intensity level of a channel "takes precedence" whenever it's output 
from more than one place in the system. 

If the "Highest" level for a channel is generated from one of the Masters it is displayed in yellow, if it 
is generated from the Main Playback it is white. 
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Software & Update 
We constantly update the Cobalt software with new features, bug fixes and changes. Check 
www.etcconnect.com periodically to see if there's a more recent version than the one you are currently 
working with. 

Software versions come in two types: Beta release and Official release. Beta releases are test versions, 
which are not meant for use on real Plays. Once Beta releases are tested and proven reliable, they 
become official releases. 

The Cobalt software is owned and manufactured by ETC. 

To update the software see System Settings - Update. 

Version Information 

You can see which version you have in About Cobalt (Browser >About>About Cobalt). 
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Workflow in Cobalt  
The workflow in Cobalt can be divided into five steps 

 

This chapter is a simplified introduction to this workflow - meant to serve as an introduction to the 
basic functionality of the system. 

Patch  
Before you can control a dimmer or device it has to be patched to a channel. See Patch (workflow). 

Control  
Control is how you select channels, set levels and control parameters. See Control (workflow). 

Record  
To be able to playback something it has to be recorded. See Record (workflow). 

Playback  
There is a main playback and 40 master playbacks. See Playback (workflow). 

Edit 
When recorded information needs to be adjusted there are many tools for editing. See Edit 
(workflow). 

Patch (workflow)  

 

There are various approaches to patching, which depend on your situation. Very often conventional 
lights are patched in one universe, and moving devices in another, in order to simplify 
troubleshooting. The main work with patching is the planning involved before approaching the 
console. 

Patching Conventional Lights 
There are three basic approaches to patching conventional lights 

Patch 1:1 
You can choose the option "Patch 1:1" when you open a new play, or you can set the Patch 1:1 in the 
Patch Wizard.  
See Patch Wizard. 
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Patch by channel 
Patch by channel is easy and fast in the Output editor. It can be done live or blind. You can start with a 
cleared patch or with a 1:1 patch.  
See Patch by Channel/Dimmer. 
 
Patch by dimmer 
Patch by dimmer is easy and fast in the Output Editor. It can be done live or blind. You can start with 
a cleared patch or with a 1:1 patch.  
See Patch by Channel/Dimmer. 
 

NOTE 
To clear the Patch, see the Patch Wizard.  
To get an overview of the current patch, see the Channels List. 

Patching Moving Devices 
To patch a moving device, scroller, color mixing device or media server you need to load a template 
for this device. This can be imported with the Import Template Wizard or from another play. You can 
also create custom templates in the Template Editor.  
See Import Template Wizard.  

There are two approaches to patching single or multiple moving devices 

Patch Wizard 
In the Patch Wizard it is easy to patch single devices, and multiple devices that have consecutive 
addresses. It's possible to add a channel offset to a template as well.  
See Patch Wizard. 

Device List 
If you are patching single devices, or multiple devices with irregular addresses the Device List is a 
great tool. It's also great for changing address or universe, and for adjusting individual parameters like 
pan, tilt and scroller calibration.  
See Device List. 

Control (workflow) 

 

Controlling channels, levels and moving device parameters is very straightforward. The default setting 
is to work in "Live" which is the sum of all playbacks. Intensities are added to live in the A field of the 
main playback.  

Command Syntax 
The whole command structure of Cobalt is designed to get you from point A to point B with as few 
keystrokes as possible. Basically, there is no function or feature that involves more than two key 
presses (besides numbers).  
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The structure is simple 

• Press a key  
• Hold a key and press another key. 

 When a number is required, simply enter it before either of the key combinations above. 

See Channels - Command Syntax. 

Channel "handles" 
Regardless if a lighting instrument is a conventional light, or some kind of moving device, the 
intensity function of this device is assigned a unique Channel number in the patch.  

Example 

• Enter a number and move the level wheel to select the channel and change the intensity.  

When you select this channel, all parameters are automatically mapped to the controls of the console. 
All parameters are divided into three groups that have a dedicated key in the console. 

• FOCUS (pan/tilt)  
• COLOR (color mixing and color wheels)  
• BEAM (gobos, shutters, iris, zoom, prism etc) 

Example 

• If a selected channel has a scroller, press COLOR. The scroller can be controlled from 
one of the four parameter wheels by number (frame) or continously.   

• If a selected channel is a moving device press FOCUS to get pan and tilt functions on the 
parameter wheels. 

See Devices - Control. 

The easiest way to control a device is from the Device Controls tab where all functions are mapped 
and accessible at the same time. See Device Control Tab.  

NOTE 
If you are looking for a "RELEASE" function you are probably used to 
working with a console that has a "programmer". There is no programmer 
in Cobalt, instead you work directly in any playback. 

Record (workflow)  
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If you press RECORD in LIVE, the default record target is the next free Preset, of the Sequence in the 
Main Playback. You can record to any other target as well, using the various recording functions.  
See Presets - Record. 

What is recorded? 

Intensities 
The default setting is that all intensities on stage are stored. Conventional lights and moving devices 
alike. 

Moving Devices 
Before you start recording moving devices, you need to make two decisions in the default settings for 
attributes (parameters). 

• What parameters do I want to record? (active (default), changed, popup, all, ).  
See Device Recording - Modes.  

• How do I want parameters to be executed? (Auto Mark (default), On Go, In B).  
See Device Play back - Go OnGo or GoInB. 

Where is it recorded? 

Presets - the basic building block 
Light intensities and moving device parameters are stored in Presets. A Preset is referenced data that 
can be played back on its own in a master or the main playback. It can also play back as the content of 
a sequence step or content effect. A preset can contain absolute data (values) or referenced data 
(palettes). 

See Presets. 
See Sequences. 

Other types of record targets 
Besides presets there are Groups for organising channel selection and Palettes for referencing moving 
device data.  
See Groups. 
See Devices - Palettes. 

Playback (workflow)  

 

There is a Main Playback, and eighty Master Playbacks. The Main Playback is used for theatre 
style sequential playback of any Preset or Sequence.  

The Master Playbacks can play back 

• Single channels  
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• Groups  
• Palettes  
• Parameters  
• Presets  
• Sequences  
• Console keys 

See Masters. 

Playing back Presets and the main sequence. 

• As soon as a preset is recorded you can play it back in the Main Playback or any of the 80 
Master Playbacks.  
See Presets - Load To Playbacks.  

• All presets that have been recorded in Live have been added to the Sequence of the Main 
Playback as Steps with default fade times (5s). They can be played back with or without this 
default time, or manually. 
See Main Playback. 

Rules for playback 

• Intensities will play back following HTP (Highest Takes Precedence) between all playbacks.  
• Attributes are LTP (Latest Takes Precedence). As soon as they are triggered they will move 

to this position. They are never owned by a playback. 

Exceptions 

• CAPTURE will override all normal playback features and "hold" the values of intensities 
and/or attributes. 
See Capture.  

• There is a PARK feature to park any intensity or parameter at a fixed value. 
See Parked.  

• There is an exclusive mode for the Independents and Master Playbacks, that will "remove" 
the intensity of the assigned channels from the normal functionality of the console. 
See Independent Modes.  

• There is an INHIBIT mode for the independents and Master Playbacks, that allow you to 
filter the maximum output of an intensity channel. 
See Independent Modes.  

• There is a FREEZE mode that will maintain a static DMX output so you can work 
completely blind.  
See Output Switch. 

  

Selecting and playing back from the Direct Selects 

A powerful and simple interface for plaing back information is the Direct Selects Tab. Open by 
clicking on a "+" sign in a screen area and select Direct Selects. You will have four types of play 
objects pre-selected: Group, Focus, Color, Beam. Click on a group to activate, then on a Focus, Beam 
or Color palette to activate that. By pressing TYPE you can change to any other type of object for fast 
access and playback. See Direct Selects.  



Cobalt 8.1 - 20181029 

61 

 

Edit (workflow)  

 

Once a Play is recorded you will want to edit and adjust data. Most of the functionality in Cobalt is 
about editing. Here is where basic data is edited. 

Groups 

• Channels, intensities and text is edited in the Groups list.  
See Groups - List. 

Presets 

• Intensities, text and FCB timing data are edited in the Preset List.  
See Preset - List.  

• Attributes and individual attribute times are edited in the Preset Attribute editor. 
See Device Views - Presets. 

Sequences 

• Presets, In/Out/Delay/Wait times, text, Attribute Move, Time Code, Macros and Notes are 
edited in the Sequence editor.  
See Sequences - Sequence List.  

• Channel Times are edited in the Channel Time editor.  
See Sequences - Times.  

• Master Links are edited in the Master Link editor.  
See Sequences - Links.  

• General playback mode (Sequence/Chase) and chase parameters are set in the Sequences list. 
See Sequences - List. 

Additional editing features 

• It's possible to track and edit intensities and parameters in a lot of different ways with the 
Track function.  
See Track - Track Editing.  

• To edit channel intensities in the main playback there is a Channel Editor Wizard.  
See Presets - Channel Editor Wizard. 
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Troubleshooting 
When you run into a problem with this system there are few probable 
reasons (system hardware, system software, operating issue, surrounding 
equipment).  
 
You may find the answer here, if not, ETC has 24/7 support >> 

This chapter contains the following sections 

• Troubleshooting - FAQ  
• Troubleshooting - Crashes & Bugs   
• Troubleshooting - Reset  
• Troubleshooting - Help from ETC Technical Services 
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Troubleshooting - FAQ 
Here are some situations that you may run into. If these don't solve the issue, contact support at ETC 
Technical Services 24/7.  

  

Troubleshooting - Console Keys do not respond 

Console is not responding to key presses 

If a key gets mechanically stuck it will seem like the console is not responding - however mouse and 
keyboard will still work.  

• Try pressing ESC twice and test again. 

  

Troubleshooting - Lights Are Not Responding 

Lights (dimmers, devices) are connected and they are not responding. 

• Have you reset the console properly? See Reset the system.  
• Is the device powered properly?  
• Is the device set to receive the protocol you have set the board to transmit?  
• Is the device receiving a signal from the console?  
• Is the device set to the right channel address?  
• Is there a light source connected to the device?  
• Is it a lamp failure?  
• Is the device circuit breaker thrown?   

If nothing works you may want to use a DMX tester to check that there is DMX at the receiving 
devices. 

Troubleshooting - Flickers 

A Dimmer/device with start address below ~200 flickers or drops out at semi-
regular intervals. 

• Turn off RDM at the DMX port it is plugged into using system settings/GCE.  
If this stops flicker then device is not fully compliant with the DMX spec, inform supplier so 
they can fix.  
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• Check termination by connecting device directly to a DMX output with no other devices 
connected. 

Troubleshooting - External Touchscreen 

Touching one selects something on the other screen. 

Touchscreens can't match the touch and screen automatically, they have to be told which is which. 

• Recalibrate and ensure to select the right screen.  
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Troubleshooting - Crashes & Bugs 

All software-based products run the risk of a crash regardless of testing 
procedures. In the unlikely event it happens, please help us to eliminate 
problems with crashes and bugs by reporting them to us. 

To make it easier and faster to solve problems with the Cobalt software, it is important that problems 
are reported in a proper and complete way. 

First, it is important to define what a Crash means. To a developer, a crash means that the application 
crashes with some kind of error message. Most crashes can be intercepted to make it possible to save 
play data and to present a proper crash message. These are known as "handled crashes". Handled 
crashes produce an error message and also produce what is known as a "Dump file" containing 
important information about the console state when the crash occurred. In addition, a "Recovery File" 
is produced and is offered on a restart so that you can recover any data you programmed but had not 
saved before the crash.  

When you have restarted, please connect your USB stick to the console and use the 
BROWSER>FILES>COPY LOG AND DUMP FILES TO USB command to copy a ".zip" archive of 
a number of files to that USB stick. Please email that ".zip" file, a copy of your play file and a detailed 
description of what you were doing at the time of the crash to cobalt@etcconnect.com. 

If the application hangs or misbehaves, this is not regarded as a crash (it may still be a serious problem 
however). 

• If the application seems to hang, please check the following things:  
• Was the hour glass constantly on in the upper corner? If so, this is a real hang-up. The system 

should only be in this state for 30 seconds before a log file is created. Please follow the 
directions above to send the log file to us.  

• Does anything work? Mouse, keyboard, some buttons etc? If an external keyboard is 
connected, is anything pressing down a key like a script or a headset?  

• Was it possible to press ESC to unlock this state? (It is possible, in some very special 
situations, that a key could be "forgotten" in the down state, which blocks other keys. ESC 
should always fix this.)  

• Does it say "Keyboard override" in the upper right corner? If so, there is probably a text cell 
open for editing somewhere on screen. 

Is there a focused tab (with the orange frame)? In rare situations the focus gets lost, meaning there is 
no tab focused, which can be confusing since some things don't do what you expect. If there is no 
focused tab, click on one using the mouse or trackball or enter a tab number and press TAB. 
  
If you need to report a problem, please try to include as much information you can about: 

• the software version number  
• the configuration (standalone, server/backup, other connected devices on the network, etc)  
• the situation the problem occurred in (what did the user do when it happened, open editors, 

special conditions etc)  
• any other information that you think could be useful 
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If we get this information from the start, it makes it easier for us to provide a fast and 
professional service. 

What to do after a crash? 

In most cases your play will have been saved (recover.asc). In this case you got a popup explaining 
this and returned to the login screen.  

• Log in again. 

If you don't return to the login screen, which is extremely unlikely you need to restart the console. 

• Press Esc if the front panel seems frozen.  
• Try resetting the console using the reset button on the back, in the middle.  
• If none of these efforts work, contact your local ETC Support. 

Making a crash or bug report 

If you have the possibility, try to reproduce the problem by repeating your actions. If you can send us 
a description of how to repeat the problem we are likely to solve it rapidly. 

Crash or bug report 
Date = 
Your Name = 
Phone/fax/mail = 
Cobalt Software version = "4.1" (bottom left corner of the main screen, or About Cobalt in the 
Browser) 

Description (example): 

1. I was trying to edit a Preset on stage. 
2. I started a crossfade  
3. I got a crash with a message = "FILE main.cpp LINE 37" or "Offset: 12345678" 
4. It is repeatable following 1 & 2. 

Please fax the bugs reports to Cobalt BUG REPORT at +49 8024 990-300 or preferably e-mail them 
to Cobalt@etcconnect.com  

An Error Popup Appears - copy log 

If you get an error popup we have saved your show data and created two files (log and dmp) that can 
be saved to a USB memory if there is one connected to the console.  

Mail these file to us. It can help us solve your problem very fast. 

1. Make sure there is a USB memory in one of the USB slots. 
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2. Open the Browser and select "Copy Log files to USB" 

 

3. Mail both files (log & dmp) to Cobalt@etcconnect.com  

NOTE 
This has to be done directly. The dmp file is a temporary file that will be 
overwritten if anything happens later. BOTH files are needed to solve the 
problem. Thank you for your help. 
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Troubleshooting - Reset 
There is a hard power switch in the back of the console and a soft power switch in the top right corner 
of the frontpanel.  

To make a soft reset, hold the power key in the top right corner of the frontpanel for five seconds. 

  

In order to reset the console completely, turn off the power, count to five and then turn back on.  
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Troubleshooting - Help from ETC Technical Services 

Emergency service is available from all ETC offices outside of normal 
business hours.  

If you are having difficulties, your most convenient resources are the references given in this manual 
and the Help system. To search more widely, try the ETC website at 
www.etcconnect.com/community. If none of these resources is sufficient, contact ETC Technical 
Services directly at one of the offices identified below.  

When calling for help, please have the following information handy 

• Console model and serial number (located on back panel)  
• Software version (is located beneath the Cobalt logo on Screen 1)  
• Dimmer manufacturer and installation type  
• Moving light information (manufacturer, mode, data cable type)  
• Other components in your system (Unison®, other consoles, etc.) 

ETC Technical Services - United 
Kingdom 

Electronic Theatre Controls Ltd. 
Technical Services Department 
26-28, Victoria Industrial Estate 
Victoria Road, London W3 6UU 
England 
Tel: +44 (0)20 8896 1000 
service@etceurope.com 

ETC Technical Services - Americas 

Electronic Theatre Controls Inc. 
Technical Services Department 
3031 Pleasant View Road 
Middleton, WI 53562 
800-775-4382 (USA, toll-free) 
+1-608 831-4116 
service@etcconnect.com  

ETC Technical Services - Asia 

Electronic Theatre Controls Asia, Ltd 
Technical Services Department 
Room 1801, 18/F, Tower I 
Enterprise Square 
9 Sheung Yuet Road 
Kowloon Bay, Kowloon, Hong Kong 
+852 2799 1220 
service@etcasia.com  

ETC Technical Services - Germany 

Electronic Theatre Controls GmbH 
Technical Services Department 
Ohmstrasse 3 
83607 Holzkirchen, Germany 
+49 (80 24) 47 00-0 
techserv-hoki@etcconnect.com  
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GENERAL FUNCTIONS 
These are important functions that apply in general and don't belong to a 
specific chapter or node of the Browser.  

These are the chapters 

• Cobalt Console Facepanel  
• Cobalt Screens  
• Power up procedure  
• Output Control  
• Copy, Cut & Paste  
• Entering Texts  
• Display Lists  
• Mute & Solo  
• Lock Console  
• Direct Selects  
• Cleaning The Cobalt Console 
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Cobalt Console Facepanel 

 

1. Touch Screens  
2. Independents  
3. Power & USB slot  
4. Screen Keys  
5. Device control  
6. Output control  
7. Master playbacks  
8. Programming section  
9. Main playback 
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Programming Section 

This is where most of the programming is done. Numerical entries, opening editors, recording and 
setting times. Some of the areas are grouped by functionality and sometimes referred to in this help 
system. 

 

1. Play objects  
2. Core editing keys often used in combination with other keys (MODIFY, ESC, INSERT, 

DETELE and arrow keys)  
3. Screen navigation (in combination with the arrow keys)  
4. Time functions  
5. Channel and level entries  
6. Level wheel  
7. Live and Blind fields and screen formatting (in combination with arrow keys and level 

wheel) 
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Cobalt Screens (8.0) 
Cobalt systems can support three external monitors/touch screens besides the two built in touch 
screens.  
In addition to this each section of five master playbacks share a smaller touch screen. 

Screens can be navigated with tap and gestures, mouse and console keys.  

• A status bar is available at the top of all screens.  
• All screens can have a multi-section layout containing tabs. 

Screen Functions (8.0) 

Screens can be set up any way you want. These are some basic functions. 

Screen 1 

 

1. Server status, Play name  
2. Status area for temporary modes that affect output   
3. Volume, screen and direct buttons for console mimic, layouts and the Browser   
4. A tab area  
5. Tab information area  
6. Info area about selected tab or channel  
7. Soft key pages  
8. A screen split from the layout tool  
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9. Software version  
10. Numerical input  
11. Level of currently selected channel  
12. Channel control - which field channels are controlled in currently  
13. Record target  
14. Message field for system warnings/information  
15. Output status indications 

Soft Key Pages 

In the right side of screen 2 (screen 1 in software versions) there are soft keys.  

 

This is the top level.  
The back arrow will bring you one level back "up" to the top level, from wherever you are.  
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The Browser 
Press BROWSER to select the Browser dock. 

 

The Browser dock gives you direct access to all functions and data in Cobalt.  
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Browser Controls 

Action Key Feedback 

Select the Browser [BROWSER] The Browser is focused. Press again 
to close or open it. 

Move up/down in a list [Arrow_Keys] Up and down arrows move in all open 
lists. 

Open a sublist [Right_Arrow] The right arrow opens a sublist under 
a closed node. 

Jump to top sublist [Left_Arrow] The left arrow jumps to the top of a 
sublist, and closes that node if pressed 
again. 

Open an editor  [MODIFY] Opens the editor of the object selected 
in the Browser. 

Collapse the Browser [C/Alt] & 

[BROWSER] 

All open nodes are collapsed. 

Open Context menu [SELECT] 

[SELECT] 

Opens the context menu 

Track item [TRACK] Tracks the selected preset or palette in 
the Sequence loaded to the Main 
Playback. 
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Browser Functions - LOAD 

Use MODIFY and LOAD to activate selected items from the lists in the Browser. This key is only in 
Congo Sr, Jr and Kid. It can be assigned to a Magic Sheet or master.  

Action Key Feedback 

Open an editor  [MODIFY] Opens the editor of the object 
selected in the Browser. 

Activate a palette [LOAD] Activates palette # for the selected 
channel(s). 

Load a Group [LOAD] Loads the selected Group to the 
active Channel View. 

Load a sequence to the 
main playback 

[LOAD] Loads the selected sequence to the 
Main Playback* 

Load a Preset to the 
active channel view 

[LOAD] Loads the selected Preset  

Load a Group to a 
master 

[LOAD] & 

[Master_key] 

Loads the selected Group to a 
master. 

Load a sequence to a 
master 

[LOAD] & 

[Master_key] 

Loads the selected sequence to a 
master. 

*Its possible to expand items like Sequences to see linked information for each step, and to open the 
corresponding editor by pressing MODIFY. 
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Tabs (8.0) 
Press TAB to select and step through all open tabs in all screens.  

 

All data and editors are opened in a tab. Tabs are opened in the currently selected screen section.  You 
can split a screen into different sections from the screen section function in the top right corner of a 
screen. Two tabs are default locked from being closed: LIVE and MAIN PLAYBACK. 

 

When you press the "+" sign in the top left corner of every screen section you will get the Tab 
Selector.  
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1. Tab header 

• Touch a tab to activate.  
• Every tab is assigned a number when opened. # TAB selects this tab. 

2. Tab header context menu 

• Open (new) tab  
• Maximize tab   
• Setup tab   
• Tab help 
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3. Tab Parameter Setup (depends on tab) 

• Include Channel View in Pool: See Live - Live Tab.  
• Lock tab from closing (See Tab Setup & Lock)  

Auto close tab mode 

In Cobalt Console Settings you can activate a mode that will close the previous tab when a new tab is 
opened, to keep down the number of tabs at all times.  

See Console Settings..  

Navigating The Tabs with console keys 

Function  Key Feedback 

Toggle open tabs [TAB] Steps through all open tabs in all 
screens 

Select Tab # [#] [TAB] Selects the tab with that number 

Move   [TAB] & 

[Right_Arrow] 

[TAB] & [Left_Arrow]

Moves the selected tab to another 
screen or screen section in a split 
screen view. 

Close   [ESC] Closes any selected tab except Live, 
Playback and those locked. 

Reset all   [C/Alt] & [TAB] Closes all tabs except Live, 
Playback and locked. 

Reset all  
(including locked) 

[C/Alt] & [TAB] 

[TAB] 

Resets to default screen layout. 
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Tab Setup and Lock 

It is possible to lock a tab from closing when you press ESC.  

• Hold SETUP and press TAB to open. 

 

Include Channel View in Pool refers only to Live Views. See Live - Live Tab. 

Split/Full Screen 

Tabs are opened in the currently selected screen section.  You can split a screen into different sections 
from the screen section function in the top right corner of a screen.  
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Tab - Console Mimic  
The Console Mimic dock gives you the user interface of the physical console.  

Symbol in the Tab Selector: 

 

• Click on a button or fader to press or move. Pressed button is indicated with a yellow 
background.  

• Hold CTRL and click on a button to "hold" it so you can press another button after. Please 
note that this is not the same a holding CTRLand pressing a key in a keyboard - since CTRL 
is used as a shift key there.  

• Combine the Console Mimic and keyboard or console commands, for example hold 
RECORD and press a Direct Select button.  

• Hold FORMAT and use the level (or mouse) wheel to zoom. 

 

NOTE 
Important Limitation - because the mimics are within Cobalt, when dialog 
boxes open on top of Cobalt all other Cobalt controls are unavailable, 
including the console mimic. For data entry and navigation of dialogs, 
physical console keys, alpha keyboard/mouse or an attached X-Keys panel 
must be used. 



Cobalt 8.1 - 20181029 

83 

 

Tab - Designer Summary 
The designer summary provides playback information at a glance that is intended to be useful for the 
lighting designer.  

Symbol in the Tab Selector: 

 

 

There are three formats that can be toggled with the FORMAT key or context menu: 

• Main playback & selected (channels)  
• Selected (channels)  
• Main playback  

1. Main Playback 

• Palette information for A or B depending on what is selected in the Crossfade Settings, see 
Play Settings - Crossfade. The Palette section only shows palette info for palettes that have 
been executed by the main playback, as part of the sequence. The box to the left indicates 
with Red background in the playback info block that a crossfade is running.  

• The number of Devices in the next fade  
• The total duration of the step in A or B, plus In/Out/Delay times for intensity and Focus, 

Color, Beam.  
• Timecode in and the next timecode step.  
• Recording mode for moving devices  
• If times are set to A or B 
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2. Selected 

• Active palettes  
• Channel database texts  
• Dimmers address, curves and device address (single channels only)  
• The previous level  
• The current level  
• A command line view of the last key presses 
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Tab - Selected Live  
The Selected Live tab shows all currently selected channels and effect playbacks. This is the view that 
will show effect playbacks and channels together. 

Symbol in the Tab Selector: 

  

 



Cobalt 8.1 - 20181029 

86 

 

Tab - Master View 
The Master View shows all masters . You can view and select masters, set levels and drag channels 
and presets to them. See Master View.  

Symbol in the Tab Selector 
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Tab - Time Code  
The Time Code tab provides a summary of the important time code features and information. 

Symbol in the Tab Selector 

 

 

To the right, use the screen buttons to select Internal or External time code source. 

Enable BU (BackUp) clock will set the internal clock to take over if the external source is lost. 

Console Time code Settings 

• LEARN activates learn mode. See MIDI - Time Code  
• Auto Locate activates auto location. See MIDI - Time Code 
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Tab - Device Controls Tab 
As soon as a device is selected, all non-intensity parameters are available in the Device Controls.  In 
the ALL tab parameter values will be fetched from the first device in the selection that has such a 
parameter defined. This works both for decimal channels where the parameter values of the sub 
channels are shown when the the whole channel is selection. It also works when selecting different 
types of devices at the same time. 

Symbol in the Tab Selector 

 

Mouse: left-click and drag to change values of a parameter, or enter a numerical value and click. 
Touch screen: touch and drag to change values of a parameter, or enter a numerical value and touch. 
 

 

Device Controls Tabs 
The Device Controls tab contains tabs that offer controls for the raw parameters of devices or effects 
and tabs that contain “virtual” controls that affect the output of devices through tools designed to 
make controlling things like color mixing systems easier or more consistent. 

Raw control 

• All parameters  
• Focus  
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• Color  
• Beam  
• U1, U2, U3 

Virtual control 

• Color Mixing tab  
• Gel Picker 

NOTE 
When more than one device is selected, all parameters are displayed for all 
selected devices. You can use Next/Last to access individual parameters 
within the current selection. 
(See Channels - Next & Last Mode) 

Parameters tabs: All, Focus, Color, Beam, U1, U2, U3 

The F/C/B and U1-U3 tabs mimic the mapping of the physical encoders on Cobalt consoles, but can 
display all of the parameters in a category on one screen simultaneously. The F/C/B tabs display 
parameters assigned to each of those categories and the U1-U3 pages show parameters in a user 
defined order. 
(See Device Control - U1-U2-U3)  

The All tab shows all the raw parameters of the selected device(s) or effect playbacks in one screen 
simultaneously, grouped by parameter category. 

 

Virtual controls tabs: ColorMixer and GelPicker 

The Color Mixer tab includes controls that are routed through a generic Hue-Saturation color space so 
that devices with differing color mixing systems can be controlled simultaneously, or so that fixtures 
with color systems including more than RGB or CMY can be controlled more easily.  
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The color wheel indicates the current setting of the selected device channel or the first channel in a 
grouping. Some of the fixture templates within the Cobalt library also include color calibration data. 
In this case, a black line is drawn on the color wheel when that device is selected. This line indicates 
the valid color space for the fixture type. Colors outside of the black line are not achievable by the 
color mixing system of that device. 

The Hue and Saturation controls will move the dot in the color wheel either around the wheel from 
one color to the next (Hue) or along the radius of the wheel where the dot is currently located 
(Saturation).  

The closer the dot gets to the center of the circle, the closer to white the color system is moving – 
approaching a saturation of zero. Away from center indicates deeper color – approaching full 
saturation. 

The RGB and CMY Saturation controls allow you to adjust the color by adding or decreasing the 
amount of  a color area within the Hue/Sat space. As you move around the wheel, the RGB and CMY 
controls will indicate equivalent mixes for those two color spaces. 

In the image below, you see a patched Source Four LED Lustr+ with a 7-color mixing system selected 
with the Mac300 device with a CMY mixing system. Both channels are selected at the same time and 
when you make adjustments within the tab, both devices will react to create a similar color. In the 
screen below you can see both lights are set to a light cyan color. In the CMY saturation tools, this 
color contains no magenta at all. 

 

As an example, if we increast the level of magenta saturation, both fixtures will shift to a more purple 
color in output, and the other color saturation handles will adjust to reflect the new mixed color. The 
dot on the color wheel will also move to the new color position. All of the controls in this tab are 
interconnected and will move as you change the colors.  

You can see that the color mixing systems of the two devices are very different, but they are adjusted 
by Cobalt to create the desired color automatically. Raising the Red Saturation control could perform 
a number of different adjustments  - increasing the red circuit in an RGB system, or increasing both.  

Magenta and Yellow in a CMY system, for example. The virtual tools allow you to mix colors 
without having to work in all the native color spaces of the devices in your rig. 

Please note, if you have devices that have been calibrated, it may not be possible to drag the 
RGB/CMY Saturation controls to “full”, depending on the current color mix of the device(s). As you 



Cobalt 8.1 - 20181029 

91 

 

can see in the images above, the selected device cannot create colors at the very edges of the color 
wheel. The color wheel is showing its concept of “full saturation” for all colors. If a device cannot 
create that saturation level of a color, the adjustment handles will stop at the maximum saturation that 
light can create. The maximum saturation level may be different depending on the other colors in the 
mix. 

Also, it is possible that devices may be able to create colors using raw controls that the generalized 
HueSaturation system won’t allow. If you want to control the raw parameters of the fixtures, please 
use the Color tab instead. 

 

  

THE GEL PICKER 
The GelPicker tab includes buttons that correspond to the color filter manufacturers in the Cobalt 
library. To use this tab, simply type the number of the color filter you want and then press the 
manufacturer button to apply it. 

 

There is also a GelPicker tab in the Browser (Browser>Devices) that includes all manufacturers/gel 
numbers in one spreadsheet view with a color chip for each color.  
(See Gel Picker) 
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Tab - Direct Selects (DS) 
The Direct Select Tab gives you fast direct access to all kinds of show content in four user definable 
matrix sections.  
 
Symbol in the Tab Selector 

 

The Direct Selects tab contains sets of buttons that can be assigned provide direct access to a number 
of different data types: 

• record targets, like groups and palettes  
• parameter ranges for devices, like color wheels, gobo wheels, strobe, etc.  
• recall objects, like screen layouts, sections and masks   
• control handles, like channels, masters and effects 

The Direct Select tab 

 

1. Tap to select User Page 1-5 of Direct Selects.  
2. The Special Functions allow you to record data directly, and set the current selection to 

0/Mark/Full/Home and deselct. (See Cobalt Direct Selects - Special Functions)  
3. Toggle to full screen mode.   
4. The quick jump buttons display the types of data assigned to each of the direct select blocks, 

and allow you to pull a block of direct selects to the top of the tab quickly. Each block can be 
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configured independently for type, number of rows displayed, and which bank/page is 
currently displayed.  

5. Select type of content in each block. (See Cobalt Direct Selects - Types of Data)  
6. Arrange functions for copying and moving items. See also Add/Replace.  
7. Select Bank. (See Cobalt Direct Selects - Bank and Page)  
8. Select Page. (See Cobalt Direct Selects - Bank and Page)  
9. Tap the Rows+ button to increase the number of buttons displayed up to 5 rows/50 buttons. 

Tap once more to return to 2 rows/20 buttons.  
10. Tap the Matrix button to access the 10x10 view. Tap the Rows+ button to return to the 

normal view.  
11. The blocks of direct select buttons may be displayed with 2, 3, 4 or 5 rows of 10 buttons 

each, or as a full 10x10 matrix.  

Full mode 
 

 

Cobalt Direct Selects - Types of Data 

Every Direct Select block can be set to contain the following types of data by pressing TYPE.  
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Focus, Color, Beam and All palettes 
Tap a palette button to activate this palette for the selected channels.   
(See Device Palettes) 

Group 
Tap a Group to select the channels of this group. Groups that are selected are flagged as yellow, 
meaning all channels of this group are selected. Orange means that only some channels are selected. 
White means no channels in this group are selected.  
(See Groups) 

Auto Group  
Tap an Auto Group to select the channels of this group. Auto Groups are automatically created from 
types of templates in the Device Patch and labels in the Channel Database.  
(See Auto Groups) 

PresetSel  
Tap the preset number in a DS button to select the channels with intensity in that preset. This allows 
you to use presets as groups for channel selection. The numbers and labels of recorded presets will be 
displayed in numerical order. 
(See Preset List).  

Channel  
Tap a channel to select or add/subtract to the current selection. Double tap to select and clear the 
previous selection. Hold finger and slide to change level. This set of buttons will display the channel 
name and leave empty buttons if channels have been renamed to zero. This is to keep the panel logical 
and to allow you to find channel numbers easily. 
(See Channels) 

Effect  
Tap an effect to select or add/subtract to the current selection. Double tap to select and clear the 
previous selection. Hold finger and slide to change level. Displays all effect playbacks created in this 
play. 
(See Effect Playbacks) 

Level  
Tap to set a pre-defined intensity levels in steps of 5% to the currently selected channel(s) and/or 
effect(s). 

Parameter 
Tap to select a parameter to set a value. Use this setting to assign a parameter with ranges to the DS 
block. To set the data type properly, first select a channel with the desired parameter name and find 
the encoder page containing that parameter. Then set the DS block to the Parameter type, and then 
press the wheel key for that parameter. As channels are selected that have ranges on that parameter 
name, these range names will populate the DS buttons live. 

Gels  
Type a gel number then tap the manufacturer DS button to apply that gel to selected device channels 
with color mixing systems.  
(See Gel Picker) 
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Mask 
Tap to apply a recorded parameter mask state to the console. 
(See Mask) 

Section  
Tap to jump to a section marker within the sequence on the main playback. 
(See Sections) 

Master  
Tap the master button and without lifting your finger, slide your finger up and down to adjust the 
output level of that master. Use the direct select keys like master faders, especially useful with Cobalt 
Nomad or when you want to adjust a master you don’t currently have assigned to a fader.  
(See Masters) 

Screen  
Tap so activate any recorded Screen setting. 
(See Screens) 

Client 
Tap to enable/disable connected clients. Displays connected clients. 

Cobalt Direct Selects - Special Functions 

Along the top of the DS tab there are some special function keys. 

 

RecordDS  
Allows you to record DS types directly within the DS tab. Select the Type of direct select you wish to 
record, press RecordDS and then press the DS button you want to store to. 

0%, Mark, Full 
These are buttons to quickly set intensity levels to selected channels directly from the DS tab. For 
additional intensity levels, use a DS block with the data type “Level”. 

HomeAll  
This button when double-tapped will send selected device channels to their default levels, as defined 
in the fixture templates or as recorded to the HOME ATTRIB key. 

ClearSel  
Deselects all currently selected channels/effects/masters. 
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Cobalt Direct Selects - Bank and Page 

Every block of direct selects can be arranged by bank and page within this bank. 

  

Bank 
Sets the block of direct selects to a range of that data type, based on the current number of buttons 
displayed multiplied by five pages. For example, with 20 buttons  displayed, a bank equals 100 
possible objects. With 50 buttons displayed, a bank equals 250 objects. The bank is subdivided into 
pages for quick access to additional objects. 

Page 
One fifth of a bank. Used for quick access to additional objects when you don’t want to use large 
portions of the screen for direct selects of a given type. The page buttons indicate the data object 
numbers – so when a Page buttons shows “Page 51-100” it indicates that you are jumping to show 
groups (or whatever data type) 51-100.  

Cobalt Direct Selects - Arrange, Copy/Move/Delete/Text  

Arrange mode is supported for Palettes, Groups and Action Macros.  

For a DS block with Palette/Group/Action Macro content, the Arrange button is shown.  

1. Press it to enter selection mode where you pick the source items.  
2. When there are items selected, the Copy and Move buttons will be active and can be pressed 

to specify a target. If there are conflicts, a warning dialog is presented. TEXT opens a text 
dialogue and DELETE a delete dialogue. You cannot add text labels to unrecorded item. 

 

On Move, Palette references in presets will be updated to refer to the new palette number. Group 
references in effects will be updated. 

You will stay in arrange mode until Arrange is pressed again, to exit.  
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Cobalt Direct Selects - Add/Replace  

For Groups there are two modes 

• Add - every new group that is selected is added to or subtracted to the previous selection  
• Replace - every new group that is selected will replace all previous selections 

 

Holding CH or ALL in combination with a DS-group or palette to select included or active channels 
will follow ADD/REPLACE. 

Cobalt Direct Selects - Console Keys in Combination  

A number of physical console buttons can be pressed in combination with DS tab buttons.  

UPDATE - to update Palettes 
RECORD - to record Palettes and Groups 
CH - Hold CH and press a Palette or Group to select all channels involved 
ALL - Hold ALL and press a Palette or Group to select all channels involved with a level above 0% 
TEXT - Hold TEXT and press a DS item to overwrite the text 
DELETE - Hold DELETE and press a DS item to delete 
 
CH/ALL will follow Add/Replace mode 

Cobalt Direct Selects - Direct Mode 

One of the very fast and unique functions of Cobalt. A large number of keys can be held to enter 
temporary Direct Mode for the Direct Selects. As long as the key is held it is possible to access the 
first forty items belonging to this key category.  

Function  Key Feedback 

1. Activate Direct Mode Hold a function key 
(see below) 

Direct Select display shows 
all recorded 

2. Select Direct Select 
screen key (1-40) OR 
Direct Select key 1-10 in 
Congo Jr/Kid. 

Direct Select key When the key is pressed 
that item is activated. 
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Keys that enter Direct Mode when held 

Key  Function 

[FOCUS] Focus Palettes. 

[COLOR] Color Palettes.  

[BEAM] Beam Palettes.  

[PALETTE] All Palettes.  

[Wheel_Parameter] Any wheel parameter can be pressed to get direct 
access to all range positions. This includes scrollers. 
Including range tables 
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Tab - Beat Boss  
Beat Boss is a master tempo that can be set to any chase or content effect with an individual rate.  

Symbol in the Tab Selector 

 

 

There is a Beat Boss tab with 9 Beat Bosses. The BPM is set to 120 at 50%, 240 at the top and 0 at the 
bottom.  

A master can be set to control a Beat Boss. The slider function will change the value, the top key can 
be used to set a specific value or to tap a specific BPM. See Masters - Beat Boss.  
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Beat Boss List  

There is a list of beat bosses in Browser/Effects (Browser>Effects>Beat Bosses) where a descriptive 
name can be given.  
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Tab - Help  
You can open a Help Tab from the Tab Selector (from the + sign) or by pressing HELP (?).  

Symbol in the Tab Selector 

 

 

There are two auto-help modes.  

• If “Follow Keys” is active, pressing buttons will update the help using the normal help topic 
names.  

• If “Follow Screen” is active, help will update when new tabs are opened or existing tabs are 
focused.  
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Tab - Direct Selects Flow (8.1) 
The Direct Selects Flow Tab gives you the same information and functions as the Direct Select tab, 
with the only difference that there is only one type of data, and the screen will reflow at all times to fit 
the width of the current tab. See Tab - Direct Selects. 

Symbol in the Tab Selector 

 

 

Click on the cog wheel to choose packed/unpacked format.  

The tab for each instance remember 

• content type  
• packed mode  
• zoom level  

 

  



Cobalt 8.1 - 20181029 

103 

 

Editors And Lists 
Most editors are lists. Some have a channel view on top that works just like any channel view. The list 
part works pretty much like a standard spreadsheet application.   

  

1. Channel view on top  
2. List  
3. Hints about functions for the currently selected cell 

You can 

• edit all cells (except those that are dimmed)   
• select and edit multiple cells at the same time  
• sort information by column  
• move columns around  
• resize a list by dragging the divider, or holding COLUMN and using the level wheel 

  



Cobalt 8.1 - 20181029 

104 

 

Navigating In Lists 

Function Key Feedback 

Step or scroll around  Arrows and wheel Use arrow keys, or hold an 
arrow key and use the level 
wheel to speed scroll in any 
direction 

Editing In Lists 

Function  Key Feedback 

Edit the selected cells [MODIFY] Entering a value and press 
MODIFY. If it is a dropdown just 
press MODIFY. If it is a text cell, 
press MODIFY, enter a text and 
press MODIFY to exit. 

Insert a new item [INSERT] Inserts a new item with the next 
free number. If you enter a number 
first, the inserted item will have 
that number. 

Delete selected item(s) [DELETE] Deletes the selected items (cannot 
be undone). 

Select all items in a column  [COLUMN] Selects all cells in a column from 
the current cell down.* 

Select multiple cells [SELECT] & 

[Arrow_keys] 

Hold Select and use Right and 
Down arrows to select multiple 
cells.*  

Select multiple cells in any 
column or order 

CTRL and 
Click  
(Keyboard & 
trackball) 

Hold CTRL and use the cursor to 
select multiple cells.*  

* When you enter a value and press MODIFY it is applied to all selected cells. 
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Sort By Column 

Function Key Feedback 

Sort from low to high [COLUMN] & 

[Up_Arrow] 

The list is sorted by this 
column from low to high.* 

Sort from high to low [COLUMN] & 

[Down_Arrow] 

The list is sorted by this 
column from high to low.* 

* These changes are temporary, they will be lost if the tab is closed and opened again. 

Change The List View 

Function  Key Feedback 

Move a column [COLUMN] & 

[Side_Arrows] 

The selected column is 
moved left/right depending 
on which arrow you press* 

Resize a column [COLUMN] & Wheel The column is resized 

Resize the list section [TAB] & Wheel The list section is resized* 

* These changes are temporary, they will be lost if the tab is closed and opened again. 
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Drag and Drop 
In most places of the Cobalt screen interface you can use a mouse or trackball to drag content to other 
locations and drop there. This is the same as doing a copy/paste or cut/paste command with key 
presses.  

Please note that there are two options for drag-and-drop editing within Cobalt - editing within the 
same play and using drag/drop to import data from another play - this can be an older version of the 
current play to perform UNDO actions, or another play entirely. 

Usually there is a dialogue box to allow you a choice of results when dragging and dropping.  

Examples 

• In the Browser, click and hold a preset in the preset node and drag it to a channel view and 
drop there to replace the content of that channel view with the preset.  

• In a Sequence Editor, click and hold a sequence step and drag it to another sequence step 
and drop there for a dialogue with options of actions (copy/move). See Sequence - drag and 
drop data.  

• In a Master View, click and hold the content of one master, then drag and drop to another to 
move around. See Masters - Drag and Drop Data. 

Dragging a preset from the Browser to Live  

1. Click, hold and drag a preset from the Browser to Live.  
2. Drop over Live - the content in Live will be replaced by the levels of the channels in that Preset. 
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NOTE 
There is no warning, the content of Live will be replaced by the intensity 
content of the Preset dropped. 

  

Dragging sequence steps  

1. Open the main playback Sequence Editor (MODIFY and PLAYBACK). 
2. Click, hold and drag a sequence step to another sequence step, then drop.  
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3. You will now get a dialogue with the following options: 

 

This dialogue allows you to COPY or MOVE the selected step.  
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COPY = Makes a copy of the source and inserts it into the sequence after the target step. 
MOVE = Moves the source and inserts it into the sequence after the target step. 

If you select the Advanced tab by pressing left arrow, you get the following options: 

 

The first option allows you to define where you want to copy/move the step to. 

• After the target step (default)  
• Before the target step  
• Replace the target step 

The second option "Create Between" allows you to create a new step with a new preset number and 
insert (after/before).  

NOTE 
For more info, see: Sequence - drag and drop data. 
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Drag and Drop - Replacing Data 

If you drag a Sequence, Preset or Palette and drop it on another node of the same kind, you will get the 
option of replacing the node you are dropping data on. This feature works both within the same play 
and in the Import From Organizer. 
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Context Menus 
Press LOCAL MENU to open a context menu for the focused screen/object. 

 

In most places of the Cobalt screen interface there is a context sensitive menu that offers the functions 
that apply most to the part of the interface you have focused at the moment.  

It can also be opened by pressing SELECT twice, or by right clicking with a mouse or trackball. This 
works in the following views:  

• Channel View  
• Attribute View  
• Editors  
• Browser  
• Organizer 

Examples 

• Press BROWSER to select the Browser. Select any node with the arrows and press SELECT 
twice to open the appropriate Context Menu.   

• Press PRESET to open the Preset List. Select any cell with the arrows and press SELECT 
twice to open the appropriate Context Menu.   

• Working with a mouse? Right-Click to open the Context Menu!  
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In a Channel View it looks like this: 

 
You can choose any of the functions with the arrow keys and press MODIFY to confirm.  

In the Playback tab over a preset it looks like this: 
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Dialogues 
All dialogues are opened on the currently focused screen. 

Example of the Save New Play dialogue 

 

• To close a dialogue press ESC.  
• To change dialogue tab, use the right/left arrows.  
• To change settings use the up/down arrows to navigate inside a tab.  
• Press MODIFY to open a dropdown menu.  
• Enter a number and press MODIFY for numerical entries.  
• Press MODIFY to toggle a checkbox option.  
• To enter a text, press MODIFY to activate text entry, enter text, press MODIFY to terminate. 
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Power-up Procedure 
For best performance, power-up your system in the following order.  

No output will be sent until the startup show file has been loaded. 

Action Hardware Feedback 

1. Turn on external hub(s) 
or switch(es) 

Power switches  

2. Turn on the console and 
monitor(s) 

Power and/or reset 
switch on console and 
monitors.  

The displays will light up 
with the Cobalt logo. The 
screens will load the login 
screen. 
 

 
3. Start the Cobalt 
software 

[MODIFY] You can select start option 
with mouse or console keys 
(trackball or arrow keys). 

4. Choose starting Play [MODIFY] or [ESC] A popup will give the choice 
of the last play (or recovery) 
or a new play. See New.  

5. Turn on any ETCNet2 
Nodes and accessories 
such as Remote Focus 
units 

Power switches You should be able to 
control the outputs now* 

*See Console Key - OUTPUT 

NOTE 
In a network with multiple Cobalt Systems online, allow the main system to 
fully start-up before starting the other systems. This will ensure that your 
network configures correctly. 
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Reset The System 
When you open a new (empty) Play, you can choose to set the patch 1:1. This chapter is a checklist 
for resetting the frontpanel and checking the output. 

This chapter contains the following sections 

• Reset The Console Facepanel  
• Check The Output  

Before you start, make sure you have loaded a new (empty) Play. See Load a New (empty) Play  

Reset The Console Facepanel 

To get light you have to make sure the console is reset properly. 

Output mode and Grand Master. 

Action  Console Feedback 

1. Enable output Set Output Mode 
Switch to ON 
 
Set Grand Master to 
Full. 

 

Main Playback crossfaders (bottom right corner of the console). 
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Action  Console Feedback 

2. Reset the crossfaders by 
moving the up and back 
down 

A/B faders to bottom 
position 

 

Check The Output 

After loading a new Play the patch is set 1:1 and the output protocol will be set to DMX512 on both 
output connectors in the back of the console.  

If you enter a number and move the level wheel, a dimmer should respond - providing there is one 
connected. 

If nothing happens, see Lights Are Not Responding. 
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Output Control 
The Grand Master and the three-position switch in the top right corner of the console facepanel offer 
output control that overrides every output from the console. The "ON" Position in the middle is the 
default mode for normal operation of the console.  

 

Grand Master 

The Grand Master is located in the top right corner of the console facepanel. 

Console  Feedback 

Grand Master Will scale the total output of all intensities (only) 
when below 100%, except channels controlled by the 
Independents and/or Masters in Exclusive mode. A 
red Level Indication will appear on the top of all 
screens. 

NOTE 
Attributes are not affected by the Grand Master. 
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B.O. Mode 

A Black Out will take out all intensities.  

Action Feedback 

B.O. A Black Out of all intensity outputs, except those 
controlled by the Independents in Exclusive mode. A 
red B.O. Indication will appear on the top of all 
screens. 

Freeze Mode 

When the Output Mode switch is set to FREEZE, the output is "frozen" and will remain static until the 
switch is set back to ON.  

When the switch is set back to ON the output is loaded to the A field of the Main Playback. The 
Sequence will also reposition to where it was when you activated Freeze. 

Action Feedback 

Activate Freeze All outputs will be "frozen", including moving 
devices. You can work with all functions without 
affecting the output* 

Deactivate Freeze The "frozen" output of Freeze is loaded to the A 
field of the Main Playback** 

*The complete output, including all Master Playbacks is loaded to Freeze. 

**If all Masters are down when you exit Freeze, there is no change in the output on stage. 

NOTE 
If you set the Output mode switch to FREEZE  before you start the 
application, the output will not be updated until you move the switch to on. 
This makes it possible to start without output and prepare the correct light 
before activating it on stage. 

This is indicated at the top of the screens with the text "FREEZE". 
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Copy, Cut & Paste 
The COPY/CUT and PASTE keys in the programming section are general keys, and can be used to 
cut and paste for example Sequence Steps, Groups, Presets and Device Templates. 

 

Action  Key Feedback 

Copy [COPY/CUT] The currently selected object is copied. 

Cut [COPY/CUT] 

[COPY/CUT] 

The currently selected object (devices 
excluded) is cut.  

Paste [PASTE] The last copied or cut object is pasted. 

NOTE 
When you paste a Sequence step in the Sequence Editor, it will be inserted 
before the currently focused step. 

When you paste a Preset in the Preset Editor, you will overwrite the content 
of the currently focused preset. This applies to Groups as well. 

Texts can be copied with the shortcut CTL-C from a keyboard. 

Copy, Cut & Paste Attributes 

In the Preset List it's possible to copy, cut and paste attributes for the selected channels from any step 
to any other step. 

1. Open the Preset List.  
2. Go to the Attributes Column.  
3. Select channel(s) to copy or cut from.  
4. Press COPY to copy, press COPY again to CUT (see the confirmation in the message bar at 

bottom of the screen).  
5. Move to the attributes column for the Preset you wish to copy to.  
6. Press PASTE 

NOTE 
Attibutes with the value "0" will not be pasted. 
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Entering Texts 

Almost every item in a Play can be labeled with a text.  

The texts are entered from a keyboard, and there is a special TEXT key that can be used to quickly 
edit the text of a Sequence Step, or a Preset/Group in a Master.  

Numbers and decimal point can be entered from the numerical keypad of the console(s). 

IMPORTANT NOTE 
If you have an external keyboard with a NUM LOCK key connected you 
have to activate NUM LOCK for the numerical keypad in Cobalt to work. 
This is because the numerical keypad on the external keyboard and Cobalt's 
keypad are linked. 

The TEXT Key 

Press MODIFY in the text cell of a spreadsheet to activate text input, since the keys of an external 
keyboard otherwise simulate functions keys of the console.  

It is also possible to activate text input directly to specific items using the TEXT key in the 
Programming Section. 

 

Action  Key Feedback 

Preset in A [TEXT] A popup for setting text to the step in 
A appears. 

Preset in B [TEXT] & 

[B] 

A popup for setting text to the step 
in B appears. 

Master [TEXT] & 

[Master_Key]

A popup for setting text to a Preset or 
Group in Master # appears. 

Cell in a spreadsheet [MODIFY] Text entry is activated for the text 
cell. 

NOTE 
In keyboard override mode, level and mouse wheels are blocked to prevent 
unintentional changes.  
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Mute & Solo 

Mute & Solo allow you to treat all Playbacks (masters and Main Playback) as 
you would in a sound console - being able to temporarily Mute or Solo the 
content of any Playback. 

• Muting a Playback will temporarily stop all output from this Playback without changing data 
or fader level.  

• Soloing a Playback will temporarily mute all Playbacks except this one, without changing 
data or fader levels. 

In effect this is the same functionality that is found in a sound console. It allows you to quickly isolate 
the lights from any Playback, for editing or for playback purposes. 

Mute and Solo are soft keys in the Misc soft keys. 

Mute & Solo - MUTE 

Mute is a Soft Key. 

   

Hold MUTE and press a Playback key to activate/deactivate. 
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Function   Key Feedback 

Mute a Master plabyack # [MUTE] & 

[Master_key] 

The Muted status is 
indicated in the Master 
Display of the console and 
in the Master View. 

Mute Main Playback [MUTE] & 

[PLAYBACK] 

The Mute status is 
indicated in the Playback 
tab. 

Un-mute a Master playback 
# 

[MUTE] & 

[Master_key] 

The master is no longer 
muted. 

Un-mute Main Playback [MUTE] & 

[PLAYBACK] 

The main playback is no 
longer muted. 

Clear all Muted playbacks [C/Alt] & [MUTE] All Muted Playbacks are 
reset. 

NOTE 
MUTE will not change any data or fader levels.  

In Congo Jr/Kid the MUTE key is a soft key in the Misc Soft Key Page. 

Mute & Solo - SOLO 

SOLO is a Soft Key.  
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Hold SOLO and press a Playback key to activate/deactivate. 

Function   Key Feedback 

Solo a Master playback # [SOLO] & 

[Master_key] 

The Solo status is indicated 
in the Master Display of the 
console and in the Master 
View. 

Solo Main Playback [SOLO] & 

[PLAYBACK] 

The Solo status is indicated 
in the Playback tab. 

Un-solo a Master playback 
# 

[SOLO] & 

[Master_key] 

The master is no longer 
soloed. 

Un-solo Main Playback [SOLO] & 

[PLAYBACK] 

The main playback is no 
longer soloed. 

Clear all Soloed playbacks [C/Alt] & [SOLO] All Soloed playbacks are 
reset. 

NOTE 
SOLO will not change any data or fader levels.  
The keyboard equivalent of SOLO is Alt Y. 
In Congo Jr/Kid the SOLO key is a soft key in the Misc Soft Key Page. 
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Lock Console 
Press LOCK in the programming section to lock the console, enter a pin code to lock and unlock.  

 

• SETUP & [LOCK] to setup the PIN code   
• ESC & C/ALT locks older Congo consoles 

 
The following mouse actions are blocked  

• Screen actions from layouts  
• Drag and drop  
• Double clicking in editors. 
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Misc Soft Key Page 
The Miscellaneous Soft Key Page is selected with the soft key MISC.  
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These are the functions  
(Solo, Mute and Park are described in the chapters: SOLO, MUTE, PARK) 

Function  Softkey Feedback 

Play back Macro # [#] [Macro] Macro # is played back.. 
See MACROS. 

Learn Macro # [#] [Learn_Macro] Macro # is recorded.  
See MACROS. 

Print Screen [Print_Screen] Prints the current screen to 
a node called 
PRINTOUTS. See Print. 

Playlist mode [Playlist] The Playlist is activated. 
See The Playlist. 

UnPark [UnPark] Is used in combination with 
other keys to unpark 
channel values. See Park. 

Suspend auto-times in 
Main Playback 

[Modify_Seq] When on, links and 
wait/followon times are not 
activated during playback. 

Remote Control List [Remote_Ctrls] Opens the Remote Control 
List. See Remotes List. 

Clear all remote levels [Clear_All_Levels] Clears all levels set by 
remotes. See Remote 
Controls. 
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Cleaning the Cobalt Console 
Do not spray liquids directly onto the screens or console facepanel! 
  
Clean the touch screens with a microfiber cloth or with a lint-free cloth dampened with glass cleaner. 
  
The metal facepanel and wrist rest may be dusted with a microfiber cloth or with a lint-free cloth 
dampened with glass cleaner. The metal surface of the console has an anodized  treatment that is 
durable and scratch resistant. It will show markings from fingernails, though, if they are scratched 
along the surface (near the master playback faders, for example). These are surface markings only and 
are easily wiped away with a microfiber cloth. 
  
It is not recommended to use cleaning cloths that release fibers easily as the fibers may stick to the 
edges of some of the console keys.  
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S1-S3 Soft Key Pages (8.1) 
The S1-S3 Soft Key Pages are selected with the soft keys S1-S3.  

Each page gives you ten user definable console buttons for fast access. 

 

To open the editor for each of the keys, hold SETUP and press S1-S3. Press MODIFY in the Function 
column for a dropdown to select any of the Cobalt button functions. The settings are stored in the 
show file separately for each user. See Change user.  
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About 
The About node shows you a summary of the system and a summary of the 
currently loaded play. 

About Node 

 

This chapter contains the following sections 

• About - Cobalt...  
• About - Play...  
• Demos  
• Dimmer/Device Feedback Log 
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About - Cobalt 
About Cobalt shows you a summary of your system configuration - this information is often only used 
in case of technical support. 

 

SOFTWARE AND OUTPUTS 

• Software Version: The version and revision of the Cobalt software installed.  
• Qt Library: Qt is a supporting tool that is used by Cobalt. Only for support.  
• Dongle number: This is your unique software number that is required when you upgrade 

your system size.  
• Console Firmware Version: Shows the version of the Cobalt Sr face panel firmware. Only 

for support.  
• IO Firmware Version: Shows the version of the I/O board firmware. Only for support.  
• Channels: The number of channels your system can run. If your system is downgraded in the 

System Settings the downgrade number is shown.  
• Outputs: The number of outputs your system is upgraded to run. The maximum is 6144 (12 

DMX universes). Contact your ETC dealer for upgrade information. 

ROLE 

• Possible roles: These are the possible roles your dongle permits: Server, Backup and/or 
Client.  
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• Name: System name  
• Current Role: The currently active role 

NETWORKING 

• Net: The logical network this console is active on.  
• IP: IP address of this system.  
• Enabled network protocols: A summary of enabled protocols and the current Universe Map 

for each of them.  
• Network DMX input: Shows if this is active.  
• ACN Library Info: Shows information about Advanced Control Network libraries in use . 

FILE PATHS 

• FileServer path: If a FileServer path has been defined, it is shown here.  
• USB path: This is the drive-letter the system is looking for a USB drive under. If Cobalt 

cannot find a connected USB memory, you can check here to see that it corresponds with the 
drive letter assigned by Windows. 
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About - Play 
This is a summary of your play. The same information is included in your printouts. 
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Dimmer/Device Feedback Log 
The Dimmer/Device feedback log (Browser >About) will show all logged dimmer feedback messages 
from: 

• RDM   
• CEM3  
• FDX  
• CEM+  
• Dimstat 

Features 

• The Active column shows if the error is active or if it has been cleared. You can also reset a 
known error (to get rid of the indication on the channel) by toggling the Active field.   

• Select one or more rows in the Dimmer Feedback Log and press DELETE to remove them 
from the list.  

• If general dimmer errors are active, there is a warning sign in the title bar (see below). 

In the Header bar on top of the screens, the warning sign indicator will show dimmer and/or other 
faults in the format: General Errors/Dimmer Errors. Active errors are marked with red. A column 
“Type” will show the source of the error.   
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Sensor3 & Sensor+ Dimmer Feedback 

These devices will show up in the “Net3/ACN Device List” (Browser >General Settings >Network 
>Net3/ACN Device List). 

Channel Display 
When a channel is patched to an output that is associated with a Sensor3 or Sensor+ dimmer then that 
channel will indicate the state of that dimmer. 

When the associated dimmer has an error or warning then the channel display will include a small 
warning sign as part of the display. 

If a channel is selected, the number of active dimmer errors for the channel will be shown in the Info 
box below the Browser. 
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Files 
The files node is where you can open, save, export and import show files. You 
can also save a default show, copy log files to a USB memory - and exit the 
system. 

Files Node 

 

This chapter contains the following sections 

• Files - Introduction  
• New  
• Open  
• Save & Save as...  
• Import from...  
• Export to Expert diskette  
• Default Play Wizard  
• Print  
• Training Projects  
• Copy Log files to USB  
• System Shutdown  
• Exit to System Settings  
• Exit to Welcome Screen  
• Power off (Quit) 
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Files - Introduction 

Make sure you save your information at all times. If the current Play has 
been altered since it was last saved, the name is displayed in yellow instead of 
white. If over 30 minutes have passed without saving, the time stamp will 
turn red. 

All file handling can be done from the File node (BROWSER >File). There is a SAVE and SAVE TO 
key in the frontpanel. 

 

This system has a hard drive as the primary storage. You can also use a USB memory stick, an 
external USB drive, Floppy or a File Server on the network. For alternative Play Paths see Login 
Settings - General Functions. 
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Function  Key Feedback 

New [MODIFY] Opens a popup asking you to confirm. 
See Load a new (empty) Play. 

Open... [MODIFY] See Open a Play. 

Save  [MODIFY] Saves the current play. Opens a popup 
asking you to press MODIFY to 
confirm. 

Save as... [MODIFY] See Save a Play 

Import from... [MODIFY] See the Import Wizard. 

NOTE 
USB memory is the main external storage media.  

The Floppy drive (option) is mainly an interface for importing shows from 
other systems using floppy such as Pronto, Safari, Expression, Strand 500-
series etc. If your system does not have a floppy drive, connect one with USB 
or move the files to a USB memory stick. On more information about 
importing shows files see IMPORT WIZARD.  

Sub folders are shown at the start of the file list with the name in [brackets]. 

Files in a network named Saved year-mm-dd (8.1) 

When a system is leaving a network session early it will automatically generated save files, and if a 
new file is received and there are unsaved local changes.  

File names will be in the format "Saved year-mm-dd xxxx.csf" 
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New 
When you want to clear the console to start with a new play, you use the "New" command (Browser 
>Files >New).  

Function  Key Feedback 

1. Select the Browser [BROWSER] The Browser is selected on 
the left side of screen 1. If 
the Browser already was 
selected - it will be closed. 
Press Browser again to 
reopen. 

 
2. Go to "Files" at the top Arrow keys Files is marked in orange 

3. Open the File node Right arrow Opens a subtree of 
functions. 

4. Select "New" Down arrow New is marked in orange 

5. Load a new play [MODIFY] Opens a dialogue - see 
below 

If the current play has unsaved changes this dialogue will open; 
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After which this one will open: 

 

If the current play has unsaved changes and has never been saved this dialogue will open instead: 
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New Play Patch Options 
These are the most important settings that you need to consider when starting a new Play in Cobalt. 

First there is a dialogue asking you about the patch options for the new play. There is an option to use 
a default patch, a channel-to-dimmer patch 1:1, to start with No patch. See Patch. 

Then there will be a dialogue asking you to select the most important settings for the new play 
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General Settings 
These settings affect default times and master recording in Live. 

• Set times to - Options are A and B to set which sequence step will receive timing commands 
made Live. 
See Sequences - Times.  

• Enable Remote Controls - When checked, allows remote controls to interact with the 
lighting system.  
See Play Settings - System.  
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• Default Go Time - Sets the time used by sequence steps with no other recorded timing data.  
See Play Settings - Crossfade.  

• Default out Time - Sets the out-fade time to be recorded to sequence steps. 
See Play Settings - Crossfade.  

• Default In Time - Sets the in-fade time to be recorded to sequence steps. 
See Play Settings - Crossfade. 

Moving Device Settings 
These settings affect how moving devices are recorded and played back. 

• Record Attribute mode - See Device Recording - Modes.  
• Sequence attribute playback default - See Device Play Back - Attrib Move. 

Master Settings 
These settings are important for the general behavior of masters and master flash keys. 

• Exclude Int. from Record - Excludes the intensities from masters when pressing Record 
(default is off).  

• Enable Flash key  - Sets Flash keys to be active (default is on). 
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Open  
When you want to open a play, you use the "Open..." command (Browser >Files >Open).  

Function  Key Feedback 

1. Select the Browser [BROWSER] The Browser is selected on the left 
side of screen 1* 

 
2. Go to "Files" at the top Arrow keys Files is marked in orange 

3. Open the File node Right arrow Opens a subtree of functions. 

4. Select "Open" Down arrow Open is highlighted. 

5. Open this node Right arrow Opens a subtree of media choices. 

6. Select Media Down arrow Selected media (Floppy, Play 
Archive (HD) or USB) is 
highlighted. 

7. Open media archive Right arrow A subtree is opened with all plays 
in the selected Media** 

8. Load the selected play [MODIFY] Opens a popup. If there are 
changes in your current play you 
will be asked to save 

9. Confirm (or don't) [MODIFY] Use arrow key to select your 
choice and MODIFY to confirm 
it. The selected Play is loaded. 

*If the Browser already was selected, it will be closed. Press BROWSER again to reopen. 

**If Floppy, File Server or USB files are not shown you can update this node by clicking on it. 
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Save & Save as... 
Press SAVE to save the play. You can also press CTRL-S on a keyboard.  

    

Depending on if the current play was saved or not you will either get the "Save" dialogue 

 

or the "Save as" dialogue 
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*It is possible to set up a file server by specifying the file server path in the Login Settings. See Login 
Settings, General Functions. 

To save using the Files node in the Browser: 

Function  Key Feedback 

1. Open the Browser [BROWSER] If it was already selected it 
will be closed. Press again 
to open. 

2. Go to Files Down Arrow Files is highlighted 

3. Expand subnodes Right arrow Subnodes are expanded.  

4. Select Save as Down Arrow "Save as..." is highlighted 

  

5. Confirm [MODIFY] A dialogue is opened (see 
below). Choose target drive 
Play Archive (Hard drive in 
console), USB (if inserted) 
or Floppy (if connected). 
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Creating Subfolders For Files 

You can create sub-folders for files with the INSERT command in the context menu (press SELECT 
SELECT or the INSERT console key)  for the Play Archive node in Browser >File >Save as... >Play 
Archive. 

 

Delete a Play 

You can delete a Play file by selecting it in the browser and pressing DELETE.  
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Save Copy to... 
Press SAVE COPY in the programming section to save a copy of the play directly to a USB memory 
stick or file server. For example, this can be used to create a backup copy of the show. BROWSER 
>Files >Save Copy. Simply connect your USB memory stick and select this option. 

 

NOTE 
You have the option of saving revisions 1-9 of a play every time you store it 
with the same name on the same USB memory if you use the Save... option to 
save to USB. 
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Import from...  

You can import part of any play into your current play, if you want to reuse 
color palettes, presets, groups or if you want to reload a previous version of 
an object such as a preset from an earlier version of the same play.  
 
You can also import lists from Excel, LightWright or WYSIWYG. See 
Channel Database - Import Text File Wizard. 

This chapter describes the import functions. Parts about drag and drop are referred to the chapter about 
Drag and Drop. See Drag and Drop.  

Import from other lighting systems 
If you are importing a play, or parts of a play from a different lighting system see exceptions and notes 
in this chapter.  

1. Open the play - any play in Standard ASCII Light Cues format (name.asc or name.alq) can 
be opened directly.  

2. Save the play as a normal Cobalt play.  
3. Use this import Organizer to import parts of these plays. 

CAUTION 
We strongly advise you to save your Play before using the Import Organizer, 
since it can alter your Play greatly. 
 
Up to version 7.2 we advice you to avoid using the Import Organizer if 
decimal channels are used due to a known bug that will be fixed in the next 
version. 

Import Organizer - Functions 

The basic functionality of the Import Organizer is that you can use drag and drop (mouse) or copy and 
paste (keys) to copy any type of data from an external play to the one in memory.  
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Importing single items 
When you want to import a single item you have a choice of using drag and drop, or the copy/paste 
function.  

Drag & Drop 

1. Click and hold on the single item you want to import in the Organizer (import from) tab.  
2. Drag the item to the same position in the Organizer tab and let go.  
3. Confirm what kind of action you are doing in the drag and drop dialogue. See Drag And 

Drop.  

Copy/Paste 

1. Use the arrows to select the single item you want to import in the Organizer (import from) 
tab.  

2. Press COPY  
3. Select the Organizer tab (TAB) and use the arrows to select the node you wish to import this 

item to.  
4. Press PASTE  
5. Confirm what kind of action you are doing in the drag and drop dialogue. See Drag And 

Drop.  

Importing multiple items 
When you want to import multiple items, you do it in the exact same way as when importing single 
items. The difference is in how you select which items to import. 

Select the top node to import all items of the same kind, like Sequence, Presets, Groups etc... 
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Hold SHIFT (keyboard) or SELECT and click to select a range of multiple items of the same kind. 
Hold SELECT and use arrows in console. 

 

Hold CTRL (keyboard) and click to select multiple items of the same kind in a random order. This is 
only possible with mouse/trackball and keyboard. 

 

Import - Types of items to import 

Here are some examples of items that can be imported from any play to the one in memory using the 
import function: 

• Sequences  
• Sequence steps  
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• Channel Times  
• Device Links  
• Master Links  
• Action Macros  
• Presets  
• Groups  
• Palettes  
• Templates  
• Patch  
• Devices  
• Effects  
• Master Pages  
• Scroller Rolls  
• Magic Sheets 

Import Items With Dependencies 

Many items in a Play are dependent on other items. For example, if you want to import a Focus 
Palette, it will be dependent on the specific device that is stored within it and the template of that 
device. To make it simple, there is an intelligent function under the hood that finds these dependencies 
and imports all related items for you. 

These are the four situations with dependencies: 

1. When you import a patch with devices, you will also import the device templates  
2. When you import a palette, you will also import the related patch, devices and templates  
3. When you import a preset, you will also import all related palettes, patch, devices and 

templates  
4. When you import a sequence, you will also import all related presets, patch, devices, 

palletes and templates 

Every time you make an import with dependencies you will first get a drop dialogue 
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And after this you will get a dialogue confirming the dependencies that have been imported as well.  

 

Import From Other Lighting Control Systems 

Importing a show from another lighting system is easy, as long as it is saved in the Standard ASCII 
Light Cues format.  

Basically the easiest way to get the information into Cobalt is to  
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1. Open the play - any play in Standard ASCII Light Cues format (name.asc or name.alq) can 
be opened directly.  

2. Save the play as a normal Cobalt play.  
3. Use the import Organizer in this chapter to import parts of these plays. 

Check each system for specific conversion rules. The ASCII Light Cues format is quite old and 
contains standard definition of simple play data like dimmer patch, cues for intensity information, 
groups and submasters. More complex data, like moving light data and effects, is not defined in the 
standard. Some control systems' ASCII files contain data not included in the standard, some not. 
Cobalt can get differing amounts of data from these ASCII show files. Systems with expanded 
capabilites are described below. 

NOTE 
Due to some difference in play structure some play data may not be 
transferred.  

Import from  ETC Express/Expression/Emphasis 

Only ASCII light cue format is supported (files ending ".asc"). Export this using Expression Offline or 
within Emphasis. See the Express(ion) and Emphasis manuals for more details. 

• Group keywords are now treated as real Groups and not as presets not in the sequence.  
• Parameter Definitions are imported.  
• Templates are imported.  
• Devices are imported.  
• Support for translation of parameter values from channel levels (the Emphasis style) to 

attribute parameters (the Cobalt style). 

Import from  GrandMa 

Cobalt can read GrandMA alq files. The tracking cues of GrandMA will be converted to full cues. 

Import from  Strand 

The following applies when opening a show with data from a Strand System. Strand ASCII Light 
Cues files that ends with .alq can be opened directly. 

Patch 
Patch 1 is always used. 

Submaster content 
If a submaster contained attributes on the Strand system, the attributes are not transferred to Cobalt, 
only the intensities. 

Palette references 
In the Strand system, attribute information stored in groups can be used as palettes and referred to in 
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presets. Strand groups that are referenced from presets are converted to All Palettes and a reference to 
the palette is stored in the Cobalt Preset.  

Groups 
Groups that are not referenced from other presets, are stored as Cobalt groups to avoid mix-up with 
preset numbers. In Strand plays groups may contain attributes - this is not supported in Cobalt. 

Parts 
Parts are translated to Channel Times. Strand consoles can store channels and values overlapping in 
Part cues in a way so sometimes it isn’t possible to translate this properly to Channel Times. Strand 
consoles can store attribute information in the Parts. This is not supported on the Cobalt side. 

NOTE 
Since a Cobalt Palette cannot store intensity values, a Strand group that gets 
converted to an All Palette will lose its intensity information. 
 
In the Strand system, intensities in a preset can also reference a group. This is 
currently not supported in Cobalt. All such values will be set to 99% to 
indicate that they have to be updated manually.  

Import from  Avab VLC Safari 

Most data from a Safari VLC play 3.5 or higher in ASCII format can be imported into Cobalt. See 
local manual for export instructions to this format. 

• Indexed parameter numbers (like Shutters) are remapped to new Cobalt parameter numbers 
to preserve the corresponding data.  

• Palette references in sequences are handled.  
• Scroller Roll references in Palettes are handled. 

These are ASCII Safari show file reading improvements in 6.3 

• Additional palette types (4 and 5) are merged into Beam palettes. Note: If there is a 
corresponding Beam palette, its existing name will be kept. If there is no corresponding beam 
palette, the VLC palette name will be used.  

• Sequences above 1 are read.  
• VLC Effects are translated to Chase Sequences with numbers offset by 10 (similar to Presto 

import). 

NOTE 
Due to some difference in play structure some play data may not be 
transferred.  

Import from  Avab Expert 

Expert plays can be read directly from a floppy drive or as ASCII plays from a USB, See local manual 
for export instructions to this format. 
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The way Expert plays are read has changed completely to be able to read more data. Using an external 
utility, the Expert binary file format is translated into ASCII Light Cues and opened just like any other 
file. 

• Loading an Expert play is done from Browser >File >Open. When a diskette with an 
Expert.pla file is detected, you get the option of converting it when you double click on it.  

• An "Export to Expert" diskette command in the Browser allows you to export a Cobalt play 
to Expert format. 

NOTE 
There are still some parts of the play that aren’t imported. More will come.  

There are five parts in an expert play (pla, eff, ren, gl & set). All five are 
needed. 
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Export to Expert diskette 
This option allows you to export the current play to a floppy disc in Avab Expert play format.  

1. Connect an external floppy drive 
2. Insert an empty floppy 
3. Select Export to Expert diskette and press MODIFY 
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Default Play wizard 
The Default Play Wizard (Browser>Files>Default Play Wizard) allows you to store various parts of 
your current show as a default file. The data in the default file will be offered when you start with a 
New Play. It is easy to create a default play using the Import Organizer to pull in data from other 
plays.  
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Print 

You can print play data to pdf files, sorted in different ways and in different 
formats. These files are copied to a USB memory and printed from any 
standard computer.  
 
Patch and Channel Database can be exported to a comma separated text file, 
suitable for spreadsheet or database programs like Excel. 

Screens can be printed with the PRINT SCREEN function in the Misc Soft 
Key Menu. 

1. Open the Printout Wizard (BROWSER >Files >Print...) 

This popup will appear 

 

2. Select what to print to pdf (or select Print to Text) 

• All  
• Sequences & Presets  
• Sequences  
• Presets  
• Groups  
• Palettes  
• Device List  
• Channel Database (only those with texts)  
• Channel List (only patched channels)  
• Output List (only patched outputs) 
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3. Choose if you want to include attributes or not. 

4. Choose if you want to sort by Channel, by level or by difference. 

5. Choose if you want to print All channels or just those that are changed (more compact).  

6. Press EXECUTE to confirm, two things will happen: 

• The print file will be stored under the print node in a node called PRINTOUTS.  
• If a USB memory is inserted before pressing EXECUTE, the files will be copied to it, in a 

folder called PRINTOUTS. 

This popup will appear and show the name of the file consisting of the play name followed by the 
name of the printout and the date and time stamp. If a USB memory is connected, it will be copied 
there as well.  

 



Cobalt 8.1 - 20181029 

161 

 

Training Projects  
This is visualisation plug-in for training purposes. The projects are created in a third-party software 
called Capture and supplied by ETC. The idea is not to run large shows with processor-heavy 
visualisation inside Cobalt. It is meant as a training tool that allows you to understand functions like 
Dynamic Effects without having a rig. 

NOTE 
The training projects will work in consoles and under Windows - currently 
not in Mac. 

Training Projects - Open Project (8.0) 

Opening a Training Project 

1. Go to the Browser (BROWSER)  
2. Navigate with the arrow keys to the File >Open > Play Archive > Demo Plays node  
3. Open the file Demo Theatre or Demo Concert (this will close the online help - open again 

and continue)  
4. Navigate with arrow keys to the File > Training Projects node.  
5. Open the file Demo Theatre.c2p or Demo Concert.c2p.  
6. You will get a visualisation tab like this 

 

The play loaded will correspond to this training project.  
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Training Projects - The Camera (8.0) 

There is a camera (viewing angle) that allows you to zoom, pan and rotate the "stage". There are some 
default functions connected to the FORMAT key of Cobalt. If you have no facepanel: to move the 
camera position you need to use Arrow keys or F4 (for Format) from the keyboard and the level wheel 
from the Console mimic (click and drag level wheel with mouse). 

Default functions  

Function Key Feedback 

Zoom [FORMAT] & Wheel The view is 
zoomed in/out 
from the camera. 

Pan stage right Right Arrow & Wheel Stage is panned to 
the right around 
the camera 

Pan stage left Left Arrow & Wheel Stage is panned to 
the left around the 
camera 

Tilt stage up Up Arrow & Wheel Stage is tilted up 
around the camera 

Tilt stage down Down Arrow & Wheel Stage is tilted 
down around the 
camera 

  

  

Training Projects - Hints (8.0) 

The Training Project is a simple way of getting to know some of the moving light functionality of 
Cobalt, and to understand Dynamics.  

In the corresponding Cobalt Play: Demo Theatre and Demo Concert there are samples of Magic 
Sheets that can be used together with the Plug-in. If you are running one monitor and split the screens 
you will have a view like this. 
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Training Projects - Demo Theatre (8.0) 

Demo Theatre showfile is a small and simple theatre stage with colormixing fixtures and moving 
lights. This showfile is suitable for trying out sequences, timings, controlling moving lights, recording 
and using and updating palettes, effects and so on. 

The Channel Database in patch includes texts for the channels, so AutoGroups on Direct selects can 
be used to select channels based on the info in the patch. 
  
Sequence 2 has some presets with different timings and Notes explaining them. 
  
There are presets and Sequences on the masters for programming help and busking a show. 
  
There are multiple Magic Sheets in the showfile with different types of Magic Sheets. 
Change Magic Sheets with # FORMAT (F4 on keyboard) 

Training Projects - Demo Concert (8.0) 

Demo Concert has a bigger lighting rig that is ideal for learning about effects. It contains both spot 
and wash type moving lights as well as a 10 by 10 matrix of LEDs which are both suitable 
playgrounds for playing with effects of different types and their timings. 
  
Here are a few examples with Effect Playbacks. 
 
Direct select page 3: has Effect Playbacks and Groups, plus All Palettes and Beam Palettes on the 
Direct Selects so it is easy to work with the effects and devices at the same time. 



Cobalt 8.1 - 20181029 

164 

 

 

Content Effects. Try on one of the Content Effect Playbacks, channels E1-E5. Below are examples of 
Effect Parameter values that will produce one kind of effect. Feel free to try adjusting the settings to 
create new effects. 
  
Stabs 
Note: Do not turn on the fixtures first, as the effect includes intensity changes. 

 

  
RGB series 
Note: Turn on fixtures first, SolaWashes in this case. This effect does not include intensity. 

 

Fly in  
Do not turn on the fixtures first, as the effect includes intensity changes. 
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Try changing the Set/Group, GrpParts, GrpDistribution 
Also try changing the GrpParts to 8 and shortening the StepTime to be about 0.5 seconds and the 
lights will overlap. Notice that with GrpParts at 4 and StepTime at 0.5 there is not enough time for the 
fixtures to move to the background state (pointing out with no light output). 
  
CanCan 

 

Try changing the Attack, Sustain and Release times on this effect. Sustain and Release are used in 
Break mode effects. 
  
Intensity Series on LED Array 
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Try changing GrpParts, GrpDistribution, StepTime, Attack, Sustain and Release. 
Zero time on Sustain and Release will essentially create a Ramp effect. Attack time defines the 
"angle" of the ramp. 
Zero time for Attack and Sustain, but 1 second or so will create an Inverted Ramp effect. 
  
Image effects: Select E16 and activate Paltte 11. This will display the text "Cobalt V8" scrolling from 
right to left in the LED Array. 
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This effect consists of the static text "Cobalt V8" and it is mapped to the intensity of the LED array. 
The scrolling is achieved by using the Effect: ScrollX and Eff.Size & Eff.Speed parameters. 
  
  
Image effect: PacMan 
Here the PacMan symbol moves from left to right again thanks to the ScrollX Effect. The image is 
mapped to the Color mix of the LED Array, so you will need to set the LED Array channels to full to 
see the output. 
 
The image has been created in the built-in image editor. Try creating your own. You'll find it in 
Browser > Effect > Image Effects > Effect Images… 
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Copy Log files to USB 
This function will copy the log files that are automatically stored in case of a program termination to a 
USB memory so you can email them to ETC for analysis. 

1. Put in USB memory 
2. Select Copy Log Files to USB 

See Troubleshooting - Crashes & Bugs 
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Exit to System Settings 

The System Settings is where you configure time, nationality, output, 
network, protocols and software update/upgrade. 

The Cobalt System Settings are opened from the Welcome Screen, or from the Browser (Browser 
>Files >Exit To System Settings). If you start an offline system all of the options will not be available, 
since they relate to the hardware of a console. 

• System Settings - General  
• System Settings - Sessions  
• System Settings - Network   
• System Settings - Monitor  
• System Settings - Update   
• System Settings - RFR  
• System Settings - Utilities 
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System Settings - General (8.0) 
These are the general System Settings. 

 

System Name 
This specifies the name this Cobalt console will use to identify itself on the network to other devices. 
It is displayed at the top of each screen. 

Time & Date 
Set time, date and Time Zone for this system. 

Preferred Language 
Select a language with MODIFY and confirm with MODIFY.  

Preferred Help Language 
Select a language with MODIFY and confirm with MODIFY.  

Keyboard 
Language settings for the keyboard. 

Locale 
This will change the way dates are entered. 
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Share Play Archive 
This is the default location to save show files. The full path must be typed in and specified in a legal 
Windows format.  

Example 
D:\congo\backup (internal path/folder) 
\\anders\playfolder (external server name/folder) 
\\192.168.1.1\plays (external IPaddress/folder) 

Channel Downgrade 
Reduces the number of control channels in a system.  

Swap 0 & C 
Swap the physical location of the numerical keypads 0 and C buttons (do so in the console as well 
physically). 



Cobalt 8.1 - 20181029 

173 

 

System Settings - Sessions (8.0) 
Each server in a session with multiple server systems requires a logical network of it's own. There are 
ten networks, 0-9. In each of these networks you can set a name, and the EDMX, sACN and Artnet 
mapping. 

 

Sessions will be shown on the start screen in alphabetical order. To create a new Session click ADD - 
assign a name. To copy an existing one press CLONE and rename.  

In a setup with several systems in the same network, such as for example a television studio, you can 
assign names to the networks belonging to each studio. 

HINT 
If you want to turn the protocol off for a specific universe, set it to zero. 
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System Settings - Network (8.0) 
These are specific network settings. 

NET3 SERVICES 
Net3 Services are a suite of services that provide infrastructure support for a Net3/ACN network. 
Those services are a dynamic IP address server, a network time server and a file server. Each of these 
services are described below. Unchecking this box acts to disable all of the Net3 Services. Checking 
the box only enables services selected to be active. 

 

DCHP Service 
Clicking in the enable box for PORT 172  will activate the Net3 settings for Address or Time Server, 
or TFTP (file transfer for software distribution). 

Address Service (DHCP) 
Net3 Services uses a DHCP (Dynamic Host Configuration Protocol) address server. DHCP is a 
TCP/IP protocol that dynamically assigns an IP address to a network device when it requests one. This 



Cobalt 8.1 - 20181029 

175 

 

is a small and simple DHCP server that is intended to be used on non-routed networks. It will not 
serve IP addresses across a router.  

CAUTION: There should only be a single DHCP server active on a network. It is possible to start 
more than one DHCP server on a single network (nothing is built-in to DHCP servers to prevent this 
from happening). If this occurs, it will result in unstable conditions and possibly result in network 
communications failures. 

Clicking in the enable box will start the DHCP server in the Cobalt console. It will use the settings 
below to determine which IP addresses it gives out.  

• Fist Address - This sets the starting IP address for the range of IP addresses that the DHCP 
server will hand out.  

• Number of Addresses - This sets how many IP addresses the DHCP server will give out. A 
setting of 500 means it will give out IP addresses to the first 500 devices that ask for an IP 
address. 

• Subnet Mask - This sets the logical network size vs. the device address. ETC’s default is 
255.255.000.000 (class B). This is the subnet mask that the DHCP server will give to 
network devices.  

• Enable Routed Network - This specifies the IP address of a router if one is present on your 
network. This is the gateway IP address that the DHCP server will send to network devices to 
use. If you are on a flat or non-routed network, the Gateway IP address should match the IP 
address of the device. In order to configure this DHCP server to send out matching gateway 
IP addresses, configure this gateway IP address to 
match the First Address field. Then the DHCP server will give out a gateway IP address that 
matches the IP address.  

• Learn Network Devices... 
Makes a refresh of all ACN network devices.  

Update Service (TFTP) 
Clicking in the enable box for PORT 1/2 will start the TFTP (Trivial File Transfer Protocol) server. 

• Update File Path - This sets the directory where files are to be served through TFTP. This 
must be  
the full path to the directory, including drive letter. For example: C:\etc\nodesbin 

Time Service (SNTP) 
Clicking in the enable box will start the SNTP (Simple Network Time Protocol) service. You 
determine if the service is running as a client (receiving time messages) or as a server (sending time 
messages) during the installation process. See Network - Time Service. 

  

IP SETTINGS 
These are the settings that determine the method to get an IP address and/or the actual IP address 
information that Cobalt uses for network communication.  
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Preferred IP address 
This tells Cobalt which network adapter it should use for communication with the lighting system. In 
consoles and Light Servers, there is only one network adapter so the Automatic (default) setting is 
fine. When Cobalt is run offline or on a Client PC, there may be more than one network connection on 
that PC (such as on laptops with both wired and wireless connections). In these cases you may need to 
tell Cobalt specifically which network connection to use to communicate with the lighting system or a 
connected visualization software application.. 

Use DHCP 
Clicking in the enable box will set Cobalt to get its IP address dynamically from a DHCP server. 
While the console is starting, it will ask for an IP address from a DHCP server. If one responds, it will 
use the assigned IP address.  

If no DHCP server is available, Cobalt will default to a self-generated link-local IP address in the 
range of 169.254.x.y. The IP address used by Cobalt in this configuration may change dynamically as 
needed. A change should typically only occur when there are changes to the network configuration or 
to resolve an IP address conflict.  

Enabling or disabling the DHCP setting will require you to reboot Cobalt for the new setting to take 
effect.  

• IP address  
o If DHCP is disabled, you set the Cobalt IP address here. This is a static IP address 

and will remain set until changed by a user.  
o If DHCP is enabled, this field will display the IP address that is being used by the 

console (whether it is served via DHCP or a self-generated link-local IP address).  

• Subnet mask  
o If DHCP is disabled, you set the Cobalt subnet mask here. This is a static setting 

and will remain set until changed by a user.  
o If DHCP is enabled, this field will display the subnet mask that is being used by the 

console (whether it is served via DHCP or a self-generated link-local IP address).  

• Gateway  
o If DHCP is disabled, you set the Cobalt gateway IP address here. This is a static 

gateway IP address and will remain set until changed by a user.  
If DHCP is enabled, this field will display the gateway IP address that is being used 
by the console (whether it is served via DHCP or a self-generated link-local IP 
address).  
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Network - Console 

 

• Obtain an IP Automatically - Clicking in the enable box will set Cobalt to get its IP address 
dynamically from a DHCP server. While the console is starting, it will ask for an IP address 
from a DHCP server. If one responds, it will use the assigned IP address.  
 
If no DHCP server is available, Cobalt will default to a self-generated link-local IP address in 
the range of 169.254.x.y. The IP address used by Cobalt in this configuration may change 
dynamically as needed. A change should typically only occur when there are changes to the 
network configuration or to resolve an IP address conflict. Enabling or disabling the DHCP 
setting will require you to reboot Cobalt for the new setting to take effect.  

• IP address  
o If DHCP is disabled, you set the Cobalt IP address here. This is a static IP address 

and will remain set until changed by a user.  
o If DHCP is enabled, this field will display the IP address that is being used by the 

console (whether it is served via DHCP or a self-generated link-local IP address).  

• Subnet mask  
o If DHCP is disabled, you set the Cobalt subnet mask here. This is a static setting 

and will remain set until changed by a user.  
o If DHCP is enabled, this field will display the subnet mask that is being used by the 

console (whether it is served via DHCP or a self-generated link-local IP address).  

• Gateway  
o If DHCP is disabled, you set the Cobalt gateway IP address here. This is a static 

gateway IP address and will remain set until changed by a user.  
If DHCP is enabled, this field will display the gateway IP address that is being used 
by the console (whether it is served via DHCP or a self-generated link-local IP 
address).  

• Physical Address - This is the address of the computer. On a typical ETC lighting network, 
the default settings for IP address of the Ethernet connection for Cobalt is: 
 
IP address: 10.101.84.101 
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Subnet Mask: 255.255.0.0 
Default Gateway: 10.101.1.1 
 
This addressing scheme should allow a Cobalt console to communicate with other ETC 
equipment via Ethernet without requiring any changes to these settings. If more than one 
Cobalt console of the same type are to be connected to the network, ensure that the default 
addressing has been changed on consoles #2 and above. 
 
Default IPs for all Cobalt family products 
 
10.101.84.101 (Cobalt 20 console) 
10.101.82.101 (Congo/Cobalt Light Server) 
10.101.79.101 (Cobalt Nomad) 
10.101.80.101 (Congo Console) 
10.101.81.101 (Congo jr) 
10.101.83.101 (Congo Kid) 

System Settings - Output Protocols  

This is where you activate different output protocols. 

 

• Streaming ACN (E1.31) 
This is a broadcast protocol, like DMX over ethernet, designed to be simple. Check this 
feature if you are using devices or nodes receiving streaming ACN. Priority is fetched from 
the setting above. In Offline mode, Streaming ACN is sent on priority 1. Visualisation 
software such as Capture require sACN tor CITP. 

• ETCNet2 
Priority: An ETCNet2 source can have a priority of 20-1. 1 is highest, and 20 is lowest. This 
parameter decides the priority status of this system if there are multiple sources (for example 
Cobalt and Unison). Sources with the same priority share on an HTP level. If there are 
different priorities, the highest one will "win". The system name that is exposed on Net2 is 
“Cobalt “ + the system name. See ETCNet2 documentation.  

• Server/Backup Use Same Priority 
This setting inhibits the Cobalt Backup unit from activating at a higher priority than the 
server. Normally, the backup will activate at a higher priority to ensure that the system is 
being controlled by only one server. In some systems, however, control is shared by the 
Cobalt server and other consoles or architectural lighting control in such a way that having 
the backup jump a priority can cause unexpected behavior of the system. In those systems, it 
may be desired to force the backup to activate at the same priority as the server. 
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• ArtNet  
- Check this feature if you are using devices or nodes receiving ArtNet. 
Address: Choose network and IP address if more than one is available.  

Enable Output in Offline Mode 
In Offline Mode output will be sent at a slower than normal pace to enable the use of external 
vizualisers. 

NOTE 
When the software is started in Offline mode there is no DMX output unless 
the output box is checked. 

Network - Interface Protocols 

 

• ACN (E1.17) 
This needs to be enabled if you have units with bi-directional communication, like for 
example the Net3 I/O Gateway. This also includes Net3 DMX/RDM Gateways because the 
RDM communication is passed via ACN to the console. 
 
ACN has to be enabled for: 

o Sensor+ dimmer feedback 
o Sensor3 power control system feedback 
o RDM via ETC Net3 Gateways 
o Net3 Show Control Gateways 
o Net3 I/O Gateways 
o Net3 RFR (the steel one) 
o DMX Input via sACN 

• FDX2000 Feedback  
Error reporting for the FDX2000 dimming system 

• Dimstat Feedback  
Activates Dimstat feedback. 

• WIFI Remote  
Activate to use iRFR Classic and aRFR Classic 

• UDP Strings 
Sets the network card for UDP Strings. See Play Settings - Show Control. 
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Network - DCHP Service 

 

Net3 Services uses a DHCP (Dynamic Host Configuration Protocol) address server. DHCP is a 
TCP/IP protocol that dynamically assigns an IP address to a network device when it requests one. This 
is a small and simple DHCP server that is intended to be used on non-routed networks. It will not 
serve IP addresses across a router.  

CAUTION: There should only be a single DHCP server active on a network. It is possible to start 
more than one DHCP server on a single network (nothing is built-in to DHCP servers to prevent this 
from happening). If this occurs, it will result in unstable conditions and possibly result in network 
communications failures. 

• Enable - Clicking in the enable box will start the DHCP server in the Cobalt console. It will 
use the settings below to determine which IP addresses it gives out.  

• Fist IP Address - This sets the starting IP address for the range of IP addresses that the 
DHCP server will hand out.  

• Number of Addresses - This sets how many IP addresses the DHCP server will give out. A 
setting of 500 means it will give out IP addresses to the first 500 devices that ask for an IP 
address. 

• Subnet Mask - This sets the logical network size vs. the device address. ETC’s default is 
255.255.000.000 (class B). This is the subnet mask that the DHCP server will give to 
network devices.  

• Routed - This specifies the IP address of a router if one is present on your network. This is 
the gateway IP address that the DHCP server will send to network devices to use. If you are 
on a flat or non-routed network, the Gateway IP address should match the IP address of the 
device. In order to configure this DHCP server to send out matching gateway IP addresses, 
configure this gateway IP address to 
match the First Address field. Then the DHCP server will give out a gateway IP address that 
matches the IP address.  

• Learn Network Devices - Record the current IP addresses of connected network devices. 
Use this to ensure DHCP-assigned devices keep the same IP address when they next request 
an IP. 
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Network - Update Service 

 

• Update Service (TFTP) 
Clicking in the enable box will start the TFTP (Trivial File Transfer Protocol) server. 

• Update File Path - This sets the directory where network device firmware files are to be 
served through TFTP. This must be the full path to the directory, including internal drive 
letter. The default is: C:\etc\nodesbin 

Network - Time Service 

 

• Time Service (SNTP) Enable 
Enabling this starts the SNTP (Simple Network Time Protocol) service. 
The console can run either as a client (receiving time messages) or as a server (sending time 
messages). 

• ETC Net2 Time 
Only use if you have Legacy Unison dimmers.  

• External Time Server 
Cobalt can also get the current time from an external NTP server 

• External Server IP: 
If External Time Server is enabled, enter the IP address of the Time Server here, eg if you 
have a local server that is to be the definitive source of the current time for the console..  
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Network - DMX Input 

 

You can activate DMX input for one DMX universe (selectable) though an ETC node from an EDMX 
or sACN universe and map it to a channel which will be the start channel for that universe. When 
DMX input is activated, master playback 20 will act as a master for the DMX input. 
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System Settings - Monitor  
System Settings - Monitor 

 

Max physical monitors 
Select the number of physical monitors you want to run your system with. If you are running an 
offline version you can choose virtual screens. 

Monitor 1 
Check this enable box to change Placement (left/middle/right) or Mode (resolution). 

Monitor 2 
Check this enable box to change Placement (left/middle/right) or Mode (resolution). 

Show Advanced Options 
If you have a custom widescreen monitor with specific coordinates, you can use the Advanced 
Options. 
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Identify 
Click here to identify all monitors with a number.   

Apply 
Click here to apply the current monitor settings with a time-out option to return to the previous 
settings. 
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System Settings - Update  
You can update software, and upgrade the number of outputs your system supports. 

• To update the software you need a USB memory stick with the latest congo.exe file from 
www.etcconnect.com that is inserted in a USB port before activating this tab.  

• To upgrade the outputs you need an upgrade code from your ETC retailer. 
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Update Software 

In a Congo Jr or Server you will need a mouse to do this. In the big Cobalt you can use the touch 
screen. 

Function  Action Feedback 

1. Download latest 
software 

www.etcconnect.com Save the file "congo.exe" 
on a USB memory stick  

2. Put USB in Cobalt  - 

3. Exit to Settings "Exit to System 
Settings" node in the 
browser 

You will open the system 
settings. 

4. Go to Update click on Update   

5. Select software in 
dropdown 

click on Software 
Update dropdown 

The Software Update 
dropdown is activated. 

6. Select INSTALL click on INSTALL  

7. Confirm Update 
Software 

Follow the steps in the 
installation wizard 

You will get an installation 
wizard to confirm all steps. 

End update Click on OK Reboots console, and 
returns to the Welcome 
screen showing updated 
version. 
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System Settings - USB RFR  
You can set HF (frequency) and Network ID (group) for each RFR remote. Simply make sure they 
correspond to your remote settings. You can also update the firmware of your RFR base unit and 
remote. For more information see Remote Control - RFR Radio Remote. 

 

For the remote to work both base station and console need to be set to the same HF and Network ID.  
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System Settings - Utilities 
These are some useful utilities for file handling.  

 

BACKUP SHOW ARCHIVE 
Will copy all shows in the archive including backup plays to a USB memory.  

COPY LOG FILES TO USB… 
Copies console log files to a USB stick. Please provide these to ETC Technical Services in the event 
of finding an issue in your console. 

PERIPHERAL TEST 
Allows you to test peripheral wings and accessories. Used together with advice from ETC Technical 
Services. 
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I/O TEST… 
Opens a terminal window and runs a script to find what modules are attached and working. 
 
UPDATERATOR... (not in image above) 
Is a software for updating Firmwares. Used together with advice from ETC Technical Services. 
  

File Manager Utilities 

The file manager utility is found in the Utilities tab of the System Settings (Browser>Files>Exit To 
System Settings) 

 

FILE MANAGER 
This opens a file manager utility for copying and/or moving files between Cobalt and a USB memory 
or file server. 
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Verify Hard Disk Utilities 

Verify Hard Disk is found in the Utilities tab of the System Settings (Browser>Files>Exit To System 
Settings). 

 

VERIFY HARD DISK 
Technical Services request that you do this as part of fault-finding and sometimes repairing disk 
issues. Select the appropriate drive letter and click START.. 

 

Facepanel Test Utilities 

The Facepanel test utlitlty is found in the Utilities tab of the System Settings (Browser>Files>Exit To 
System Settings). It allows you to check that all buttons and faders work properly in a console.  

 

FACEPANEL TEST 
Opens a test screen for the facepanel. 
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When finished click on the X in the top right corner.  

Network Configuration Applications (GCE, NCE, Concert etc) 

The Network Configuration Applications are found in the Utilities tab of the System Settings 
(Browser>Files>Exit To System Settings) 

This is where you can configure your Net3 Gateways and ETC Networks. To be able to configure 
nodes from the console NCE and/or Concert (that has replaced GCE) have to be installed, which they 
are default. You may want to update Concert. Download the latest Concert from the ETC website, put 
it on a USB stick in the same folder as Cobalt installers and install it in the same way as you update 
the Cobalt software. 

 

Please check the corresponding manuals for these products. 
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Backup and Restore System Settings 

Backup and restore system settings are found in the Utilities tab of the System Settings 
(Browser>Files>Exit To System Settings) 

 

BACKUP SETTINGS 
Creates a backup of your system settings in case you need to reimage the system. 

RESTORE SETTINGS 
Allows you to restore settings from a backup.  

 

IMPORT CONGO SETTINGS 
Allows you to restore settings saved in an older Congo system.  

Backup and Restore User Template Library 

Backup and Restore the user template library are found in the Utilities tab of the System Settings 
(Browser>Files>Exit To System Settings). 

 

BACKUP USER TEMPLATE LIBRARY 
Allows you to create a backup of your user template library. 

RESTORE USER TEMPLATE LIBRARY 
Allows you to restore a user template library from a backup 

Deep Clear Utilities 

Deep Clear is found in the Utilities tab of the System Settings (Browser>Files>Exit To System 
Settings) 

 

It deletes the Last Saved (play) Data and internal caches. 
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Exit to Welcome Screen (8.0) 
Press MODIFY to exit to the Welcome Screen. From here you can start as Server, Backup or Offline. 
You can open System Settings and Quit. 

In the message box you will be notified 

• If there are Cobalts with different software versions running on the same network.  
• If the same sACN or Net2 universe is mapped to multiple Cobalt universes. 

 

1. Date and time.  
2. Software version  
3. Network Settings  
4. Start Offline  
5. Available Sessions (See below)  
6. System settings (See Exit to System Settings)  
7. Quit  
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Session Start/Join buttons  
All Session buttons display the name of the Session. 

• Sessions you can Start or Join are Cobalt blue.  
• A "running" Session also shows the name of the loaded showfile in italics across the bottom.  
• Sessions that you can't Join are dark red. 

 
There are two possible reasons for this: 
  
A) Software version doesn't match. 
- Instead of the word "Join", the title will show the required software version. 
  
B) The Session is full (Max. 7 members) 
- The title becomes "Full". 
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Power Off (Quit) 

Always shut down your system correctly with the Exit function (BROWSER 
>File >Power Off). 

Function  Key Feedback 

1. Open the Browser [BROWSER] If it was already selected it 
will be closed. Press again 
to open. 

2. Go to Files Down Arrow Files is highlighted 

3. Open subnodes Right arrow Subnodes are opened 

4. Select Power Off Down Arrow Power Off is highlighted 

5. Confirm Power Off [MODIFY] You will get a popup 
asking you to confirm, and 
exit the system. 

NOTE 
The current play will be saved to a temporary file called "SAVED.ASC". 
This file is loaded automatically the next time the Cobalt is powered up.  

Power Loss 

ETC recommends use of an external UPS (Uninterruptible Power Supply) to ensure the possibility to 
save your data and perform a proper shutdown of the Cobalt system in the event of an external power 
loss. The console and the monitor with the Browser should be connected to the UPS. 

NOTE 
The current play will be saved to a temporary file called "SAVED.ASC". 
This file is loaded automatically the next time the Cobalt is powered up.  

Always make sure to save a backup to an external media like a USB device. It 
is your only protection against an internal hardware failure. 
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General Settings 
The General Settings node contains all the settings for the play, the console, 
networking, printing, tab areas etc. 

  

General Settings Node 

 

This chapter contains the following sections 

• Play Settings  
• Console Settings  
• DMX Settings  
• Network  
• Print Wizard  
• Screens (5.0)  
• Dock Areas  
• User Login  
• Event List  
• Macro List 
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Play Settings 
The Settings define default times and values, the behaviour of recording 
functions, and attribute behaviour in faders during playback. 

This chapter contains the following sections 

• Play Settings - Introduction    
• Play Settings - Let's Begin  
• Play Settings - Channel  
• Play Settings - Main Playback  
• Play Settings - Master   
• Play Settings - Effects  
• Play Settings - System  
• Play Settings - Attribute  
• Play Settings - Show Control 
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Play Settings - Introduction  
Press SETUP in the programming section to open system settings. You can also open a local settings 
popup for any key by holding SETUP and pressing that key (for example GO or RECORD) 

 

The system settings popup contains the following sections 

• LETS BEGIN >A summary of the most important settings.  
• CHANNELS >Configure default values and select Command Syntax.  
• CROSSFADE >Configure default times, fader modes and fade direction.  
• MASTERS >Configure  Flash and fade on time and Auto-save master pages.   
• EFFECTS >Configure "Remember Effect Parameters".  
• SYSTEM >Configure Auto-save, rubberband, beep, remote etc.  
• ATTRIBUTES >Configure default times and recording modes.  
• MIDI >Midi Settings  
• SHOW CONTROL >Configure Midi, Show Control and Time Code. 



Cobalt 8.1 - 20181029 

199 

 

Play Settings - Basic 
The Basic settings are a cross selection of settings from all tabs that are very important to fill in before 
starting to work with a new show. See New. 
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Play Settings - Channels  
Press SETUP and use the right/left arrows to select the Channel Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY or # MODIFY to change values.  
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Channel Settings 

The Channel Settings are general for all Channel Views. 

Function  Explanation Default value 

ID Level The level used by the ID function 
(hold CHANNEL and press 
@LEVEL) 

100% 

Step Level The Level applied when pressing 
@LEVEL without any value 

70% 

Step % Value The Level applied when pressing 
the +/-% keys 

5% 

Release Time Default release time for Captured 
channels 

3** 

Slower level wheel 
response 

Reduces the response speed of the 
level wheel 

Off 

Use REM DIM as Balance Sets the function of the REM DIM 
key to BALANCE 

Off*** 

Channel Database Texts Sets a text header for the Channel 
Database texts 

-**** 

** See Channels - Capture Mode 
***See Channels - Balance Mode 
****See Channel Database 
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Play Settings - Main Playback 
Press SETUP and use the right/left arrows to select the Crossfade Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY or # MODIFY to change values.  

 

Crossfade Settings 

The Crossfade Settings are general for the Main Playback. 

Timing settings 
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Function  Explanation Default 
value 

Default GO Time The Time used by the GO key when no 
times have been assigned to a crossfade 

5 

Default Go Back Time The Time used by the GO BACK key when 
pressed independent of any ongoing fades. 

2 

Default Out/In Time Causes the specified time(s) to be 
automatically recorded into all new 
sequence steps, which will be used instead 
of the Default GO time. 

  

Playback mode settings 

Function  Explanation Default 
value 

Modify Sequence Deactivate all Auto-times, Master Links and 
other Autostart items for all Sequences. 

Off 

Build Sequence Presets recorded in LIVE will automatically 
added into the Sequence of the A/B 
Playback. They will always be stored in the 
Preset List 

On 

Crossfade both ways Crossfaders make a crossfade both up and 
down (instead of only up). 

Off 

Set times to Times are set directly to the Sequence Step 
in the A field, or the B field 

B 

GOTO jumps to GOTO fades to Preset numbers, or 
Sequence Step numbers 

Preset 
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Specific playback settings 

Function  Explanation Default 
value 

Disable PB Rubberband Disables attributes from the faders of the 
Main Playback. 

Off 

Always start Dynamics on 
Go 

Sets Dynamics to start on Go regardless of 
other settings. 

Off 

Don't loop Sequence At the end of a Sequence it will not restart at 
step 1. 

Off 

Don't advance Playback Crossfades will not advance any sequence 
steps automatically. 

Off 

Show sequence numbers Display of Sequence Steps in the Playback 
tab. 

On 

Designer summary shows 
data from 

Designer summary shows data from A or B A 

Solo affects Main PB  Allows Flash Solo mode on masters to affect 
also the output from the Main PB.  

Off 

Auto-stop Dynamics in PB Loading a new Sequence to the Main 
Playback stops all running Dynamics started 
from the current Sequence.  

Off 

Alert Alarm Time The time at which the warning (yellow and 
beep) will be issued before the Alert time is 
finished. 

5 

Beep on Alert Audio Alert warning. On 
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Play Settings - Masters 
These are the global settings for the whole play. There are a lot of individual master settings as well.  
(See Masters - Settings) 

Press SETUP and use the right/left arrows to select the  Master Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY to toggle a setting.  

 

Expanded Master Settings 

 

Master Settings  

The Master Settings are general for the Master Playbacks. 

Function  Explanation Default value 

Auto-Update master page Changes to a Master Page are stored 
automatically. 

On 

Exclude Int. from 
Record (6.1) 

Excludes all master intensities from 
record actions in Live 

Off 

Enable Flash key (6.1) Enables Flash mode to momentary 
(on) in all consoles and wing panels 
with physical flash keys. 

On 
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Play Settings - System 
Press SETUP and use the right/left arrows to select the System Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY to toggle a setting.  

 

System Settings 

The System Settings are general for the behaviour of the console. They are divided into User 
Settings and Global Settings  

User Settings 

Function  Explanation Default 
value 

Beep An audio "beep" warning when 
illegal commands are performed 
AND when a crossfade is 
completed 

On 
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Global Settings - for every system in a Session  

Function  Explanation Default 
value 

Enable Remote Controls Activate Radio remote focus units 
and remote trigger. 

On   

Allow recording from remote Allow recording/updates from 
remote(s) 

Off 

Remotes use separate fields Remotes will work in a separate 
remote field 

Off 

Auto-save on Record  
  

Saves the Play after each time you 
press RECORD.  

Off 
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Play Settings - Attribute 
Press SETUP and use the right/left arrows to select the Attribute Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY or # MODIFY to change values. 

 

  

  



Cobalt 8.1 - 20181029 

209 

 

Attribute Settings 

The Attribute settings affect recording and control of moving device parameters. 

Recording and control functions 

Function  Explanation Default  

Sequence attribute 
playback default 

Record attributes to move "live" 
(GoOnGo), when the positions are 
loaded for the next Crossfade 
(GoInB) or Auto Move. 

Auto Mark* 

Record Attribute mode There are different modes for 
recording Attributes. See Device 
Recording - Modes. See Attrib 
Move in Sequence List - Functions. 

Active 

Attribute Editor default The default setting for entering 
values in the Attribute Editors: 
Palettes or %. 

Palette 

Default Attribute time Sets a time for all moving device 
changes during programming.  

3 seconds 

Time: Use % as default Times are set as % of the In-time of 
a crossfade, or in seconds. 

Off (seconds) 

Coarse/Fine 16 bit control When checked, holding down the 
Wheel Key gives 'fine' control on 
the parameter wheel. When 
unchecked, moving the wheels 
slowly gives fine control. See 
Device Templates - 16 bit control. 

Off (8 bits) 

Override scroller fan value Override the fan of all patched 
scrollers with fan control. 

0% 

Sort devices by type Specifies if attribute views should 
be sorted by channel number or by 
device type 

Off 

 *You can change this separately for each Sequence Step in the Sequences - Sequence List. 
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Time settings 

Function  Explanation Default  

F-Del A default delay time in seconds or 
% (of the In time), used when 
recording Preset with Attributes. 

0 seconds 

C-Del See above 0 seconds 

B-Del See above 0 seconds 

F-Time A default time in seconds or % (of 
the In time), used when recording 
Preset with Attributes. 

100% 

C-Time See above 100% 

B-Time See above 100% 
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Play Settings - MIDI 
Press SETUP and use the right/left arrows to select the MIDI Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY or # MODIFY to change values. 

 

Standard MIDI  

All keys and faders can send notes and controllers when this is activated in the MIDI Settings.You can 
use MIDI notes and controllers to remote control any key or fader of the Console.The Cobalt can also 
be set to activate a specific crossfade when receiving a Program Change command through MIDI. See 
MIDI. 
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Function  Explanation Default value 

Direct mode Midi Direct Mode  On 

MIDI Channel The MIDI channel used by Cobalt 1 

Keys All keys are sent as notes. Off 

Faders All faders are sent as controllers. Off 

Program Change Jumps to sequence step # - 

MIDI Show control 

Cobalt supports sending and receiving of MIDI Show Control (MSC) commands. See MIDI - MIDI 
Show Control. 

Function  Explanation Default value 

Active Activates reception of MSC. Off 

Device ID Sets a Device ID for this Cobalt. 1 

Time Code 

Every sequence step can be triggered both manually, and by a specific MIDI Time Code time on the 
MIDI port. See MIDI - Time Code. 

Function  Explanation Default value 

Time Code MIDI Times Code reception is on. Off 

Learn mode Activate learn mode for setting 
Time Code to Sequence Steps.  

Off 

Auto-locate step Sets if Time Code should auto-
locate steps or not. 

Off 

Enable Backup clock Enables the backup clock Off 

Internal clock start Sets a start time for the internal 
clock. 

--.--.--.-- 
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Direct Mode MIDI 

Direct Mode is designed to allow you to connect any MIDI equipment to Cobalt and be able to make it 
work, providing it is sending the corresponding MIDI commands.  

Notes MIDI 
Channel<

Start at
number

End at
number

Count 

Master 1-20 1 0 19 20 

Flash 1-20 1 20 39 20 

Page+/Page-, block 1 1 40 41 2 

       

Master 21-40 2 0 19 20 

Flash 21-40 2 20 39 20 

Page+/Page-, block 2 2 40 41 2 

       

Master 41-60 3 0 19 20 

Flash 41-60 3 20 39 20 

Page+/Page-, block 3 3 40 41 2 

       

Master 61-80 4 0 19 20 

Flash 61-80 4 20 39 20 

Page+/Page-, block 4 4 40 41 2 

       

Direct Select 1-40  
(Congo hardware) 

1 50 89 40 

Direct Select Page 1-5 
(Congo hardware) 

1 90 94 5 

       

Independent 7-9 1 100 102 3 

       

GO, Pause, GoBack 1 103 105 3 

Refresh 1 106 106 1 

       

Controllers      

Master 1-20 1 0 19 20 

Master 21-40 2 0 19 20 
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Master 41-60 3 0 19 20 

Master 61-80 4 0 19 20 

       

Crossfade A, B 1 100 101 2 

Speed Control A, B 1 102 103 2 

GrandMaster 1 104  1 

Independent 1-6 1 110 115 6 

       

Program Change      

Page, block 1 1 0-127  128 

Page, block 2 2 0-127  128 

Page, block 3 3 0-127  128 

Page, block 4 4 0-127  128 

       

Jump in main playback 5 0-127  128 

       

MSC      

Extend to allow control of all masters.     
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Play Settings - Show Control 
Press SETUP and use the right/left arrows to select the Show Control Settings tab.  

• Use the down arrow to select a cell.  
• Use MODIFY or # MODIFY to change values.  

 

Show Control Settings  

The Show Control Settings are general for the system. 

OSC 

Open Sound Control (OSC) is a content format for messaging among computers, sound synthesizers, 
and other multimedia devices. See OSC Functionality. 

Function  Explanation Default value 

Activate Activate OSC Off 

Input Port The Input Port Cobalt listens to 8000 

Output Port The Output port Cobalt sends to 7000 

Output IPs The Output IP(s) Cobalt sends to, 
add multiple and separate with 
semicolon ";". 

- 
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UDP Strings 

UDP (User Datagram Protocol) is a communications protocol where messages are exchanged between 
computers in a network that uses the Internet Protocol (IP). See UDP data. 

In Cobalt UDP allows you to use the Ethernet network to:  

• Receive Cobalt specific Action Macros directly from another unit, without having to first 
create a trigger and event.  

• Send any proprietary string of data to another unit that can receive commands over UDP 

Function  Explanation Default value 

Input Port The Input Port Cobalt listens to 0 

Output Port The Output port Cobalt sends to 0 

Output IPs The Output IP(s) Cobalt sends to, 
add multiple and separate with 
semicolon ";". 

0 
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Console Settings 
The Console Settings are set from the node Console Settings in the Setup node of the Browser. 
(Browser >General Settings >Console Settings).  

You can set the values from 0-100%. They will take effect immediately and are NOT related to 
different play files.  

 

At Mode 
Sets At Mode for the console. An indicator will show that it is active, in the status bar at the bottom of 
all screens. 

At Mode point style 
This allows you to enter levels "5.5" for 55 and then ".6" for turning that into 56. 

Auto Close Tab Mode 
When this is checked you will close the previous tab when opening a new one, to keep the number of 
tabs down. 

See RDM Functionality. 
See Channels - Command Syntax 
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Key Backlighting in Cobalt 
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Displays Lighting 

 

  

Congo Hardware console settings 
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Sound Settings 

The volume of the internal speaker is set by holding SETUP and moving the level Wheel. You will 
see the result in the value next to the loudspeaker symbol in the top right corner of the monitor 
screens. 

 

This will take effect immediately and is NOT related to different play files. 

You can also right-click on the speaker to open a context menu for setting sound levels. 
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DMX Settings  
DMX Settings for up to four DMX ports. Each port uses a universe number (instead of start address). 
Only connected ports will be displayed, marked with “internal” or “gadget”. 

The main reason for changing output speed is that you are controlling older equipment that isn't 
compatible with full speed DMX. 

• Start address  
• Speed = Maximum, Fast, Medium, Slow  
• RDM = on/off 
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Network (8.0) 
This chapter covers the network features including multiconsole sessions.   

his 

 

This chapter contains the following sections 

• Network - Introduction  
• Network - Functions  
• Network nodes  
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Network - Introduction (8.0) 
A physical network can contain any number of logical networks - each logical network is referred to 
as a Session. All consoles in a Session will share play and global resources.  

A Cobalt Session will always have an active Server, which will be the first console started. Every 
other Every other output-capable device (consoles, ETCnomad/Puck) that joins the Session will be a 
potential backup. Should the server stop, the backup with the lowest number will take over and 
maintain control.  
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General Facts 

• Only the Server transmits output data  
• All systems running Cobalt software can join a Session with other devices, this includes 

Cobalt 20, Cobalt 10, Cobalt Light Server, ETCnomad, ETCnomad Puck and the older 
hardware such as th Congo Jr, Congo Kid and Congo Light Server.  

NOTE 
A backup can only back up within its channel and output limitations.  

See System Settings - Networking. 
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Network - Functions 

These are the general network functions.  

This chapter contains the following sections 

• Network - Server/Backup   
• Network - Multiconsole Sessions 
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Network - Server/Backup (8.0) 
When more than one console is used in the same Session the first will be Server, outputting data 
actively, and the other will be backup that the takes over in the event that communication with the 
server is lost. A Backup only starts sending data to the lighting system once it has taken over and 
become Server.  

 

Multi-console systems (server/backup) should be connected to each other through an Ethernet switch 
and should use ETC Net3 DMX/RDM Gateways (or similar) for DMX output. It is not recommended 
to use a crossover cable or local DMX in backup systems. All backup devices can also be used as 
active programming/playback stations.  

Server/Backups 
When communication with the Server is lost, the next Cobalt in the system (lowest backup number) is 
automatically converted to the Server role. 

ETCNet2 
You can connect to ETC nodes with a Switch (avoid routers, they tend to complicate things). Cobalt 
consoles/Client PCs should be given IP addresses in the 10.101.201.101+ range when used with 
ETCNet2. Please see the ETCNet2 v4 Planning Guide for information on configuring an ETCNet2 
network. 

Console    

Cobalt Nomad   10.101.79.101 10.101.79.253 

Congo jr Console 10.101.81.101   10.101.81.253 

Congo Light Server   10.101.82.101   10.101.82.253 

Congo Kid   10.101.83.101   10.101.83.253 

Cobalt 20 Primary NIC   10.101.84.101   10.101.84.253 

Cobalt 10 Primary NIC   10.101.87.101   10.101.87.253 

Cobalt LS Primary NIC   10.101.88.101   10.101.88.253 
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ETC recommends that ETCNet2 systems should be in the 10.101.x.y range - "Primary" NIC. 

Network - Server takeover, loss and return (8.0) 

If consoles in any segment of a Session lose contact with consoles in any other segment, each segment 
will select a new Server. If segments then rejoin the network, the Session must rapidly detect which 
segment is the leader and rejoin it, with all other Servers becoming Backups. 

There are three possible situations 

No activity has occurred in any segment. 

• There is no show data to resolve.  
• The lowest-numbered Server stays as Server, all higher number Servers return to the Backup 

state 

Activity has occurred in only one segment 

• The inactive Server becomes a Backup.  
• Consoles enter the “Catching” state and catch up to the rest of the Session 

Activity has occurred in more than one segment 

• The Server with the most recent Session activity remains Server  
• All others become a Backup  
• All consoles enter the Catching state and sync their activity. 

If changes were made to the same object in two segments, the older changes are lost in both cases. If a 
network switch is lost, many Consoles in the Session will then become isolated from each other. Some 
of these may be able to see each other, while others do not. 
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Network - Multiconsole Sessions (8.0) 
Every console has a Default Session. All consoles within a Session share the same Play data. Hitting 
“Save” in any console causes all consoles to save the Play to their local hard disk. Save actions shall 
have no noticeable effect on connected consoles other than to delay loading or quitting until a save is 
completed. 

You may create any number of individual multiconsole Sessions in the same network. Each additional 
console can access and work independently with the data of the Play in the Server. Playback controls 
are shared (See Multiple Users - Global Functions).  

All Sessions set up in a network are shown and synchronized at the Welcome Screen. 

• All consoles on a network list all the Sessions that it can Join.  
• A console started in Offline mode does not communicate with any other console and does not 

join a Session.  

A Session contains the following data: 

• The user-defined name 
• An optional password 
• DMX mapping between the console patch universes (1-32) and all supported Ethernet-based 

lighting protocols. 

A Session may be Inactive (no consoles are in the Session), Active with one or more consoles 
connected, or Full (when 7 consoles are connected to the Session.) 

A software version may be displayed for any given Session, indicating the software version of the 
current Server. All consoles in a Session must be using the same software version. 

Multiconsole Sessions - Global Functions (8.0) 

All Play data is Global and stored in every console. All Session members track recorded changes from 
any member. 

All Session members track changes from any member 

• Content on all Playbacks.  
• Temporary’ content of A, B, Blind and Master fields  
• Changes in fully blind tabs are not distributed until Record/Update occurs. 

Multiple Main Playbacks 
Nine (9) additional “main playbacks” allow independent playback of a "console-local" sequence from 
multiple consoles (every user can choose which main playback field 1-9 to assign to their main 
playback) (hold SETUP & PLAYBACK). Additional main playbacks are filtered through the 
partitioning system. 
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Channels controlled from a different main playback will have a green level.  

 

Master Playbacks 
The 80 master fields are global. 

Partitioning 
Within a Session, partitions can be used to subdivide channel control, recording and Main Playback 
functions.  

• Partitions are conceptually Filters that filter out all channels not included in the partition.  
• Updating and recording presets will record values for all recordable channels in the partition 

and will not affect channels that are outside of the partition. 

Freeze/Blackout & Grand Master 
Freeze is activated locally and will freeze all outputs. Blackout and Gand Master will do the same. 
They are all global. 

Inputs/Outputs 
To ensure seamless operation it is recommended in a multiconsole system (multiuser or with a 
backup) that a network is used to distribute DMX and to interface to other I/O and show control 
protocols.  

Multiconsole Sessions - Local Functions (8.0) 

Basically everything is local except the global features described above. See Multiple Users - Global 
Functions. There are some special cases: 

Capture 
Each user has its own Capture mode, but all captures channels are handled on a global system level on 
a first come, first served basis. This means that if a channel can be controlled from two consoles and 
one of them has Captured it - it is "owned" by this console until released. 

Group Wheel Mode 
Group Wheel mode is local for each console - just like all other channel control functions. 

Multiconsole Sessions - Patching, Users and Partitions (8.0) 

To set up a multiconsole Session in a system it is important to do things in a specific order. It is also 
important to structure the working method of the Users since they will all be sharing the same system.  
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Patch First! 
Start by patching the whole system, with devices and everything. See Patch. Basically you can 
connect several clients directly after patching, to a Server, or Server/Backup system - and each user 
can access the whole system in parallel with the other users.  

Option: Define Partitions 
You can define Partitions that can be activated for different users. The Partitions can be helpful to 
avoid one user affecting channels of another user. Make sure you do this BEFORE activating 
Partitions or User Logins other than the default ones. See Partitions. 

Option: Define Users 
If necessary, define User Logins for different work stations. The User Logins may be of help when 
different users try to access the Server - partly because there are personal settings, and partly because 
Partitions can be set to default and automatically be activated when a specific User logs in. See User 
Login. 

Multiconsole Sessions - Status (8.0) 

The number of connected consoles/devices are displayed in the lower right corner status indication of 
screens.   

 

Multiconsole Sessions - Start and Join a Session (8.0) 

To start output from a console a Session has to be joined. There is a default Session in every system 
and more can be created in System Settings. The first Console to join an Inactive Session makes it 
Active and sets the Software Version. The first Console to load a play file in a Session sets the Play 
file. 

Starting a Session  
The first console to Join an Inactive Session must start this Session. 

1. The Software Version is set, and the Session status is now Active.  
2. The user is asked which Play to load (Last, Play Archive or New). 

Joining a Session  

1. Select the Session you wish to Join. If the Software Version is not compatible, your are 
warned and cannot join the session.  

2. If the Sessionhas a password, your must enter it.  
3. Your console then begins the process catching the Session .  

• The most recent play file “sequence point” is downloaded from an existing Console.  
• Changes are downloaded in the order they occurred and applied to this snapshot.  
• The console catching up will adds ongoing changes to the end of the queue, to be processed 

when it reaches them.  
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• Once the Console has caught up, it is assigned a Backup Number. 

Multiconsole Session - Leave or Shut Down (8.0) 

Any  user can ask to Shut Down or Leave the Session. After doing this, you may Power Off or return 
to the Welcome Screen. 

Shutting Down a Session 
The console Shutting Down the Session will request all other consoles to Leave the Session. The other 
consoles will have an opportunity to cancel the shutdown. In this case the Session does not shut down 
and stays Active. 

Leaving a Session 
If a console is the last to Leave the Session, it shall Shut Down the Session. When the console Leaves 
the Session, it shall save a copy of the show file and will show in a start dialog that it left the session 
early last.  
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Network nodes 
This node shows all Cobalt devices on the network, including the one you are working on, which is 
indicated with a * before the name.  

You can see the role, IP address and logical network in the Info area. See System Settings. 
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Net3/ACN Device List  
Lists all Net3 Devices in the network, and allows some editing. Cobalt servers and backups will 
automatically connect to discovered CEM3s as it 
does with CEM+s when it is configured to do so. Cobalt console will attempt re-connect CEM3s when 
a network disconnect occurs as it does with CEM+s. 

 

Press MODIFY to open the Net3/ACN Device List 

 

HINTS (5.1) 
RFR BaseStation and RFR Handheld devices are shown in the list. 
RFR Host is shown as active. 
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Screens (8.0) 
You can store all screen settings including screen areas, zoom and channel format into 100 screen 
memories.  

The screen areas are set up with the screen browser in the top right hand corner of every screen. Select 
a screen area layout and it will be activated immediately. No tabs are closed. To open a tab in an 
empty area press the "+" sign in the top left corner. See Tabs.To record the areas and tabs in all 
screens use the Record Screen function in the Direct Selects, hold RECORD and press one of the 
screen select buttons in the console, or use the RECORD option in this tab. See Screens.  

 

The first six are accessible by the screen buttons between the touch screens. To record hold RECORD 
and press one of the buttons - the current screens are stored to that button. Button 1 (top left) is default 
and cannot be overwritten. You can also record screens in the Screen tab. See Record Screens (8.0).  
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When you press a screen key, all screens will change to the stored layout and format. 

These Screens can be accessed from the Browser (Browser>General Settings>Screens) and the Direct 
Selects. Screens can also be recorded in the Direct Selects. (See Cobalt Direct Selects: Special 
Functions) 

You can resize all areas using mouse or trackball on the divider lines - with a touch screen you can 
activate Resize handles by selecting "Resize" in the middle section. Click again on the resize symbol 
in the top right corner of the screen to finish.  
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Record Screens (8.0) 

Screens can be recorded directly to the screen keys in the consoles, in the screen tab and in the Direct 
Selects. 

To the screen keys 

1. Hold RECORD and press a SCREEN KEY.  
2. You will get a popup where you can name the screen 

 

In the screen tab 

1. Open the screen tab (click on the symbol in the top right corner of all screens)  
2. Click on the RECORD symbol. All recordable screen symbols will be highlighted and you 

can select an existing one or NEW.  
3. You will get a popup where you can name the screen. 
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In the Direct Selects 

1. Open the Direct Selects tab  
2. Click on TYPE and select SCREENS for a section  
3. Click on RecordDS  
4. Click on any Screen button to record the current screens. If it is a new one, you will get a 

chance to name it.  
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(See Cobalt Direct Selects - Types of Data and Cobalt Direct Selects: Special Functions) 

Load screen 

You can load a screen from the Screen Keys in the consoles, from the screen tab, from the Direct 
Selects or from the Browser. To load from the Browser, select the screen and press MODIFY or 
double click.  
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Delete or Rename Screens - Screens List (8.0) 

Open the screen list in the Browser >General Settings >Screens... to see, rename and delete screens.  

 

This is the list 
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Select a screen and press DELETE. You will get a popup allowing you to confirm.  

 

You can rename Screens also in the Direct Selects, like any other Direct Select content - Hold TEXT 
and click on the button.  
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User List 
User logins allow you to keep personal settings for Direct Selects, Screens and Notes, within the same 
Play as other users.  
See Direct Selects, and Notes. 

It's also possible to connect Partitions to User Logins, which makes it possible to have a User Login 
with a predefined set of channels that can be accessed by that user.  
See Partitions. 

You can view, edit and create new Users in the User List (Browser >General Settings >User List).   

 

User List - Columns 

Function  Key Feedback 

User  The ID of each Partition. Cannot be 
changed. 

Name [MODIFY] Press MODIFY to activate and end 
text input. This text is shown in the 
top of the screens. 

Default Partition [MODIFY] Toggles the Default Partition on/off. 
This is the partition that will be 
activated when this User logs in. 

Allowed Partitions [MODIFY] Opens the User Partition List where 
it is possible to toggle the 
permission for each Partition on/off 
* 

* Please note that the Default Partition has to be set to Onin the User Partition List as well - this is 
done automatically.  
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NOTE 
The default Users "Default" and "View" are defined to allow access to the 
full system. 

Create a User Login  

User Logins are created in the User List. 

1. Open the User List (BROWSER >General Settings >User List).  
2. Press INSERT to create a new User.  
3. Select the Name cell and press MODIFY to enter a text label.  
4. Select Default Partition (press MODIFY in the Default Partition cell) 

Allowed Partitions 
When a new user is created, the Default Partition is set to ALL, and all Partitions are set as Allowed. 
You can disallow Partitions for a User by pressing MODIFY in the Allowed Partitions cell - opening 
the User Partition List. 
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Change User 
User Login is activated from the command Change User in the Browser. If no User has been logged 
in, the Default User will be logged in when a Play is opened. 

1. Select the node Change User and press MODIFY (BROWSER >General Settings >Change 
User). You will get a popup where you can choose from all defined Users. 
 

 

2. The User is activated and indicated in the top left corner of all screens: 
 

 
 
Any Partitions associated to this User will be activated. See Partitions. 

   

NOTE 
The last used login name will be remembered in each station and used for the 
next startup. 
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Event List  
An Event combines a Trigger with an Action Macro. 

Action Macros are a powerful way of creating commands inside Cobalt and 
to control external devices.  

Triggers can start Cobalt commands from external inputs like the COM port 
(unison macros for example).  

This chapter contains the following sections 

• Event List - Introduction  
• Event List - Action Macros  
• Event List - Events  
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Event List - Introduction 
An Event is a combination of a Trigger and an Action Macro. An Action Macro can be defined also 
directly in the step of a Sequence.  

Action Macro 
An Action Macro consists of a string of characters forming a line of commands. These commands can 
be used to trigger internal actions (Go, Pause etc) or external devices (DVD players, computers etc) 
with serial & MIDI commands 

Trigger 
A Trigger is used only to trigger an Action Macro. This can be done from the local Com or MIDI 
ports, Closure or through a Net3 node.  

Event 
An Event is created when a Trigger is combined with an Action Macro. 

NOTE 
The COM port of Cobalt has to be activated to receive Triggers. See System 
Settings - Com Port. 
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Event List - Action Macros 
An Action is a kind of Macro that consists of a string of characters forming a line of commands. These 
commands can be internal (Cobalt) or external (COM port serial communication with DVD player, 
computers etc). Action Macros can be entered directly  in the Sequence Action Macro column (see 
Sequence List - Columns). Action Macros can be linked to Triggers in the Event list. 

In the Playback View Action Macros are shown with the"*" character or the word "Action Macro" 
depending on format.  

See also Serial Com Data and MIDI Data. 

Action Macro Rules  

The rules for all Action Macros are very strictly defined. There is no warning if your formatting is 
wrong. 

• An Action Macro starts with an action type (for example COM, MIDI, GO, RELAY). The 
commando is followed by a list of parameters, separated by commas.   

• Parameters in <> are optional.   
• Multiple commands can be entered in the same Action Macro, separated by a semicolon ; 

character. 

Cobalt Action Macros  

These are the available Cobalt Action Macros. Some have changed from over the years. Please note 
that existing Action Macros using the changed commands will not be converted automatically. They 
have to be manually updated to work as expected. To access Action Macros from the Direct Selects 
tab see Action Macro List.  
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Remember the RULES.  

Function   Command Information 

Master START START Mx 
<,target> <,time> 

Moves Master x to 'target' percent 
in 'time' seconds 

Master GO Go Mx <,preset> <,time> Mx,preset,time. If Preset is 
omitted, a simple GO command is 
made, otherwise a GOTO (preset) 
is executed. If Time is set, it will 
replace sequence timing. 

Playback GO Go PB <,preset> <,time> As per Go Mx but in the Main 
Playback. 

Master PAUSE Pause Mx Pause fade on master. 

Playback PAUSE Pause PB Pause fade on playback. 

Run Macro # Macro x Executes macro x 

Change Page #  Page x<,y> Selects page x on bank y  
(1=lower bank 1-20), (2=upper 
bank 21-40). 

Relay Status   Relay Groupx 
,Relayx,ON/OFF 

Sets the status of relay 1-24, in 
relay group #. Group 0 is local to 
the console. 

UDP String UDP <String> Sends an UDP string to the port 
and IP defined in System 
Settings. 

COM  COM grp,data* Sends COM data to a port. Grp = 
0 is local Grp >0 us a serial port 
in ACN. 

MIDI  MIDI grp,data* Sends MIDI datato a port. Grp = 
0 is local Grp >0 us a serial port 
in ACN. 

OSC  OSC <String> Sends an OSC string to the OSC 
devices defined in System 
Settings. 

Load Sequence to 
master playback 
(7.2) 

LOADSEQUENCE Mx,s Loads sequence s to master 
playback x  

Load Sequence to 
main playback 
(7.2) 

LOADSEQUENCE PB,s Loads sequence s to the main 
playback  

Set screen 
backlight (7.2) 

SCREENBACKLIGHT 
x 

x is a value between 1-10. Only 
works on built in Cobalt screens. 

Restore screen 
backlight (7.2) 

SCREENBACKLIGHT 
restore 

Only works on built in Cobalt 
screens 
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Function   Command Information 

Load Screen 
Layout (7.2) 

SCREENLAYOUT x Load screen layout with index x 
(there are no id numbers on 
screen layouts). 

Execute Action 
Macro (7.2) 

ACTIONMACRO x Execute action macro x 

NOTE 
*Data, is a special format that allows ASCII and Hex code to mix.  

Every byte is represented by one or two characters.  

One character = ASCII 
Two characters = HEX 

”1 2 3 0D 0A” sends ASCII characters 1, 2, 3 followed by a Carriage return 
(0D in Hex) and Line feed (0A in Hex) 

Examples 
Observe that there is no space before or after a comma.  

Go M3,100 (Master 3 GOTO Preset 100 in default time) 

Go PB,1 (Goto Step 1 in the sequence of the Main Playback) 

Relay 1,2,ON (Set relay 2 in group 1 to ON) 

See also OSC Functionality 

Serial COM data  

In an Action Macro, this data is started with the word COM. Two parameters are used after the COM 
type.  

• Group number (group 0 is the local console) followed by a comma.  
• The parameter values (hexadecimal or ASCII) 

RULES 

• You can mix ASCII and hexadecimal values.  
• The data bytes are separated by a space character.  
• A hex byte is always written as two hexadecimal characters (like AE) followed by a space.  
• An ASCII character is written as a single character followed by a space.  
• Carriage return is written 0D.  
• Line feed is written 0A.  
• Tab is written 09.  

Examples 
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COM 1 ,ee 0e 00 00 40 M a c r o 1 . E X E C 00 00 (ETC Unison system example string) 

COM 1 ,41 42 43 sends a serial string with three bytes (all values in hex) 

COM 1 ,P L A Y 1 sends a serial string with the value PLAY1 (ASCII data)  

COM 1 ,P L A Y 1 0D sends a serial string with the value PLAY1 followed by Carriage Return. 

MIDI Data  

You can send an arbitrary data string on the console MIDI port, or through MIDI on a Net3 Gateway.  

In an Action, this data is started with the word MIDI followed by port, comma and data.  

RULES 
When specifying data for a MIDI port trigger or Action, you enter the string with hexadecimal values.  

• Group number (group 0 is the local console) followed by a comma.  
• The data bytes are separated by a space character.  
• A hex byte is always written as two hexadecimal characters (like 7E) followed by a space.  
• Basically any type of MIDI message can be sent from an Action Macro. Note On, Note Off, 

Program Change and System Exclusive (including Midi Show Control) messages are most 
frequently used. 
  

Examples 

MIDI 0, 90 24 40 sends a Note On message to the console output on Channel 1 for note 24 (36 in 
decimal) with a velocity of 40 (64 in decimal) 

MIDI 1, 80 24 00 sends a Note Off message on group 1 in a Net3 Gateway on Channel 1 for note 24. 

More examples for the local console port 

MIDI 0, F0 7F 01 02 01 01 F7 sends a Midi Show Control (System Exclusive) command: GO 

MIDI 0, F0 7F 01 02 01 01 31 30 F7 sends a Midi Show Control (System Exclusive) command: 
GOTO Cue 10 

MIDI 0, C0 10 sends a Program Change message (on channel 1) for program 10 (16 in decimal)  

UDP data 

UDP (User Datagram Protocol) is a communications protocol where messages are exchanged between 
computers in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission 
Control Protocol (TCP) and, together with IP, is sometimes referred to as UDP/IP. 
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In Cobalt UDP allows you to use the Ethernet network to:  

• Receive Cobalt specific Action Macros directly from another unit, without having to first 
create a trigger and event.  

• Send any proprietary string of data to another unit that can receive commands over UDP 

Receiving Action Macros over UDP 
For Cobalt to receive Action Macros you need to set a receive port in the Play Settings - Show 
Control (Browser >General Settings >Play Settings) and make sure that the incoming Action Macro 
text strings are written by the rules for Cobalt Action Macros explained in that chapter. An incoming 
Action Macro is processed the instant it is received. 

Sending UDP Strings 
For Cobalt to send Action Macros a send port and IP address have to be set up in the Play Settings - 
Show Control (Browser >General Settings >Play Settings) and the the text string you send needs to be 
written according to the specifications of the receiving device.  
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Event List - Events  
To trigger an Action Macro from an external input an Event has to be created and a Trigger has to be 
defined. This is done in the Event List. 

For each type of trigger (input), an Event list needs to be created. This is to allow for future expansion 
of both internal ports and network ports.  

1. Open the Event List 
 

 
 
Insert an item (INSERT) and define a Trigger (you can add a description).  
  

2. Open the editor by pressing MODIFY in the first column. 
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3. Use INSERT to insert a new line. Define the Trigger and Action string using the formats 
described in Actions & Events - Actions. You can add a description as well (recommended). 
Press MODIFY in TEST EXECUTION to run an event.  

Triggers for Events  

An Event is a way to link a Trigger to an Action Macro. A Trigger can be serial communication 
received on a COM or MIDI port of the console. Note that COM x,' and 'MIDI x,' are not required in 
Triggers. 

• Local Com-port - See Serial COM data 

• Local MIDI-port - See MIDI and Serial MIDI data 

• Net3 I/O Node Com-port  

• Net3 I/O Node Closure - You can specify the closure input (1-24) and if you want to trigger 
on close of open state. Note: Closure input are using the analog inputs of the physical node 
but has only two states, on and off. 

• Net3 I/O Node Analog - You can specify an analog input (1-24), a trigger value and the 
direction. 

• Local Closure - You can define triggers and actions for the external trig inputs in the same 
way as for Net3 I/O node closures. 
If a trigger is defined for an input, the default action (Go, Pause, Go Back and Master 40) 
won’t be carried out. See Connectors 

  

Group Numbers 
Using Group numbers, you can set up a system where Cobalt listens to several different I/O nodes (or 
local ports) and reacts with different actions. Group 0 applies to local serial and MIDI ports, Group 1-
x applies to network ports and has to match the group configured in the node.  
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Macro List  
A Macro is basically a series of key presses and actions that are stored under a number for random 
playback. 

NOTE 7.3 
If you have used Cobalt master/flash/encoder buttons in a 
button macro, you would need to re-record these when brought into 7.3 due 
to internal changes to button mapping. 

• Macros can be recorded and played back in real time or fast.  
• Macros can be linked to a sequence or chase step.  
• Each Macro can have a text label.  
• Macros can not be edited.  
• There is an indication in the top right corner when a Macro is being played back. 

The Macro List is opened by holding MODIFY and pressing MACRO. In the list it is possible to 
toggle between real-time and fast playback - and set a text label. 
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Macros - Record & Playback 

Macros are recorded with the LEARN MACRO soft key of the Misc Soft key page in the consoles. 

   

Record a Macro 

1. Select the Misc Soft Key page. 

2. Enter a number and press LEARN MACRO. As long as recording is going on the text "Recording 
macro" is displayed in the top right corner of the screens. 

 

3. Click on Recording Macro in the top right corner of the screens to end recording. 

  

Playback a Macro 

Enter the number and press MACRO. As long as the Macro is being played back the text "Playing 
macro" is displayed in the top right corner of the screens. 
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Action Macro List  
The Action Macro list (Browser>General Settings>Action Macro List) allows you to create Action 
Macros that are available in the Direct Select tab (DS) as screen buttons. For information on how to 
create an Action Macro see Event List - Action Macros.  

 

Each Action Macro will appear on the DS button with the corresponding number when the content 
type Action Macro is selected. If you rearrange in the DS dock the Action Macros will be rearranged 
in the list, since the number corresponds to a button.  
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Patching 
Before you can control a channel or moving device, it needs to be patched.  

  

Patching Node 

 

This chapter contains the following sections 

• Patch - Introduction   
• Patch by Channel/Dimmer  
• Import Template Wizard  
• Patch Wizard  
• Device List   
• See RDM Functionality  
• >Settings and Tools - Patching  



Cobalt 8.1 - 20181029 

258 

 

Patch - Introduction  
Patch is where outputs are assigned to channels, either directly in the case of dimmers or using a 
Template in the case of devices. All settings pertaining to outputs, channels and devices are also 
adjusted within the patch.  

Before you can control a dimmer or device it has to be patched to a channel. When opening a new 
play you can choose to set the Patch 1:1 or cleared. There are many ways to patch. These are the 
available options. 

Patch by channel or output 
Depending on how you mount your rig you may want to patch by output (not knowing which output is 
connected to which light) or by channel (having a plot). Both are done easily in the Output Editor. See 
Patch by Channel/Dimmer. 

• To edit Channel scale factor, fade curve, park status or rename, see the Channel List.  
• To edit Output scale factor, fade curve & park status, see the Output List.  
• To clear the patch see the Patch Wizard. 

Patch multiple moving devices 
Before you can patch a moving device, you need to import the template using the Import Template 
Wizard. See Import Template Wizard.  
Once a template is imported, you can adjust it and patch single or multiple devices using either the 
Patch Wizard, or the Device List. See Patch Wizard. See Device List. 

• To adjust individual devices, such as inverting or swap pan/tilt. Scroller roll & calibration. 
Change template, channel or address. See Device List. 

Channel Database 
The channel database allows you to tag each channel handle with up to four texts. These texts will 
create auto-groups. See Channel Database. 

  

Flexible Patching (7.1) 

You can patch within up to 32 universes (12 with Congo). You are free to patch dimmers or devices to 
any of these universes. The universe map decides which actual universes on the network they are 
transmitted to. You should be able to use sACN universe numbers up to 9999. 

• Output values above the maximum allowed output count are now forced to 0% 
• The system counts all patched outputs and shows a title bar indicator “Output limit reached”. 
• About Cobalt: Shows the total amount of outputs, how many that are used and how many that 

remains. 
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Patch by Channel/Dimmer 
Press OUTPUT in the programming section to open the Output Editor. (BROWSER >Patching >Patch 
by Channel/Dimmer) 

From here you can patch by channel or by dimmer.  

 

 

1. Select by Output or by Channel.  
2. View Outputs in different formats (All, patched, unpatched, selected)  
3. Universe number  
4. Output number  
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5. Levels are shown in 8 bits (0-255). Changing Levels are shown with a blue background for 
going up.  

6. Levels are shown with a green background going down  
7. Number of the channel this output is patched to  
8. Unpatched outputs  
9. A device is held together with a color, and all parameter names are shown for each output.   

(See Patch - Introduction) 

Output Editor - Formats 

The currently selected format is indicated in the top right corner. You can toggle between these 
formats by pressing FORMAT, or from the context menu (touch or click on the current format title). 

• All outputs  
• Patched  
• Un-patched  
• Selected 

Level of detail 
Compact level of detail (Hold FORMAT and press down/up arrow). 
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High level of detail 
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Zoom Out 
Hold FORMAT and move the level Wheel to zoom out/in. When you zoom out you will see all 
available universes. 
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Output Editor - Patch By Channel 

As soon as a channel is selected, the Output Editor is automatically in channel mode. Select a single 
channel or a range of channels to patch to Outputs. Use 0 MODIFY to unpatch. 

Patch a single channel 

Action Key Feedback 

1. Select channel [#] [CHANNEL] Channel is selected. 

2. Patch to output [#] [MODIFY] A popup will ask if you 
want to replace existing 
output(s)* 

3. Confirm [MODIFY] Patch is complete. 
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* 

 

Patch a channel range  

Action Key Feedback 

1. Select channel range Channel functions Channels are selected 

2. Patch to output(s) [#] [MODIFY] A popup will ask if you 
want to patch a range of 
outputs starting at #  

3. Confirm [MODIFY] Patch is complete. 

Output Editor - Patch By Dimmer 

As soon as an output is selected, the Output Editor is automatically in outputmode. Select a single 
output or a range of outputs to patch to channels. Use 0 MODIFY to unpatch. 

Patch a single output 

Action Key Feedback 

1. Select output [#] [OUTPUT] Output is selected. You can 
use the format 
output.universe. 

2. Patch to channel [#] [MODIFY] A popup will ask if you 
want to replace existing 
channel* 

3. Confirm [MODIFY] Patch is complete. 
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* 

 

Patch an output range  

Action Key Feedback 

1. Select output range Output functions Outputs are selected 

2. Patch to channel(s) [#] [MODIFY] A popup will ask if you 
want to patch all to one 
channel or as a range*. Use 
0 to unpatch selected 
outputs. 

3. Confirm [MODIFY] Patch is complete. 

* 
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Output Editor - Dimmer Check Mode 

Dimmer Check mode is a fast way to check the outputs consecutively. 

1. Select first output with # OUTPUT 

2. Set a level for checking with # @ LEVEL (a level is given between 0-255. 128 = 50%) 

3. Press + or - to use this level and step to the next/previous Output. Levels that are higher than zero 
are restored automatically as they are passed by. 

4. Deselect the last output to leave channel check mode (0 OUTPUT). Or, simply set that output to a 
level of 0% (0 @ LEVEL or use the wheel) 

Output Editor - Channel Check Mode 

Channel Check mode is a fast way to check the channels consecutively in the output editor. 

1. Select first output with # CH 

2. Set a level for checking with # @ LEVEL (a level is given between 0-255. 128 = 50%) 

3. Press + or - to use this level and step to the next/previous patched channel. Levels that are higher 
than zero are restored automatically as they are passed by. Channels that are not patched will not be 
lit. 

4. Deselect the last channel to leave channel check mode (0 CHANNEL or C/ALT CH). Or, simply set 
that channel to a level of 0% (0 @ LEVEL or use the wheel) 
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Import Template Wizard  
Before you can patch a moving device you need to import or create the corresponding template. 

• To import from the libraries, use the Import Template Wizard in the Browser (Browser 
>Patching > Import Template Wizard).   

• User templates from other Plays are imported with the Import Wizard. See Import Wizard.  
• Custom templates can be created from scratch with the Templates Editor.  
• You can save and import user templates to the User Library.  

1. Open Import Template Wizard from Browser >Patching >Import Template Wizard 

 

2. Select Library (Extended, Standard or User - see NOTE below). 

3. Filter by manufacturer or model, press Import Selected Template. The imported Template is added 
to the "Templates" node of the Browser >Patching. 

Using the Filter: The tree is refreshed when you stop typing. If you type several words, the tree will 
show nodes that match all words in manufacturer or model fields combined. 
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Devices with calibrated color data are indicated - this means they will be possible to use with the Gel 
Picker and calibrated Color Picker even if they have more than three color emitters. 

It is possible to select the tree view when focused by pressing MODIFY (similar to how we enter a 
text field). You can then navigate inside the tree view with the arrow keys. Leave the tree view by 
pressing MODIFY again. 

NOTE 
Standard or Extended Library? 

There are two default libraries of templates - standard (smaller) and 
extended (larger) - both are accessed from the Import Template Wizard. We 
recommend that you first check the extended library (default). 

The standard library is the one that's been in Cobalt from the start. All 
templates are hand-made. The Extended library is data we get from the 
Carallon subscription service and is made by crunching a lot of data. The 
templates are as good as Carallon (with some work from ETC) can make 
them, but they have not all been tested with real lights or adjusted. 
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User Library 

The User Library is where you can store all templates you create, and/or imported templates that you 
have modified, and wish to be able to use in other shows by importing them with the Import Template 
Wizard.  

See User Templates.  
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Patch Wizard  
The Patch Wizard is opened from the Browser (Browser >Patching >Patch Wizard). See Navigating - 
Browser. 

 

There are four sections 

• Patch Dimmer - patch one, or a range of dimmers  
• Patch Device - patch one, or a range of devices  
• Set/Clear - clear or reset a range/all outputs, devices or renaming.  
• Clone - will copy all matching parameter data from a source channel, providing target 

channel is patched to a template first. 

Patch Dimmer(s) 

Enter the number of dimmers, the desk channel, DMX address and universe. If you check Replace 
existing dimmers, these will be unpatched automatically.  
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Patch Device(s) 

Select a template from the list, or open the Import Template Wizard. See Import Template Wizard. 
Importing a template will add it to the list in this dropdown. 

Enter the number of devices, desk channel, DMX address and universe. When the device type and 
number of devices are specified the required block of outputs is indicated in italic over the DMX 
Address (see image). The first free DMX address and output offset is suggested too. 

If you check Replace existing dimmers (default), they will be unpatched automatically. If you are 
patching scrollers, you can select a scroller roll. You can assign a scroller roll later as well, from the 
device settings list. 

Output Offset allows you to set an offset from the first attribute of each moving device to achieve a 
specific numbering for the start addresses. 
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NOTE 
Patched devices are automatically set to default values.  
See Home Positioning.  

NOTE 
As soon as a moving device is patched, the channel symbol in the channel 
views will get an extra field for moving device information. 

Set/Clear patch or rename 

You can reset (1:1) or clear the dimmer patch, the moving device patch, or the renaming system for 
any channel range from # to #. If you check "Apply To All" you don't need to specify a range. 
Unpatch All clears channel, device and name patch. 
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These are the options in the Clear wizard tab 

 

See Renaming Channels 

NOTE 
Checking Apply To All clears everything up to the total system limits 
regardless of any prior downgrade of channels/outputs.  

Clone Device(s) in Patch (8.0) 

Clone allows you to copy all data from a single source channel to a selection of other channels to 
increase the number of fixtures in a show , for example "yesterday I had 8 back lights, now I have 10" 
- and get the base data into them quickly. 

In the example above this is done by copying the data from one of the original 8 backlights into the 2 
newly patched additional channels. The Clone feature copies all palette, preset and cue data from the 
source channel to the new channels. If the source channel is included in a group, the new channels are 
added at the intensity level of the source channel. From this point you can edit at will.  
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Example 

1. Open Patch Wizard  
2. Activate Clone tab  
3. Select target channels (they shall already have templates assigned in the Device List).  
4. Select source channel  
5. Press Execute 

The parameter data from the source channel is cloned to the parameters of the target channels. 

The clone function requires that the target channels are patched with an appropriate template and 
configured before cloning. Best results are obtained when the target channels use the same template as 
the source channel. 

Cloning to a different fixture type 
Cloning will copy all matching parameter data from a source channel to target channels across the 
play file. Parameters are matched by name. Cloning copies raw DMX values, so some editing may 
still be needed after cloning. Parameters that do not match between source channel and target channels 
will be hidden.  
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Device List 
Hold MODIFY and press DEVICE to open the Device List where you can view and edit moving 
device settings. (BROWSER >Patching >Device List).  

 &  

See Introduction To Patching 

 

Remaining outputs are indicated in the hint text line¨at the bottom. 
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Device Settings - Columns & Functions 

Column  Input Function 

Item No input The number of this item - cannot be edited 
here. 

Channel 0-3072 The number of the desk channel this device 
is assigned to. 

Template Dropdown 
menu 

Shows the device template - dropdown to 
change. Use the Import Template Wizard to 
import templates. 

Device Address #.# Shows the device address - change by 
address.universe. You can change universe 
by ".universe" 

Inv. Pan Off/On You can invert pan for this device on the 
input (manual control) or output (stored 
data) 

Inv. Tilt Off/On You can invert tilt for this device on the 
input (manual control) or output (stored 
data) 

Swap Pan/Tilt Off/On Swap pan/tilt for this device. 

Scroller Roll Dropdown 
menu 

Shows the assigned scroller roll - dropdown 
to change. See Scroller Rolls. 

Calibration Editor [MODIFY] Press MODIFY to open the Calibration 
Editor for a specific scroller roll. See 
Calibrate Individual Scroller Rolls. 
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Device Settings - Patching 

It is possible to Patch devices directly into the Device Settings tab. You can use any channel selection 
to patch fast. 

Function  Key Feedback 

Insert a new 
Device 

[#] [INSERT] A new Device is inserted. 

Delete the selected 
Device 

[DELETE] The selected Device is deleted. You 
can only delete one device at a time. 

Insert the current 
channel selection 
as devices 

[INSERT] The current channel selection is 
inserted as Devices. 

Change template 
for multiple 
devices 

[SELECT] Use SELECT to select multiple 
cells. Select a new template from 
the dropdown and press MODIFY * 

Change address for 
multiple devices  

[SELECT] Use SELECT to select multiple 
cells. Enter a start address and press 
MODIFY. 

Unpatch a device [0] [MODIFY] In the Adress cell you can unpatch 
the currently selected devices by 
entering 0. 

*If a template isn't available, use the Import Template Wizard to import it. See Import Template 
Wizard. 

NOTE 
When you patch a template with multiple parts, separate devices will be 
created for the various parts and decimal channel numbers will be assigned. 
Changing the start address of the base channel will update the sub devices 
accordingly. 

 

  



Cobalt 8.1 - 20181029 

279 

 

Edit/Change a Device 

You can exchange one moving device with another in the Device List. All parameters that are similar 
will continue functioning.  

Function  Where Explanation 

Change Device Type* Device Settings, 
Template column 

Press MODIFY to get a 
dropdown with all 
templates. Select a new 
device template. 

Change Device Address Device Settings, 
Device Address 
column 

Enter a new device address 
with address.universe. You 
can change universe only 
by ".universe" 

Change Device Channel Device Settings, 
Device Channel 
column 

Enter a new device 
channel.  

Delete Device Device Settings Press DELETE in any row. 

* All play information that can be read by the replacement device template will be used. You can 
swap back to the first device at anytime later. This is useful if you have to replace one type/brand of 
Moving Device with another. 
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>Settings and Tools - Patching 
These are the settings and tools for Patching. 

This chapter contains the following sections 

• Channel List    
• Output List   
• Parked  
• Templates  
• User Templates  
• Parameter Definitions  
• Dimmer Curve List  
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Channel List 
Hold MODIFY and press CHANNEL to open the Channel List. You can view and edit dimmer 
outputs, scaling and constant ch level in the Channel List (BROWSER >Patching >Settings & Tools 
>Channel List).  

 &  

See Patch - Introduction for more information. 

 

NOTE 
When a step is selected, the corresponding channel and output are selected in 
the Live and Output Editor tabs 
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Channel List - Columns & Functions 

Column  Input Function 

Channel No input The number of this Channel - cannot be 
edited here (see Output List). 

Dimmer Address #.# Enter the address, followed by decimal point 
and then DMX universe. You can change 
the universe by entering ".#" 

Dimmer Address [MODIFY] Opens an Output Editor for adding multiple 
outputs or editing. 

Device No input Shows the device template - cannot be 
edited here (see Device Settings). 

Device Address #.# Enter the address, followed by decimal point 
and then DMX universe. You can change 
the universe by entering ".#"  
(see Device Settings). 

Scale 0-200% Sets the scaling factor for the intensity of 
this channel. 

Park 0-100% Shows the level a channel is parked at. Set a 
level with # MODIFY and remove with C & 
MODIFY. See Park. 

Name 0-6144 Enter the number and press MODIFY to 
change a channel name (see Renaming 
Channels). 
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Channel List - Select & Patch Channels 

It is possible to select and patch channels to outputs directly with a Command Syntax in this list (this 
does not work in At Mode). 

Function  Key Feedback 

Select a channel [#] [CHANNEL] The channel is selected in the list 
and in the Live tab. 

Add a channel to 
this selection 

[#] [+] The channel is added to the current 
selection. 

Add a range of 
channels to this 
selection 

[#] [THRU] The channel range is added to the 
current selection. 

Patch a range of 
outputs to this 
selection 

  

[#] [MODIFY] The output range is patched to the 
current selection. A popup will 
warn if outputs are in use already. 
Once the current channel is patched 
the next channel is auto-selected so 
you can continue entering # 
MODIFY, # MODIFY... to 
continue patching. 
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Patch - Rename Channels  
Hold MODIFY and press CHANNEL to open the Channel List.  

 &  

You can change the number used to access your instruments, without altering your Patch. This is 
useful when you want to keep your addresses and dimmer assignments as they are, but you want to 
change the numbering to fit the numbering of a Plot. Renaming is done in the Name column of the 
Channel List (BROWSER >Patching >Channel List) 
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Change a channel name  

Function  Key Feedback 

Change name [#] [MODIFY] Enter a new name and press 
MODIFY. If the name exists 
you will get a warning message 
about this. 

Change names [#] [MODIFY] Select several cells, enter a start 
name and press MODIFY.  

Remove selected channel(s) 
from all channel views 

[0] [MODIFY] If a Name is set to zero, the 
channel will disappear from all 
channel views and cannot be 
accessed until given a name.* 

Clear all channel names Patch Wizard All Channel Renames can be 
cleared from the Patch Wizard. 

Set names 1:1 Patch Wizard The Rename function can be 
reset from the Patch Wizard. 

*It will not disappear from Channel Layouts. 
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Output List 
Hold MODIFY and press OUTPUT to open the Output List. This is an extremely useful tab for 
troubleshooting and patching dimmers. 

 &  

You can view and edit desk channel, scaling and curve for outputs in the Output List (BROWSER 
>Patching >Output List >Universe #).  

 

See Patch - Introduction  
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NOTE 
The Output List is divided into DMX universes. Open each from the Browser 
>Patching >Output List >Universe # 

Output List - Columns & Functions 

Column  Input Function 

Output (EDMX)* No input The number of this Output (and EDMX) - 
cannot be edited here. 

Channel 0-3072 Enter the number, followed by MODIFY.  

Proportion 0-100% Sets a proportional scaling factor for the 
intensity of this output (channels can be 
scaled in the Channel List). 

Curve dropdown Shows the output curve. See Dimmer 
Curves. 

Device Info No Input Shows the moving device template and 
parameter assigned to this output. Cannot be 
edited - see Device Settings. 

Park 0-100% Shows the level an output is parked at. Set a 
level with # MODIFY and remove with C & 
MODIFY. See Park. 

*Output Lists show EDMX numbers in ( ) after the offset.port numbers in the first column. This is a 
direct translation of EDMX values calculated using the EDMX Start value in the Settings dialog 
(Cobalt output 1.1 = the EDMX Start number, and all subsequent outputs are calculated from there). 

Output List - Select & Patch Outputs 

It is possible to select outputs directly with a Command Syntax in this list (only in RPN mode). 

Function  Key Feedback 

Select output [#] [OUTPUT] The output is selected in the list and 
in the Live tab. 

Add output  [#] [+] The output is added to the current 
selection. 

Add a range  [#] [THRU] The output range is added to the 
current selection. 

Patch to channel [#] [MODIFY] The output selection is patched to 
channel #. 
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Parked  
Hold PARK and press a channel, parameter group (FOCUS, COLOR, BEAM) or parameter key to 
park at a fixed value. 

 &  

Hold UNPARK and press a channel, parameter group (FOCUS, COLOR, BEAM) or parameter key to 
unpark. 

 &  

Parking an output or attribute means it will remain fixed at the parked value regardless of all other 
functionality.  
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1. When an intensity or parameter is parked there is a PARK indication at the top of every 
screen.  

2. Channels that have parked parameters are dimmed.  
3. Parameter cells that are parked are dimmed. 

Park - Parked Items List 

The Parked Items list shows all parked channels, intensities and attributes. 
Individual items can be unparked by selecting the appropriate row and pressing [DELETE].  
See Parked. 
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Templates 
A Template maps the functions of a Device to the Device controls of Cobalt. 
This chapter is about creating and editing Templates. 

This chapter contains the following sections 

• Templates - Introduction  
• Templates - List  
• Templates - Editor  
• Templates - Create  
• Templates - Type LTP or HTP  
• Templates - Type 8/16 Bit Control  
• Templates - Snap Or Fade  
• Templates - Ranges  
• Templates - Mode Tables  
• Templates - Fade With Intensity  
• Templates - Scroller Rolls  
• Templates - Import Template Wizard 
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Templates - Introduction 
A template maps the attributes of a moving Device to the controls and functions of Cobalt. Most 
common devices and scrollers already have templates in the library, ready to use. 

 

General Facts 

• Templates can be edited or created at any time.  
• Templates are stored to and imported from Plays.   
• Change a Template during a show and all similar parameters will continue functioning.  
• Table ranges can be set to control modes in devices such as the x.Spot from High End.  
• Color mix can follow intensity to dim mixing devices such as the Nesys Quadra.  
• Trim the 16bit resolution to finetune control of 16bit parameters.  
• Extensive scroller handling with roll libraries and individual calibration per unit.  
• Assign any device parameter to a Master and store in a Master Page. 
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Templates - List 
The Template List is opened from the BROWSER (Browser >Patching >Settings and Tools 
>Templates).   

 

Template List - Columns & Functions 

Function  Key Feedback 

Template [MODIFY] The ID of each Template. Press MODIFY to 
open the Editor 

Manufacturer [MODIFY] Manufacturer name. Press MODIFY to 
activate and end text input.  

Name [MODIFY] Template name. Press MODIFY to activate 
and end text input.  

Parameters [MODIFY] The number of DMX channels it uses. Press 
MODIFY to open the Editor. 

Comment [MODIFY] Press MODIFY to activate and end text 
input.  

Time Stamp  Date and time 

Import Wizard [WIZARD] Opens the Import Template Wizard. 
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Templates - Editor 
The Template Editor is opened from the Item or Parameter cell in the Template List (Browser 
>Patching >Templates). Open an existing one directly in this node as well (Browser >Patching 
>Templates >xxxx).  
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Template Editor - Columns & Functions 

Press INSERT to insert a new Parameter. These are the functions in the columns.  

Function  Key Feedback 

Parameter [MODIFY] Opens a dropdown. Select parameter. 

DMX [#] [MODIFY] Set DMX offset (1-256).  

Type [MODIFY] Set HTP (intensity) or LTP 8/16bits. 

Default [MODIFY] The default value that is used when 
patched, and by HOME ATTRIB. 

Highlight [MODIFY] The value used in Highlight mode. 

Snap [MODIFY] Set Snap or Fade. 

Invert [MODIFY] Invert the values of a parameter. 

Ranges [MODIFY] Opens the Range Editor for subranges 
such as gobo positions. 

Tables [MODIFY] Opens the Table Editor for table 
functions. 

Low DMX [#] [MODIFY] Set the low resolution DMX offset for 
16 bit parameters 

Fine Step [MODIFY] See 16 Bit Control - Fine Step 

Fade with int [MODIFY] The parameter will follow the intensity 
of this Device.  
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Templates - Create 
1. Open the Template List from the Browser (Browser >Patching >Templates) 

 

2. Press INSERT to select a new Template at the end of the list. 

3. Enter a name in the text column (press MODIFY to activate and MODIFY to store). 

 

4. Press MODIFY in the first column.   
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This will open the Template Editor, which will be empty. 

 

5. Use INSERT to create as many steps as the Moving Device has control channels. 

 

6. Edit the columns for each step to fit the specification of the Moving Device. Start with Parameter. 
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7. Continue with DMX channel within the device. These two are the most important. See the rest of 
this chapter and the manual of the device to specify the rest.  
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Templates - Type LTP or HTP 
Each parameter in a Template can be set to LTP (Latest Takes Precedence) or HTP (Highest Takes 
Precedence). 

• HTP8 is used for 8 bit intensity parameters  
• HTP16 is used for 16 bit intensity parameters*   
• LTP8 is used for 8 bit parameters  
• LTP16 is used for 16 bit parameters* 

 

This is set in the Template Editor.  
See Device Templates - Editor. 

*Observe that the DMX offset of a parameter has to be incremented by 2, if the previous parameter is 
set to 16-bit resolution. 
See Device Templates - 16 bit Control 
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Templates - Type 8/16 bit control 
Some Devices have parameters that require 16 bit control. Usually this is Pan, Tilt (LTP16) or 
intensity (HTP16). This is set in Type cell of the Template Editor.  

• HTP/LTP 8 bit - normal 8 bit control  
• HTP/LTP 16 bit - 16 bit control 

 

16 Bit Control And Wheel Behaviour 

The functionality of "Coarse/Fine 16 bit control" is set in the Attribute Setup. Hold SETUP and press 
ATTRIB.  
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• On = The wheel controls the Coarse part of the16- bit value. Hold the wheel key down and 
move the wheel to control the Fine part of the 16-bit value.  

• Off (default) = The wheel will control Coarse when moved fast, and Fine when moved 
slowly. 
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16 Bit Control - Fine Step 

Devices with 16 bit control rarely use all 16 bits. Therefore it is possible to fine tune the resolution of 
this parameter in the cell Fine Step in the Template Editor. 

 

Full 16 bit control, which few Devices use (generally Media Servers, for example Catalyst) require 
this value to be set to 1 (default = 4). 
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Templates - Snap or Fade 
Snap or Fade is defined in the Template Editor (Browser >Patching >Templates >xxxx).  

 

When set to Snap it will not be affected by times. It will move at the beginning of each repositioning. 

When set to Linear the parameter will fade on times. See Devices - Times. 

Press modify in the Parameter cell to toggle On/Off. 
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Templates - Ranges 
The Template Range Editor makes it possible to define (and edit) ranges, subranges and positions (for 
colors, gobos etc) in Templates.  

This editor is opened by pressing MODIFY in the Range column of the Template Editor.  

This is the range editor for the Strobe parameter in a Mac 300™ 

 

There is a Range Wizard to create ranges. See Template Range Wizard. 
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Template Range Editor - Columns 

Function  Value Feedback 

Min 0-255 This is the start value for a sub range*. The same 
value for Min and Max will be treated like a position 
(for a color or gobo for example). The Min value can 
be entered in the Min% column as well. 

Max 0-255 This is the end value for a sub range*. The Max 
value can be entered in the Max% column as well. 

Min% 0-100 The Min value can be entered as % here instead of 
bits (0-255) in Min. 

Max% 0-100 The Max value can be entered as % here instead of 
bits (0-255) in Max. 

Text  This text is displayed in all editors, and in with the 
Parameter Wheels. 

Centered On/Off When On, selecting a range will set the output to the 
middle of the given range. Parameter values are 
displayed relative to this centre position with +/- 
steps. 

This can useful for speed, rotation or index 
parameters for wheels, with a stop position in the 
middle. 

*Values between positions (start=stop) cannot be set with the wheel, unless they are specified as 
subranges. 

Template Range Wizard  

Press WIZARD in the Template Range Editor. This Wizard simplifies entering a number of evenly 
spread ranges, for example frames, between 0-255. This is useful to create positions for a scroller, or a 
gobo/color wheel. 

1. Open the Template Range Editor. See Device Template - Ranges. 

2. Press WIZARD. 
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3. Enter the number of ranges you wish to create and press MODIFY. 

4. Step to Centered and Snap Positions with arrow keys. Use MODIFY to toggle. 

• Centered = The middle value of a range is always output when selected   
• Snap Positions = Fixed positions (Start = Stop) 

5. Select EXECUTE and press MODIFY (previously existing ranges will be overwritten). 
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Templates - Mode Tables 
ModeTables make it possible to control multiple mode devices such as, for example, the High End 
x.Spot™.  

• A set of ranges are defined for a parameter.  
• The Table defines which range is used for one parameter based upon the Range setting of 

another parameter. 

In the High End x.Spot™ there are Mode parameters (color mode) that affect the function of another 
parameter (color wheel). When a mode is set by selecting a Range on one function, the corresponding 
Table Range will be assigned to the other parameter.  

If there are both Range Tables and Ranges defined for a parameter, the Range Table will be used if 
there is a corresponding range, otherwise the normal Ranges will be used. 

Define A Mode Range Table  

1. Define the ranges for the different "modes" of the Device. See Device Templates - Ranges. 

2. Define Range Tables for these modes in the corresponding function parameter. Start by opening the 
Range Table editor by pressing MODIFY in the Tables column of the Template Editor.   

This is the Template Mode Range Table editor for Gobo in a High End x.Spot™ Color parameter. 
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3. Use INSERT* to create a Range Tables. These are the options. 

Function  Key Feedback 

Parameter [MODIFY] Opens a dropdown. Select the mode 
parameter that activates this Range Table. 

Range [MODIFY] Opens a dropdown. Select the range position 
in the mode parameter that activates this 
Range Table. 

Ranges [MODIFY] Opens the Range Editor for defining these 
ranges. 

*When you make INSERT for additional Range Tables, the parameter will be copied from the first 
defined Range Table. 
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Templates - Fade With Intensity 
Fade with Intensity can be set in the Template Editor. This is useful for controlling a softlight or LED 
fixture with color mix coming from colored fluorescents, that also are light sources. It makes it 
possible to mix a color and fade the intensity of the result without changing the Hue (color mix result). 

This example is from a Color Kinetics™ LED ColorBlast. 

 

When On, the parameter will be scaled through the intensity channel of the device. Also, the types of 
fixtures where color = intensity will be able to be controlled by the Grand Master and Black Out key 
when set up with an Intensity parameter. 
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User Templates 
All user templates, new or modified, that are in the User Library are displayed in the User Templates 
node (Browser >Patching >Settings & Tools >User Templates). This is where you can add templates 
from your current show file to the User Library, and/or delete user templates from the User Library. 
See User Library. 

• Use INSERT to select a template from the show file to store into the User library.  
• Use DELETE to delete a template from the library.  

When inserting templates, the system will automatically include part templates that are used by the 
template you specify. 
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Parameter Definitions 
Parameter types are defined in the first cell or the Template Editor.  

Each parameter is used differently. For example, Pan and Tilt automatically belong to Focus Palettes, 
and are mapped to the trackball in Parameter mode. 

Press MODIFY in the Parameter cell to open the dropdown. Select with arrow keys (or use the first 
letter from the keyboard) and press MODIFY to confirm. 

 

The Parameters are picked from the Parameter Definition Editor. Parameters can be added to this list 
if necessary. See Parameter Definition Editor. 

Parameter Definition Editor 

The complete Parameter Definition Editor contains all to this point known parameters. (Browser 
>Patching >Settings & Tools >Parameter Definitions) 
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Function  Description 

Parameter Parameter ID - cannot be changed. 

Name The name is used for controlling the parameter. 
WARNING - Changing an existing name could 
alter the complete functionality of all Templates 

Palette The Group defines which Palette and parameter 
group a parameter will belong to* 

*Palette and parameter Groups 

Group  Description 

INT All intensities belong to INT.  

FOCUS Focus parameters 

COLOR Color parameters 

BEAM Beam parameters 

AUX 1 Control parameters  

AUX 2 Control parameters  
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Dimmer Curve List 
The Dimmer Curve List contains set of default Curves can be assigned to dimmers in the Output 
Setup. It is also possible to create user specific dimmer curves. (Browser >Patching >Settings & Tools 
>Dimmer Curve List) 

When you open a new show some default curves are loaded (contained in the file CURVES.DEF). 
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Patch - Dimmer Curve Editor 

It is possible to create any kind of curve in the Dimmer Curve Editor. 

Action Key Feedback 

1. Open the Dimmer Curve 
List 

Browser >Patching 
>Dimmer Curve List 

The Dimmer Curve List is 
opened. 

2. Insert a New Curve [INSERT] A new curve is inserted. 
You can name it in the Text 
cell. 

3. Open the Dimmer Curve 
Editor 

[MODIFY] Press MODIFY in the 
Dimmer Curve cell to open 
the editor. 

Dimmer Curve Editor (example: On/Off Curve) 

 

Action Key Feedback 

4. Insert a position [INSERT] A position is inserted. You 
can set percent, Output and 
if this step should use 
interpolation to the next 
step. 
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INTERPOLATION 
When Interpolation is ON the values to this point will be calculated smoothly from the previous point. 
When Interpolation is OFF the value will be jumped to at this level. 

NOTE 
If a curve does not have a 0% and 100% rows, it will default to  
0% = 0 output and 100% = 100 output 
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Main Show Data 
The main show data is what you generate when you start recording. All data 
are under this node of the Browser, except effects, which have a node of their 
own.  

  

Main Show Data Node 

 

This chapter contains the following sections 

• Groups  
• Presets  
• Sequences  
• Playlist  
• Groups/Palettes overview  
• >Settings & Tools - Main Show Data 
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Organizer (1 tab) 
The ORGANIZER key opens the Organizer tab where you can view, edit and restructure all data in 
your show, The Organizer can be opened with focus on a specific type of data or with all show data 
visible at once.  

 

There are three more ways to open it 

• Open from the Browser> Main Show Data> Organizer (1 tab)  
• Press LOAD to open in any tab or spreadsheet cell (except from Browser)  
• From a context menu in any List (SELECT SELECT) 

 

Most things in the Organizer can be edited.  
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There are two main working methods in the Organizer 

• Drag and drop with mouse  
• Context Menus (SELECT SELECT) 

You can press TRACK for items like presets, groups, palettes to track use in the current Play. 

Opening Focused Organizer Tabs 

You can open an organizer tab with only one type of object focused by holding LOAD and pressing 
one of the following keys.  

• PRESET  
• GROUP  
• SEQUENCE  
• FOCUS  
• COLOR  
• BEAM  
• PALETTE 

Example of organizer focused on presets 
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Execute from the Organizer 

In the Organizer there is a function that allows you to execute (play back) Sequence Steps, Groups and 
Presets in the Live field directly. 

Right-click on the appropriate object to open the context menu and select Execute. 

 

Drag and Drop in the Organizer 

You can click, hold and drag items in the Organizer from one place to another. See Sequence - Drag 
and Drop .  
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Here are some examples of items that can be copied or moved by dragging and dropping: 

• Sequences  
• Sequence steps  
• Channel Times  
• Device Links  
• Master Links  
• Action Macros  
• Presets  
• Groups  
• Palettes  
• Templates  
• Patch  
• Devices  
• Effects  
• Master Pages  
• Scroller Rolls  
• Channel Layouts  

If you drag and drop an item on top of a similar item, for example a Sequence Step, you get the 
option of creating a copy of this item or moving it.  
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There is also an advanced tab where you can choose if you want to create an extra step, an extra 
preset, before or after or replacing the step you dropped it on.  
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Organizer (2 tabs) 
This is the same organizer as the 1 tab organizer, with the option of being able to move items between 
two windows, to make work simpler. (Browser >Main Show Data >Organizer (2 tabs). 

 

Functionality, see Organizer (1 tab).  
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Groups 
Groups are a way of recalling a channel selection with a single number. They 
are often used to speed up programming.  

This chapter contains the following sections 

• Groups - Introduction  
• Groups - Record  
• Groups - Select Channels  
• Groups - Fetch Intensities  
• Groups - List  
• Groups - Load To Playbacks  
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Groups - Introduction 
The GROUP key is used to record and recall Groups. Groups are used mainly for selecting lights, but 
may also be assigned to masters where they function like traditional intensity submasters.  

 

You can store channel combinations into groups. The difference between a group and a Preset is that a 
group does not necessarily need levels for the channels involved, only the channels selected are stored 
regardless of how many other channels are active. Groups also do not contain moving light attributes.  

Any currently selected channels and levels are stored in a group, under a single number and name. 

 

For editing groups see Group List Functions. 
Groups are accessible from the remotes. See Remote Control. 

Group functionality 

• Only selected channels are stored in a group.  
• Each group will "remember" the order in which channels were selected to create the group.  
• Groups are not automatically inserted into the Sequence in the Main Playback.  
• Each group can have a text label.  
• A group can be selected in the same way as a single channel  
• A group can be loaded to a Master, a Direct Select section or a Magic Sheet.  
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Record a Group 

Record a Group: 

1. Select channels (setting levels is optional)  
2. Hold RECORD and press GROUP  - you will get a popup suggesting the next free group 

number  
3. Press MODIFY- you have now recorded a group 

Use this Group to select channels: 

1. Enter 0 and press CHANNEL - no channels are selected  
2. Enter the number of the group you just recorded and press GROUP - these channels should 

now be selected 

or 

1. Select GROUP as content type to a section of Direct Selects in the Direct Select tab. 
2. Use the screen slider to select and bring the group up. 

NOTE: If you are operating in the At Mode syntax you select a group by pressing GROUP followed 
by the group number.  

Assign this Group to a master: 

1. Enter the number of the Group  
2. Hold GROUP and press a master key. This group is now assigned to this master. If the group 

has intensities stored they will apply when the master is raised. To select the channels in this 
group, press the master key.  
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Groups - Record 
There are three ways to record a new group. Only selected channels are recorded. The selected 
channels can have a level, but it is not necessary. 

Function   Key Feedback 

Record  [RECORD] & 

[GROUP] 

You will get a popup where 
you confirm recording this 
group, and can write a text 
label. 

Record as... [#] [RECORD] & 

[GROUP] 

You will get a popup where 
you confirm recording this 
group, and can write a text 
label. 

Record with Direct Selects [RECORD] & 

[direct_select] 

You will get a popup where 
you confirm recording this 
group, and can write a text 
label. 

NOTE 
The order in which the channels were selected is stored with the group. 

900-groups 

900 groups is a remnant from the eighties, when consoles often never had more than 900 channels. To 
be able to access user definable channel groups from a remote control for focusing, an exception was 
made for these presets. In Cobalt groups 1-999 are available instead. If an play with 900-groups is 
imported they will be converted to Cobalt Groups. 
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Groups - Select Channels 
You can add and subtract channels that are stored in Groups to/from the current channel selection. 

Function   Key Feedback 

Select  [#] [GROUP] All channels in the 
specified Group are 
selected and can be 
controlled by wheel or with 
level functions. 

Add  [#] [GROUP] & [+] All channels in the 
specified Group are added 
to the current channel 
selection. 

Subtract  [#] [GROUP] & [-] All channels in the 
specified Group are 
subtracted from the current 
channel selection. 

Select range  [#] [GROUP] 

[#] [GROUP] & 

[THRU] 

All channels stored in 
every Group from # to 
# are selected. 

At mode syntax  

If your Cobalt is set to use At Mode for channel commands, groups are selected in the same way as 
channels once the GROUP key has been pressed. Press CHANNEL to return to channel selection. 

Action  Key Feedback 

Select group mode [GROUP] From this point all select 
functions apply to groups. 

Select group [#] Group # is selected 

Add group [+] [#] Group # is added to the 
current selection 

Subtract group [-] [#] Group # is subtracted from 
the current selection 

Add multiple group [#] [THRU] Up to group # is added to 
the current selection 

Groups - Select Channels Context Menu 

You can select the channels of a Group in the Browser by opening the context menu and choosing 
SELECT CHANNEL(S).  
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Groups - Fetch Intensities 
Fetch intensities for all or specific channels from any Group. 

Function   Key Feedback 

Copy level  [#] [FETCH/ON] &  

[GROUP] 

All selected channels are 
set to the levels stored in 
Group #. 

Copy levels and channels  [#] [GROUP] & 

[@LEVEL] 

All channels in the 
specified Group are 
selected and set to the 
levels in Group #. 

Add proportionally [#] [GROUP] & 

Level Wheel 

Group # is faded in 
proportionally on the Level 
Wheel 
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Groups - List 
Press GROUP to open the Groups List. You can view, edit and create new Groups directly in the 
Group List (GROUP or BROWSER >Main Show Data>Group). 

 

 

If the content of a group is changed, the top header will be purple to indicate this. The channel order 
of the group is indicated in the far right column. 
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Group List - Columns & Functions 

These are the functions in the Group list. 

Function   Key Feedback 

Open list [GROUP] The Group List is opened. 

Open list at... [#] [MODIFY] & 

[GROUP] 

The Group list is opened and 
focused at the specified group. 

Update changes [UPDATE] [UPDATE]

or 

[RECORD] [RECORD]

Updates all changes in the 
current group. There is a popup 
after the first key. 

Insert  [INSERT] Inserts a new group with the 
next free number, with the 
channels that are selected. 

Insert as... [#] [INSERT] Inserts a new group with this 
number, with the channels that 
are selected. 

Delete  [DELETE] Deletes the selected group. 
Cannot be undone. 

Set text  [MODIFY] Press MODIFY in the text cell, 
enter the text and press 
MODIFY to exit. 
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Groups - Load To Playbacks 
You can load Groups directly to any Playback. 

Action  Key(s) Feedback 

Load  to master  [#] [GROUP] & 

[Master_Key] 

Group # is loaded to the 
Master Playback 

Add to Live [#] [GROUP] & 

[LIVE] 

Group # is added to Live 

Add to Blind [#] [GROUP] & 

[BLIND] 

Group # is added to Blind 
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Presets 
A Preset is used to store intensities, attributes or attribute times for playback 
in a Sequence, Main- or Master Playback. 

This chapter contains the following sections 

• Presets - Introduction  
• Presets - Record  
• Presets - Update  
• Presets - List  
• Presets - Load To Playbacks  
• Presets - Copy  
• Presets - Select Channels    
• Presets - Fetch Intensities  
• Presets - Display List  
• Presets - Channel Editor Wizard  
• Presets - Auto-Save  
• Presets - Times  
• Presets - Compare Mode  
• Presets - Delete  
• Presets - Rename 



Cobalt 8.1 - 20181029 

333 

 

Presets - Introduction 
The basic building block in Cobalt is called a Preset. A preset can be played back on a master or as a 
step in a Sequence.  

 

General Facts 

• Channels, levels, attributes and Dynamic Effects are stored into Presets.  
• Presets can be played back from the Master Playbacks, and the Main Playback one by one, or 

as part of a Sequence or Chase.  
• You can store Presets with up to three decimals using Preset numbers 0.001-9999.999.  
• Presets can be arranged in a list called a Sequence, with predefined fade times.  
• Presets can be modified blind or live.  
• Presets can be copied.  
• Presets can be added together to create new Presets  
• You can retrieve individual channel levels from recorded Presets with Fetch.  
• When a Preset is recorded in the A playback, it is automatically placed in numerical order in 

a step of the Sequence in that playback.  

NOTE 
A Preset is a memory that can be reused in several Sequences or Playbacks at 
the same time. To delete it completely you have to go to the source of all 
Presets: the Preset List. See Presets - List.  

This does NOT mean that the Preset number will disappear from the 
Sequence or from Master Pages, but it means that it will be an empty Preset 
with no channels or levels stored. It also means that the number of the Preset 
will be regarded as an unused Preset in the system.  

When deleting a Preset in the Preset List you will get a checkbox option of 
deleting all related Sequence Steps. 
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Record a Preset Live 

Record a preset in the A field (live): 

1. Enter a number  
2. Use the level wheel to set an intensity level  
3. Press RECORD - you will get a popup suggesting the next free preset number  
4. Press RECORD again - you have now recorded a preset 

Try out this preset in the Main Playback (live): 

1. Enter 0 and press GOTO  - lights in A fade to zero  
2. Enter the number of the preset you just recorded and press GOTO - it should now fade in 

NOTE 
The Main Playback and the Master Playbacks share intensities using HTP 
(Highest Takes Precedence) logic. Channels with intensities coming from 
Master Playbacks may not appear to fade in the Main Playback if the levels 
from the masters are the same or higher than those in the Main Playback. 



Cobalt 8.1 - 20181029 

335 

 

Presets - Record 
The RECORD key in the programming section allows you to record the output on stage, or part of it, 
to a Preset or a Cue in the Main Playback. or in a master. What you see in the active Channel View is 
what is recorded. Normally only changed moving device parameters are recorded. You can set any 
master or playback as the record target for the RECORD key, see Record Target.  

 

Function   Key Feedback 

Record new [RECORD] Record the content of the 
selected Channel View to a 
new Preset or Cue in the 
Main Playback with the 
next free number. You will 
get a popup. See The 
Recording Popup 

Record new # [#] [RECORD] Records preset #. You will 
get a popup. See The 
Recording Popup 

NOTE 
You can define how moving device parameters are stored in the Record 
Settings. You can set the record target. Hold SETUP and press RECORD.  

A recorded Preset is always added to the Preset List (Browser >Presets). 

If there are moving devices defined and you are using "Changed" recording 
mode, the first preset in an empty sequence will ask you if you want to make 
a block cue.  

The Recording Popup 

The recording popup has Basic, Advanced, and Times tabs. The last used tab is saved as the default 
choice for the next record action. The Times tab will default back to the Advanced tab for the next 
record action. 

In the Basic tab you can confirm recording a Preset (RECORD or MODIFY). You can also add a 
Preset or Sequence text and define the fade type. 
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In the Advanced tab, in addition to the options of the basic tab, you can set a Block flag for 
intensities, attributes, and keep Running Dynamics. It is also possible to toggle the GoOnGo flag and 
toggle Section Markers.  
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In the Times tab you can set fade and moving device times. 



Cobalt 8.1 - 20181029 

338 

 

 

See Preset Times  
See Sequence Times 
See Moving Device Times 
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Record Presets - Live Tab 

When the channel control is set to the Live Tab, you will record the complete stage output. The Preset 
is automatically added to the sequence in the Main Playback. 

Action  Key Feedback 

1. Activate the Live tab [LIVE] The Channel Controls are mapped to 
the A field. 

1a. Record the complete 
stage output to a new 
Preset with the next free 
number 

[RECORD] You will get a popup with the next free 
preset suggested. You can write a text 
label. The Preset is added to the 
sequence in the Main Playback.* 

1b. Record a new Preset 
with a specific number 

[#] 

[RECORD] 

You will get a popup where you also 
can write a text label. The Preset is 
added to the sequence in the Main 
Playback 

*This depends on the BUILD SEQ mode (softkey in the Playback soft key page of the Main Display). 

Record Presets - Field A Only 

There are a lot of options for recording presets. some are set in the Record Settings (hold SETUP and 
press RECORD). This is a summary of the rest. 

Action  Key Feedback 

Record 
new 

[RECORD] & 

[A] 

No output from the Master Playbacks will be 
recorded. The Preset is added to the sequence in the 
Main Playback. See The Recording Popup. 

Record 
new # 

[#] 

[RECORD] & 

[A] 

No output from the Master Playbacks will be 
recorded. See The Recording Popup.The Preset is 
added to the sequence in the Main Playback. 

Record Preset - Do not add to Sequence  

When a Preset is recorded, it is automatically added to the sequence in the Main Playback. It is 
possible to bypass this. 

Action  Key Feedback 

Record 
selected to 
Preset #  

[#] [RECORD] 

& [PRESET] 

The Preset is recorded and added to the 
Preset List, but not to the Sequence in the 
Main Playback. 
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Record All Attributes for selected channels 

Depending on how attribute recording is set up only changed moving device parameters are 
recorded.  You can record all parameters of the selected channels at any time with a shortcut (similar 
to a block cue). See Device Recording - Introduction.  

Setting  Key Feedback 

Record selected [RECORD] & 

[ATTRIBUTES] 

Record all attributes for the 
selected channels to the 
currently loaded Preset in 
the A field.  
 
You will get a popup, see 
below. 

Record selected to... [#] [RECORD] & 

[ATTRIBUTES] 

Record all attributes for the 
selected channels to Preset 
#.  

You will get a popup, see 
below. 

This is the Record Attributes popup 

 

NOTE 
Control parameters are normally not recorded. However, many fixtures have 
control on the Strobe parameter, which is recorded. 
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Record Directly To A Master 

You can record the selected channels, or all channels with an intensity on stage directly to a Master. A 
preset will be created automatically if none is specified. If Attribute recording is set to Automatic, 
attributes will also be recorded. The time is default set to 100%. See Presets - Times. 

Action  Key Feedback 

Record selected [RECORD] 

& Master Key 
You will get a popup with 
the next free preset 
suggested**. 

Record selected as... [#] [RECORD]

& Master Key 
You get the message 
"Preset Recorded" in the 
status bar. 

*If no channels are selected - all channels in A are recorded. 
**To separate the number series of Presets in Masters and in the Main Playback the suggested Preset 
number (if no number is entered) will be starting at Preset 801. After this the last used number when 
recording to this Master will be incremented. 

NOTE 
For a Master with a Sequence or Chase, a new preset is recorded to that 
Sequence or Chase. 

For a Preset - all attributes are recorded, except those Masked by the Global 
Mask. For a Sequence step attributes are recorded in the same way as the 
sequence of the Main Playback. 

Record Selected Channels To Any Preset 

Record the selected channels, with attributes and dynamics, to a specified Preset. All moving device 
attributes for the selected channels will be recorded (not only changed attributes). 

Setting  Key Feedback 

Record selected [CHANNEL] & 

[RECORD] 

You will get a popup where 
you confirm recording this 
Preset, and can write a text 
label. 

Record selected to... [#] [CHANNEL] & 

[RECORD] 

You will get a popup where 
you confirm recording this 
Preset, and can write a text 
label. 
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Setting a Master as the General Record Target  

The default record target for the Record function is the Main Playback. All recording actions are 
assumed to relate to this playback.  

You can set any other master playback (1-80) to be the record target. This is helpful when you work 
with multiple sequences on masters. 

Setting a master as the general record target can be done in two ways: 

In the Record Settings - Hold SETUP and press RECORD. 0 is the Main Playback, 1-80 are the 
masters.  

C & RECORD will reset the general recording target to the Main Playback. 

 

When you record to a Master using RECORD & MASTER KEY (see the checkbox "use this master 
as general recording target") 
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Presets - Update 
The UPDATE key in the programming section updates the preset in the playback connected to the 
channel control. This can be Live, Blind, any Master Playback or a step in the Preset List. 

 

Action  Key Feedback 

Update  [UPDATE] Updates changed levels and 
attributes to the currently 
loaded Preset.  

You will get a simpler 
version of the Recording 
popup. See The Recording 
Popup 

NOTE 
If you are in the Live field the Preset loaded to the A field of the Main 
Playback will be updated. 
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Presets - List 
Press PRESET to open the Preset list, which is a spreadsheet view of all presets in your play. You can 
view, edit and create new Presets (blind) in the Preset List. (Browser >Main Show Data >Presets).  

 
 
See Presets - Introduction.  
See also Preset List - Functions. 
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1. Current Channel View format  
2. Settings  
3. Channel view  
4. Spreadsheet view 

Preset List Channel View 

The top part of the Preset list is a channel view where you can edit all the channel and attribute values 
directly.  

Press ATTRIB to toggle to the attribute view between channels and attributes. In the attribute view 
you can use all the moving device controls to edit parameters. 

 

See Navigating - Channel Views. 

NOTE 
You can only edit attributes with console functions (wheels and keys). If you 
want to edit attributes on the screen, move to the Attributes cell and press 
MODIFY to open the Preset Attribute Editor. 
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Preset List - Columns 

Column  Input Function 

Preset No input The number of this Preset - cannot be 
edited. 

Text ABCDE... Press MODIFY to activate and end text 
input. This text is shown also in the 
Playback views. 

Channels No input Shows how many channels/devices that 
are stored with an intensity in this Preset 

Attributes [MODIFY] Shows how many moving devices are 
stored in this Preset. MODIFY opens 
the attribute editor. 

Dynamics [MODIFY] Shows how many Dynamics are stored 
in this Preset. MODIFY opens the 
Dynamics editor. 

Mask [MODIFY] Open the Mask editor where you can 
mask any parameter. 

FCB-Time [#] [MODIFY] Hold C and press MODIFY to enter a 
time in seconds instead of % of the main 
fade times. 

FCB-Delay [#] [MODIFY] Hold C and press MODIFY to enter a 
time in seconds instead of % of the main 
fade times. 

Note [MODIFY] Opens the Note list for a note 
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Preset List - Functions  

These are the functions in the Preset list. See also Copy, Cut & Paste. 

Setting  Key Feedback 

Open  [PRESET] The Preset List is opened. 

Open  [MODIFY] & 

[PRESET] 

The Preset List is opened. 

Open at Preset # [#] 

[MODIFY] & 

[PRESET] 

The Preset list is opened 
and focused at the specified 
Preset. 

Update focused Preset  [UPDATE] Updates all changes in the 
current Preset. 

Copy Preset  [#] [RECORD] Records a copy of the 
current Preset with this 
number. 

Delete Preset [DELETE] Deletes the selected Preset. 
Cannot be undone. See 
Presets - Delete. 

Insert new Preset # [#] [INSERT] Inserts a new Preset #, with 
the channels and levels 
from Live (A). 

Insert new Preset with the 
next free number 

[INSERT] Inserts a new Preset with 
this number. 

Edit a cell with a numeric 
value 

[#] [MODIFY] Changes the value of the 
selected cell. 
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Presets - Load To Playbacks 
You can load Presets directly to any Playback. 

Action  Key(s) Feedback 

Load to A [#] [PRESET] & 

[A] 

The Preset is loaded to the 
A field, replacing the 
content of that field. 

Load to B [#] [PRESET] & 

[B] 

The Preset is loaded to 
the B field, replacing the 
content of that field. 

Load to master [#] [PRESET] & 

[Master_Key] 

Preset # is loaded to the 
Master Playback 

Load to Live [#] [PRESET] & 

[LIVE] 

Preset # is loaded to Live 

Load to Blind [#] [PRESET] & 

[BLIND] 

Preset # is loaded to Blind 

Quick-load Presets to Masters 

The direct functions allow you to load a series of recorded Presets to Masters, this is called quick-
loading Presets to Masters.  

1. Enter the number of the first Preset. 
2. Hold down the PRESET key, and pull your finger over a range of Master Keys. 

All existing consecutive Presets will be loaded. 
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Presets - Copy  
Copy a Preset by recording it with a different Preset number. This can be done in any Playback, or 
directly in the Preset List. In the Preset List it can be done with the COPY function as well. See Preset 
List and Copy, Cut & Paste. 

Action  Key Feedback 

Copy preset  [#] [RECORD] Copies the preset in the 
channel view connected to 
the channel controls to a 
new number. 
 
You will get a popup. See 
The Recording Popup 
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Presets - Select Channels 
You can add and subtract channels that are stored in Presets to/from the current channel selection. 

Function   Key Feedback 

Select all  [#] [PRESET] All channels with a level in 
the specified Preset are 
selected. 

Add to current  [#] [PRESET] & 

[+] 

All channels with a level in 
the specified Preset are 
added to the current 
channel selection. 

Subtract all  [#] [PRESET] & [-

] 

All channels with a level in 
the specified Preset are 
subtracted from the current 
channel selection. 

Select all over 0% [#] [PRESET] & 

[ALL] 

All channels with a level in 
the channel control, that 
also have a level in 
the specified Preset, are 
selected. 

Select all in a range  [#] [PRESET] 

[#] [PRESET] & 

[THRU] 

All channels stored in 
every Preset from # to # are 
selected. 

Presets - Select Channels Context Menu 

You can select the channels of a Preset in the Browser by opening the context menu and choosing 
SELECT CHANNEL(S). 
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Presets - Fetch Intensities 
Press ON/FETCH to set all selected channels to their last stored levels.  

 

You can fetch intensities for all or specific channels and/or parameters from any Preset.  

Function   Key Feedback 

Set last stored level  [ON/FETCH] All selected channels are 
set to their last stored 
levels. 

Copy level  [#] [ON/FETCH] All selected channels are 
set to the levels stored in 
Preset #.* 

Copy levels and channels  [#] [PRESET] & 

[@LEVEL] 

All channels in the 
specified Preset are 
selected and set to the 
levels in Preset #. 

Add proportionally  [#] [PRESET] & 

Level Wheel 

Preset # is faded in 
proportionally on the Level 
Wheel 

HINT 
You can fetch attribute values as well. See Device Control - Fetch/Copy. 

*You can press # ON/FETCH & PRESET as well. 
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Presets - Channel Editor Wizard 
The Channel Editor Wizard allows you to track intensity changes in all Presets with powerful 
arguments. Press WIZARD in any channel view to open the Channel Wizard. 

 

NOTE 
You cannot reverse or undo changes made with this Wizard. We therefore 
recommend you strongly to save your play before using this function. 
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Channel Editor Wizard - Type Of Change 

You can perform the following actions through any range of Presets.  

The parameter "Include All Channels" will affect channels with no level (0%) as well, and is 
necessary in some cases. 

 

Function   Explanation 

Set Level Set level # 

Add Absolute Adds # points to the current channel(s) intensity 
level - adding with a value of 5, 50% becomes 55%, 
80% becomes 85%. 

Subtract Absolute Subtract # points from the current channel(s) 
intensity level. 

Add percent Adds a % of the current channel(s) intensity level - 
adding with a value of 10, 50% becomes 55%, 80% 
becomes 88%. 

Subtract percent Subtracts a % from the current channel(s) intensity 
level. 

Swap channels Change levels between the selected channel and the 
channel # in Argument. 

Copy from channel Copy all levels from channel value # to the selected 
channel(s). 

Set min level Sets a minimum level HTP with the current levels. 

Set max level Sets a maximum level to the current levels. 
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Channel Editor Wizard - Value 

Depending on the type of change - the number here is the Value used. It can be a level or a channel 
number.  

Channel Editor Wizard - Include If 0% 

This parameter will allow the change to affect the channels with no level (0%) in the target Presets.  
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Presets - Auto-Save 
Each time you record a preset or a group all changes to the play since the last RECORD or Save are 
stored in a play called AUTOSAVE.ASC.  

This play is stored in the Play Archive (Browser >File >Open >Play Archive) and can be opened like 
any play. 

Function  Console Feedback 

Open Auto Save setting [SETUP] & 

[RECORD] 

Opens a popup where you 
can set Auto-Save to ON. 

 

NOTE 
This is a feature that we recommend you to use with caution. Saving a large 
show can slow down the system temporarily. 
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Presets - Times 
The timing information stored in a Preset, is the FCB times for device parameters. Other timing when 
used in a Sequence, such as channel times, in/delay/out times are stored in the Sequence Step. (See 
Device Times - Individual or FCB) 

• The default setting for FCB times is 100% of the main In time  
• The default setting for FCB delay times is 0 seconds. If you set FCB delay times in %, then 

that setting refers to main In time. 

These times are executed when played back from a Sequence or from a Master Playback.  

Hold SETUP & press ATTRIB to open the Time settings for Parameters.  

 

You can set them in % or as absolute times in seconds. You can select what to default to in these 
Settings. Hold C/Alt and press MODIFY to set the opposite of what is currently selected. 
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Presets - Compare Mode 
The COMPARE soft key allows you to temporarily toggle the current light in the active field with the 
recorded version of a preset in the active field. When Compare mode is active it is indicated in the top 
of all screens. 

(Soft Key Pages are commands in the lower right corner of screen 2) 

   

 

Action Key Feedback 

Compare to stored [COMPARE] The last stored version will 
be loaded. Press 
COMPARE to exit 
Compare mode. 

Compare to preset [#] [COMPARE] The selected preset will be 
loaded. Press COMPARE 
to exit Compare mode. 
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Presets - Delete 
Presets are deleted from the Preset List (Browser >Main Show Data >Presets). 

Action  Key Feedback 

Delete selected Preset. [DELETE] You will get a popup where 
you can choose to delete 
the corresponding 
Sequence Steps this Preset 
is used in as well. 
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Presets - Renumber 
You can renumber presets in the organizer from the context menu in the Preset nodes. 

1. Press SELECT SELECT or right click to open the context menu, then click Renumber. 

 

2. Press MODIFY and click to open the Change Number dialog. 

 

  



Cobalt 8.1 - 20181029 

361 

 

3. Enter a new preset number and press MODIFY to confirm. 

NOTE 
Changing the number of a Preset will not change any of the references, such 
as Master Links, Masters, Sequence Steps, Content Effects, that pointed to 
the previous number. 
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Presets - Import & Undo 
If you need to import a preset from a previously saved version of your play, because you want to undo 
the current changes - it is done in the organizer.  

1. Open the Import Organizer for the last saved version (name.001) in the Browser (Browser >Files 
>Import From >Play Archive) 

2. Drag the previously saved version of the preset and drop on the same preset in the current play 

 

3. In the Advanced dialogue, check the box "overwrite" (or save with a different number) 
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Presets - Multiple Import & Undo 

You can import a range of presets from a previously saved version of your play. 

1. Open the Import Organizer for the last saved version in the Browser (Browser >Files >Import From 
>Play Archive) 

2. Use SELECT or SHIFT & arrow/mouse to select a range of presets in the previously saved play.  

3. Drag and drop on preset node in the current play 
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4. In the Advanced dialogue, select the renumbering option "Keep original spacing and gaps" or 
"Convert to consecutive numbers" and enter a "start at" number for the first preset. 

Keep original spacing and gaps will keep preset numbering as it was in the old play, using the start 
at value to create an offset. For example, if you drag in presets numbered 1, 1.5 and 3 into the current 
play with a start at value of 5, the new presets will be numbered 5, 5,5 and 8. 
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Convert to Consecutive Numbers will clean up decimals and gaps in the preset list - so dragging in 
the same three presets 1, 1.5 and 3 into the current play using this setting and a start at value of 5 will 
create presets 5, 6 and 7. 
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Sequences 
A sequence is a list of presets that can be played back manually, with fade 
times, and as a chase. 

This chapter contains the following sections 

• Sequences - Introduction  
• Sequences - In The Main Playback  
• Sequences - List  
• Sequences - Sequence List  
• Sequences - Crossfade Movefade, Lockfade  
• Sequences - Times  
• Sequences - Insert Step  
• Sequences - Delete Step  
• Sequences - Links  
• Sequences - Load  
• Sequences - Build & Modify Modes  
• Sequences - Block Values  
• Sequences - Track List  
• Sequences - Chase mode  
• Sequences - drag and drop data 
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Sequences - Introduction 
Press PLAYBACK in the Main Playback section to open the Playback tab. Theatrical style playback 
of a number of pre-recorded looks and times is called a "sequence" in Cobalt. (See Playback View) 

 

 

A sequence is a list of sequence steps. There are two ways to create a sequence 

• Preset steps (referenced data from a central and shared Preset List)  
• Cue steps (unique data in each step) 

Preset or Cue mode is selected as a default for your play in the Let's Begin dialog when you start a 
new play, and in the Play Settings dialog under Basic.You can chose either mode at any time when 
you create a new sequence.  

A sequence step always contains a Preset or a Cue. Each time a Preset or a Cue is recorded in the Live 
tab a new Sequence step is created with that Preset in the Main Playback.  
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A Sequence Step consists of two main components 

Item  Contains Read More 

Sequence Step Data Fade Times, Auto Times, Text, 
Master Link, Master Page Link, 
Macro Link, Automark flag for 
Attributes. 

See  Sequences - 
Sequence List  

Preset or Cue Intensities, Dynamics, 
Attributes and Attribute Times. 

See Preset List or Cue 
List. 

General Facts 

• You can rearrange the order in a Sequence of Presets at any time.  
• The same Preset can exist in several sequence steps, and sequences.  
• A Cue is a unique step and can only exist once in the same sequence.   
• You can set times to every channel and parameter in a sequence step.  
• Sequences can be played back from the Main playback, or any Master Playback.  
• You can create up to 999 sequences.  
• You can link any Master Playback to a sequence step.  
• You can trigger a Sequence with MIDI and Time Code.  
• You can play back any Sequence in Chase (looped) mode with BPM and rate.  
• A new play begins with Sequence 1 already loaded into the Main Playback, ready for 

creation by simply recording presets.  
• Basically everything in Cobalt can be triggered from a sequence. 

Record a Sequence Live 

Record a sequence in the Main Playback: 

1. Enter a number  
2. Use the level wheel to set an intensity level  
3. Press RECORD - you will get a popup suggesting the next free preset number  
4. Press RECORD again - you have now recorded a preset or a cue, and it has been added as the 

first (or next) sequence step in the main playback  
5. Repeat this procedure three times - you will have a sequence with three steps 

Play back this sequence on the Main Playback: 

1. Enter 0 and press GOTO  - lights in A fade to zero  
2. Press GO to fade through the sequence - the fade time is default set to 5 seconds 

NOTE 
The Main Playback and the Master Playbacks share intensities using HTP 
(Highest Takes Precedence) logic. Channels with intensities coming from 
Master Playbacks may not appear to fade in the Main Playback if the levels 
from the masters are the same or higher than those in the Main Playback. 
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Sequences - In The Main Playback 
When you open a new play there is a default sequence (1) in the Main Playback.  
When you record a Preset or Cue in the Live field it will be added to the sequence in the Main 
playback. 

These are the sequence functions for the Main Playback 

Function  Key Feedback 

Record a new step [#] [RECORD] Each time a Preset 
or Cue is recorded in Live 
it is added as a new step to 
the sequence loaded to the 
Main Playback* 

Edit step [MODIFY] & 

[PLAYBACK]  

Opens the Sequence List 
for the sequence in the 
Main Playback. See 
Sequences - Sequence List. 

Navigate  See Main Playback. 

*Unless the mode  Build Sequence is off. See Settings - Crossfade. 
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Sequences - List  
Press SEQ in the programming section to open the Sequences List. You can insert and delete 
sequences, and change playback modes (normal/chase). (BROWSER >Main Show Data 
>Sequences...). 

 

 

Sequences List - Insert/Delete/Load 

Function  Key Feedback 

Insert  [#] [INSERT] Sequence # is inserted into 
the list 

Delete  [DELETE] The selected sequence is 
deleted* 

Load  [Master_Key] The selected sequence is 
loaded to this Master 
Playback. 

*The Sequence is deleted, and all timing and text information. The Preset still exists in the Preset list 
and can be used again. 
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Sequences List - Columns  

Column  Input Function 

Sequence [MODIFY] The number of this Step- cannot be edited. Press 
MODIFY to open the Sequence List. 

Text [MODIFY] Press MODIFY to activate and end text input. 
This text is shown in the top of the Playback 
views. 

Mode [MODIFY] Toggles between Normal, Chase and Loop (7.3) 
mode. 

Rate [#] 

[MODIFY] 

Speeds up the playback by #% (Chase mode). 

Bounce [MODIFY] Sets playback to alternate continuously between 
forward and reverse (Chase mode). 

Reverse [MODIFY] Sets Playback in the reverse direction only 
(Chase mode). 

Single Shot [MODIFY] Sets Playback to one time (Chase mode). 

BPM [#] 

[MODIFY] 

Suppresses fade times and sets step time (wait) 
to BPM # (Chase mode). 

Master View: 
Show Step 
Numbers 

[MODIFY] Toggles how step numbers are shown for this 
sequence in Master Views. 

Cue [MODIFY] Shows if this sequence is set to Presets or Cues 
(cannot be changed) 
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Sequences - Sequence List 
Press # SEQ to open a Sequence List for any sequence. You can view, edit and delete sequence steps 
in a Sequence list (BROWSER >Sequence >#). 

The currently active sequence step in the main playback is indicated with a brown background. 

 

NOTE 
You can open the Sequence List for the Main Playback by holding MODIFY 
and pressing PLAYBACK. This is not possible, however, in Tabs that use 
MODIFY for other functions. 

It is possible to enter the number of a step/preset first to open the list with 
that step focused 
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Sequence List Channel View 

The top half of the Sequence List is a channel view. Press ATTRIB to toggle to the attribute view 
between channels and attributes. In the attribute view you can use all the moving device controls to 
edit parameters. 

 

 

NOTE 
You can only edit attributes with console functions (wheels and keys). If you 
want to edit attributes on the screen, move to the Preset cell and press 
MODIFY twice to open the Preset Attribute Editor. 
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Sequence List Functions 

Function   Key Feedback 

Open List [#] [SEQ] The Sequence List is opened for seq #. 

Open List [#] 

[MODIFY] 

[SEQ] 

The Sequence List is opened for seq #. 

Go to Step [GOTO] Fades in the Main Playback to the selected 
step. 

Update Step [UPDATE] Updates level changes in the current step. 

Insert a new Step  [#] 

[INSERT] 

Inserts a new step, with Preset #. 

Edit Text  [MODIFY] Opens the text cell for editing. The Cobalt 
keyboard is activated in Master Playback 
display four. 

Delete selected Step(s) [DELETE] Deletes the selected Step. Cannot be 
undone. 

Edit any value [#] 

[MODIFY] 

Enter a new value and press MODIFY. 

Move Step Drag and 
drop 

You can drag and drop a Sequence Step 
with the trackball to move it. 

In time  [#] [IN] Sets an In time of # seconds directly to the 
focused step. 

Out time [#] [OUT] Sets an Out time of # seconds directly to 
the focused step. 

NOTE 
You can use COPY, CUT and PASTE to insert and delete steps in the 
Sequence List as well. See Copy, Cut & Paste. 
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Sequence List - Columns 

Part 1 

Column  Input Function 

Step No input The number of this Step. Cannot be edited.  

Preset [#] 

[MODIFY] 

This is the number of the Preset in this step. It 
can be edited with the Preset Change Wizard. 

DelayOut [#] 

[MODIFY] 

Edit the delay out time. 

Out [#] 

[MODIFY] 

Edit the Out time. 

DelayIn [#] 

[MODIFY] 

Edit the Delay In time. 

In [MODIFY] Edit the In time. 

WFA * [MODIFY] Toggle time type between Wait, Followon and 
Alert. 

WFA Time [#] 

[MODIFY] 

Edit the (WFA) time.  

Mode [MODIFY] Change fade mode. Select between crossfade (x) 
movefade (m) lockfade (l) and split fade (s). 

Text [MODIFY] Press MODIFY to activate and end text input. 
This text is shown in the Playback views. 

* You can toggle the time between two steps between Wait, Alert and Followon. See Sequence Times 
- Alert Times and Sequence Times - WAF Wait & Followon Times  
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Part 2 

Column  Input Function 

Attrib Move [MODIFY] Toggle between, AutoMark, GoOnGo and 
GoInB. Controls if moving devices will move on 
GO or when the step is loaded in B (next). 

ChTime [MODIFY] Shows the number of channel times in this step. 
Opens the channel time editor. 

MastLink [MODIFY] Shows the number of master links in this step. 
Opens the master link editor. 

MastPage [#] 

[MODIFY] 

Shows or edits which Master Page is linked.  

Fade Curve [#] 

[MODIFY] 

Shows or edits which Fade Curve is linked.  

LinkToStep [#] 

[MODIFY] 

Shows or edits which step this step is linked to.  

TimeCode [#] 

[MODIFY] 

View/Edit Time Code for this step 

Note [MODIFY] Opens the editor for an existing Note 

Block 
Tracking 

[MODIFY] Blocks tracking through this step 

Macro [#] 

[MODIFY] 

Sets this step to trigger Macro #. 

Action Macro [MODIFY] Opens this cell for text input of an Action Macro 
- See Actions & Events - Actions. 

Profile [DELETE] Shows if there is a profile on this step. Press 
DELETE to clear (no Undo). 

Section 
Marker 

[MODIFY] Toggles Section Marker on/off. 
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Sequence and Preset texts 

In the sequence list you can see and edit both the unique sequence step text and the text belonging to 
the preset occupying a sequence step. 

• Go to the Text column and press MODIFY to edit the sequence step text.  
• Go to the P-Text column and press MODIFY to edit the Preset text. 
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Sequences - Crossfade Movefade & Lockfade 
When you press RECORD to record a new Preset in a Sequence you will get the option to store it as a 
Crossfade, a Movefade or a Lockfade. Each of these modes affects how channels in that Preset will be 
played back when a the next crossfade is started.  

A Split Fade is a different fade type that is set in the Sequence List. See Sequence List - Columns. 

 

Function   Shortcut Feedback 

Record a crossfade [RECORD] Normally a crossfade (x) is recorded. 
This means that all channel values are 
replaced when a new crossfade is 
started. 

Record a Move 
Fade 

[+] & [RECORD] When a movefade (m) is followed by 
another movefade, only channels with 
new levels will be affected. 

Record a LockFade [-] & [RECORD] When a lockfade (l) is started, the 
channels involved will not be affected 
by anything until they have finished the 
fade they started. 

Stepping in the sequence will stop 
ongoing lock fades. 

HINTS 

• When you jump in the sequence with GOTO, the history of all fades will be executed to 
recreate the correct state after the jump.  

• GOTO & B updates the current state (scanning backwards in the sequence accumulating 
Move/Lock fades).  
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• For a Lock fade, it is not possible to press PAUSE or GO BACK, since the nature is to "lock" 
the fade regardless of other playback controls.  

• Stepping through the sequence with SEQ+/SEQ- or using GOTO will stop current Lock 
fades.  

• If you start a move or lock fade on top of a crossfade, the crossfade now continues to run in 
the background and is also available for speed control on the display.  

• Move and Lock fades are indicated with M and L in the Channel Views. 
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Sequences - Times 
You can set times to a sequence step, and all channels and moving device parameters will follow that 
time. 

You can also set individual times in seconds, or as a percentage of the in- and delay times for each 
channel and moving device parameter in a sequence step. 

Times are set from, like this: 0.01 – 9.99. seconds to 49.59 minutes (0.1- 4959). It is possible to use 
hundreds of seconds as input during the first 10 seconds (v6.0) 

When no time is set to a sequence step, the default time (5seconds) will be used. Change this setting 
by holding SETUP and pressing A. 

The easiest way to set times to ANY step of the sequence in the main playback is to use the TIME 
EDITOR. Enter the number of the step, hold MODIFY and press TIME. See The Time Editor Popup. 

NOTE 
Fade times of a Sequence Step are related to that step, not to the Preset 
occupying the Step. This makes it possible to use the same Preset with 
different fade times in other Steps or in the Masters.  

To edit the times for a step open the Sequence List. 

Sequence Times - Set To A or B 

Times are set to A or B depending on what situation you are working in. The current setting is 
indicated with an arrow next to the times: 

 

It is possible to toggle if times are set to A or B by holding TIME and pressing A or B. 
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Sequence Times - Main Times (in/out/delay/wait) 

Times are set to the step in A (Active) or B (Next) depending on the setting for times (SETUP & 
TIME).  

Function  Key Feedback 

In time [#] [IN] A time is set for the 
incoming channels. 

Out time [#] [OUT] A time is set for the 
outgoing channels. 

In- and Out time [#] [TIME] A time is set for the in- and 
outgoing channels. 

Delay In time [#] [DELAY] & [IN] A delay time is set for the 
incoming channels. 

Delay Out time [#] [DELAY] & 

[OUT] 

A delay time is set for the 
outgoing channels. 

Wait, Followon or 
Alert time * 

Sequences - Sequence 
List  

Enter the time in the WFA 
Time column of the 
Sequence List. You can 
toggle between Wait, Alert 
or Followon in the previous 
column 

* A Wait or Followon time will automatically execute a crossfade to the Step it is assigned to. The 
difference is that a Wait time starts counting down after the END of the previous crossfade, while the 
Followon time starts counting down from the START of the previous crossfade. Wait times is the 
default setting. The Alert time will count down as a warning to the operator, but not execute the next 
fade. See Sequence Times - Alert Times. 

See Times Soft Key Page. 

You can view/edit the main times in the Sequence List. 
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Sequence Times - Channel Times 

Times are set to the step in A (Active) or B (Next) depending on the setting for times (SETUP & 
TIME).   
Function  Soft Key Feedback 

1. Select the TIME soft 
menu page 

TIMES (soft key) The time soft key page is 
selected in the main 
display. 

2. Set a channel time for 
the selected channels 

[#] [CH_TIME] A time is set for the 
selected channels. You can 
set a text label to the 
channel time group. 

3. Set a channel delay time 
for the selected channels 

[#] [CH_DELAY] A time is set for the 
selected channels. 

You can set channel times with two shortcuts as well. 

Function  Key Shortcut Feedback 

Channel time  [#] [CHANNEL] & 

[TIME] 

or  

[#] [TIME] & 

[CHANNEL] 

A time is set for the 
selected channels. You can 
set a text label to the 
channel time group. 

Channel delay  [#] [CHANNEL] & 

[DELAY] 

or 

[#] [DELAY] & 

[CHANNEL] 

A time is set for the 
selected channels. 

This is what it looks like in a playback view, If no name is assigned, the channel numbers will be 
shown. 
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This is how the time is indicated in the live channel view, under the level.  

 

NOTE 
When Channel Times are activated, the first four Channel Times are shown 
on the Main Display over the 4 wheels. The status for each Channel Time is 
displayed over each wheel. Rate for each channel can be adjusted with the 
corresponding wheel and the Channel Time can be started/stopped with the 
corresponding wheel key. 

Sequence - Channel Time Editor 

press MODIFY in the ChTime column of the Sequence List to open the channel time editor. See 
Sequence List. 

Here you can add a text to each channel time group. This text is shown in the graphical time line view 
of the Playback list.  
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Editing Channels in a Channel Time Group 

1. Select the Group in the Channel Time Editor  

2. Add or remove Channels. 

3. Press UPDATE to store. 

  

The Time Editor Popup 

The Time Editor (also part of the Record popups Advanced tab) allows you to edit the times of any 
sequence step from a popup. 

Press MODIFY and TIME to open the Time Editor popup for the step in A or B (see NOTE below).  
Enter the number of a step first to open it for any step. 
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NOTE 
The Time Editor follows the setting of the "Times in A/B" parameter in the 
Cobalt Setup (SETUP or F11).  

The WAF box allows you to toggle between Wait, Alert and Followon time 
for this step. 

The first six existing Channel Times can be edited directly in the Channel Times tab. 
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The Times Soft Key Page 

The Time Soft Key Page is selected with the soft key TIMES in the Main Display of the console.  

   

These are the functions available. All times are set to the Main Playback. 

Function  Softkey Feedback 

Channel time [#] [CH_TIME] Sets a channel time (#) to the 
selected channels. 

Channel delay  [#] [CH_DELAY] Sets a channel delay time (#) to the 
selected channels. 

Wait  [#] [WAIT] Sets a Wait time (#) to the Preset in 
A (or B). 

FCB time [#] [FCB_Time] Sets FCB times (#) to the Preset in 
A (or B). 

FCB delay [#] [FCB_Delay] Sets FCB delay (#) to the Preset in 
A (or B). 

Learn Alert * [Learn_Alert] Activates Learn Alert Time mode. 

Learn Profile [Learn_Profile] Activates Learn Profile mode for 
the next crossfade.  
See Sequences - Crossfade Profiles. 

* See Sequence Times - WFA Alert Times. 
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Sequence Times - FCB Times 

FCB Times are set to the Preset of a Sequence Step. See Moving Device Times - FCB Time  

Sequence Times - Parameter Times 

Individual Moving Device Parameter times are set to the preset of a Sequence Step. See Moving 
Device Times - Parameter Time.  

Sequence Times - WAF Alert Times 

An Alert time will count down from the completion of the previous crossfade, and alert the operator as 
to when the next fade should be manually executed.  

There is a Learn Mode that will record Alert times automatically as a show is played back in real time 
by an operator. This mode is activated with the soft key LEARN ALERT in the Times Soft Key page. 
See The Times Soft Key Page. 

Time Limit 
There is both a visual and an audio warning set to alert 5 seconds before the next fade. You can 
change this time limit in the Time Settings. See Settings - Crossfade. 

Visual 
The top part of the playback view will be green as long as the alert time is over 5 seconds. At 5 
seconds it turns yellow and after completion it turns red.  

 

 

 

The Alert time is edited in the Sequence List WFA and WFA Time columns. It can be toggled to be a 
Wait or Followon Time as well. See Sequence List - Columns. See also  Sequence Times - WFA Wait 
& Followon Times.  

Sequence Times - WAF Wait & Followon Times 

It's possible to set a Wait or Followon time between each step of a Sequence.  
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Wait 
A Wait time will execute the step it is on, # seconds after the completion of the previous fade. 

Followon 
A Followon time will execute the next step, # seconds after the start of the fade. The Followon time is 
displayed in the same way as the Alert Times. See Sequence Times - WAF Alert Times. 

The Wait and Followon times are edited in the Sequence List WAF and WAF Time columns. They 
can be toggled to be an Alert Time as well. See Sequence List - Columns.  



Cobalt 8.1 - 20181029 

390 

 

Sequences - Crossfade Profiles 
You can record the movements of the A and B faders. When you start the crossfade the next time, the 
profile will be played back.  

1. Start recording a profile by pressing the LEARN PROFILE soft key in the Times soft key page. See 
Times Soft Key Page. 

2. The recording will stop when both faders reach their end position at the same time.  

A preview of the profile is shown in the timeline view.  

 

The total time of A and B are separately stored as the Out and In times. If you change these times, the 
recorded profiles will be scaled on playback to play back in the new time.  

A new column (Profile) is added in Sequence Editor. It shows a check mark when a profile has been 
recorded. You can press DELETE in this column to delete the profile. 
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Sequences - Insert Step 
There are two ways of inserting a sequence step between two existing ones.  

• Record a preset with a (decimal) number that fits between  
• Insert any preset in the Sequence List (See Sequence List) 

Insert A Sequence Step - In any playback 

When you are working directly in a Playback and record a new preset, it is inserted numerically into 
the sequence of that Playback.  

Function   Shortcut Feedback 

Insert Step  [1] [.] [5] 

[RECORD] 

Inserts between 1 and 2. A 
popup will ask you to 
confirm recording. 

Confirm  [RECORD] The preset is recorded 
between 1 and 2. 

Insert A Sequence Step Directly In The Main Playback 

You can insert a preset into the sequence of the main playback directly. This is not available with Cue 
Sequences. 

Function   Shortcut Feedback 

Insert before A [#] [INSERT] & [A] Preset # is inserted before the 
current step in A 

Insert before B [#] [INSERT] & [B] Preset # is inserted before the 
current step in B 

Insert A Sequence Step - In The List 

Function   Shortcut Feedback 

1. Open the Sequence list [#] [SEQ] The List for sequence # is 
opened. 

2. Move to the step you 
wish to insert a new step 
after 

Arrow Keys The selected step is 
highlighted in yellow. 

3. Insert Preset # [#] [INSERT] The preset is inserted after 
the selected step 
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NOTE 
You can use COPY, CUT and PASTE to insert and delete steps in the 
Sequence List as well. See Copy, Cut & Paste. 

NOTE 
The Preset does not bring sequence texts, fade times or links from other 
sequence steps if it has been used earlier. 
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Sequences - Delete Step 

Function   Shortcut Feedback 

1. Open the Sequence list [#] [SEQ] The List for sequence # is 
opened. 

2. Select the step you wish 
to delete 

Arrow Keys The selected step is 
highlighted in yellow. 

3. Delete the selected step [DELETE] You will get a popup where 
you can choose to delete 
this step and the related 
Preset. 

 

NOTE 
When you delete a Sequence Step all assigned times, links and texts are lost. 
The Preset of that step can still exist in the Preset List, and can be used again. 

Delete a sequence step directly in the main playback 

You can delete a sequence step in the main playback directly. The Preset is left intact in the Preset 
List. 

Function   Shortcut Feedback 

Delete step in A [DELETE] & [A] The sequence step in A is 
deleted.  

Delete step in B [DELETE] & [B] The sequence step in B is 
deleted 
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Sequences - Links 
A sequence step can have a  link to Master fades, a Master Page, a different sequence step (see NOTE 
in this explanation), and a Macro. 

All links are done in the Sequence List which can be opened with # SEQ or Browser >Main Show 
Data >Sequences >#. 

Sequence Step Links - Master Playbacks 

Master Links are loaded when the Sequence step is loaded to the B field. They are faded when GO is 
pressed or the crossfade faders are moved.  

 

Function  Key Feedback 

1. Select MastLink column* Arrow keys The column is highlighted 

2. Open Master Link List [MODIFY] The Master Link List is 
open. 

3. Insert a link to Master # [#] [INSERT] Master # is linked, with its 
current content, and a target 
level of 100%. 
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*In the Sequences - List. 

NOTE 
All functions in the Master Link list are the same as in the View Masters list. 
The only differing one is Target, which is the level the Master will fade to. To 
load a Master for manual operation, set the target level to 0%. 

Sequence Step Links - Shortcut 

There is a shortcut for inserting a Master Link directly to the current Sequence Step in the Main 
Playback. 

Function  Key Feedback 

Insert link [INSERT] & 

[Master_Key] 

Master # is inserted as a 
link to the Step in A. 

Insert link with target [#] [INSERT] & 

[Master_Key] 

Master # is linked, with its 
current content, and a target 
level of 100 or 0% 
depending on earlier links. 

Sequence Step Links - Master Pages 

You can insert a link to a master page. 

Function  Key Feedback 

1. Select the MastPage 
column* 

Arrow keys The column is highlighted 

2. Insert a link  [#] [MODIFY] Master Page # is linked. It 
will be loaded to Masters 1-
20 when this step is loaded 
to the B (Next) playback. 

*In the Sequence List. 

Sequence Step Links - Another Step 

NOTE 
Links to another sequence step are used mainly to create playback loops. 
Links are NOT used to change a playback order in Cobalt - this is done by 
cutting and pasting a step in a different location. See Copy, Cut & Paste. 
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Function  Column Feedback 

1. Select the LinkTo 
column* 

Arrow keys The column is highlighted 

2. Insert a link to Sequence 
Step # 

[#] [MODIFY] Sequence Step # is linked. 
When this step is faded in, 
the next step will be Step #. 

*In the Sequence List. 
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Sequences - Load 
A Sequence can be loaded to the Main Playback, or any Master Playback. For information on how to 
control a Sequence once it is loaded, see Main Playback and Masters. 

Function  Keys Feedback 

Load  [#] [SEQ] & 

[PLAYBACK] 

Sequence # is loaded to the 
Main Playback. The light in 
A (Active) and B (Next) is 
not affected. 

Load to master  [#] [SEQ] & 

[Master_Key] 

Sequence # is loaded to 
the Master Playback.  

NOTE 
Loading a non-existent Sequence to Playback will open a window asking if 
you wish to create that Sequence. 

You can load a sequence directly from the Browser as well (LOAD is only available in Congo Jr and 
Kid).  

Function  Keys Feedback 

Load  [LOAD] & 

[PLAYBACK] 

Sequence # is loaded to the 
Main Playback. The light in 
A (Active) and B (Next) is 
not affected. 

Load to master  [LOAD] & 

[Master_Key] 

Sequence # is loaded to 
the Master Playback.  
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Sequences - Build & Modify Modes 
There are two modes that affect recording and playback of Sequences. Build Sequence and Modify 
Sequence.  

The fastest way to toggle them on/off is with the context menu (right-click) on the header of the 
Playback Tab. 
Both can be set in System Settings as well. See System Settings - Crossfade.  

 

Sequence - Build Sequence Mode  

This mode is set in the Crossfade Settings. See System Settings - Crossfade. 

The default setting for this mode is ON. When ON every Preset recorded in the Live or A tab will 
automatically be added to the Sequence in the Main Playback (in numerical order). The only reason to 
set this mode to OFF is when a Preset recorded in Live or A should NOT be added to the sequence in 
the Main Playback. 

NOTE 
You can record a Preset without adding it to the Sequence in the Main 
Playback with a shortcut; # RECORD & PRESET 

See Record Preset - Do not add to Sequence 
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Sequence - Modify Sequence Mode 

Press MODIFY SEQ in the Misc Soft Key Page to toggle. See Navigating - Misc Soft Key Page. 

   

The default setting for this mode is OFF. When turned ON all crossfade in Sequences will disregard 
Wait and Followon Times, Master Links, Master Pages, Links and other linked information. It is a 
mode created for rehearsals where only the main lighting changes are advanced manually. 

When activated there will be a popup explaining what this means for the user; 
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Sequences - Block Values 
It is possible to set a block for all track editing functions for a step in the Advanced tab of 
the Recording Popup or later, in the Sequence List. See also Track - Track Editing 
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A block is indicated in the Playback List with a B after the Preset and a line over the step.In this image 
step 4 is blocked. 

 

NOTE 
Currently all intensities are blocked. To block the intensity for an individual 
channel set it to a different value from incoming or outgoing values (like 99% 
or 49%). 
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Sequences - Track List 
It is possible to track edit intensities, channels, devices and attributes in Groups, Presets, Palettes and 
Sequences. 

 

All tracking features are described in the chapter Track List.  
See Track List.  
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Sequences - Chase Mode 
A chase is a sequence set to chase mode, which means it will constantly loop 
during playback. See Sequences. 

This chapter contains the following sections 

• Chase - Introduction  
• Chase - Playback View  
• Chase - Playback Modes  
• Chase - Set Rate  
• Chase - BPM & Tap Tempo  
• Chase - Wizard  
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Chase - Introduction 
A Sequence can be set to run in Chase mode. This means the Sequence will chase endlessly through 
all Steps on the predefined times. There are several parameters that can affect how it will run in Chase 
mode.  

General Facts 

• Chases are edited in the same way as Sequences.   
• In addition to Sequences they have Rate and BPM.  
• BPM can be set with TAP from the Master Playback.  
• A Chase has playback modes such as Reverse, Bounce, Single Shot.  
• You can link any chase to a sequence step using a Master Link.   
• You can play back a chase from any playback, including the Main Playback. 
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Chase - Playback View 
The Chase playback view is the same as the Sequence Playback view with some added indicators for 
chase mode. 

 

The added chase indicators appear under the sequence name display in the top of the Playback view. 
The functions are described in The Sequences List Columns as well as the rest of this chapter. 
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Chase - Playback Modes 
There are three modes that affect the playback of a chase.  

Mode  Where Function 

Reverse Set in The Sequences List 
Columns 

Reverses the chase direction. 

Bounce Set in The Sequences List 
Columns 

Makes the chase reverse direction 
every second time. 

Single Shot Set in The Sequences List 
Columns 

The chase will run one time and stop. 
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Chase - Set Rate 
You can set a rate 1-1000% for a Chase. It will scale all times proportionally. 

Action  Keys Feedback 

1. Open the Sequences list [SEQ] The Sequences List is 
opened. 

2. Step to the Rate cell for a 
chase 

Arrow Keys The cell is highlighted.  

3. Enter a new Rate  [#] [MODIFY] The Rate # is assigned to 
this Chase. All fade times 
are proportionally scaled. 



Cobalt 8.1 - 20181029 

408 

 

Chase - BPM & Tap Tempo 
You can set the tempo/speed to a chaser in BPM. This can be set numerically in the Sequences tab 
(Browser >Main Show Data >Sequences) or using the Tap Tempo function. 

Set BPM Numerically 

Action  Keys Feedback 

1. Open the Sequences list [SEQ] The Sequences List is 
opened. 

2. Step to the BPM cell for 
a chase 

Arrow Keys The cell is highlighted.  

3. Enter a new BPM  [#] [MODIFY] The BPM # is assigned to 
this Chase. * 

*The BPM parameter is only used for sequences in Chase mode. When the BPM parameter is set, it 
will override all programmed times. The In and Out times will be 0 s and the Wait time will be set 
according to the BPM parameter. 

Set BPM using Tap Tempo 

Action  Keys Feedback 

1. Assign the chaser to a 
Master 

[#] [SEQ] & 

[Master_Key] 

The Chase is assigned to 
the Master Playback. 

2. Tap the Tempo [TAP] & 

[Master_Key] 

Hold TAP and tap the 
Master Key at least twice.* 

*You have to tap at least 2 times in a row before the new tempo is activated. The tapping speed is 
translated to, and stored as the BPM parameter in the Sequence List. You can easily change it 
afterwards.  
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Chase - Wizard 
The Chase Wizard can create a chase sequence from a channel selection. It is activated from within 
the Sequences List. 

Action  Keys Feedback 

1. Open the Sequences list [SEQ] The Sequences List is 
opened. 

2. Open the Chase Wizard [WIZARD] The Chase Wizard is 
opened. The next free 
Sequence number is 
suggested. 

3. Select channels and set 
levels 

Channel functions The current channel 
selection from Live is 
automatically 
loaded. Change if wanted 
to. 

4. Fill in the Chase Wizard Arrow Keys See Chase Wizard -
Functions 

5. Execute the Chase 
Wizard 

[EXECUTE] The Wizard is closed, and 
the new Chase is added to 
the Sequences List. 
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This is the Chase Wizard 
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Chase Wizard - Functions 

Column  Input Function 

Number of steps [#] [MODIFY] The number of steps the Chase 
shall have. 

Channels per step [#] [MODIFY] The number of channels you 
wish to have in each step 

Step time [#] [MODIFY] Default wait time for each step. 
Can be edited after. 

Chase number [#] [MODIFY] The number this Chase will 
have. Next free is suggested. 

Start at preset [#] [MODIFY] The Preset number this Chase 
will use for the steps. It will 
start at Preset 800 by default. 

Increment [#] [MODIFY] You can set the Chase to use 
Presets with an increment of .1 
here. 

Build [MODIFY] Check if you want the 
Sequence Steps to continue 
adding new channels in each 
step to the previous ones. 

NOTE 
If you want to make changes in the Chase Sequence you just created, use the 
Sequence and Preset editors. It is a "normal" Sequence that has been created 
by the Chase Wizard. 
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Sequences - Split Fade 
There is a setting in the Mode cell of each step in the Sequence List that allows you to set the fade 
mode to S (Split) in which there will be no dipless calculation between the crossfaders - allowing for a 
blackout by moving each fader to zero.  

Example 
There is a preset in A in which channels 1-10 are at 10.  
In the next preset channels 5-10 will go from 10-100. 
 
If the fade is Split, it will be like bringing one master down fading out channels 1-10, and then 
bringing in 5-10 to 100, with a "split" between them.  

If the fade is not Split (default mode) the channels will go from 10 where they are, to 100, without a 
"dip" in the crossfade.  
   

 

See Sequences - Sequence List 
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Sequences - Drag And Drop 
There are many ways of moving around data in a sequence. Drag and drop is one of them. It can be 
useful if you want to reorganize the order of your sequence steps, or for example if you want to move 
an attribute link from one step to another.  

NOTE  
You cannot drag and drop steps in a Cue Sequence. 

Drag and Drop a Sequence Step 

Moving or copying a sequence step to another position can be done in all three Sequence views: 

• Playback View  
• Sequence List  
• Organizer 

Simply select the step you wish to move, click, hold and drag to another position and drop.  

In the Playback View: 
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In the Sequence List: 

 

In the Organizer: 
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In all three cases you will get the following dialogue: 

 

This dialogue allows you to COPY or MOVE the selected step.  

COPY = Makes a copy of the source and inserts it into the sequence after the target step. 
MOVE = Moves the source and inserts it into the sequence after the target step. 

If you select the Advanced tab by pressing left arrow you get the following options: 
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The first option allows you to define where you want to copy/move the step to. 

• After the target step (default)  
• Before the target step  
• Replace the target step 

The second option "Create Between" allows you to create a new step with a new preset number and 
insert (after/before).  

Drag and Drop Device Attributes 

Moving and copying device links in a sequence can be done in the organizer, or in the main playback 
tab. 

Organizer 

1. Open the Organizer tab (Browser >Main Show Data >Organizer (1 tab)) and expand the sequence 
nodes. 
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2. Left-click, hold and drag the Devices node from step preset 200 to preset 201 and drop. This will 
give you a dialogue: 
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Your options are to either copy, or move the device link you just dragged.  

NOTE  
You can drag all devices, devices of the same type or just a single device 
depending on where you click when you drag. 

  

Main Playback Tab 

In the main Playback Tab, left-click, hold and drag devices in the device cell of a sequence step to 
another step and drop to get the same dialogue as when you drag and drop in the Organizer as 
described above.  
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Sequences - Section Markers 
You can organize the contents of a sequence visually by setting section markers that will provide a 
blue heading. In addition to this you can jump between section markers. 

The quickest way to apply or remove a section marker is using the context menu (right-click over a 
sequence step in the Playback tab). 

 

You can see and set the section markers in the sequence editor as well - in the column at the far right 
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AND you can set the section marker also when you record a new preset in the sequence from the 
Advanced Record dialogue. 
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Jump Between Section Markers 

There are different ways to jump between section markers 

Function  Keys Feedback 

Next marker to A [GOTO] & [SEQ+] Step with next marker is 
loaded to A 

Previous marker to A [GOTO] & [SEQ-] Step with previous marker 
is loaded to A 

Next marker to B [JUMPTOB] & 

[SEQ+] 

Step with next marker is 
loaded to B 

Previous marker to B [JUMPTOB] & [SEQ-

] 

Step with previous marker 
is loaded to B 

Snap to next/previous 
marker (from keyboard) 

G & up/down_arrows From Keyboard: Snap to 
next/previous marker  

You can set TYPE to Section in the Direct Selects as well.  
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Sequences - Cues  
You can create a sequence with unique cues instead of the default presets. A preset is a referenced 
piece of data from the central preset list, a cue is a unique piece of data belonging to a specific 
sequence and step.  

You can choose which of these you prefer to work with at any time and in any of these dialogues: 

In the Let's Begin dialogue that is the first thing you see when you open a new show.  
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In the sequence tab of every record dialogue to a master (Hold RECORD and press master key). 
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In the Play Settings dialogue (press SETUP) 
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In the dialog that appears when you press INSERT in the Sequence List. 

 

When the sequence is set to cues the playback view will look like this: 
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Cue Sequence Attribute Editor  

When you are in a cue sequence there is a short command for opening the attribute editor for a cue. 
See Preset Attribute Editor. 

# SEQ & ATTRIB 
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Sequences - Loop Mode  
There are 3 modes that affect playback of Sequences. Normal, Chase and Loop. The mode of Loop is 
an addition to a normal sequence, only that there is no empty step between the last and the first when 
you reach the end.  

You can toggle this is in the mode column of the Sequences List. See more in Sequences List - 
Columns.  
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Playlist 
The Playlist allows you to arrange the order in which sequences are loaded to the main playback.   

1. Make sure you have some sequences to arrange in the playlist. 
2. Open the Playlist editor 

The Playlist is opened from Browser >Main Show Data >Playlist. 

 

These are the functions in the Playlist. 

Function  Keys Feedback 

Insert  [#] [INSERT] Sequence # is inserted into 
the Playlist 

Delete [DELETE] Sequence # is deleted from 
the Playlist 

Load  [GOTO] Loads the selected 
Sequence to the Main 
Playback from the next 
fade. 

3. Activate Playlist Mode from the Misc Soft Key Page (see below). 

NOTE 
You can reset the Playlist to strart from the top at anytime by holding C and 
pressing PLAYLIST in the Misc Soft Key Page. 
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The Playlist - Mode 

The PLAYLIST allows you to activate Playlist mode for playback of a number of sequences in a 
predefined order in the main playback.  

(Soft Key Pages are commands in the lower right corner of screen 2) 

    

When it is active all Sequences in the Playlist will be loaded when the previous is finished, until the 
end. Every time a new Sequence is loaded this will be notified with a message on the main screen.  
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The Playlist - Activate and Use 

Hold [<--] and press the softkey PLAYLIST in the Misc soft key page to activate the Playlist. 

In the Main Playback tab. 

 

The sequences will play back in the order they are stored in the Playlist until the end. 

In the Direct Selects - you can arrange them here as well. See Direct Selects - Arrange.  
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Groups/Palettes Overview  
This is an overview showing both Groups and Palettes of all types (Focus, Color, Beam, All) in the 
same tab.  

Open from the Browser >Main Show Data >Group/Palette Overview.  

 

• Press MODIFY to activate a selected item.  
• Press TRACK to track a selected item.  
• Press MODIFY to edit a name. 
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Cobalt 8.1 - 20181029 

434 

 

>Settings & Tools - Main Show Data 

These are the settings and tools for Main Show Data. 

This chapter contains the following sections 

• Fade Curves  
• Notes Editor  
• Delete Wizard  
• Auto-create Palette Wizard 
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Fade Curves 
It is possible to create and assign fade curves to each crossfade. It is possible to create any kind of 
curve in the Fade Curve Editor. The curves affect intensities, not Moving Device attributes.  

Action Key Feedback 

1. Open the Fade Curve 
List 

Browser >Main Show 
Data >Settings and 
Tools >Fade Curves 

The Fade Curve List is 
opened. 

2. Insert a New Curve [INSERT] A new curve is inserted. 
You can name it in the 
Name cell. 

3. Open the Fade Curve 
Editor 

[MODIFY] Press MODIFY in the Fade 
Curve cell to open the 
editor. 

When you create a new play  a set of standard fade curves are loaded.  

 

Fade Curve Editor (example: fast Top Curve) 
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Action Key Feedback 

4. Insert a position [INSERT] A position is inserted. You 
can set percent, Output and 
if this step should use 
interpolation to the next 
step. 
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Sequence - Assign Fade Curves 

Assign curves to a sequence step in the Sequence Editor. 

Action Key Feedback 

1. Open the Sequence 
Editor 

[MODIFY] & 

[PLAYBACK] 

The Sequence List is 
opened. 

2. Move to the column 
"Fade Curve" 

Arrow Keys The cell is highlighted 

3. Open the Fade Curve 
popup 

[MODIFY] The popup is opened. If no 
curves are defined it will 
only have "No curve". 

 
4. Select a Curve Arrow keys The selected curve is 

highlighted 

5. Confirm [MODIFY] The popup is closed and the 
selected curve is assigned 
to this step. 
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Notes Editor 
A NOTE allows you to add a comment and a color code to any Sequence Step, Group, Preset or 
Palette. All Notes are summarized in a list with a time and user stamp - and a direct link to the object 
the Note is attached to. 

  

• All Notes are tagged with a time stamp, and the user login of the operator.  
• Notes are shown in the Playback View with Flags.  
• The color of these flags can be set in the Notes Editor.  
• In the Notes Editor, it is possible to edit, delete and change color code for Notes. 

Notes - Create 

Pressing NOTE (for example in the Preset List) will produce the following popup 

 

Notes are created in the following lists by pressing NOTE. 

• Playback view  
• Sequence List  
• Preset List  
• Group List  
• Focus Palette List  
• Color Palette List  
• Beam Palette List  
• All Palette List 

Press MODIFY to save. See Notes - Editor. 
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Notes - Editor 

Open the Notes Editor by holding MODIFY and pressing NOTE or from the Browser (Browser 
>Main Show Data >Settings and Tools >Note Editor). 

 

You can change the color of the NOTE flag in the far right column of this editor. 

Note Editor - Columns 

These are the columns in the Note Editor. 

Column  Input Function 

TimeStamp [MODIFY] The time stamp of this Note - Press 
MODIFY to open the editor for this 
object. 

User [MODIFY] The user that created this Note - Press 
MODIFY to open the editor for this 
object. 

Linked to [MODIFY] The object of this Note - Press 
MODIFY to open the editor for this 
object. 

Note [MODIFY] The Note text. MODIFY opens the text 
for editing. 

Color [MODIFY] The color popup (only for the playback 
tab). Press MODIFY to open and select. 
Press MODIFY to close* 

*The color flag is shown for Notes in the Playback View, and the text is shown to the left of the 
graphical view of the crossfade. 
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Note Editor - Delete 

Notes are deleted in the Note Editor.  

1. Open the editor. See Notes - Editor. 

2. Select the Note with arrow keys. 

3. Press DELETE. The Note is deleted. 
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Delete Wizard 
The Delete Wizard allows you to delete bulk data in your play.  

It is opened from the Browser >Main Show Data >Settings and Tools >Delete Wizard. 

There are two tabs.  

• Delete All (of a type of data)  
• Delete Partial (a type of data from #-# of that data) 

Delete All 
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Delete Partial 
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Auto-create Content Wizard... 
This wizard allows you to generate palettes and groups for each range for selected parameters in the 
currently selected devices. Ranges with the same name will be merged together in the same palette. 
You can specify the starting number for newly generated palettes.  

Open in the Browser from Browser >Main Show Data>Settings and Tools >Auto-create Content 
Wizard... 

Auto-create Palettes from Ranges 
For example, if you choose parameter 1 to be a gobo wheel, beam palettes will be created for each 
gobo, with the name of the gobo starting at beam palette 101. 

 

Auto-create Groups from Auto-groups 
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Channels 
Every dimmer or device controlled from Cobalt is selected and controlled by 
its channel number. 

  

Channels Node 

 

This chapter contains the following sections 

• Channels Functions  
• Live View  
• Blind View  
• Track List  
• Parked  
• >Settings and Tools - Channels  
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Channels - Introduction 
A channel is the "handle" you call upon to control any dimmer or device connected to the system.  

Dimmer channel formats. 

 

Device channel formats 

  

Channels are selected with the channel functions of the programming section. The Channel Control 
functions are mapped to any section of the console at any time - for example pressing LIVE connects 
to the A field of the Main Playback, pressing BLIND connects to the Blind field. 

NOTE 
Channel Control is not the same thing as a "programmer" where channels 
are "stolen" into the programmer and have to be "released" - instead the 
Channel Control is mapped to any Playback (A, B, Live, Blind, Masters), and 
controls the channels directly in that playback. 

General Facts 

• Channel levels can be set with the faders in Channels Only Mode  
• Channels can be selected and set with a Command Syntax from the keypad  
• Channel levels are set from 0-100%. 0% values are not displayed on the channel screen and 

100% values are displayed as F, standing for "Full". The full resolution of DMX 512 is 
higher than 100 steps, its 256 steps called bits. Therefore there are functions for setting and 
changing levels in increments of bits (0-255).  

• Channels are always controlled directly in a playback or an editor, and the current one is 
indicated in the small display "Channel Control" at the bottom of all screens.  

• There is a Highlight mode, mainly used for focusing devices, that can also be used for 
conventional lights.  
(See Device Control -- Highlight Mode) 
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Channels - Functions 
These are the channel functions. 

This chapter contains the following sections 

• Channels - Views  
• Channels - Command Syntax  
• Channels - Ch Only Mode  
• Channels - 8 bit 256 Step Levels  
• Channels - Capture Mode  
• Channels - Clear Functions  
• Channels - Check Mode  
• Channels - Balance Mode  
• Channels - Random Selection  
• Channels - Scale Level  
• Channels - Used & Unused  
• Channels - Group Wheel Mode   
• Channels - Rem Dim  
• Channels - Next & Last Mode  
• Channels - Select Functions  
• Channels - Find Highest Level 
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Channels - Views 
Channels (dimmers and devices) are displayed in channel views.  

 

1. This is the Live tab in Channels mode  
2. Settings - expand/compress level of detail, switch palette name or number  
3. Live tab in Attributes mode for devices. Use context menu or ATTRIB to toggle  
4. Context menu for format, if you click on a channel there are channel functions.  

A Channel View like the Live Tab shows only channels, but a channel view can also be a part of 
editors like the Preset Editor, the Sequence Editor, Effect Editors etc.  
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If you right-click on a channel or hold LOCAL MENU and click on it, you will get the channel 
context menu with a selection of commonly used functions that can be applied to the currently 
selected channel(s).  

 

Channel views can show channel intensities, palettes and attributes. They have different levels of 
detail and can be zoomed. For more information see Navigating - Channel Views and Live - 
Introduction. 
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Navigating - Channel Views 
The FORMAT key is one of the main keys used to navigate in the Channel Views.  The channel 
symbols and formats are described in another chapter.  
(See Channel Symbols) 

 

 

• Hold FORMAT and use the level wheel to zoom  
• Hold C & FORMAT to reset the zoom factor  
• Press FORMAT to toggle channel formats  
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• Hold FORMAT and press ALL to select the All Channels format directly  
• Hold FORMAT and use up/down arrow to select compact format (see below)  
• Enter a number and press FORMAT to select a Magic Sheet  
• Hold CHANNEL and press Arrow keys to page  
• Hold CHANNEL and move the level wheel to scroll (not in Magic Sheets) 

The status bar in the top shows the current Preset in the Main Playback to the left and the selected 
format to the right. You can touch or click on the right side of the header bar to open a context menu 
with all formats as shown above. 

Compact Channel Format  

There is a compact channel format where relative intensity levels are shown with a white status bar.  

• FORMAT & up arrow - compacts the format  
• FORMAT & down arrow - expands the format 
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Channel View Formats - Selected 

Only selected channels are shown. (Pressing FORMAT toggles through the formats.) 

 

Channel View Format - Selected and non-zero 

Selected and non-zero channels are shown. (Pressing FORMAT toggles through the formats.) 

 

Hold FORMAT and press CHANNEL to select this format directly. 
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Channel View Format - Selected And Captured 

Selected and captured channels are shown. (Pressing FORMAT toggles through the formats.) 

 

Hold FORMAT and press CAPTURE to select this format directly. 
See Channels - Capture Mode. 

Channel View Format - Used In Play 

Only channels recorded in some way in this play are shown. (Pressing FORMAT toggles through the 
formats). 
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Channel View Format - Magic Sheet (8.0) 

The last selected Magic Sheet is shown. (# FORMAT selects Magic Sheet #.) If there are no Magic 
Sheets stored in the show, a dialogue to create one will appear. 

 

 

Channel View Zoom 

Hold FORMAT and use the wheel to Zoom in/out. (You can hold FORMAT (F4) and then right-click 
and drag with mouse as well). 
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NOTE 
Hold C & FORMAT to reset the zoom factor.  



Cobalt 8.1 - 20181029 

456 

 

Channels - Command Syntaxes (RPN/At Mode)  
Depending on where you come from you will be accustomed to some kind of command syntax. In 
Cobalt it is possible to do most of your design and programming without having to worry about this, 
since most functions are available directly on the screens. However, for traditional number crunching 
of lights and levels it makes a difference. There are two options. Rpn and At Mode.  

RPN 
The default mode for entering commands in the system is simple to learn, requires few keystrokes and 
applies to all functions in the system. It is used a lot in HP calculators for speedy calculations and is 
called Reverse Polish Notation (RPN). Since RPN applies to everything in the system we recommend 
you spend the necessary 30 minutes to understand it. There's one single rule: enter the number first 
and press the function key after.  

AT MODE 
At Mode (also called (Direct Entry) is different in the way that ch numbers are entered directly, 
followed by a function (@ LEVEL for example) and the value of that function.  

NOTE 
At mode setting is set up and stored in the registry as a system setting. See 
Console Settings. 
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Select Channels 

The fastest way to select a channel and set a level regardless of syntax is to enter the number of that 
channel and move the level wheel. 

This is a table with the key entries for most channel commands. See also Multicell Devices. 

Channel  RPN AT MODE 

Clear selected channels [C/Alt] [C/Alt] [C/Alt] & [C/Alt]

Select channel 1 [1] [CHANNEL] [1]

Add channel 2 [2] [+] [+] [2]

Add through 7 [7] [THRU] [THRU] [7]

Subtract ch 3 [3] [-] [-] [3]

Select all channels with a 
level in the channel 
control 

[ALL] [ALL]

Select all channels at 
level # in the channel 
control 

# [ALL] &  [@LEVEL] # [ALL] &  [@LEVEL] 

Select all channels with a 
level in any playback 

[ALL] [ALL] [ALL] [ALL]

Invert the current channel 
selection (of all channels 
with a level) 

[INV_GROUP] [INV_GROUP]

Step to the next ch [+] [+]

Step to the previous ch [-] [-]

NOTE 
To complete a channel selection in At Mode without pressing the @ LEVEL 
key. use the decimal [.] key twice. 

See Channels - Clear Functions 
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Selecting Decimal Channels (7.1) 

Channel  RPN AT MODE 

Select complete device [1] [CHANNEL] [1]

Select only base channel [1] [.] [0] 

[CHANNEL] 

[1] [.] [0] 

Select only decimal 
channels 

[1] [.] [1] 

[CHANNEL] 

[1] [.] [1] 

Invert base/decimal [INVERT] & [.] [INVERT] & [.]

  

Set Channel Levels 

Once a channel(s) is selected you can set levels in the following ways. 

Level Command RPN AT MODE 

Set to 50% [5] [0] 

[@LEVEL] 

[@LEVEL] [5] [0]

Set to 55% [5] [5] 

[@LEVEL] 

[@LEVEL] [5] [5]

Set to 100% [@LEVEL] 

[@LEVEL] 

[@LEVEL] [@LEVEL] 

Set to 70%* [@LEVEL] [@LEVEL] [7] [0]

Set to 0% [@LEVEL] 

[@LEVEL]  

[@LEVEL]  

[@LEVEL] [0]

Set to 0% [C/Alt] & [-%] [C/Alt] & [-%]

Add 5% [+%] [+%]

Subtract 5% [-%] [-%]

Select ch # and add 5% [#] [+%] [#] [+%]

Select ch # and subtract 5% [#] [-%] [#] [-%]

Increase level by #% [#] [.] [+%] not possible in at mode 

Diminish level by #% [#] [.] [-%] not possible in at mode 

Revert to last used level 
(Undo) 

[ON/FETCH] & 

[@LEVEL] 

[ON/FETCH] & [@LEVEL] 
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*This is the Step Level value of the SETUP for the Level key. You can change it by holding SETUP 
and pressing @LEVEL. 

NOTE 
There is a function for setting the last recorded level, and for fetching levels 
from any recorded Preset. 

See Presets - Fetch Intensities 

Park Level 

You can set a channel at a constant level. It will not be affected by any other controls (including the 
Grand Master).  

See Park. 
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Channels - Ch Only Mode 
The CH ONLY MODE key in the programming section allows a complete novice to get some lights 
on stage. It converts all 40 Playback faders to channel faders temporarily, actually turning the console 
into a single scene board.  

 

Action Console Feedback 

1. Make sure the Grand 
Master is up 

Grand Master Otherwise there is no light 
output 

2. Make sure the FREEZE 
switch is set to ON 

Freeze Switch Otherwise there is static, or 
no light output 

3. Activate channel only 
mode 

[CH_ONLY_MODE] Channels 1-40 can be 
accessed from the Master 
faders now. Move fader 1 
and you can see the value 
for channel 1 on the 
channel views. 

You can select a channel 
range from the master 
buttons above/under the 
displays 

Master buttons The channels in each range 
are indicated in the 
displays. 

The levels will remain when you exit Channel Only mode and can be used in the normal mode. 

To exit Channels Only Mode, press again. 
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Channels - 8 bit 256 Step Levels 
You can work with 8 bit 256 step levels. 

Action  Key Feedback 

Increase 1 bit  [.] & [+%] As long as the decimal 
point is held, pressing +% 
will add one bit step  to the 
selected channels 

Decrease 1 bit  [.] & [-%] As long as the decimal 
point is held, pressing +% 
will subtract one bit step 
from the selected channels 

Show 256 bit levels [FORMAT] & 

[[@LEVEL] 

Toggles the view between 
decimal and 256 bit levels 

EXPLANATION 
Levels for channels controlling dimmers are traditionally set from 0-100%. The internal resolution of 
DMX 512 however, is about 2.5 times greater, from 0 to 255. You may want to use this higher 
accuracy when you are setting values for mechanical dimming devices. 

The board will display the %-value rounded off to the closest value. (1.4% will be displayed as 1% 
and 1.6% will be displayed as 2%) 

To convert between 0-100% and 0-255 raw DMX levels, you divide the % level with 0.39 
(100/255=0.39). For example: 50% / 0.39 = 128 bit steps (actually 128.21) 
 
The other way around you multiply by the same factor of 0.39. Example: 129 x 0.39 = 50,31% 

NOTE 
256 bit step levels are not displayed on the channel screen, but are stored with 
the show and exported in ASCII Light Cues. 
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Channels - Capture Mode 
The CAPTURE key in the programming section allows you to capture a channel or device and control 
and record it regardless of where it is output from in the system. Captured levels are considered to be 
changed at all times and will be recorded into Presets accordingly. A Catpured channel/device stays 
this way until released with the RELEASE key.  

  

You can capture a channel/device by selecting the channel(s), holding CAPTURE and pressing CH or 
moving the level wheel, and you can activate Capture Mode (by pressing CAPTURE twice) in which 
any channel/device that is changed will be captured until release. 

The channel number background of a captured channel is red. 
 

 

RECORD will store the captured level. 

It is possible to work in a permanent Capture mode, and there are functions for Capturing any part of a 
ch. 

As soon as Capture is active for a channel or parameter, this is indicated at the top of all screens. 
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Permanent Capture Mode  

While Capture mode is activated, all channels that are changed are automatically captured. 

Action Key Feedback 

Activate  [CAPTURE] [CAPTURE] Capture will light up. All 
channels that are selected and 
changed will remain at that 
level until released.  

Deactivate  [CAPTURE] [CAPTURE] Capture light goes off. 
Captured channels remain 
captured until released. 
Captured channels will have a 
red background for the channel 
number. 
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Capturing levels or parameters 

Regardless if Capture mode is active or not, it is always possible to capture channels or part of 
channels. Capture mode is not toggled to a permanent active state by these commands (5.0). 

OBSERVE  
That all of these commands will affect the currently selected channels. If a number is entered first, 
only this channel will be affected. 

Action Key Feedback 

Intensity and 
parameters 

[CAPTURE] & 

[CHANNEL] 

Captured channels will have a 
red background for the channel 
number. 

Intensities [CAPTURE] & 

[@LEVEL] 

Level is captured until released. 

Parameters [CAPTURE] & 

[ATTRIB] 

Parameters are captured until 
released. 

Single Parameters [CAPTURE] & 

[Wheel_key] 

Parameters are captured until 
released. 

Focus parameters [CAPTURE] & 

[FOCUS] 

Parameters are captured until 
released. 

Color parameters [CAPTURE] & 

[COLOR] 

Parameters are captured until 
released. 

Beam parameters [CAPTURE] & 

[BEAM] 

Parameters are captured until 
released. 

U1-U3 parameters [CAPTURE] & [U1-

U3] 

Parameters are captured until 
released. 

Recording only Captured channels  

You can record only captured channels. 

Action Key Feedback 

Record captured  [RECORD] & [CAPTURE] Levels and parameters of only 
captured channels are recorded.  
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Releasing Captured Channels 

Captured channels are released back to the sum of all playbacks, this can be done on time. 

Action Key Feedback 

Selected  [RELEASE] The selected channel intensities 
are released, regardless if 
Capture is active or not. 

Selected  [RELEASE] & 

[CHANNEL] 

The selected channel intensities 
and attributes are released, 
regardless if Capture is active or 
not. 

In # seconds [#] [RELEASE] The selected channels are 
released in the time #, regardless 
if Capture is active or not. 

All [RELEASE] 

[RELEASE] 

All captured channels are 
released, regardless if Capture is 
active or not. 

Focus  [RELEASE] & 

[FOCUS] 

Release captured Focus 
parameters 

Color  [RELEASE] & 

[COLOR] 

Release captured Color 
parameters 

Beam  [RELEASE] & 

[BEAM] 

Release captured Beam 
parameters 

Single parameters [RELEASE] & 

[Wheel_key] 

Release captured parameters 

Grouped parameters [RELEASE] & 

[U1-U3] 

Release captured parameters 
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Channels - Clear Functions 
The C/Alt key in the programming section is used in combination with other keys to quickly clear 
different playback areas of content. 

 

These functions can be used to clear channels and levels 

Action Key Feedback 

Clear selected  [C/Alt] [C/Alt] All channels in the 
contributing field of the 
channel view connected to 
the channel control are 
deselected. 

Clear A [C/Alt] & [LIVE] All channels in the A field 
are set to zero and 
deselected. 

Clear all [C/Alt] & [LIVE] 

[LIVE] 

All channels in all 
Playbacks are set to zero 
and deselected**  

Clear Blind [C/Alt] & [BLIND] All channels in 
the Blind field are set to 
zero and deselected. 

Clear channel view [C/Alt] & [CHANNEL] All channels in the 
Playback connected to the 
Channel Control are set to 
zero and deselected. 

Clear and home [C/Alt] & [CHANNEL] 

[CHANNEL] 

All channels in the 
Playback connected to the 
Channel Control are set to 
zero, deselected, homed 
and the changed flag is 
reset. 

Clear selected  [C/Alt] & [@LEVEL] Selected channels in the 
Playback connected to the 
Channel Control are set to 
zero and deselected. 

*Captured channels and Independent Channels in Exclusive mode are not cleared.  
**Channels in Master Playbacks are restored by bringing the Master fader to zero and back up. 
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Home Attribute functions  

Action Key Feedback 

Clear  [C/Alt] & 

[HOME_ATTRIB] 

Homes all attributes and clears 
all Dynamics. 

Clear  [C/Alt] & 

[HOME_ATTRIB]  

[HOME_ATTRIB] 

Homes all attributes and clears 
all Dynamics and intensities. 
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Channels - Check Mode 
The CHECK +/- keys in the programming section are used for stepping through a series of channels at 
any selected level. If a channel is already set to a level when checked it will cut back to the previous 
level when the next channel is checked.  

 

Action Key Feedback 

1. Select start channel and 
set a level 

[#] Level_Wheel This level will be used by 
check mode. 

2. Activate temporary check 
mode in up or down direction

[CHECK+]

[CHECK-] 

The level is set to the 
next/previous channel. 

3. Exit temporary check 
mode  

[C/Alt] Check mode is exited 
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Channels - Balance Mode  
The BALANCE key in the Soft Keys makes it possible to temporarily set all channels to 0% except a 
selection, to be able to work with that selection. The original output of the subdued channels is 
restored when Balance Mode is exited.   

(Soft Key Pages are commands in the lower right corner of screen 2) 

   

As soon as balance mode is activated, it is indicated at the top of all screens. 

 

Action Key Feedback 

1. Select the channels to 
work with 

See Channel Command 
Syntax 

2. Activate Balance  
Mode 

[BALANCE] All other channels in the 
channel view will be set to 
0% temporarily. You can 
now work with the selected 
channels. 

3. Exit Balance Mode [BALANCE] The channel levels that 
were muted are restored. 
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NOTE 
It is not possible to use RECORD when Balance mode is active. 

Balance Mode Key 

It is possible to set the REM DIM key to function as BALANCE instead. This is done in the System 
Settings.  

 

See System Settings - Channel 
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Channels - Scale channel levels 
The SCALE key in the Soft Keys makes it possible to apply a scaling factor to the intensity level of 
any channel/device.  

(Soft Key Pages are commands in the lower right corner of screen 2) 

    

When 100%, channels are controlled and played back at normal or recorded levels. Scale settings 
other than 100% will proportionally inhibit or boost the intensity output by the channel. For example, 
a channel scaled to 150% will play back 75% when actually recorded and played back at 50% by a 
preset.   

Scaling is used in situations such as: 

• When the light source is too bright due to temporary change of hanging position (100-0%)  
• When you need to brighten part of a rig temporarily to adapt it for camera footage (100-

200%).  
• When a touring rig is adapted to a different stage size. 

  

Scaling with the SCALE soft key 

1. Hold the SCALE soft key in the Channels Soft key page of the main display. The channel view will 
show the scale levels.  
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2. Use the level wheel to set the scale level 0-200% for the selected channel(s). 

No scale is shown as "---". 

  

A channel with a scaled level gets a symbol next to the level, and the scale leve is shown in the INFO 
area of the Browser when the channel is selected. 
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Scaling from the channel list 

Action  Key Feedback 

1. Open the Channel List  [MODIFY] & 

[CHANNEL] 

The Channel List is opened 
and focused at the channel 
with that number. 

2. Select the channel [#] [CHANNEL] Channel is selected. 

3. Move to the Scale 
column 

Arrow keys  

4. Set a Scale level [#] [MODIFY] All levels of this channel 
will be multiplied by the 
Scale factor. A +/- symbol 
will be shown next to the 
level. Set 100% to remove 
the Scale factor. 

Clear Scale Values 

Clearing scales from channels is a key shortcut 

Action Key Feedback 

1. Select channel(s) [#] [CHANNEL] Channels to be unscaled 

2. Clear scale [C/Alt] & [SCALE] Scales are cleared. 
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Channels - Used & Unused  
You can create a selection of channels based on if they are used or not in the sequence loaded to the 
Main Playback. 

Action  Key Feedback 

1. Open the Channel 
Selection Wizard 

[WIZARD] & 

[CHANNEL] 

A popup with the Channel 
select wizard is opened. 

2. Select UNUSED or 
USED 

[MODIFY] This is a choice in the 
dropdown menu. 

3. Select the Start and Stop 
ranges 

Arrow keys This is default set to the 
first and last step of the 
Sequence. 

4. Execute the selection Based on your choice all 
unused or used channels of 
the sequence loaded to the 
Main Playback are 
selected. 
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Channels - Group Wheel Mode 
The GROUPWHEEL key in the Soft Keys makes it possible to assign a different/overlapping channel 
group to each wheel under the Main Display. All wheels interact inside the A field of the Live tab on a 
Latest Takes Precedence basis.  

(Soft Key Pages are commands in the lower right corner of screen 2) 

   

The Channels soft key page 

 

With groups loaded 
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 Load channels 

Action Key Feedback 

Load selected  [PRESET] & 

[Wheel_Key] 

The selected channels are 
loaded as a channel group 
to the wheel. 

Load selected  [GROUP] & 

[Wheel_Key] 

The selected channels are 
loaded as a channel group 
to the wheel. 

Load group [#] [GROUP] & 

[Wheel_Key] 

The channels of Group # 
are loaded to the wheel. 

Load selected  [CHANNEL] & 

[Wheel_Key] 

The selected channels are 
loaded as a channel group 
to the wheel. 

Load channel... [#] [CHANNEL] & 

[Wheel_Key] 

The channel # is loaded to 
the wheel. 

NOTE 
The channels affected by a group wheel are updated when they are selected. 
This means that if the level has changed (by a crossfade or a manual change 
of some kind), the group wheel will now always catch up. The 
overflow/underflow information will therefore be lost if you are taking 
multiple channels over 100% or under 0%. 

NOTE 
In a client setup with multiple users each client will have individual settings 
for group wheel mode. 
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Channels - Rem Dim 
The REM DIM key in the programming section will set all channels in the Channel Control to zero, 
except the currently selected channel(s). 

 

Function Key Feedback 

Dim remaining [REM_DIM] All channels in the 
Channel Control 
are set to zero, 
except the current 
selection. 

  

NOTE 
It is possible to set the REM DIM key to function as BALANCE. This is done 
in the System Settings. See System Settings - Channel 
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Channels - Soft key page 
The CHANNELS soft key page provides a number of functions that are useful when working with 
channel intensities.  

(Soft Key Pages are commands in the lower right corner of screen 2) 
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Functions 

Function  Soft Key Feedback 

Compare mode [Compare] Activates Compare mode.  
See Presets - Compare mode 

Balance mode [Balance] Activates Balance mode.  
See Channels - Balance mode 

Data [Data] Toggles if console displays and 
monitor screens display absolute 
device data or references to palettes. 

Mark [Mark] Sets a Mark level to the selected 
device(s).  
See Active Mode & Mark 

Scale [Scale] Activates Scale when held.  
See Channels - Scale channel 
levels. 

Group Wheel 
Mode 

[Group_Wheel_mode] Activates Group Wheel mode.  
See Channels - Group Wheel Mode 
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Channels - Next & Last Mode  
The NEXT and LAST keys in the programming section will sub-select singel channels in the current 
channel selection, in the order they were selected. The focused channel is mapped to intensity and 
parameter controls so you can adjust it individually. Press SELECT ALL to exit Next/Last mode.  

 

Action  Key Feedback 

Activate Next/Last  [NEXT] The first channel in the 
current channel selection is 
marked as red, and mapped 
to the level and device 
controls. LAST can be used 
as well. 

Step forward [NEXT] Channels are focused in the 
order they were selected. 
The focused channel is 
highlighted in red in the 
active Channel View* 

Step backwards [LAST] Same as above, but 
backwards. 

Leave Next/Last mode [SELECT_ALL] All channels are selected 
again 

*The currently focused channel is highlighted in red. 
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NOTE 
Next/Last and Highlight Mode are often used in combination for focusing 
single channels within a channel selection. See Highlight Mode 

When you focus a channel with NEXT/LAST, it will be shown with number 
and name in the Information area of the Browser.  
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Channels - Select Functions 
The select functions allow you to select odds, evens, randoms and more from any channel selection.  

(Soft Key Pages are commands in the lower right corner of screen 2) 
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Select - Sub-selection Functions 

In all cases below - Press SELECT ALL to return to the original selection.  
Function  Soft Key Feedback 

Every 2nd  [Select_2nd] Every second channel from the 
current channel selection is 
selected. Use NEXT/LAST to step. 

Every 3rd  [Select_3rd] Every third channel from the 
current channel selection is 
selected. Use NEXT/LAST to step. 

Every # th * [#] [Select_Nth] Every # th channel from the current 
channel selection is selected. Use 
NEXT/LAST to step. 

Random 2nd  [RANDOM] & 

[Select_2nd] 

Two random selections are created 
from the current selection. Use 
NEXT/LAST to step. 

Random 3rd  [RANDOM] & 

[Select_3rd] 

Three random selections are created 
from the current selection. Use 
NEXT/LAST to step. 

Random Nth  [RANDOM] & 

[Select_Nth] 

Nth random selections are created 
from the current selection. Use 
NEXT/LAST to step** 

*If no number is entered, the last used number will be used. 

**The last used Random selection # is used. 

Channels - Random Select 

It is possible to randomize the order of the channels within the current selection. This can be used to 
get a random order in a chase or with a Dynamic Effect.  

Action Soft Key Feedback 

1. Select the channels you 
want to work with 

See Channel 
Command Syntax 

2. Select the Selects Soft 
Key Page  

[SELECT] This changes soft 
menu to the Select 
functions  

3. Make a random selection [RANDOM] The channels are 
re-selected in a 
random order. 

You can use the numbering functions that allow you to select every 2nd, 3rd or Nth together with the 
random function. 
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Function Soft Key Feedback 

Random 2nd [RANDOM] & [SELECT_2nd] Every random 2nd 
is selected. 

Random 3rd [RANDOM] & [SELECT_3rd] Every random 3rd 
is selected. 

Random Nth [RANDOM] & [SELECT_Nth] Every random Nth 
is selected. 
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Channels - Find Highest Level  
Cobalt has 81 Playbacks (80 masters and a main playback) and any channel's intensity can be output 
from all of these at the same time. The highest level of output from any playback is the one that takes 
precedence on the output.  

To find what field the highest intensity level of output for any channel is coming from, select the 
channel in a channel view and open the context menu (right click or LOCAL MENU). Select Find 
Highest Level (First selected) and the editor for that playback will be selected and opened.  
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Live 
The Live tab is the most fundamental tab, where you can view and edit values 
for channels and devices "live". 

This chapter contains the following sections 

• Live - Introduction  
• Editing in Live  
• Channel Symbols 
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Live - Introduction 
Live is the main Channel view where you can control and view the live output of all channels and 
devices.  The Live tab shows all channel levels, no matter where they are output from. If you add 
channel intensities they will be output from the Active field of the Main Playback (A).  

NOTE 
The Live Tab cannot be closed with ESC unless it is unlocked. To unlock 
 hold SETUP and press TAB when it is selected. 

Select the Live Tab 

Pressing LIVE selects the Live tab, which allows you to select and control channels and devices.  
(See Channels - Views) 
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Selecting channels with mouse 

Click on a channel to select or deselect it, and hold THRU and click on another channel to select a 
range.Double-click a channel to select just that channel.  

Right-click in a channel view to open the context menu with channel functions 
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You can drag and drop channels between channel views, and to masters. All intensities will be copied.  

Channel viewing formats 

All channel views have a variety of viewing formats (selected, non-zero etc). The currently selected 
format is indicated in the top right corner of each Channel View. To read more about the viewing 
formats see Navigating - Channel views. 

You can toggle through these formats by pressing FORMAT repeatedly: 

• All channels  
• Selected channels  
• Selected and non-zero channels  
• Selected and captured channels  
• Selected and used in play channels* (see NOTE)  
• Magic Sheet (if there is one defined)  
• # FORMAT (select Magic Sheet) 

You can activate the following of those formats directly by holding FORMAT and pressing a key 

• All channels (FORMAT & ALL)  
• All non-zero channels (FORMAT & CH)  
• Captured channels (FORMAT & CAPTURE)  
• Parked channels (FORMAT & PARK) 
•  
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NOTE 
SELECTED AND USED IN PLAY = Shows channels that are recorded in 
presets and Groups. If you select previously not recorded channels, they will 
be shown in this view. But, when you select this format the next time, a new 
scan through all groups and presets will be made and they will disappear 
again if they don’t have recorded levels. 

  

Channel View Zoom 

Hold FORMAT and use the wheel to Zoom in/out. (You can hold FORMAT (F4) and then right-click 
and drag with mouse as well). 
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NOTE 
Hold C & FORMAT to reset the zoom factor.  

Channel Information - Info Box 

In the top right corner of the screen with the soft keys (under the screen and browser soft keys) there is 
an INFO box which will show information for the currently selected channel(s). It is possible to use 
NEXT/LAST to focus a single channel within a selection and get the channel info.  

 

The following information is shown 

• Text A-D for the channel  
• Template name.  
• If a dimmer curve is assigned.  
• The Dimmer/Device Addresses.  
• Park status.  
• More than one channel select is shown as “x channels selected”.  
• If there are dimmer errors reported for a channel. 

Multiple Live Tabs 

It is possible to open several Live tabs. They can be set to operate individually, or linked to the same 
channel pool - synchronising to show as many channels as possible at all times. 

Action  Key Feedback 

Open new [TAB] & [LIVE] A new Live tab is opened. 

Every Live tab that is supposed to be linked to the same channel pool needs to activate this feature. 

1. Hold SETUP and press TAB (with the Tab in mind focused). 
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2. Check the box "Include Channel View in pool". 
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Editing in Live  
All controls of the console are available for editing when Live is active. 

Select channels and/or devices and you can 

• Set/change intensities with level wheel or level keys  
• Change parameters with parameter wheels  
• Activate palettes with palette keys and/or direct selects 

Intensities = HTP 
Intensities are added to the output in the A field of the main playback. The levels are piled by Highest 
Takes Precedence (HTP)on top of the output from all playbacks. 

Override = Capture Mode 
If you want to control intensity or attributes of any channel regardless of where it is output from, use 
Capture Mode. Capturing a channel is similar to using a programmer, which means that the channel 
has to be released back to the playbacks or it will stay at the captured level. See Capture Mode. 

Edit Attributes on screen  
Please note that Spreadsheet editing on screen is OFF as default. To activate this open the tab settings 
by holding SETUP and pressing TAB. 
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Record in Live 

Recording 
You can record in Live directly to the sequence in the main playback, directly to a master, or to Preset. 

Action  Key Feedback 

Record Live [RECORD] A popup will ask you to 
confirm that the content of 
Live is recorded to the next 
free preset of the sequence 
in the main playback.  

Record to a Master [RECORD] & 

[Master_Key] 

A popup will ask you to 
confirm that the selected 
channels are recorded to 
the next free preset in that 
Master Playback. 

Update Preset  [UPDATE] A popup will ask you to 
confirm updating the preset 
currently loaded to A.  
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Channel Symbols 
In every Channel View there are channel and device symbols with indicators for basic modes and 
content.  

Basic indications 

Indicator  Screen Explanation 

Selected and 
HTP 

 

A gold frame shows that a 
channel is selected. If a 
master is source the level is 
shown in yellow (channel 6). 
The top right corner shows 
the source of the current 
highest level* 

Changed values A magenta background 
indicates that a level or 
parameter type has changed. 

*Masters are 1-40, Main Playback is AB, Independents are displayed as "I", Capture as "C" and 
Remote fields are displayed as "Re". 

You can choose different levels of detail as shown below by holding FORMAT and pressing the 
up/down arrows.  

Dimmer channel formats 
The channel number is on top, and the level is indicated with a level bar to the right of the number 
and/or a level in % 0-F under. 

 

Scroller channel formats 
Similar to dimmer channels, except there is additional information about the currently selected color. 
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Device channel formats 
Similar to dimmer channels, except there is additional information about the device template and 
Focus, Color and Beam palettes and activity. If the device has color mixing there is a color preview to 
the left of the channel number showing the current mix. 

    

You can toggle if palette names or number are shown by holding FORMAT and pressing left/right 
arrow. 
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Channel Information - Important Level Modes 

These are the different modes and functions that can "steal" or "filter" the levels and parameters of a 
channel or device. 

Function  Screen examples Explanation 

Captured A red background for 
the channel number 
indicates attributes are 
captured. A red 
background for the 
level indicates the 
level is captured. 

Parked The background of all 
information is 
dimmed. "PARK" is 
indicated at the top 
of all screens. 

Exclusive level A blue level indicates 
this level is set as 
exclusive to a master 
or independent 

Scaled level A +/- sign after the 
level indicates it is 
scaled 

Inhibited level A red level indicates 
an inhibit master is 
limiting the level 
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Channel Information - Fade indications 

Channel information for fades are only shown in the Live channel view and are all related to the 
sequence in the main playback. 

Function  Screen Explanation 

Fade 
direction  

 

The arrow indicates what it will 
do on pressing GO, not 
necessarily what it is doing right 
now. 

Up = blue arrow 
Down = green arrow 
No indication means it is not 
changing. 

Channel 
Times 

  

Channel Time (T) and Delay (D) 
are indicated under the level 

Move Fade Channel Time (T) and Delay (D) 
are indicated under the level 

Lock Fade An "L" after the time indicates 
Lock Fade 

Effects En "E" (effect) or "D" 
(dynamics) is shown under the 
level 

Device 
parameters 

White on grey = current 
White on purple = changed 
White on blue = Automarked 
Yellow  = moving 
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Blind 
The Blind tab allows you to view and edit values for channels and devices 
blind. 

This chapter contains the following sections 

• Blind - Introduction  
• Editing in Blind 
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Blind - Introduction  
Blind is a channel tab where you can control any channels and devices blind.   

• Create a look blind and load or record to any playback.  
• Load the content of any playback to Blind, and load the content of Blind to any playback.  
• Record the content of Blind. 

Select the Blind Tab 

Pressing BLIND will select the blind tab, and allow you to edit channels and devices without affecting 
the output.  

 

The channel viewing formats, zoom and channel information are the same as for all channel views and 
Live - see Channel viewing formats. 
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Editing In Blind 
Most normal controls of the console are available for editing in Blind. 

Select channels and/or devices and you can 

• Set/change intensities with level wheel or level keys  

When the attribute view is open you can 

• Change parameters with parameter wheels  
• Activate palettes with palette keys and/or direct selects  
• Use Fetch to copy attributes and levels from any existing preset 

Edit Attributes on screen 
Please note that Spreadsheet editing on screen is OFF as default. To activate this open the tab settings 
by holding SETUP and pressing TAB. 

 

Record and copy in Blind 

Recording 
You can record from Blind directly to a master, or to Preset. 

Action  Key Feedback 

Record to a Master [RECORD] & 

[Master_Key] 

A popup will ask you to 
confirm that the content of 
Blind is recorded to that 
Master Playback. 

Record Blind [RECORD] A popup will ask you to 
confirm that the content of 
Blind is recorded to the 
next free preset.  

Update Preset  [UPDATE] A popup will ask you to 
confirm updating the preset 
currently loaded to Blind.  
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Copy and load functions 
There are shortcuts for quickly copying information to and from the Blind tab. 

Action  Key Feedback 

Clear  [C/Alt & [BLIND] Clears all values in Blind 

Copy Live to Blind [LIVE] & [BLIND] All in Live is copied to 
Blind 

Copy Blind to Live [BLIND] & [BLIND] All in Blind is copied to 
Live 

Load Preset [#] [PRESET] & 

[BLIND] 

Preset # is copied to Blind 

Load Group [#] [GROUP] & 

[LIVE] 

Group # is copied to Blind 

Try intensities [BLIND] & Wheel The intensities in Blind are 
piled on top of the rest of 
the output. 
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Track List 
It is possible to track intensities, channels, devices and attributes in Groups, 
Presets, Palettes and Sequences. 

This chapter contains the following sections 

• Track - Introduction  
• Track - Channels  
• Track - Lists  
• Track - Presets  
• Track - Palettes  
• Track - Track Editing 
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Track - Introduction  
Press TRACK to track the current channel selection in the sequence of the main playback. 

 

It is possible to Track a channel/moving device selection with attributes through Play data (Presets, 
Groups, Palettes, Sequences. It is also possible from the Browser, to track Presets and Palettes.  

A channel selection can be tracked 

• In the Sequence of the Main Playback  
• In the Sequence of a Master Playback  
• In all Sequences  
• In all Presets  
• In all Groups  
• In all Palettes (Focus, Color, Beam, All)  
• In the Play (Sequences, Presets, Groups & Palettes) 

From the Browser it is possible to track  

• Where Presets are used (in Sequences)  
• Where Palettes are used (Focus, Color, Beam, All) 

To track an object press TRACK or open the context menu (SELECT SELECT or right-click). 

 

NOTE 
From 7.3 the number of channel columns that will be displayed as the result 
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of a search has been expanded from previously 30 to 100.  

You can press MODIFY in the first column of any track list to open the 
corresponding editor for that item. 

As long as a Track List is open the tracking commands UPDATE & 
@LEVEL and UPDATE & ATTRIB are blocked to avoid confusion. 

IMPORTANT: Be careful using track editing or unblock wizard in a show 
where presets appear in multiple sequences or on masters as well as 
sequences, since the changes follow through in all places. 
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Track - Lists 
Press TRACK to open the track list.  

 

Any selection of channels/effect playbacks can be tracked. Once the Track List is opened you can  

• View and edit levels directly.  
• Select multiple cells by holding SELECT and using arrow keys.  
• Press DELETE to delete the data in a cell.  
• Enter a number and press MODIFY to set referenced data like palettes for parameters.  
• Enter a number, hold C/ALT and press MODIFY to set absolute data for parameters.  
• Use the WIZARD to select how far forward you want to track the value of the currently 

selected step.  

 

NOTE 
In all Track Lists with attributes (Seq, Preset, Palettes), both attributes and 
levels can be toggled on/off. See Track Channels - Show Levels & Attributes. 

Open any editor directly by pressing MODIFY in that column. 
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Track List - Functions 

Column  Action Feedback 

Step [MODIFY] Opens the Sequence List 
focused at this Step. 

Preset [MODIFY] Opens the Preset List 
focused at this Preset. 

Text No Input Shows the Step Text. 

Mode [MODIFY] Opens the Sequence List 
focused at this Preset. 

Devices [MODIFY] Opens the Preset Attribute 
List for this Preset. 

Channel/Device cells [#] [MODIFY] Sets an intensity or 
 reference data for the 
selected cells. 

Channel/Device cells [DELETE] Delets intensity or data for 
the selected cells. 

Parameter cells [#] [C/Alt] & 

[MODIFY] 

Sets absolute data for the 
selected parameter cells 
when the parameter editing 
default is set to Palettes. 
Sets a Palette number when 
the parameter editing 
default is set to abslute 
data. 

Parameter cells [WIZARD] Track the level from the 
current cell forward to any 
step selected in the 
dropdown. 
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Track List - Show Levels & Attributes 

In all Track Lists with attributes, the attributes and levels can be toggled on/off with the following 
functions. 

Function  Column Feedback 

Levels [FORMAT] & 

[@LEVEL] 

The intensity column is 
toggled. 

Focus attributes [FORMAT] & 

[FOCUS] 

The Focus parameter 
columns are toggled. 

Color attributes [FORMAT] & 

[COLOR] 

The Color parameter 
columns are toggled. 

Beam attributes [FORMAT] & [BEAM] The Beam parameter 
columns are toggled. 

Parameters [FORMAT] & 

[Parameter_Key] 

Specific parameter columns 
are toggled 

Example - show a single parameter (Prism, for example) 
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Track - Channels 
The current channel selection can be tracked in Sequences, Chases, Presets, Groups and all kinds of 
Palettes (Focus, Color, Beam & All). 

Once the channel(s) are selected there is a key combination of TRACK and some other key to activate 
the corresponding tracking tab.  

You can delete attribute values by pressing DELETE in a cell. There is no undo for this. (5.0)  

Track Channels - In Sequences 

Track the current channel selection in a Sequence or Chase. 

Function   Key Feedback 

Main Playback. [TRACK] Track List for Sequence in 
Main Playback is opened* 

All Sequences [TRACK] & [SEQ] Track List for all 
Sequences is opened 

A Master Playback [TRACK] & 

[Master_Key] 

Track List for Sequence in 
Master Playback is opened 
providing the master setting 
is "Selected Channels"  

*Track list for the Sequence of the Main Playback 
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See Track Channels - Show Levels & Attributes. 

Track To Wizard 

If you press WIZARD on a level in a sequence step, you will get a popup where you can select up to 
which Sequence Step the same level should be changed (= Tracked To). 

 

Track Channels - In Presets 

Track the current channel selection in all Presets. 

Function   Key Feedback 

Presets [TRACK] & 

[PRESET] 

Track List for Presets is 
opened 

See Track Channels - Show Levels & Attributes. 

Track Channels - Groups 

Track the current channel selection in all Groups. 

Function   Key Feedback 

Groups [TRACK] & [GROUP] Track List for Groups is 
opened* 
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Track Channels - Palettes 

Track the current channel selection in Palettes (Focus, Color, Beam, All).  
See Track Channels - Show Levels & Attributes. 

Function   Key Feedback 

Focus Palettes [TRACK] & [FOCUS] Track List for Focus 
Palettes is opened 

Color Palettes [TRACK] & [COLOR] Track List for Color 
Palettes is opened 

Beam Palettes [TRACK] & [BEAM] Track List for Beam 
Palettes is opened 

All Palettes [TRACK] & 

[PALETTE] 

Track List for All Palettes 
is opened 

Example: Track list for Focus Palettes 
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Track Channels - In The Play 

Track the current channel selection in Sequences, Presets, Groups and Palettes. 

Function   Key Feedback 

Play [TRACK] & 

[CHANNEL] 

Track List for Play is 
opened* 

*Track list for Play 
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Track - Presets 
A Preset can be tracked through the current Play. The TRACK function used in the Browser will 
produce a listing of all sequences and steps where that Preset is used in the current play.  

Track a Preset in the Browser 
Select the preset under the Preset Node in the Browser (F10) and press TRACK (F12) or use the 
context menu Track command (SELECT SELECT or right-click). 

 

Track list for tracking Preset 3.0 from the Browser: 
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Track a Preset in the Organizer 
Select the preset under the Preset Node in the Organizer tab and press TRACK (F12) or use the 
context menu Track command (SELECT SELECT or right-click). 
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NOTE 
The Track command can only be used on objects within the current play and 
not in the Organizer (Import From) tab. 
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Track - Palettes 
All types of Palettes can be tracked through the current Play. This is done by selecting the Palette in 
the Palette node of the Browser (F10) and pressing TRACK. 

Function   Key Feedback 

1. Open the "Palettes" node 
in the Browser 

See Navigating - 
Browser 

Palettes node is selected 
and opened 

2. Open a Palette type 
(Focus, Color, Beam, All) 

See Navigating - 
Browser 

A Palette node is selected 
and opened 

3. Select a Palette See Navigating - 
Browser 

A Palette is highlighted 

4. Track this Palette [TRACK] Track List for Palette # is 
opened* 

*Track list for tracking Color Palette 3.0 from the Browser. 
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Track - Track Editing 
Track editing is a very powerful way to edit in a Sequence and very similar to how editing is done in a 
"tracking style console". It are used to save time when the same type of change is wanted in a series of 
Presets. There are some simple rules and they are described in this chapter.  

Pressing TRACK opens the track list. Holding UPDATE and pressing @LEVEL or ATTRIB will 
initiate the  track editing dialog. 

 

Track Editing - Intensities 

Intensity changes in a Preset (for all channels) can be tracked forward and/or backward. When an 
Intensity Block is set they will stop. This can be set in the Sequence List. See Sequences - Block 
Values. 

1. Make level changes in a Preset 
2. Hold UPDATE and press @LEVEL. A track popup will open. 

 

3. Select forward, backward or both. 
4. Confirm. 

 



Cobalt 8.1 - 20181029 

519 

 

NOTE 
Each channel will be tracked individually until the position where the level 
changes value. Dialog shows the number of channels that will be affected.  
 
A step in the sequence set to Block Tracking will prevent levels from tracking 
through beyond that step (the step with the block is always tracked through). 
Both forwards and backwards.  
 
To set a block on individual channels in a step – set the intensity to 1% higher 
or lower on those channels you wish to block. 

Track Editing - Update Attributes 

Attribute changes in a Preset (for all channels) can be updated to the Preset where they were last 
changed.  

1. Make level changes in a Preset 
2. Hold UPDATE and press ATTRIB. A track popup will open. 

 

This dialog includes the possibility to track forwards/backwards/both directions like the intensity 
dialog. 

Record if changed looks up the sequence on the main playback and finds the source of the tracked-in 
attribute(s) and makes the update in that preset.  
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Record if Active updates many presets, forwards, backwards or in both directions from the current 
preset, until a different value or a block instruction is encountered.  

3. Confirm. 

NOTE 
If you have RECORD set to ACTIVE the console will insert data where 
required in previous and7or subsequent steps when this editing is used. 

Track Editing - Unblock Attributes 

If you have been recording all device parameters in every preset and wish to remove all redundant 
parameter values from the sequence in the main playback there is an Unblock function can be 
accessed by pressing WIZARD in the Sequence List.  

 

It will remove all duplicate parameter values for Devices in the sequence in the main playback. You 
can select the start and stop step for this operation. 

1. Open the Sequence List for Sequence # by entering # SEQ. 
2. Press WIZARD to open the unblock Wizard. 

 

3. Make your selection and confirm. All redundant parameters will be deleted. 
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Parked 
Park allow you to Park any part of a channel or device at a constant value. 
The Park status is stored with the play.  
Keyboard shortcut = Z. 

This chapter contains the following sections 

• Park - Introduction   
• Park - Parking Values    
• Park - Edit Parked Values  
• Park - Un-parking Values  
• Park - Parked Items List 
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Park - Introduction 
The PARK key is used in combination with other keys to park data. 

 

Park allows you to Park the output of any part of a channel or device at a constant value.  

• Parked values are indicated with PARK in the Channel view and the Info box of the Browser 
when the channel is selected.  

 

• A parked channel or parameter can still be altered and recorded blind.  
• Park can be held and used with  

@LEVEL 
CH 
ATTRIB 
FOCUS 
COLOR 
BEAM 
U1-U3 
Wheel parameter keys.  

• There is a softkey UNPARK for unparking parts of a channel or device.  
• In Live Attributes PARK and UNPARK are used for selected cells.  
• There is a PARK tab for viewing and clearing Parked values. MODIFY & PARK.  
• Keyboard equivalent = Z 

NOTE 
Park replaces the Constant feature of older versions than 4.2. 
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Park - Parking values  
The PARK key is used to park channels, parameter groups (F, C, B) or parameters.  

 

The Parked status is indicated in the status part at the top of the screens in blue, in the Live channel 
view for each channel ("PARK") and in the attribute views (dimmed).  

There is a Parked items list that is opened with MODIFY & PARK.  
You can hold PARK and press several different values consequently. 

Function   Key Feedback 

Channel [PARK] & 

[CHANNEL] 

Park all values of the 
selected channel(s) 

Level [PARK] & [@LEVEL] Levels are parked. 

Attributes [PARK] & [ATTRIB] Attributes are parked. 

Focus [PARK] & [FOCUS] Focus parameters are 
parked. 

Color [PARK] & [COLOR] Color parameters are 
parked. 

Beam [PARK] & [BEAM] Beam parameters are 
parked. 

U1-U3 [PARK] & [U1-U3] U1-U3 parameters are 
parked. 

Parameter [PARK] & 

[Wheel_key] 

Single parameter is parked. 
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NOTE 
PARK applies to the selected cells when an Attribute View is open. 
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Park - Edit Parked Values 
Parked values can be edited in the PARK column of the Channel and Output lists. Select the cell, enter 
a value and press MODIFY (or click).  

Channel List 
Open by holding MODIFY and press CHANNEL. See Patch - Channel List. 

 

Output List 
Open from Browser (Browser >Settings & Tools >Output Lists >). See Patch - Output List. 
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Park - Un-parking Values  
The UNPARK key is used in combination with other keys to unpark values.  

 

The Parked status is indicated in the Live channel view ("PARK") and in the attribute views 
(dimmed). The key UNPARK is also available in the Misc Soft Key Menu. 

You can hold the soft key UNPARK (Misc) and press several different items consequently. 

Function   Key Feedback 

Channel [UN-PARK] & 

[CHANNEL] 

Unpark entire Channel (Intensity and all 
parameters) 

Level [UN-PARK] & 

[@LEVEL] 

Levels are un-parked. 

Attributes [UN-PARK] & 

[ATTRIB] 

Attributes are un-parked. 

Focus [UN-PARK] & 

[FOCUS] 

Focus parameters are un-parked. 

Color [UN-PARK] & 

[COLOR] 

Color parameters are un-parked. 

Beam [UN-PARK] & 

[BEAM] 

Beam parameters are un-parked. 

U1-U3 [UN-PARK] & 

[U1-U3] 

U1-U3 parameters are un-parked. 

Parameter [UN-PARK] & 

[Wheel_key] 

Single parameter is un-parked. 

Unpark a parameter or parameter group  

Hold UNPARK and press 

[FOCUS] [COLOR] [BEAM] [U1] [U2] [U3] [Wheel_Keys] 

Un-park all values of the selected channels and devices 
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[C/Alt] & [PARK] 

or  

[UNPARK] & [CHANNEL] 

There is a Parked items list that is opened with MODIFY & PARK where it is possible to un-park as 
well with DELETE. See Park - Parked Items List.  
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Park - Parked Items List 
Hold MODIFY and press PARK to open the Parked Items List. 

 &  

The Parked Items list shows all parked channels, intensities and attributes. 
Individual items can be unparked by selecting the appropriate row and pressing [DELETE].  
See Parked. 
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>Settings and Tools - Channels 
These are the functions in the Settings and Tools node for Channels in the 
Browser. 

This chapter contains the following sections 

• Channel Database & Autogroups  
• Magic Sheets  
• Channel Partitions  
• Remote Controls 
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Channel Database 
You can give each channel up to four text labels (ABCD). From these texts "auto-groups" are 
automatically created. The auto-groups are available from the Direct Selects. 

Any moving device that is patched will automatically show up on the Name List as well, which allows 
you to select all "Stage Zooms" or "Scrollers" without creating any groups in advance. 

The Channel Database is opened from the Browser (Browser >Channels >Settings & Tools >Channel 
Database). 

 

Set Channel Texts For The Database 

There are three ways of setting text to channels in the Channel Database (Browser >Patching 
>Channel Database). 

Method 1 
In the Channel Database cells directly 

Action Key Feedback 

Set a text in a cell(s) Select any cell(s) in the 
ABCD columns 

Press MODIFY, enter a 
text and press MODIFY 
again to confirm. 
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Method 2 
In the Channel Database with a Wizard 

Action Key Feedback 

1. Select text column Select any cell(s) in the 
ABCD columns 

Cell is highlighted 

2. Open the Wizard [WIZARD] Text Wizard is opened 

3. Select channels Channel functions Channels appear in Text 
Wizard 

  

Action Key Feedback 

4. Enter Text Text cell Select text cell, Press 
MODIFY, enter a text and 
press MODIFY again to 
confirm. 

5. Confirm Execute button Select Execute, Press 
MODIFY to confirm. 
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Method 3 
In any channel view 

Action Key Feedback 

1. Select channels Channel functions Channels are highlighted in 
yellow 

2. Open Text Wizard [CHANNEL] & 

[TEXT] 

Text Wizard is opened. 
You can set text ABCD and 
EXECUTE. 
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NOTE 
You will not get a warning if you are overwriting existing texts. 

Auto Groups - From Database and Templates 

The Auto Groups are channel handles that are created automatically for any type of device patched in 
the device list, and for the different text lables assigned in the Channel Database.  

For example, if you patch a moving device with the template "VL2500Spot", an autogroup with this 
name will appear in the Direct Selects for Auto Groups. Click to select all patched devices of this 
type. See Auto Groups in Cobalt Direct Selects - Types of Data.  

In the same way, if the text label "Par64"is given in the channel database to a number of lights, an 
Auto Group will be created, and can be used to select all channels with this tag.  

Click to select the channels, click and drag to set a level directly.  

 

NOTE  
When you patch compound devices or multichannel devices with decimal 
channels, three Auto Groups will be created: 
 
- All (base channels and subchannels) 
- Only subchannels 
- Only base channels  

Channel Database - Import Text File Wizard 

The Channel Database can import any comma or tab-delimited file and assign four text fields to the 
text fields (ABCD) of the database. This makes it possible to import data from programs like 
Lightwright, Excel, Word, Wysiwyg and such.  

The file has to have the ending .txt and is opened from the Browser (Browser >File >Import from...).  
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Follow the instructions (1, 2, 3) and import the texts. You can save your mapping and reuse if you 
want to import a similar file later.  

1. Select the delimiter used by the file you are importing. 
2. Select which columns that should be mapped to the internal channel database fields. 
3. If you want, choose to store the mappings under a given name for later reuse. 

  

Field description 

Setting  Feedback 

Text file format Choose if the file you are importing is tab or comma 
delimited. 

Map to columns Channel numbers, and text to each column. 

Use column headers in 
Channel Database 

The source file headers will be displayed instead of 
TEXT A, B, C, D. 

Use existing mapping Use this mapping or select a previously stored 
mapping. 

Save as new mapping Save this mapping for later use. 

Name for new mapping Name for this mapping when saving. 

   

Import Text File - LightWright 

It is easy to import Channel Database texts from LightWright. Here are some good things to know.  

You can download the Lightwright demo from http://www.mckernon.com. The demo works fine and 
you can even save shows (it has a limit of 75 units). It also contains a demo show. 

Export Format  
In Lightwright, data can be exported to tab or comma separated *.txt files.  We recommend tab 
separated files, since comma separated files can cause problems with data that includes commas. This 
is found under File > Export > Data. In this popup you can also select which data to export. 

Uncheck Items 
We suggest you select which items to export in the export popup mentioned above, or you will have 
an enormous amount of data to select from. 

Typical categories to include would probably be 

• Channel  
• Dimmer  
• Wattage  
• Purpose  
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• Position  
• Instrument  
• Type  
• Color  
• Type & Wattage  
• Color & Template. 

A suggestion for columns to import (besides Channels) into the Channel Database would be 

• Text A= Purpose  
• Text B= Position  
• Text C= Color & Template  
• Text D= Type & Wattage 

  

Uncheck Parentheses 
Lightwright seems to by default use parentheses (#) on channel numbers. So channel 1 in Lightwright 
is (1). 
When you export the data from LightWright, in Export options, check the option "Strip channel 
parentheses ()". If you do not check this option, the channel will be exported with the parentheses and 
Cobalt will not understand that it is a channel number.  

There is also a setting in Edit > Preferences, "Use parentheses () around channel numbers". By 
checking that box, it's also possible to get rid of the parentheses in the lists. 

Export Devices as Channels 
Check the option "For lights with attributes, export only the first row" in Export options. Otherwise it 
will export all of the attribute channels as separate channels for moving lights. 

  

LIMITATIONS 
If there are multiple items/units with the same channel number, only the item/unit data for the last 
item/unit will be imported. This is because the multiple units use the same channel number and one 
channel cannot contain different data's. In this case each unit has its own row in the exported file, so 
several rows have the same channel number. 

If the Lightwright show includes several units patched to one channel, only the last Unit# will be 
imported. 

Import Text File - Excel 

It is easy to import Channel Database texts from an Excel file. Here are some good things to know.  

If you have a nicely formatted list (check example below) and want to import this to the Channel 
Database, you need to make sure the table only has headers at the top, since these are recognized by 
the import tool. Save as a Tab delimited .txt file. 
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Example - Data in Excel easy to import 
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Magic Sheets (8.0) 
Magic Sheets are user-created graphic displays that offer customizable 
interactive views for showing data and programming.  
 
Magic Sheets replace the Channel Layouts of previous software versions. 
Previously stored Channel Layouts will be converted to Magic Sheets. 

This chapter contains the following sections 

• Magic Sheets - Introduction  
• Magic Sheets - Create New  
• Magic Sheets - Editor  
• Magic Sheets - Layout Toolbar  
• Magic Sheets - Object Libraries  
• Magic Sheets - Object Target & Attributes  
• Magic Sheets - Load and navigate  
• Magic Sheets - List  
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Magic Sheets - Introduction (8.0) 
Magic Sheets are user-created graphic displays that offer customizable interactive views for showing 
data and programming. Magic Sheet objects can be set to show data, such as channels and palettes, or 
can be representational graphics, such as scenic pieces, architecture or electrics. Magic Sheets replace 
the Channel Layouts of previous software versions. Previously stored Channel Layouts will be 
converted to Magic Sheets. 

Magic Sheets are powerful for everyone in a lighting team 

• A Lighting Designer may use them to lay out channel displays in a custom or specialized 
way.  

• An Assistant Lighting Designer may use them to track data, keep up with labels, and help the 
Designer keep track of moves, marks, discrete timing, etc.  

• A Programmer may use them to view and interact with certain portions of the rig, or to bring 
forward tools to make programming quicker.  

• An Electrician may use them for specialty views, rig-specific layouts, or data regarding the 
health of fixtures.  

• Non-Technical people can interact with Magic Sheets to accomplish tasks on the system 
without any programming knowledge, such as architectural or entertainment installations.  

• Other Production Team members may use Magic Sheets for indication of rig status that 
pertains to their area of operation. 
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1. Workspace  
2. Layout Toolbar  
3. Object Libraries  
4. Editor handle  
5. Object color, target & attributes 

General Facts 

• # FORMAT is used to open a Magic Sheet in any channel view  
• You can have up to 999 Magic Sheets   
• The same channel can exist in several Magic Sheets   
• Magic Sheets can contain any type of data besides channels 
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Navigating Magic Sheets 

• Two-finger pinch or mouse wheel to zoom  
• Two-finger drag och right-click to reposition  
• Objects can be selected by dragging a frame around any part from right-to-left  
• Objects can be selected by dragging a frame around the whole object from left-to-right  
• The Layout Toolbar has zoom options for repositioning and centering and zooming to 

selection 
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Magic Sheets - Create New (8.0) 
You can create a Magic Sheet in any channel view by entering a number # and pressing Format. This 
will give a dialog if the Magic Sheet doesn't exist.  

You can create Magic Sheets in the Magic Sheet List (Browser>Channels>Setting&Tools>Magic 
Sheets...). 

Function  Key Feedback 

1. Open the Magic 
SheetList. 

Browser >Channels 
>Settings&Tools 
>Magic Sheets... 

Opens the Magic Sheet list. 

2. Create a new Magic 
Sheet 

[#] [INSERT] A new Magic Sheet is 
inserted. 

3. Name Layout [MODIFY] Move to TEXT cell and 
press MODIFY. Give a 
name and press MODIFY 
to save and exit. 

 

To load this Magic Sheet in a channel view see Magic Sheets - Load & Navigate. To edit it click on 
the Editor Handle in that channel view, see Magic Sheets - Editor. 
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Magic Sheets - Editor (8.0) 
Once a Magic Sheet is selected in a Channel View using # FORMAT, the Editor is opened and 
closed by clicking on the Editor handle (4). 

 

1. Workspace  
2. Layout Toolbar  
3. Object Libraries  
4. Editor handle  
5. Object color, target & attributes 

Basically you open the Editor (4) to work in the workspace (1) selecting objects from 
the Object Libraries (3) using the tools in the Layout Toolbar (2). Once an object is 
placed in the workspace you can us the Object Targets (5) panel to set target, color and 
what information to show. You can group it to other objects and tie intensity and/or 
color to the frame or body.  
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NOTE 
To use a Magic Sheet (or any other console function) you need to close the 
Editor first.  

The only way to work in this editor is with a mouse/touchscreen and external 
keyboard. Commands from the console keypad are not recognized.  

Magic Sheets Editor - Object Editing (8.0) 

The easiest way to work with a Magic Sheet is with a mouse, you can manage most of the functions 
with a touchscreen as well. An object is basically following the rules you would expect in most simple 
drawing programs.  

1. Choose simple arrow  
2. Click in the Object Library on the rectangle  
3. Click to place it somewhere in the workspace and use handles to modify 

 

• Green Handle for proportional stretch  
• Blue handles for edge stretch  
• White dot handle for rotate  
• Pink handles for individual point move  
• Arrow keys move object 

Mouse Navigation Tools 

• Left click selects an object  
• Right click and hold to pan or drag the display  
• Use your mouse wheel to zoom in and out  
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• [Shift] + mouse wheel provides a fine zoom of the magic sheet 

Like in most graphical programs, selecting from left to right will open a blue window and any objects 
completely inside the box is selected. Selecting from the right opens a green window and any object 
that crosses the boundary line of is completely inside the window is selected. 

To learn about all Objects see Magic Sheets - Object Libraries. 

Magic Sheets Editor - Object Colors (8.0) 

It is possible to set outline and body color for all objects. Every object with a channel target can link 
intensity and color to either of these. You can set line weight of outlines. 

1. Select object.  
2. Select the color tools  

 



Cobalt 8.1 - 20181029 

545 

 

The color functions are the same for outline and background: 

• Select a color from the color picker  
• Use the slider to the right to change overall contrast to access more colors  
• The currently selected color is shown under the slider  
• Define a color with RGB values  
• Link to Channel Color  
• Link to Channel Intensity 

For more functions see Magic Sheets - Object Color, Target & Attributes 

Magic Sheets Editor - Object Target (8.0) 

For an object to have any function when selected in a Magic Sheet it needs to have a target.  

1. Select an object  
2. Select target 
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The possible targets include 

• Show data  
• Console buttons  
• Commands  
• Zoom and Selection functions in the Magic Sheet 

Depending on what type of target you choose the options you can set will be different. Most targets 
simply require a number as an ID. Note that when assigning decimal values to channel objects in the 
Magic Sheet, the increment value should be set to 0.01, not 0.1 as shown in the live view. 

 

You may wish to select the text fields to show the channel target and ID information. For more 
information see Object Target & Attributes - Fields. 
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A console button will require that you choose the button in a dropdown. 

 



Cobalt 8.1 - 20181029 

548 

 

For more functions see Magic Sheets - Object Color, Target & Attributes 

Magic Sheets Editor - Array, Align & Distribute Objects (8.0) 

There are different align options for a selection of objects. 

1. Select objects  
2. Click on the Align popup  
3. Select Alignment or Distribution 

 

Functions 

• Create Array - allows you to create arrays of objects. First set the object target and target 
number. After placing one object of your choice, click on {Create Array} to open an 
additional window for choosing what array type you want to use.  

o Rectangle – to create a rectangular array of objects. You can define how many 
rows, columns, and the spacing  

o Circle – to create a circular array of objects. You can define the number or count of 
objects and the size of the circle. 

• Align Settings - allows you to align objects either to the left, center, right, or top, middle, 
and bottom.  
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• Align Rotation - allows you to select multiple objects and align their rotation to the first 
object selected.  

• Distribute Horizontally - allows you to distribute objects horizontally at an equal distance 
apart between two objects. 
Set the distance you would like by placing the first and last objects.  

• Distribute Vertically - allows you to distribute objects vertically and evenly spaced. Set the 
distance you would like by placing 
the first and last objects.  

• Distribute Rotation - allows you to distribute objects at an equal rotation between two 
objects (create a circle). Set the  
level of rotation you would like by placing the first and last objects at a rotation. 

Magic Sheets Editor - Texts (8.0) 

It is possible to set a user defined text to any object.  

1. Select the object  
2. Write the text in the Text: input box  
3. Use the text tools to select color, font, size, bold, italic, underline and positioning 
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Magic Sheets - Layout Toolbar (8.0) 
The Layout Toolbar includes four basic tools that affect editing of objects in general: 

 

Function  Symbol Explanation 

Arrows and Edit 
Modes  

 

Create and duplicate objects 
incrementally 

Zoom tools  Zoom functions 

Array, align & 
distribute tools  

Aligning, distributing and 
creating arrays of objects 

Ordering/stacking tool Group and order objects  

  

Magic Sheet - Arrow Tools for Edit Mode (8.0) 

The Arrow tools for Edit Mode 
- This tool will allow you to create new objects with a preselected target and autonumber them.  

 

• Grid Enabled - toggles between a grid being displayed and no grid. With the grid enabled, 
the magic sheet will have a snap to 
grid behavior when placing objects. Hold SHIFT to override the snap.  

• Normal arrow - allows for selecting and assigning objects from the object list.  
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• Quick Layout (arrow plus) - allows for placing more instances of a selected object. When 
finished, click the {Done} button or change to the normal arrow.  

• Quick Number - used to quickly assign target numbers to objects. While in quick number 
mode, clicking on an object will assign the selected target and increment the target numbers.  

• Target - used to specify object, starting target number, and increment for use in quick 
number mode. 
− Object - assigns the object from the list. 
− Start - assigns the starting target number. 
− Increment - assigns what increment the target numbers will use after the start number. 

Magic Sheet - The Zoom Tools (8.0) 

The Zoom tools 
- These zoom options do exactly what they say.  
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Magic Sheet - Array, Align & Distribute (8.0) 

The Array, Align & Distribute tool 
 

 

See Magic Sheets Editor - Array, Align & Distribute Objects  

  

Magic Sheet - Ordering/Stacking (8.0) 

The Ordering/Stacking tool provides basic drawing functions for ordering and stacking objects in 
relation to each other. 
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Each magic sheet is made up of multiple layers. Objects can either be placed on their own or stacked 
on top of or beneath each other. 

• Group - allows you to group objects together so they can be moved and rotated like a single 
object.  

• Ungroup - removes grouping.  
• Send Backward - will send an object back a layer.  
• Bring Forward - will move an object up a layer.  
• Send to Bottom - will send an object beneath all other objects.  
• Bring to Top - will stack an object on top of all other objects. 
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Magic Sheets - Object Libraries (8.0) 
The Object Libraries provide access to symbols and objects, and you can import your own as well. For 
information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - 
Object Editing. 

 

Function  Symbol Explanation 

Object Types General and specific objects 
that can be tied to play data  

Channel Objects Channel objects, user symbols 
can be imported 

Import Images  Import and use image files 

Background settings 
 

Set a specific 
color/gradient/image for the 
live and blind background 

  

Magic Sheets - Object Types (8.0) 

Objects 
These are different object types and some are general shapes (like rectangles) while others have 
primary uses (like the clock) but they can all be assigned a target, for example a truss can activate a 
group of channels. For information on how to select, place and arrange objects in the Library, see 
Magic Sheets Editor - Object Editing. 
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Function  Symbol(s) Explanation 

Button 

 

A blank button that can be 
assigned to any target. Any 
other object can function as a 
button as well.  

Channel icon Mirrors indicators from any 
channel view. 

Fader Set any console fader as target. 

Text Places a text. 

Clock A clock.  

Line 

 

Draws a line, can be used for 
fixture pipes or dividers 
between butons for example. 

Truss Places truss.  
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Shapes Places shapes. Can be used to 
make invisible buttons over 
background images. 

Free Shapes  

 

Create free form objects with or 
without fill. Press ESC 
(external keyboard) to finish. 

Free Line/arrow 

 

Create free form lines or multi 
form arrows. Press ESC 
(external keyboard) to finish. 

Pixel Grid 

 

Set target to an Effect Layout to 
create a pixel grid for image 
effects. See Effect Libraries. 

Media Server Set target to a media server 

Magic Sheets - Channel Objects (8.0) 

Channel Symbols 
For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - 
Object Editing. 
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Magic Sheets - Import Images (8.0) 

Import images 
For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - 
Object Editing. 
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Images from the third tab can be imported into magic sheets to be used as background images or as 
icons. You can use a graphics image file as a background or icon. The following is a list of accepted 
image formats: .bmp, .gif, .ico, .jpg, .pbm, .pgm, .png, .ppm, .svg, .svgz, .tga, .tiff, .xbm, and .xpm.  

• The maximum image size allowed is 1920 x 1920.  
• You will need to have the images on a USB drive to import them into the desk.  
• Once an image has been imported, it is saved with the show file. 

To import an image: 
Step 1: Click on the import image icon. A separate window will open displaying any found USB 
drives. 
Step 2: Select the appropriate drive. 
Step 3: Navigate to the file you use to upload. 
Step 4: Click on the file and then press {Ok}. It will now appear in the images tab. 

Click on an image to select it. To use as an icon, drag and drop the image onto the magic sheet. You 
will be able to resize it. 
Background images need to be set in the background settings tab. You can also adjust the background 
settings there. 

Magic Sheets - Background Settings (8.0) 

You can set a solid color, gradient or image as a background for a Magic Sheet.  
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Solid – use Red, Green and Blue to select a color or click on the small square next to ‘Red’ to open a 
color picker, complete with saturation bar on the right. Note the X closes the color picker. 

Gradient – select top and bottom colors and display will scale between the two colors 

Image -- click on the image icon to select a background image, set width, height and opacity, options 
for inverted or normal. Currently accepts image files: jpg, tif, bmp, png. 
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Magic Sheets - Object Target & Attributes (8.0) 
Any object can be set to any target in the Object Target panel. This is also where you can define the 
information shown and how that information is aligned, and where you can connect intensity and 
color to outline or body of a channel object. 

Select any object(s) and choose targets and attributes: 

   

• Color  
• Font  
• Target  
• Text  
• Command  
• Fields  
• Scroller  
• Field 1-6  
• Position  
• Size  
• Rotation  
• Items 
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Object Target & Attributes - Line & Color (8.0) 

You can customize objects and fixture symbols in numerous ways found in the Object Properties area. 

   

• Color - the object’s outline line weight, outline and fill colors can be adjusted here. 
• The object’s outline and fill colors can be linked to channel color or linked to 

channel intensity. 
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Object Target & Attributes - Fields (8.0) 

Up to six different fields of custom information can be displayed per objects.  

 

Fields can display the following data for objects where this is relevant: 

• Target ID  
• Fixture Type  
• Target Name  
• Label  
• Text A, B, C, D (from the channel database)  
• Intensity  
• Intensity Bar  
• Color Swatch  
• FCB Summary  
• Focus  
• Color  
• Beam  
• Status 

The Font (Abc) icon allows the means to adjust the font type, size, color and style (bold, italic, 
underline) of each individual field. Used also to change the size and color of an intensity bar 

The alignment of the each field can be set by selecting a position on the grid of the Alignment icon 
next to the font icon. 
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Magic Sheet - Palette times (8.1) 

You can execute any type of palette in a Magic Sheet with a time by entering a fresh number before 
clicking on that palette.  

For a button or object to be a palette, set the target, see Magic Sheets Editor - Object Target. 
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Magic Sheets - Load & Navigate (8.1) 
These are the functions to load and navigate a Magic Sheet in a channel view. 

Function  Action Feedback 

Load  [#] [FORMAT] Magic Sheet # is loaded in the 
currently selected Channel View. 

Load from Browser 
(8.1) 

[MODIFY] The selected MS is loaded in the 
currently selected Channel 
View. You can also double-click. 

Zoom  Two-finger pinch or 
mouse wheel 

Zoom in Magic Sheet. 

Move  Two-finger pinch or 
right-click and drag 

Reposition Magic Sheet. 

Zoom functions In the layout tools 
under the magnifying 
glass 
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Magic Sheets - List (8.0) 
This list is used to create a Magic sheet for editing with the edit functions - see Magic Sheet - Editor. 
Enter a number (#) and press INSERT to create a Magic Sheet in the Magic Sheet list (Browser 
>Channels >Settings & Tools >Magic Sheet). 

 

The Magic Sheet will be created and can be selected in any Channel View by # FORMAT 

Magic Sheet List - Columns & Functions (8.0) 

Function  Key Feedback 

Magic Sheet  The ID of each Magic Sheet. Cannot be 
changed. 

Text [MODIFY] Press MODIFY to activate and end text 
input. This text is shown in the lower 
right corner of the channel views. 

Auto Selectable [MODIFY] Enables Auto-Select* 

Delete Magic 
Sheet 

[DELETE] Deletes the currently selected Magic 
Sheet. Cannot be undone. 

Insert a new Magic 
Sheet # 

[#] [INSERT] Inserts a new Magic Sheet** 

Copy a Magic 
Sheet 

[COPY] Copies the selected Magic Sheet 

Paste a Magic 
Sheet 

[#] [PASTE] Pastes a copied Magic Sheet to a new 
layout # 

*If you select a channel that is included in a layout marked as "Auto-selectable", this layout will be 
selected. If the same channel is included in several layouts, the first Auto-Selectable one will be 
selected. 
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Channel Partitions 
A channel partition is a definition of a limited set of channels and attributes. 
When activated, only these channels can be accessed. 

This chapter contains the following sections 

• Partitions - Introduction  
• Partitions - List  
• Partitions - Create  
• Partitions - Activate  
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Partitions - Introduction 
A partition is a definition of a set of channels/devices. Every Partition has a permission mask which 
defines if the Partition is applied to 

• IFCB  
• Intensity  
• Intensity/Color  
• Intensity/Focus/Beam/Other 

Partitions can only be activated by users that have permission to activate them. Once a Partition is 
active, it limits the access to these channels. The following functions are filtered through the Active 
Partition: 

• The channel selection (only allowed channels can be selected and viewed)  
• Parameter access (non-allowed attributes are not shown in Attribute Views)  
• Recording of attributes or intensities 

Non-allowed Partitions for the current logged in User are indicated with --- in the Partition List. Every 
partition can have a text label.  

NOTE 
The default Partition "All" allows access to all functions of all channels. 
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Partitions - List 
Open the Partition List from the Browser (Browser >Channels >Settings and Tools >Channel 
Partitions).   

You can view, edit and create new Partitions in this list.  

 

Partitions List - Columns 

Function  Key Feedback 

Partition  The ID of each Partition. Cannot be 
changed. 

Text [MODIFY] Press MODIFY to activate and end text 
input. This text is shown in the top bar 
of the channel views. 

Active [MODIFY] Toggles the Partition on/off. * 

Apply to [MODIFY] Opens a dropdown where it is possible 
to select if the Partition applies to IFCB, 
I, C, FB/Other. 

* If a User is logged in that does not have permission to activate a Partition, the Active cell will show 
"---". See User Login.  

NOTE 
The default Partition "All" is always defined to allow access to the full 
system. 
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Partitions - Create 
Partitions are created in the Channel Partition List. 

1. Open the Channel Partition List (Browser >Channels >Settings and Tools >Channel 
Partitions)  
 

 

2. Press INSERT  
3. Select channels (they will show up in the Channel View part).  
4. Press RECORD or UPDATE to store the channel selection.  

 

 
 

5. Press MODIFY in the TEXT cell to give a name to this Partition  
6. Press MODIFY in the APPLY TO cell to choose permission level (IFCB). 
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Partitions - Add Partition Wizard 

There is a Wizard to assist you in creating Partitions using Play information that already has been 
generated. 

1. Open the Partition List (BROWSER >Setup >Partition List)  
2. Press WIZARD. 

 

 

These are the different options. 

Add by Device Type 
Choose a Template corresponding to the Device Type, and what it applies for (IFCB, Intensity, Color, 
Focus/Beam/Other). 

Add by Channel Database Text 
Enter the Database Text you wish to search for, and what it applies for (IFCB, Intensity, Color, 
Focus/Beam/Other). 

Add by Channel Number 
Select a channel range from channel # to channel #, and what it applies for (IFCB, Intensity, Color, 
Focus/Beam/Other). 

Add by Magic Sheet 
Choose channels corresponding to a Magic Sheet. 
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Partitions - Activate 
Partitions are activated from the Partition List. 

1. Open the Partition List (Browser>Channels>Settings and Tools>Channel Partition)  
2. Press MODIFY in the ACTIVE cell to toggle on/off. The active Partition is indicated in the 

yellow info banner at the top of all Channel Views. 
 

 

   

NOTE 
If no Partition is active, all channels are available, and shown in the Live 
View. 

In Live Attributes, only channels and attributes that can be controlled are 
shown. 

  

NOTE 
REFRESH with no channels selected will affect all channels in the Playback 
including channels outside the Partition. 
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Devices 
A channel with any attributes (parameters) in addition to intensity is called a 
Device. This includes scrollers, moving lights and media servers. 

  

Devices Node 

 

This chapter contains the following sections 

• Devices - Introduction  
• Devices - Functions  
• Live Attributes  
• Gel Picker  
• All Palettes  
• Focus Palettes  
• Color Palettes  
• Beam Palettes  
• Mask  
• >Settings & Tools 
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Devices - Introduction 
A Device has to be Patched before you can start controlling it. See Patch Device(s). 

Devices - Controls 

• Select a channel to get control of a Device.  
• The Main Display of the console has wheels and keys for controlling Moving Device 

parameters.  
• Position pan/tilt with the trackball or wheels.  
• There is a special Device mode for testing.  
• Load and change templates at any time   
• There is a soft key page for lamp strike.  
• Select odds and evens at any time with the Selection tool.  
• Fan and align any kind of parameter   
• Mask any parameter or group of parameters  
• Special functions for scrollers with rolls and calibration. 

Devices - Views 

• The Live Attribute View shows all parameters for selected devices. 

Devices - Palettes 

• Store reference Palettes for Focus, Color and Beam (or All).  
• Select all active devices using a palette - "all blue" or "all centre stage".   
• Store palettes for "all of the same type" and reuse (for color mixing).  
• Palettes are quickly accessible from the Direct Selects.  
• Load Palettes to Masters and fade selected channel(s). 

Devices - Playing Back 

• Play back Devices from any playback.  
• Parameters can follow the fader.  
• Any device parameter can be assigned to a Master Playback  
• There is a GoOnGo or GoInB function (Move while dark)  
• Times can be set to follow In, to groups (FCB), devices or single parameters. 

Devices - Focusing Mode 

• Next & Last Mode  
• Highlight Mode  
• Palette Focusing Mode 

Devices - Effects 

• Use Effects to create patterns of intensity, color or movement such as circles or fly-outs.  
• Define your own Effects 
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Devices - Templates 

• Edit a template at any time  
• Create your own templates  
• Change a template (device) for another 

Devices - Multicell Devices (7.1) 

A device that has more than one set of intensities or color sources. The challenge in controlling this 
type of devices is that there may be several intensity controls, and multiple cells of color mixing light 
sources that can be controlled both individually and as a group.  

Sometimes these fixtures are controlled as one unit, with pan/tilt and overall intensity - and at the 
same time it is desirable to have individual control of each cell to be able to create effects, fanned 
intensities, or pixel mapping.  

Examples of multicell devices. 

• A moving device with individually controllable cells of LEDs, such as the Clay Paky B-Eye.  
• A multicell striplight, like the ETC Selador 63.  
• An LED-array such as the Martin EvenLED.  

Channel Selection of multicell devices 
There are a number of channel selection functions to optimize selecting channels and subchannels in a 
multicell or decimal device. Three Auto groups are created: xxx (all), xxx (base) and xxx (decimal). 

Selection logic for touch screen/mouse operation  

• Clicking on a base channel will now select the base channel, not the related decimal ones.  
• Holding SELECT while clicking on a base channel will expand the related selection 

operation to include the associated sub channels.  
• Holding THRU when clicking on a channel after selecting one, will select a range of 

channels 
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Selection logic for channel selection from numerical keypad with default Cobalt syntax (RPN mode). 
See also Select Channels >> 

Select Function Key Explanation 

Select complete device [1] [CHANNEL] Selects the base channel 
and all decimal channels 

Select only base channel [1] [.] [0] 

[CHANNEL] 

Selects only the base 
channel. 

Works with 
PLUS/MINUS/THRU  

Select only decimal 
channels 

[1] [.] [1] 

[CHANNEL] 

Selects only the decimal 
channel.  

Works with 
PLUS/MINUS/THRU  

Invert base/decimal [INVERT] & [.] Inverts the current 
selection between base 
channels and decimal 
channels 

Clear selected channels [C/Alt] [C/Alt] Clear  
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Selection logic for channel selection from numerical keypad with AT Mode. Note that a channel will 
not appear to be selected on the screen until the next command is pressed, such as @LEVEL.  

Select Function Key Explanation 

Select complete device [1]  Selects the base channel 
and all decimal channels 

Select only base channel [1] [.] [0] Selects only the base 
channel. 

Works with 
PLUS/MINUS/THRU  

Select only decimal 
channels 

[1] [.] [1] Selects only the decimal 
channel.  

Works with 
PLUS/MINUS/THRU  

Invert base/decimal [INVERT] & [.] Inverts the current 
selection between base 
channels and decimal 
channels 

Terminate a selection 
command  

[.] [.] To terminate a channel 
selection without pressing 
@LEVEL, press the 
decimal point twice. 

Clear selected channels [C/Alt] [C/Alt] Clear  
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This is what the template for a multicell device such as the Martin EvenLED looks like in the Device 
List (Browser>Patching>Device List) 

 

In the Channel Views there is a tool for toggling how decimal channels are shown 

 

Devices - Compound Devices 

A compund device is a device made up of several separate devices, for example a moving light yoke 
with a fixture and a separate color changer. You may also say, that any single device that has more 
than one DMX address and that you wish to control as if it were one device - is a compound device.  



Cobalt 8.1 - 20181029 

578 

 

In the case of a scroller, this is handled automatically by assigning the scroller to the dimmer 
controlling the intensity of the fixture. In any other case, use a compund device template.  

All parameters of all parts of a compound device will be shown as attributes when this device is 
selected. 

This is what the template for a compound device can look like 

 

Devices - Media Servers (8.1) 

Cobalt can download media names and thumbnails from Media Servers that support CITP/MSEX, eg 
Arkaos and Hippotizer. 

To use this 

1. First patch the media server as normal. 
2. To connect and download/update, type the channel number of the first layer, and press 

modify on the media server in the Browser. 
This download process will take some time, depending on how much media there is. 

Each time you connect, the media names and thumbnails will be updated and stored in the media 
server layer personality template in your showfile. 

Cobalt assumes that all the media servers of a given type in a show have the same set of media. 
If you have multiple media servers with different media, make a copy of the Layer template for each 
server 
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Devices - Functions 

These are the general device functions. 

This chapter contains the following sections 

• Device Control  
• Device Views   
• Device Recording  
• Device Palettes  
• Device Times  
• Device Playback  
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Device Control 
The Main Display section of the console is optimized for working with 
functions in moving devices.  

These are the sections in this chapter 

• Device Control - Introduction  
• Device Control - Lamp Control  
• Device Control - Home Positioning  
• Device Control - U1-U2-U3  
• Device Control - Align  
• Device Control - Fan  
• Device Control - Fetch/Copy  
• Device Control - Highlight Mode  
• Device Control - Flip  
• Device Control - Moving Light Dock Area  
• Device Control - Select Changed 
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Device Control - Introduction 
When you select the channel(s) of a moving device(s) (see Channels - Command Syntax) - all controls 
are automatically mapped to this section (and to the Device Controls Tab). 

1. Parameter group 
2. Parameter name 
3. Parameter wheel 
4. Parameter wheel key  
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Device Controls - Functions 

Number  Function Explanation 

1 Parameter Groups* Parameters are divided into three categories, 
Focus, Color and Beam. Select category by 
pressing one of these keys. All available Device 
Parameters within this category are mapped to 
the Wheels and shown in the display above 
them (2). If there are more than four 
parameters, press the category key again for the 
next set. 

2 Parameter name Each wheel has a section of the display 
dedicated to it. In this section the parameter 
type is displayed on top, and the current value 
(or Palette name) under. If there is a range 
number it is displayed. 

3 Parameter Wheel Move the parameter wheel to set a value. For 
16-bit control move slowly, for 8-bit control 
move fast. 

4 Wheel key with value Press to toggle between zero and full. Enter a 
number and press the key to set a value.  

 Wheel key with list Hold wheel key to get the sublist in the display. 
Use the wheel to select, and let go to activate. 
Enter a number and press the key to select a 
range. 

*All parameters of a moving device are grouped into four groups of functions.  

Focus = Pan and tilt 
Color = all color functions such as CMY, color wheels etc 
Beam = everything else 

Intensity = is stored in Presets 

Control parameters = are usually not stored, but can be included or excluded by using Masks.  
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Device Control - Lamp Control 
The LAMP CONTROL key in the programming section activates the Lamp Control Soft Key Page 
with functions which are defined in the template of each device.  
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Control Soft Key Page - Functions 

In Cobalt hardware there is no need to hold ENABLE with lamp control functions, in older hardware 
the following rules apply: 

Action  Soft Key Feedback 

Enable [ENABLE] This key has to be pressed 
together with Lamp 
On/Off/Reset to activate 
them (as a safety measure). 

Lamp Idle [ENABLE] & 

[Lamp_Idle] 

The Device is set to it's 
Lamp idle value 

Lamp On [ENABLE] & 

[Lamp_On] 

A lamp strike is set to the 
selected channel(s) 

Lamp Off [ENABLE] & 

[Lamp_Off] 

A lamp off is set to the 
selected channel(s) 

Reset [ENABLE] & [Reset] A lamp reset is set to the 
selected channel(s) 

NOTE 
These functions are Device and Template Specific. Check the manual and 
template of each Device.  

Control parameters are not stored in Presets. 

Press HOME ATTRIB after a Lamp On/Off/Reset, or lamp idle, to avoid 
sending control commands to the lights forever. 
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Device Control - Home Positioning 
The HOME ATTRIB key in the programming section allows you to set devices or parts of devices to 
their home position. Home positioning of a device means setting all parameters (or part of them) to the 
default values defined in the template of this device. Normally this means setting pan and tilt to 50%, 
color to white and all other parameters to neutral. (See Devices - Templates) 

 

These functions apply to the currently selected channel(s) 

Action  Key Feedback 

All attributes [HOME_ATTRIB] 

[HOME_ATTRIB]  

All parameters are set to 
home 

Focus [HOME_ATTRIB] & 

[FOCUS] 

Focus parameters are set to 
home 

Color [HOME_ATTRIB] & 

[COLOR] 

Color parameters are set to 
home 

Beam [HOME_ATTRIB] & 

[BEAM] 

Beam parameters are set to 
home 

Single parameters [HOME_ATTRIB] & 

[Wheel_Key] 

Parameter # is set to home 

Another way of doing the same thing 

Action  Key Feedback 

Focus [0] [FOCUS] Focus parameters are set to 
home 

Color [0] [COLOR] Color parameters are set to 
home 

Beam [0] [BEAM] Beam parameters are set to 
home 

All attributes [C/Alt] & 

[ATTRIBUTES] 

All parameters are set to 
home 
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Device Control - U1-U2-U3 
The parameter group keys U1-U3 in the programming section can be set up with any mix of device 
parameters. Each of them have three sub-pages. This makes a total of nine user definable parameter 
pages. 

 

This editor is opened by holding MODIFY and pressing U1-U3 or a Wheel key when a bank (U1-U3) 
is selected. 

 

NOTE 
Each User Bank (U1-U3) has three parameter pages (1-3). They are shown in 
the same editor.  
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U1-U3 - Setting Up Parameters 

Column  Function Feedback 

Page No function This is the number of the 
Page (1-3) under this User 
Bank (U1-U3) 

Wheel No function This is the number of the 
Wheel, and cannot be 
changed. 

Parameter [MODIFY] Opens a dropdown with all 
parameters. Select one and 
press MODIFY to confirm* 

*The letter (FCB) after a parameter indicates it's parameter group. 

NOTE 
Parameters in U1-U3 are still stored in the original palette types (Focus, 
Color, Beam).  
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Device Control - Align 
The Align key in the programming section copies parameters from one Device to several others. 

 

1. Select all involved devices, including the one you want to copy parameters from  
2. Use Next/Last to select the device you are copying from  
3. Hold ALIGN and then press the key corresponding to the parameter or parameter group you 

want to copy: 

Function  Key Feedback 

Align FOCUS [ALIGN] & [FOCUS] All Focus parameters are 
copied* 

Align COLOR [ALIGN] & [COLOR] All Color parameters are 
copied* 

Align BEAM [ALIGN] & [BEAM] All Beam parameters are 
copied* 

Align single parameters [ALIGN] & 

[Wheel_Key] 

The parameter assigned to 
the wheel is copied. 

*If Palettes are used, the palettes will be aligned, not the values. 
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Device Control - Fan 
The FAN key in the programming section is used to distribute values of a parameter evenly around a 
centre point.  

 

There are four shapes of fan: 

Linear 
S = S shaped 
V = V shaped 
U = U shaped 

Function  Key Feedback 

1. Select channels Channel Select 
functions 

Selected channels are 
highlighted in the Channel 
View 

2. Select base channel* [NEXT] The focused channel is 
highlighted in red 

3. Fan parameter # [FAN] & [Wheel] Parameter # is fanned 
according to the shape in 
the Settings, around the 
channel focused by 
NEXT/LAST. 

*If no base channel is selected, the centre channel of the selection is used. 
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Fan Settings 

Hold SETUP and press FAN to open the Fan Settings 

 

Select with arrow keys, and press MODIFY to confirm. 
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Device Control - Fetch/Copy 
The ON/FETCH key in the programming section is used to copy parameter values for devices from 
any Preset. Fetching from Presets in the Main Sequence will copy the STATE of those devices 
including any tracked values from presets earlier in the Sequence. 

 

1. First select the devices you wish to copy values to.  
2. Select function from the table below: 

Function  Key Feedback 

FOCUS values [#] [ON/FETCH] & 

[FOCUS] 

Focus values from Preset # 
are copied to the selected 
channel(s). 

COLOR values [#] [ON/FETCH] & 

[COLOR] 

Color values from Preset # 
are copied to the selected 
channel(s). 

BEAM values  [#] [ON/FETCH] & 

[BEAM] 

Beam values from Preset # 
are copied to the selected 
channel(s). 

Parameter values  [#] [ON/FETCH] & 

[Wheel_Key] 

Parameter values from 
Preset # are copied to the 
selected channel(s). 

All values  [#] [ON/FETCH] & 

[ATTRIB] 

All parameter values from 
Preset # are copied to the 
selected channel(s). 

NOTE  
If the Preset specified is in the Main Sequence, you will fetch the ACTUAL 
STATE of the attributes in the specified preset. This is not necessarily the 
same values that are stored in that preset, since some of them may be 
tracking into it from previous presets. 

HINT 
You can fetch intensity values as well. See Presets - Fetch Intensities. 
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Device Control - Highlight Mode 
The HIGHLIGHT key in the programming section is used to set Devices to a temporary Highlight 
mode. It will set all intensity channels to the ID level in Cobalt Settings (default 100%) and all device 
channels to the values defined in their templates, with the highlighted device to white.  

 

Action  Key Feedback 

Activate Highlight  [HIGHLIGHT] All channels in the current selection are 
highlighted. The LED in the key is 
lit.Highlight is indicated at the top of the 
screens 

Step forward  [NEXT] Channels are focused, and Highlighted in 
the order they were selected. 

Step backwards  [LAST] Channels are focused, and Highlighted in 
the order they were selected. 

Leave Highlight mode [HIGHLIGHT] Highlight mode is deactivated. The LED 
in the key is off. All Devices return to 
their last CB values. 

NOTE 
Highlighted Intensity channels are indicated in the channel views with a 
highlighted background. 
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Device Control - Flip 
If a moving head reaches its end position for Pan - it is possible to press FLIP to invert the pan and tilt 
values so that the end position is "passed". Observe that the result of a flip depends on the pan range 
of a device, and will not always be the same position as before the flip.   

(Soft Key Pages are commands in the lower right corner of screen 2) 

   

Select the device(s) you wish to flip, and press FLIP. To undo press FLIP again. 
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Device Control - Device Control Tab 
As soon as a device is selected, all parameters can be accessed from the Device Control tab. (See 
Cobalt Device Control Tab) 
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Device Control - Select Changed  
The SET CHANGED soft key allows you to select all devices that have manually changed attributes 
other than intensity, since the current preset was loaded to the A field.  

(Soft Key Pages are commands in the lower right corner of screen 2) 
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Device Control - Device Mode  
Press DEVICE to activate Device Mode. The top potentiometers in the masters section will provide 
direct access to a definable number of device parameters. There is a default Device Mode page (1) that 
is assigned to all templates, and you can configure 19 more (2-20) and assign to any templates. This 
way you can make sure you have the optimal parameters automatically at hand when a particular type 
of device is selected. An example is if you have a number of different LED fixtures and want them all 
to use the same Device Mode page, whileyour profiles with framing shutters, or media servers will 
have a different Device Mode page. 

 

 

The easiest way to edit the parameters in a Device Mode Page is to hold the console wheel parameter 
key for a parameter and press the yellow potentiometer you want to assign it to. You can change and 
edit the parameters of each page in the Device Mode Page List.  
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The parameters are definable in the Device Mode settings.  

In Cobalt 10: Press RANGE to the other upper/lower bank.  

Device Mode Settings and Device Mode Page List  

The parameters for each of the 20 Device Mode pages are defined in the Device Mode Page List. 

Hold SETUP and press DEVICE to open the Device Mode Page List or open it from 
(Browser>Devices>Settings and Tools>Device Mode Pages...). It will open focused on the currently 
active Device Mode Page.  

   

Press MODIFY or touch/click in a parameter to change 
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You can assign the Device Mode Page to each template in the Templates List 
(Browser>Patching>Setting and Tools>Templates...) 
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Device Views 
Attributes for devices can be shown in any channel view.  

This chapter contains the following sections 

• Device Views - Introduction  
• Device Views - Live  
• Device Views - Filtering  
• Device Views - Editing  
• Device Views - Presets  
• Device Views - Data 
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Device Views - Introduction  
A device view with attributes can be opened in any channel view  by pressing ATTRIB. 

They are all edited in the same way. In the Live tab attribute view you can set times. See Devices - 
Times. 

General Facts 

• Devices are listed by type  
• You can set attribute values directly (depending on the Attribute Setup)  
• You can set Palettes directly (depending on the Attribute Setup)  
• You can filter parameter groups  
• Changed values are shown with a purple background (Live)  
• You can view/edit attribute times  

NOTE 
Hold FORMAT and press @LEVEL to toggle levels between 100% and full 
8/16 bit values. 

HINT 
In the browser Preset items have a sub node called “Attribute Editor” for presets with attributes. 
Pressing MODIFY on this node opens the attribute editor (v5.0). 
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Device Views - Live 
The Device view is viewed in the Live tab by pressing ATTRIB. 

 

You can toggle between these formats by pressing FORMAT 

• Selected devices  
• Non-zero devices  
• Selected and changed devices  
• All devices 

The currently selected format is indicated in the top right corner of each Channel View 

 

You can open cells for setting parameter times and delays directly by holding FORMAT and pressing 
the DOWN ARROW. 
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Device Views - Filtering 
Hold the FORMAT key and press FOCUS, COLOR or BEAM to select which parameter group to 
hide/show in a Moving Device View. Below only COLOR is shown.  
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Device Views - Editing 
When you open a device view you can use all palette and wheel controls to edit attributes.  

NOTE 
All attribute views need to be unlocked for screen editing by holding SETUP 
& TAB and activating in the popup. 

If you unlock the view for screen editing you can enter a value or a Palette reference, depending on 
the Attribute Editor Default Settings. The default setting is Palette. See Attribute Settings.  

This is how you can enter values for the selected cell(s). To save changes press UPDATE. 

Function   Key Feedback 

Enter a value* [#] [MODIFY] The Palette # is assigned to 
the selected cell(s) 

Open a dropdown [MODIFY] All available Palettes 
(FCB) for the selected 
cell(s) are opened in a 
dropdown 

Set an absolute value [#] [C/Alt] & 

[MODIFY] 

The absolute value is set to 
the selected cell(s) (not 16 
bit values) 

Delete the content of 
selected cell(s) 

[DELETE] The content is deleted for 
these cells. 

*Changed values get a purple background in the Live Attributes View 
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NOTE 
If the Attribute Editor Default Setting is set to Absolute, you can select 
Palettes in the same way as setting absolute values in Palette mode: enter the 
number, hold C/ALT and press MODIFY. 
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Device Views - Presets 
You can view and edit all device parameters for a Preset in the Preset Attribute Editor (# PRESET & 
ATTRIB).  

 

   

NOTE 
Select format by pressing FORMAT.  

Hold FORMAT and press Down Arrow to open up Time and Delay rows. See 
Device Times - Attribute Time Editor 
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Preset Attribute Editor - Columns 

These are the different Device parameters that are displayed for each with their current values. For 
editing see Device Views - Editing. 

Function group  Parameters Explanation 

Channel & Level No input The number of the device is 
highlighted when selected, and red 
when focused with NEXT/LAST. 
The level is indicated to the right. 

Device Delete Device Press DELETE to delete this device 
completely* 

GoOnGo AutoMark, GoOnGo or 
GoInB per Device 

Overrides the Sequence Step 
GoOnGo setting for this particular 
Device. 

FOCUS 
parameters  

Pan, Tilt, Focus Speed The parameters that exist for the 
selected device are shown with their 
values. 

COLOR 
parameters 

Cyan, Magenta, 
Yellow, Color,  
Color2, CTO, Color 
speed etc... 

The parameters that exist for the 
selected device are shown with their 
values. 

BEAM parameters Focus, Iris, Zoom, 
Strobe, Gobo, Gobo 
<>, Gobo rot, etc... 

The parameters that exist for the 
selected device are shown with their 
values. 

CONTROL 
parameters 

Aux 1, Control, 
Dummy ch's etc... 

The parameters that exist for the 
selected device are shown with their 
values. 

*There is a popup to confirm deleting a device. 
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Preset Attribute Editor - Times 

You can toggle the format of the Preset Attribute Editor to show Times and Delays by holding 
FORMAT and pressing arrow DOWN or arrow UP.  
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Device Views - Data  
Press DATA to toggle attributes to show in absolute values or referenced values (palettes).   

 

Absolute values are preceded by a # character to show that they are absolute values in stead of 
palettes. 

Show Palette 

 

Show Values 

 

Live Effects/Preset Attribute Editors show Absolute/Palette in the header depending on the current 
setting. 

In Congo hardware this is a soft key in the Channels Soft Key Page. 
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Device Recording 
Attributes are stored in Presets just like intensities. There are different 
recording modes. 

This chapter contains the following sections 

• Device Recording - Introduction  
• Device Recording - Modes  
• Device Recording - Block Cues  
• Device Recording - Delete  
• Device Recording - Cue Only 
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Device Recording - Introduction  
 There are four recording modes for recording device parameters: 

• Active (default)  
• Changed  
• All  
• Popup 

If only changed Device parameters are recorded it is important to record all parameters (a block cue) 
in the beginning of each Sequence. There is a check box for this in the Advanced Tab of the 
Recording Popup. 

Regardless of these settings it's always possible to record attributes 

• All attributes manually  
• Selected device(s) only  
• Selected device(s) to any Preset  
• Set all or selected parameters to Changed (to record as Changed) . 

NOTE 
IF you are working with Changed, there is a SET CHANGED softkey in the 
Devices soft key page of the Main Display that allows you to force the flag 
changed for any parameter or parameter group. See Device Recording - 
Modes. 
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Device Recording - Modes  
There are four different Recording modes for recording Device attributes.  

They are set in the RECORD SETTINGS (Hold SETUP and press RECORD). You will get this 
popup 

 

These are the modes 

Function  Description 

Changed  All changed attributes are recorded automatically*  

Popup A popup is provided to confirm recording all 
changed attributes 

All  All attributes are recorded  

Active (default) All attributes of devices with an intensity over zero 
are recorded. 

*This means that it is necessary to record all attributes for the first step in a Sequence manually. See 
Record All Attributes for selected channels 

Changed mode 

Attributes are tagged as Changed when they have been altered since they were last recorded. This 
indication is a purple background in Channel and Attribute views.  
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If you are recording "Changed" attributes you may wish to force this flag manually. This is done with 
the soft key SET CHNGED in the Devices soft key of monitor 2. 
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All commands are executed to the currently selected Devices. 

Function  Key Feedback 

Set all parameters to 
changed 

[Set_Chnged] & 

[PALETTE] 

All parameters are flagged 
as changed (purple 
background). 

Set Focus parameters to 
changed 

[Set_Chnged] & 

[FOCUS] 

Focus parameters are 
flagged as changed (purple 
background). 

Set Color parameters to 
changed 

[Set_Chnged] & 

[COLOR] 

Color parameters are 
flagged as changed (purple 
background). 

Set Beam parameters to 
changed 

[Set_Chnged] & 

[BEAM] 

Beam parameters are 
flagged as changed (purple 
background). 

Set a specific parameter to 
changed 

[Set_Chnged] & 

[Wheel_Key] 

Specific parameters are 
flagged as changed (purple 
background). 

The changed device indication is cleared when you fade or step in the Sequence.  

See Channel Information - Detailed 
For more information see Presets - Record 

Active Mode & Mark 

Active Mode (default) means that all devices with an intensity over 0% will be recorded with all 
parameters.  

To be able to record parameters when an intensity is at 0% there is a special intensity state called 
"Mark" which is indicated with an "M" where the level is normally shown.  

To set a Mark level, select the channels press MARK. 

 

Active Mode & Attribute Tracking 

This is a mode that is automatically set to ON when you select Active mode for recording attributes 
(5.1). 
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Hold UPDATE & ATTRIB to update changed attribute values in multiple presets (useful in record if 
Active mode) similar to Intensity tracking.  

 

Use the check box to activate track-editing through a series of sequence steps of the main sequence 
(stopping at Blocks) and select forward, backward or both in the direction dropdown.  
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Device Recording - All Attributes 
In Changed mode, only changed (purple) parametersare recorded for devices. The opposite of this is to 
record all attributes.  

When you record devices directly to a Master Playback all attributes are always recorded. In the 
sequence it is an option in the advanced Recording Popup. See The Recording Popup. 

 

Check the box "Record all attributes" to record all attributes. 
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Device Recording - Delete  
You can delete device data from a Preset in the Preset editor, in the Organizer or in the Preset 
Attribute editor.  
See Device Views - Editing. 

1. Open the Preset List for the Preset.  

• Enter the number of the Preset, hold MODIFY and press PRESET  
• OR open the List from the Browser (Browser >Main Show Data >Presets) 

 

2. Select the Attributes column. 

3. Select the channels you wish to delete. If no channels are selected, attributes for all channels will 
be deleted. 
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4. Press DELETE. A popup will appear for confirmation. 

 

5. Press MODIFY to confirm. 
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Device Recording - Cue Only 
When this option in the Advanced tab of the Record dialog is activated all the attribute values that 
were active in the previous sequence step (regardless of where they were coming from) will be copied 
into the Preset in the sequence step following the newly inserted preset. This is useful when you want 
to record a new state within a series of tracked values. 

Cue Only is an option in the advanced Recording Popup. See The Recording Popup. 

 

Check the box "Attributes: Cue only" to record Cue only. 



Cobalt 8.1 - 20181029 

620 

 

Device Palettes 
Moving Device values can be stored in Palettes, that are used to recall these 
values. Palettes can be stored in Presets, as references to the stored values. 
Palettes are organized in parameter groups (Focus, Color, Beam, All).  

This chapter contains the following sections 

• Device Palettes - Introduction  
• Device Palettes - Record  
• Device Palettes - Update  
• Device Palettes - Edit  
• Device Palettes - Lists  
• Device Palettes - Activate By Number  
• Device Palettes - Direct Mode  
• Device Palettes - In Masters  
• Device Palettes - Select Active Channels  
• Device Palettes - Select Stored Channels  
• Device Palettes - Display List  
• Device Palettes - Focusing Mode  
• Device Palettes - Renumber 
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Device Palettes - Introduction 
A Palette is a memory for all or some parameters of a Moving Device. A Palette is used to load these 
parameters quickly, and stored as a reference in Presets for playback.  

Direct selects are important for accessing Palettes. See Direct Selects. 

There are four kinds of Palettes 

Type  Key Parameters 

Focus Palettes  [FOCUS] Position parameters like 
pan, tilt... 

Color Palettes  [COLOR] Color parameters like 
cyan, magenta, yellow, 
color wheel... 

Beam Palettes  [BEAM] Beam parameters like 
gobo, shape, shutter, focus, 
iris... 

All Palettes  [PALETTE] All parameters 

"By device" or "By device type" 

Palettes usually store individual values for all devices. Color and Beam Palettes can be stored for one 
device, and reused for all devices of the same type. This choice is available in the recording popup. 

Palettes in Presets 

When a Palette is used to position a Device before recording a Preset - the Palette is referenced, not 
the individual values for each Device. This means that changing the Palette will update this reference 
in the whole Play. 

Palettes in Direct Selects 

• Palettes can be accessed from the Direct Selects 
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Device Palettes - Record 
To record a device palette hold RECORD and press the PALETTE, FOCUS, COLOR or BEAM key 
(see below). 

• Palettes are stored for the currently selected channel(s).  
• To re-record a Palette, store it with the same number again.  
• In the recording popup for Palettes there is a Text field to label each Palette. This is displayed 

every time the Palette is used. 

NOTE 
When you record a Palette, it is also activated and will be recorded into the 
next Preset.  

To recall a Palette once it has been recorded:  

1. Select the device channel(s).  
2. Enter the number of the palette and press FOCUS, COLOR, BEAM or ALL PALETTE 

Each Device or Each Device Type 

In the Palette recording popup there is a choice to store the values individually for Each Device, or for 
Each Device Type.  

• Positions (FOCUS) are best stored for Each Device, since they always are unique for each 
Device (channel).  

• Color and Beam values are best stored for a Each Device Type, since color and beam 
parameter levels are the same for each Device (channel), and can be reused. 

NOTE 
If several Device Types are selected, the highest selected channel of each type 
will be recorded.  

An "Each Device Palette" (individual) will override an "Each Device Type 
Palette" (General).  
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Record A Focus Palette 

1. Select channel(s) 

2. Initiate recording of next free Palette or Palette # 

Function  Key Feedback 

Record  [RECORD] & 

[FOCUS] 

Records the next free Focus 
palette. You will get a 
popup* 

Record as... [#] [RECORD] & 

[FOCUS] 

Records as palette #.  
You will get a popup* 

Record Direct [RECORD] & 

[direct_select] 

Records to a direct select in 
palette mode. You will get 
a popup* 

*Popup 

 

3. Enter a text (optional) 

4. Select Recording mode. For Focus Palettes this is usually "Each Device".  
See Each Device or Each Device Type. 

5. Press MODIFY to confirm recording. 

NOTE 
The MASK function can be used to filter out unwanted parameters when 
recording a Palette. See Device Control - Mask. 
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Record A Color Palette 

1. Select channel(s) 

2. Initiate recording of next free Palette or Palette # 

Function  Key Feedback 

Record  [RECORD] & 

[COLOR] 

Records the next free Color 
palette. You will get a 
popup* 

Record as... [#] [RECORD] & 

[COLOR] 

Records as palette #.  
You will get a popup* 

Record Direct [RECORD] & 

[direct_select] 

Records to a direct select in 
palette mode. You will get 
a popup* 

 
*Popup 

 

3. Enter a text (optional) 

4. Select Recording mode. For Color Palettes this is default set to "Each Device Type".  
See Each Device or Each Device Type. 

5. Press MODIFY to confirm recording.  

NOTE 
The MASK function can be used to filter out unwanted parameters when 
recording a Palette. See Device Control - Mask. 
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Record A Beam Palette 

1. Select channel(s) 

2. Initiate recording of next free Palette or Palette # 

Function  Key Feedback 

Record  [RECORD] & [BEAM] Records the next free Beam 
palette. You will get a 
popup* 

Record as... [#] [RECORD] & 

[BEAM] 

Records as palette #.  
You will get a popup* 

Record Direct [RECORD] & 

[direct_select] 

Records to a direct select in 
palette mode. You will get 
a popup* 

*Popup 

 

3. Enter a text (optional) 

4. Select Recording mode. For Focus Palettes this is usually "Each Device Type".  
See Each Device or Each Device Type. 

5. Press MODIFY to confirm recording.  

NOTE 
The MASK function can be used to filter out unwanted parameters when 
recording a Palette. See Device Control - Mask. 
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Record An All Palette 

1. Select channel(s) 

2. Initiate recording of next free Palette or Palette # 

Function  Key Feedback 

Record  [RECORD] & 

[PALETTE] 

Records the next free All 
palette.You will get a 
popup* 

Record as... [#] [RECORD] & 

[PALETTE] 

Records as all palette #. 
You will get a popup* 

Record Direct [RECORD] & 

[direct_select] 

Records to a direct select in 
palette mode.You will get a 
popup* 

*Popup 

 

3. Enter a text (optional) 

4. Select Recording mode. For All Palettes this is usually Each Device. 
See Each Device or Each Device Type. 

5. Press MODIFY to confirm recording.  

When an All Palette is assigned to a device, and no other palette type (FCB), the name of the All 
Pallette is displayed in the channel view.  
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NOTE 
The MASK function can be used to filter out unwanted parameters when 
recording a Palette. See Device Control - Mask. 
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Device Palettes - Update  
The fastest way to update all changed palettes when working in the sequence loaded to the main 
playback is to use the UPDATE PALETTE function in the soft keys on screen 1.  

1. Press <--- to reach the top menu.  

2. Press DEVICE to select the Device Soft Key page.  

3. Press UPDATE PALETT  to update all changed Palettes for the selected channel(s). 

   

2. You will get a popup confirming which ones are involved. 
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Device Palettes - UPDATE direct key 

If a Palette is loaded to a Direct Select section, or to a Master Playback - it is possible to update it by 
selecting the involved channels, holding UPDATE and pressing the corresponding Direct Select or 
Master key. 

NOTE 
This shortcut is not available when an Editor is focused that uses UPDATE 
for something else. For example the Preset List.  

Re-record A Palette - Merge Or Replace 

When you re-record a preset or palette where attribute information already exists, you will get a 
choice of merging or replacing the existing attributes.  

 

• Merge with existing will add the changes for the selected channel(s)  
• Replace existing will replace all values in this Palette with those of the selected channel(s) 
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Device Palettes - Edit 
Open the Device Palette Attribute Editor from the Browser >Devices >Focus Palette... (Color, Beam, 
All). 

Device Palettes are edited and filtered in the same way as the Live Attributes and Preset Attribute 
views.  

 

See Device Views - Editing and Device Views - Filtering. 
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Device Palettes - Lists 
Hold MODIFY and press FOCUS, COLOR, BEAM or PALETTE to open a Palette list where you can 
edit palettes.  

The Palette Lists are also opened from the Browser (Browser >Devices >Palettes >Focus Palettes).  

 

NOTE 
Palettes that have been recorded "per type of device" are shown first in these 
lists. Most often these are Color Palettes. See Each Device or Each Device 
Type 

Palette List - Columns & Functions 

Function  Key Feedback 

Palette  The ID of each Palette. 
Cannot be changed. 

Text [MODIFY] Press MODIFY to activate 
and end text input.  

Attribute [MODIFY] Opens the Palette Attribute 
Editor. The number 
indicates how many 
Devices are stored in this 
Palette. 
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Device Palettes - Activate By Number 
Activate a Palette for the selected channel(s) by number. 

Function  Key Feedback 

Focus Palette  [#] [FOCUS] Values are set from Palette 
#. 

Color Palette  [#] [COLOR] Values are set from Palette 
#. 

Beam Palette [#] [BEAM] Values are set from Palette 
#. 

All Palette [#] [PALETTE] Values are set from Palette 
#. 

NOTE 
Only selected channel(s) that are referenced in Palette # will be affected.  
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Device Palettes - Direct Mode 
When a Palette key (FOCUS, COLOR, BEAM, PALETTE) is held the first 40 Palettes can be 
activated from the Direct Select keys, or the Direct Select keys 1-10 in a Congo Jr/Kid. 

Function  Key Feedback 

1. Activate Direct Mode Hold a Palette key Direct Select display shows 
the first 40 

2. Select Palette Direct Select key When the key is pressed 
that Palette is activated. 
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Device Palettes - In Masters 
Enter the number of a palette, hold the pallete type key (FOCUS, COLOR, BEAM, PALETTE) and 
press a Master key to load to that master.  

 

The Device Palettes can now be played back from Master Playbacks by pressing the master key. See 
Master Playbacks - Palettes.  
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Device Palettes - Select Active Channels 
All channels currently referencing a Palette can be selected using the Direct Select keys for Palettes 
(FOCUS, COLOR, BEAM, PALETTE), in combination with CHANNEL and ALL.  

Palettes are selected from the Direct Selects for this function. See Direct Selects. 

Function  Key Feedback 

Select channels [CHANNEL] & 

[Direct_Select#] 

All channels stored in 
Palette # are selected in the 
active Channel View. 

Select channels over zero% [ALL] & 
[Direct_Select#] 

All channels with a level 
in the active Channel 
View are selected . 
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Device Palettes - Select Stored Channels 
You can Select all channels that are stored in a Palette as Each Device.  

NOTE 
This is not possible for palettes stored as "Each Device Type", since no 
specific channels are stored with them.   

Function  Key Feedback 

Focus channels [#] [CHANNEL] & 

[FOCUS] 

All channels stored in 
Palette # are selected in the 
active Channel View. 

Color channels [#] [CHANNEL] & 

[COLOR] 

All channels stored in 
Palette # are selected in the 
active Channel View. 

Beam channels [#] [CHANNEL] & 

[BEAM] 

All channels stored in 
Palette # are selected in the 
active Channel View. 

Palette channels [#] [CHANNEL] & 

[PALETTE] 

All channels stored in 
Palette # are selected in the 
active Channel View. 
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Device Palettes - Focusing Mode 
Focusing mode is designed for quickly focusing and updating palettes. It is activated from the FOCUS 
MODE soft-key in the DEVICE Soft page.  

Start by activating Focus Mode from the soft key under the soft key Device. 

    

The Focus Palettes - Focusing mode tab will open and Highlight Mode will be activated. 
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Action  Key Feedback 

1. Select Palette from the 
list 

Mouse, touch screen or 
arrow keys. 

The corresponding 
channels are selected and 
displayed in the Channel 
Display list. The palette is 
activated and Highlight 
mode is turned on.  

2. Focus one by one with 
NEXT/LAST 

[NEXT] & [LAST] Each focused channel is 
mapped to the channel 
controls. 

3. Update the Palette [UPDATE_PALETTE]

(Softkey) 
The Palette is updated and 
you are returned to the 
Focus Palette list to the 
next Palette. 

4. Exit Focus Mode [FOCUS_MODE]

(Softkey) 
Focusing mode is exited 
and the Focus Palette tab is 
closed. 
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Device Palettes - Renumber 
You can renumber a Palette of any type (FCBP) in the Organizer. 

1. Open the Organizer for the type of palette you wish to renumber by holding LOAD and pressing the 
palette key (FOCUS, COLOR, BEAM, PALETTE). 

 

2. Enter the new number and press MODIFY 
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Device Times 
Times for Moving Devices can be set in seconds or as a percentage of 
the Sequence Step In-times.  

This chapter contains the following sections 

• Device Times - Introduction  
• Device Times - Individual or FCB  
• Device Times - Attribute Editor Times    
• Device Times - Fan Times 
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Device Times - Introduction 
A Moving Device can have Times and Delays in the following ways. 

• No time - follows the Sequence Step In-time.  
• Parameter group times - an attribute time for FOCUS, COLOR or BEAM parameters.  
• FCB times - Same as above, but there is a shortcut for setting all three  
• Device parameter times - A time for each attribute of a Moving Device. 

NOTE 
All times are set to the Preset in the A or B field depending on the setting of 
the parameter "Set Times To Field" in the Cobalt Settings. 

All attribute times are stored with a Preset.  

There is a default Attribute Time that is used when Moving Devices are positioned manually or with 
GoInB. See Moving Device Times - Default Attribute Time. 

Percent times, or seconds? 

Times for Moving Devices are set in seconds (absolute) or as a percentage of the IN time of a 
Sequence Step.  

The default setting is percent. This means that all FCB-Times will equal the IN time of a Sequence 
Step, and all FCB-Delay Times will execute as a percentage of the IN time of a Sequence Step. 

 

In the example above, the FCB Times are 100% of the In time (5 seconds). 



Cobalt 8.1 - 20181029 

642 

 

 

If the FCB Times are set to 50% of the IN-time they will be 2.5 seconds at an in time of 5 seconds. 

 

If the In-time is changed to 10 seconds, the FCB-times will be 50% of 10 (= 5 seconds). 

NOTE 
In Congo plays files earlier than Version 4.2, the FCB Delay time was set to 
100% due to the fact that Delay Times were inherited from the Delay In 
time. These plays (pre-4.2) with FCB Delays set to 100% will be converted to 
use a delay of 0s instead.  

Default Attribute Time 

The Default Attribute Time (3 seconds) is used mainly to keep noise and unnecessary mechanical 
friction down when a Moving Device is positioned in the following situations: 

• When attributes are executed from Independents  
• When copying Blind attributes to Live  
• When using Stop table for an old dynamic  
• When you press Home Attributes  
• When jumping in the sequence  
• Using REFRESH in the Main Playback 
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To change this time see Attribute Settings. 

NOTE 
The Default Attribute Time does not affect how fast a palette is activated 
from direct selects or directly. This time can be set on the fly - for example 
#(s) DIRECT SELECT PALETTE.  

See Shortcuts - Device Palette Activating 
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Device Times - Individual or FCB 
Device times can be set to individual parameter of selected devices, or to a parameter group like 
Focus, Color or Beam for all devices in the preset.  

FCB times are defaulted to run in 100% of the main In and Delay times for a step. You can change 
this percentage or set an absolute time in seconds. An individual parameter time always wins over a 
general FCB time.  

Times are shown in the playback view. Individual parameter times are shown as a red dot at the end of 
FCB timelines - See Color in the example below.  

 

Setting times in the advanced recording popup 
You can set these times directly in the Advanced tab of the Recording Popup when you record a new 
preset.  
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Setting times with key shortcuts 
You can set times with a key shortcut by entering the time, holding TIME and pressing a destination 
key (see table).  

You will get a popup asking if you want to set the times on a general FCB -level for all devices, or as 
individual Parameter Times for the selected devices.  
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Key Shortcuts for device times 

Function  Key Shortcut Feedback 

Focus time  [#] [TIME] & 

[FOCUS]  

Popup (see above) 

Color time [#] [TIME] & 

[COLOR] 

Popup (see above) 

Beam time  [#] [TIME] & 

[BEAM] 

Popup (see above) 

Parameter time  [#] [TIME] & 

[Parameter_Key] 

An individual time is set to 
this parameter for the 
selected device(s) 

Focus delay time  [#] [DELAY] & 

[FOCUS]  

Popup (see above) 

Color delay time  [#] [DELAY] & 

[COLOR] 

Popup (see above) 

Beam delay time  [#] [DELAY] & 

[BEAM] 

Popup (see above) 

Parameter delay time  [#] [DELAY] & 

[Parameter_Key] 

An individual delay time is 
set to this parameter 

You can edit FCB times in the Preset List. 

NOTE 
There is a shortcut for setting both F, C and B-Times to the same value. 
Enter the time and hold TIME or DELAY and press ATTRIBUTE. 

In the Times soft key page there are keys for setting FCB time and delay 
directly. See Times Soft Key Page. 
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Device Times - Attribute Editor Times 
Times can be set and edited in the Live Attributes and Preset Attribute Editors. Please note that times 
are set to A working in this editor, regardless of all other settings. 

• Press ATTRIB to open the Live Attribute Editor.  
• Enter a Preset number, hold PRESET and press ATTRIB to open the Preset Attribute Editor.  

 

Hold FORMAT and press the down arrow to open Time and Delay rows.  
Hold FORMAT and press TIME or DELAY to do the same thing. 
Hold FORMAT and press the up arrow to close these rows. 

In this editor press FORMAT to toggle between 

• Selected devices  
• Non-zero devices  
• Changed devices  
• All devices  
• Devices with attributes 

The current format is indicated in the upper right corner ("Selected devices" in the example above). 

NOTE 
Times can be set default as % or in seconds. See Device Times - Percent Or 
Seconds.  
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Attribute Times 

These functions will work in the Live Attribute Editor and the Preset Attribute Editor. 

Action  Key Feedback 

1. Open the Time row [FORMAT]  & 

[Down_arrow] 

or 

[FORMAT]  & 

[TIME] 

The Time row is opened 
under each cell 

2. Select Attribute time 
cell(s) 

Arrow keys The cell(s) is highlighted 

3. Set time # [#] [MODIFY] The time # is set to the 
selected cell(s) 

4. Update Preset [UPDATE] Only needed in Live 
Attributes Editor. 

NOTE 
Times can be set to the selected devices also by holding TIME and pressing 
FOCUS, COLOR or BEAM. 

Set Time to Devices popup. 
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Attribute Delay Times 

These functions will work in the Live Attribute Editor and the Preset Attribute Editor.  
Action  Key Feedback 

1. Open the Delay row [FORMAT]  & 

[Down_arrow]  

[Down_arrow] 

or 

[FORMAT]  & 

[DELAY] 

The Delay row is opened 
under each cell 

2. Select Attribute delay 
cell(s) 

Arrow keys The cell(s) is highlighted 

3. Set delay time # [#] [MODIFY] The delay time # is set to 
the selected cell(s) 

4. Update Preset [UPDATE] Only needed in Live 
Attributes Editor. 

NOTE 
Delay times can be set to the selected devices also by holding DELAY and 
pressing FOCUS, COLOR or BEAM. 
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Device Times - Fan Times 
In the Live and Preset Attribute Views there is a wizard for fanning parameter times. This Wizard will 
only open when a Time or Delay cell is selected. The selected cells are fanned between the devices. 

1. Open an Attribute view. See Device Views - Live and Device Views - Presets. 
2. Open the Time and Delay rows by holding FORMAT and pressing the Down Arrow.  
See Device Times - Attribute Time Editor. 
3. Select the Time or Delay cells for the parameters and devices intended. 

 

4. Press WIZARD. The Fan Time Wizard popup will open. 

 

5. Select values and confirm. 
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Device Play Back 
When moving Devices are played back from the Main Playback and the 
Master Playbacks there are different modes for when and how attributes are 
trigged. 

This chapter contains the following sections 

• Device Play back - Introduction  
• Device Play back - Attributes Follow Faders  
• Device Play back - Attrib Move 
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Device Play back - Introduction  
Attributes will be trigged during playback in the following situations 

• A Preset is faded in a Sequence or Chase  
• A Preset is faded in on a Master Playback fader  
• A Preset is faded out on a Master Playback fader  
• A Master is flashed  
• A Dynamic effect is started 

In a Sequence Step attributes can be set to move with Auto Mark (5.0), OnGo (live) or InB (move 
while black, preposition). 
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Device Play back - Attributes Follow Faders 
Attributes will follow the manual movement of masters depending on the Master Settings. These are 
some general rules. See Master Settings.  

The always follow the B fader of the Main Playback.  

• They start moving at 1%.  
• Snap parameters also trig at 1%.  

Master Playbacks behave different from the crossfaders of the Main Playback. 

Masters And Attributes - General 

When a master leaves its 0% position, the corresponding attribute parameters are trigged and follow 
the fader. 

During a timed fade in a Master, attributes will follow the FCB-times of the Preset in that Master.  

If another master with overlapping attribute parameters is activated, (leaves 0%), it will take control of 
the corresponding attributes. To re-gain control from any Master, move it to 0% and up again. 

How attributes behave when moving the Master fader down depends on the settings for the fader. 

Crossfaders And Attributes 

When a manual crossfade is made, the attribute positions will follow the B fader. If the fader is moved 
slower than the time assigned to the attributes, the fader has control. If the fader is moved faster than 
the assigned time, the time will take control to make a smooth movement.  
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Device Play back - Attrib Move  
Attributes can be executed in three ways 

• AutoMark  
• On Go  
• In B 

Depending on this setting Attributes will be executed when a step is faded in live (On Go) or when a 
Step is loaded to be faded in (In B). See System Settings - Attribute. 

You can choose a setting as default depending on the style of your show - and then change 
individually for any step or device. See Sequence List. 

NOTE 
GoInB attributes follow the times recorded in the preset.  

The old (pre v5.0) dynamics can be set to start on GO always - See Settings - 
Crossfade. 

AutoMark  

The default setting is AutoMark but you can change this on the sequence step or in the Preset 
Attribute editor. In AutoMark mode, attributes are automatically activated In B or On Go based on the 
level in Live and in B. 

• If the device intensity is >0% in Live, attributes are On Go.  
• If the device intensity is 0% in Live and >0% in B, attributes are In B.  
• If the device intensity is 0% in Live and 0% in B, attributes are On Go.) 

Live view: Channels that are auto-marking are indicated with a blue background on the FCB 
indicators. This indicator remains until you press GO. 
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Live Attributes 
In addition to the Attribute format of the Live tab you can view all moving device parameters in the 
Live Attribute Editor.  

This tab can only be opened from the Browser (Browser >Devices >Live Attributes). The functions 
are the same as in any channel view with attributes. 

NOTE 
All attribute views need to be unlocked for screen editing by holding SETUP 
& TAB and activating in the popup. 

PARK works against selected cells when an Attribute View is open. 

 

Hold FORMAT and press Right Arrow to show all parameters listed over each other, blanking out the 
ones not relevant. Hold FORMAT and press Left Arrow to change back. 

Running attributes are shown with yellow progress bars. 
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NOTE 
Select format by pressing FORMAT.  

Hold FORMAT and press Down Arrow to open up Time and Delay rows. See 
Device Times - Attribute Time Editor 

Live Attributes - Columns 

These are the different Moving Device parameters that are displayed for each with their current 
values. For editing see Device Views - Editing  

Function group  Parameters Explanation 

Channel & Level No input The number of the device is 
highlighted when selected, 
and red when focused with 
NEXT/LAST. The level is 
indicated to the right. 

FOCUS   Pan, Tilt, Focus Speed Current parameter values 
are shown. 

COLOR   Cyan, Magenta, Yellow, 
Color, Color2, CTO, 
Color speed etc... 

Current parameter values 
are shown. 

BEAM   Focus, Iris, Zoom, 
Strobe, Gobo, Gobo <>, 
Gobo rot, etc... 

Current parameter values 
are shown. 

CONTROL* Aux 1, Control, Dummy 
ch's etc... 

Current parameter values 
are shown. 
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*Control parameters labelled "control" can be edited, but will not be stored, Aux values are stored. 

NOTE 
Hold COLUMN and move wheel to change column sizes. 
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Gel Picker  
There is a Gel Picker that uses the data for each moving device with CMY/RGB mix to generate the 
values for gels of each type.  

It is opened from the Browser >Devices >Gel Picker. Tap or use arrow keys and MODIFY to select a 
color.  

 

If you know the exact gel brand and number you can select a gel from the Direct Selects as well.  
(See Virtual controls tabs: ColorMixer and GelPicker) 
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All Palettes 
This node opens the list of All Palettes.  

 

Press MODIFY in the Attribute cell to open the corresponding Palette editor. 
See Device Palettes. 
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Focus Palettes 
This node opens the list of Focus Palettes.  

 

Press MODIFY in the Attribute cell to open the corresponding Palette editor. 
See Device Palettes. 
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Color Palettes 
This node opens the list of Color Palettes.  

 

Press MODIFY in the Attribute cell to open the corresponding Palette editor. 
See Device Palettes. 
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Beam Palettes 
This node opens the list of Beam Palettes.  

 

Press MODIFY in the Attribute cell to open the corresponding Palette editor. 
See Device Palettes. 
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Mask  
You can mask whole groups of parameters (FCB) or single parameters in a group with the MASK 
key.  

 

• When mask is active it is indicated in the LED of the MASK key, and at the top of the 
screens.  

• The mask is used when recording Presets, Palettes and Dynamics.  
• Masked parameters are displayed in Live tab Attributes view and in the ML LCD on the 

facepanel with "--".  
• When you record a Preset or Palette, masked parameters are NOT recorded.  
• You can prepare and store 999 Mask templates and activate as the global mask anytime.  
• User Masks can be accessed as content in the Direct Selects. 

Global Mask - Functions 

Function  Key Feedback 

Enable/Disable Mask  [MASK] The LED in MASK is lit. 
In the Main Display you 
can see "Mask: and "-" for 
nothing, "fcb" for partial 
and "FCB" for full 
masking. On the top of 
every screen you can see: 

Mask FOCUS [MASK] & [FOCUS] Toggles the Mask for the 
all FOCUS parameters 

Mask COLOR [MASK] & [COLOR] Toggles the Mask for the 
all COLOR parameters 

Mask BEAM [MASK] & [BEAM] Toggles the Mask for the 
all BEAM parameters 

Mask parameter [MASK] & 

[Wheel_Key] 

Toggles the Mask for any 
single parameter 

Open Mask editor [MODIFY] & [MASK] Opens the Mask editor (see 
below). 
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Masking indication 
When Mask is enabled, a summary of active masks is shown in the ML display. Each parameter 
category is indicated with a dash, lowercase or uppercase letter.  

"-" (Dash) means the category is unmasked - all parameters are available for control and recording. 

"fcb" (Lowercase lettering) means the category is partially masked - some parameters have been 
masked and are unavailable for control or recording. 

"FCB" (Uppercase lettering) means the entire category is masked and no parameters from that 
category are available for control or recording. 

Mask - Editor 

Hold MODIFY and press MASK to open the editor. 

In the Mask Editor, single parameters can be toggled on/off by pressing MODIFY in the Allow 
column. This also means that, if you want to toggle a parameter column on/off, you can select the top 
cell, press COLUMN to select the whole column, and the press MODIFY.  

 

User Masks - Functions 

You can save and label up to 999 different combinations of masked parameters. These Masks can then 
be applied to masters as playback masks, or to the Global Mask for use when recording Palettes or 
Presets. They are stored in the Mask List (Browser > Devices >Masks). 

To record a user Mask: 

1. Set up the Global Mask any way you want (See Global Mask - Functions)  
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2. Enter a number, hold RECORD and press MASK (with no preceding number the next free 
Mask is recorded) 

To recall a user Mask: 

1. Enter a number and press MASK or  
2. Press a Direct Select for this Mask. 

To load a user Mask to a master: 

1. Enter the number, hold MASK and press the Master key.  
- This will load this mask as a playback mask for the content of this master. 

You can use # INSERT and DELETE to add or remove masks from this list, and you can edit them by 
pressing MODIFY in the Mask cell - which will open the Mask Editor for that Mask. 
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>Settings & Tools 

These are the settings and tools for Devices. 

This chapter contains the following sections 

• Scroller Rolls  
• See Device Mode Settings and Device Pages  



Cobalt 8.1 - 20181029 

667 

 

Scroller Rolls 
Scroller Rolls are defined in the Scroller Roll Editor. It is opened from the Browser (Browser 
>Devices >Settings & Tools >Scroller Rolls) 

 

Scroller Rolls Editor - Columns 

Function  Value Feedback 

Scroller Roll 1-999 The ID of each Template. Press MODIFY to 
open the Editor 

Fan = Intensity On/Off Press MODIFY to toggle if Fan should 
follow intensity channel of the scroller 
Device to keep down noise when not in use 
(providing the scroller and template have a 
fan parameter). 

Default Time 0s-45min This is the default time per frame the 
scroller will use when changed manually, to 
keep down noise, and save the gel string.  

Text  Press MODIFY to activate and end text 
input.  
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Create a Scroller Roll 

1. Open the Scroller Rolls List from the Browser (Browser >Devices >Settings and Tools >Scroller 
Rolls).  

2.Press INSERT to create a new Roll (a number of standard Rolls are created by default when you 
open a new Play).  

3. Set Fan=Intensity, Default Time and TEXT for this roll. 

4. Press MODIFY in the Scroller Roll cell to open the Scroller Roll Editor. A Wizard is opened where 
you can define the number of frames and the default Fan value (can be edited later).  

 

5. This it what the scroller roll editor looks like with five frames defined 
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  You can define the following functions 

Function  Value Feedback 

Position 1-999 The ID of each Position. Cannot be 
changed. 

Text  Press MODIFY to activate and end text 
input.  

Fan % 0-100% It is possible to set a Fan value for each 
color (to keep noise down). 

AutoMove 0-10 The scroller will move slowly forth and 
back 0-10 bits when the corresponding color 
is selected. It will not take individual 
calibration into account.  

Value 0-255 This is the 8 bit value (0-255) that will be 
output when this frame is selected. 

6. Exit with ESC. 

Assign A Scroller Roll 

Scroller Rolls can be assigned from the Device List. They can also be assigned when a scroller is 
patched, from the Patch Wizard. 

1. Open the Device List (Browser >Patching >Device List). (You can also hold MODIFY and press 
DEVICE). 

 

2. Use arrow keys to select the Scroller Roll Cell for a channel. 

3. Press MODIFY to get a dropdown with all defined Rolls. 
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4. Select a roll with arrow keys. 

5. Press MODIFY to confirm. 

The currently selected color will be shown in the black box under the level in the Channel Views. 

Calibrate Individual Scroller Rolls  

Each scroller roll can be calibrated individually. This is done in the Scroller Calibration Editor that is 
opened from the Device List. 

1. Open the Device List (Browser >Patching >Device List). 

2. Use arrow keys to select the Calibration Editor cell to the far right. 

3. Press MODIFY to open the Calibration Editor for the selected channel. 

 

4. Select Adjusted Position, enter a new value (confirm with MODIFY). It is updated live. 

5. Press ESC to exit. Changes are stored automatically. 

NOTE  
(v5.0) If you change the scroller calibration for a device and close the Scroller 
Calibration Editor, recorded data (presets, palettes) for the previous frame 
values will be updated to the new frame values. Values between frames will 
not be affected. 

To "clear" calibrations from a device/scroller: Re-select the same scroller roll 
in the Device list 
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Scroller Fan override 

In the Attribute setup (SETUP & ATTRIBUTE) it is possible to specify an Override value for all 
Scroller Fans. If you set a value > 0%, this value will be used instead of the Fan values programmed in 
the Scroller Roll. This is useful for making a temporary and absolute override of all fans, for example 
during long rehearsals when heat is higher than during a performance. 
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Effects 
In Cobalt v6 there are four different kinds of effects: 

• Intensity Chase (step based)  
• Dynamic (relative waveforms)  
• Content (Absolute)  
• Image (mapped)  

There are two slightly different types of effects, which are Sequences in Chase 
mode, and Direct Dynamics.  

  

Effects Node 

 

This chapter contains the following sections 

• Effects - Introduction  
• Channel Distribution Wizard   
• Live Effects  
• Effect Playbacks  
• Effect Overview  
• Chase Effects   
• Content Effects  
• Dynamic Effects  
• Image Effects  
• Channel Sets  
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Effects - Introduction 
The effects in Cobalt are powerful devices that allow you to create and play with effects in a very 
intuitive and fast way, regardless the size or nature of your rig. All effects are defined in, and can be 
tested in the demo shows, which is a good way to become aquainted with them. See Try out the effects 
in a Demo Play >> 

There are four types of effects 

Chase  Content Dynamic Image 

 

Stepped intensity 
effects with live 
control of tap 
tempo. The effect 
is edited into parts 
with individual 
timing and hi/low 
levels per part.  

Step based effects 
with 
comprehensive live 
control over 
channel 
distributions, 
directions and 
timing. Apply to 
groups or sets. 

Dynamic 
Templates  
(waveforms) are 
applied to 
parameters to 
create movement 
effects relative to a 
base point, such as 
circles, rainbows, 
etc. Apply to 
groups or sets. 

An image (jpg/gif) 
or text is mapped 
to intensity or 
color in a Magic 
Sheet pixel grid, 
with 
comprehensive live 
control over 
channel 
distributions, 
directions and 
timing. 

Control 
To control an effect you create an Effect Playback from which you can control, record and edit it like 
a moving device into presets and palettes from the Device Controls tab. 

    

•  When the intensity is over zero the effect will run.  
•  Effect intensities are recorded, edited, copied and tracked like any other channel intensity.  
•  Effect parameters are stored into palettes and presets just like any moving device parameters.  
•  There is a Live Effects tab, and you can open a tab to show active effect playbacks.  
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NOTE 
Effects are controlled, recorded and edited like any moving device with an 
intensity. The only difference is that you select them with # EFFECT. 

LIMITATIONS 
Current limitations are: 

• Number of effect channels: 100  
• Number of outputs used by effects: 2 x 512  
• Number of groups that can be used in effects: 256 

Try out the effects in a Demo Play 

One way of understanding the simple, and powerful features of the effects is to try them out in one of 
the demo plays.  

1. Open Demo Tour (Browser >Files >Open >Demo Plays >Demo_Tour)  
2. Open the Demo_Tour Training Project (Browser >File>Training Projects >Demo_Tour) 

Now you can test the pre-programmed effects of each type.  

Chase Effect 

1. Enter 1, press EFFECT and move the level wheel to full. You should now have a chase effect 
shown in the training tab.  
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2. In the Device dock, you have two parameters, Chase: (symmetrical), Rate (100%). Tap on 
the rate to change the tempo.  

3. Hold C and press LIVE LIIVE to clear all output.  

Content Effect 

This is a content effect, it uses steps defined in a Series. A Series can contain palettes, presets and 
parameters. Note that the Groups used are those already recorded, and the number of the Group is 
used by the effect.  

1. Enter 2, press EFFECT and move the level wheel to full. You will see nothing until you 
select a ChSource, Group, Series and GrpParts in the Device Control Dock.  

2. Touch or click and set  
 
ChSource = Group 
Group = All VL 
Series = Intensity 
GrpParts = Parts 2 
 
You should now see an intensity chase with two parts on all varilites in the rig. You can 
change the rate and distribution. Play around with the parameters.  

3. Now select Series = RGB - and you will have a color effect instead. Play around with the 
parameters. Explore.  

4. To store in a preset, record one as usual. What you see is what you get.  
5. Hold C and press LIVE LIIVE to clear all output.  

Dynamic Effect 

This is a Dynamic Effect, it uses wave-tables to create movements around the current focus point of 
the lights. Note that the Groups used are those already recorded, and the number of the Group is used 
by the effect.  

1. Enter 3, press EFFECT and move the level wheel to full. You will see nothing until you 
select a ChSource, Group and DynTemplate in the Device Control Dock.  

2. Touch or click and set  
 
ChSource = Group 
Group = All VL 
Dynseries = >Circle (default) 
 
You should now have a circle effect running on all varilites in the rig. You need light to see 
the beams.  

3. Set the intensities to full in the group All VL by clicking and dragging on group 3 in the 
Direct Selects. Now you should see the circle effect.  

4. Reselect the effect with 3 EFFECT.  
5. Play around with the parameters. Explore.  
6. To store in a preset, record one as usual. What you see is what you get.  
7. Hold C and press LIVE LIIVE to clear all output.  
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Effects - Functions  
These are the general effect functions. 

This chapter contains the following sections 

• Effect - Views  
• Effects - Command syntax  
• Effects - Soft Key Page  
• Effects - Edit  
• Effects - Record  
• Effects - Channel Distribution Wizard 
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Effects - Views 
Effects can be viewed in three views 

• Effects tab  
• Selected channels - Live tab area  
• Live Effects tab 

There are two ways to display an effect 

• As a channel handle (in tabs)  
• As a device (in Live Effects) 

Channel handle 
The effect handle in the Effects and Selected Channels - Live dock have four levels of detail. Hold 
FORMAT and press up/down arrow to select them. 

 

 

 

 

Device 
In the Live Effects tab all attributes are displayed just like a moving device. See Live Effects. 
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Effects in Tabs 

Effects are shown in Live, Effects and Live Effects tabs. See Live - Introduction. See Live Effects.  

Live Effects 
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Effects 

 

Selected channels - Live 

 

Using a mouse or trackball 
Click to select and use the mouse wheel, or hold the right key and move to set levels. Click to add 
more, double-click to deselect all but the last clicked. 
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Effects - Command syntax  
Effects are selected and adjusted one by one or in groups in the same way as moving devices. Instead 
of using the CHANNEL key there is an EFFECT key.  

As soon as an effect is selected you can control the intensity with all level functions, and attributes 
with attribute controls and palettes. 

Select and activate effects 

An effect is activated as soon as the level of the Effect Playback is over zero. Please note that you 
must create an Effect Playback before you can control it. See Effect Playbacks.  

Default Cobalt syntax (RPN) 

Action  Key Feedback 

Select effect [#] [EFFECT] Effect # is selected and can 
be controlled with level 
wheel and attribute controls 

Add an effect [#] [+] Effect # is added to the 
current selection 

Subtract an effect [#] [-] Effect # is subtracted from 
the current selection 

Add multiple effects [#] [THRU] Up to effect # is added to 
the current selection 

Add a channel [#] [CHANNEL] & 

[+] 

Channel # is added to the 
current selection 

Add a group [#] [GROUP] & [+] Group # is added to the 
current selection 

Add an effect to a channel 
selection 

[#] [EFFECT] & 

[+]  

Effect # is added to the 
current selection 

Subtract a channel [#] [CHANNEL] & 

[-] 

Channel # is subtracted 
from the current selection 

Subtract a group [#] [GROUP] & [-] Group # is subtracted from 
the current selection 

Subtract an effect  [#] [EFFECT] & [-

]  

Effect # is subtracted from 
the current selection 
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At mode syntax  

If your Cobalt is set to use At Mode for channel commands, effects are selected in the following ways. 
You can terminate a selection in At Mode pressing @Level or the decimal point. 

Action  Key Feedback 

Select effect  [EFFECT] [#] Effect # is selected 

Add an effect [+] [EFFECT] [#] Effect # is added to the 
current selection 

Subtract an effect [-] [EFFECT] [#] Effect # is subtracted from 
the current selection 

Add multiple effects [THRU] [#] Up to effect # is added to 
the current selection 

Add a channel [+] [CHANNEL] [#] Channel # is added to the 
current selection 

Add a group  [+] [GROUP] [#] Effect # is added to the 
current selection 

Subtract a channel [-] [CHANNEL] [#] Channel # is subtracted 
from the current selection 

Subtract a group  [-] [GROUP] [#] Effect # is subtracted from 
the current selection 

Select channels from effect 

These functions make it possible to select channels involved in an effect. 

Action  Key Feedback 

Select active channels [EFFECT] & 

[CHANNEL] 

All channels involved in effects 
that are active are selected. 

Select all in effect... [#] [EFFECT] & 

[CHANNEL] 

All channels involved in effect 
playback # are selected. 

Select active effects [EFFECT] & [ALL]

or 

[ALL] & [EFFECT] 

All active effect playbacks are 
selected. Pressing ALL alone 
will never select effect 
playbacks. 

Toggle between 
selecting an effect and 
the channels assigned 
to it. 

[Inv_Eff/Ch] 

or 

[C/Alt] & [INV 

GROUP] 

The soft key Inv Eff/Ch in the 
Effects soft key meny allow 
you to toggle the channel 
selection between the selected 
effect playback and the 
channels assigned to it.  
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Home functions for effects  

A very useful function for effects is Home. You can store a home position for all parameters. 

Action  Key Feedback 

Record HOME  [RECORD] & 

[HOME_ATTRIB] 

All current parameters of 
the selected effect(s) are 
recorded as a home 
position. 

HOME  [HOME] & [EFFECT] All Effect Playbacks move 
to their Home position. By 
default, this will stop all 
Content, Dynamic and 
Image effects but does not 
stop Chases. 

Load an effect to a master 

A single effect playback can be loaded to a master. This allows you to control the effect intensity with 
the master fader. If you press the master key you will select the effect. 

Action  Key Feedback 

Load effect  [#] [EFFECT] & 

[master_key] 

Effect # is loaded to master 
# 
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Effects - Soft Key Page  

The EFFECT soft key provides direct keys for functions related to Effect Playbacks. 

(Soft Key Pages are commands in the lower right corner of screen 2) 

    

Function  Softkey Feedback 

Channel Set List [Channel_Set] Opens the Channel Set List. 
See Channel Sets. 

Series List [Series] Opens the Series List. See 
Series List. 

Effect Overvi [Effect_Overvi] Opens the Effect Overview 
Tab. See Effect Overview. 

Chase  [Chase] Opens the Chase Editor. 
See Chase Editor. 

Dynamics [Dynamics] Opens the Dynamics Soft 
key menu. See Dynamic 
Effects. 
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Effects - Edit 
Effects are edited in the same way as moving devices.  

Attribute wheels 
A soon as an effect is selected the effect parameters are available on live attribute controls in 
parameter banks U1-U3. On Cobalt jr these can be found under the Device softkey or by using [C/Alt 
& [FOCUS], [COLOR], [BEAM] respectively. 

Palettes 
All effect attributes can be stored and played back from All Palettes. 
Hold RECORD and press PALETTE. 

Home 
You can store a home position for every effect playback.  
Hold RECORD and press HOME. 

Fetch 
You can fetch attribute values for any parameter from any preset.  
Hold FETCH and press the parameter wheel key, or PALETTE. 

Mask 
You can mask attribute values for any parameter from any effect playback.  
Hold MASK and press the parameter wheel key. 

See Devices. 
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Effects - Record  
Effects are stored in Presets in the same way devices are stored.  

1. Select the effect  
2. Set a level  
3. Record 

If you have the default device setting "store if active" all effect parameters are stored automatically 
when the intensity is over zero%. 

The level of the effect playback shown and edited in the same way as channel intensities. 
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Effects - Channel Distribution Wizard  
The Channel Distribution Wizard is used for Sets and Chase effects. I allows you to distribute a 
selection of channels into a number of parts (steps) in eight different ways. 

There are two ways to open this wizard 

• Press MODIFY in the PARTS cell in a channel set list or chases list.  
• Create a Chase Object. 

 

1. Select channels  
2. Select number of parts  
3. Select distribution method for the channels into the parts 

These are the different distribution methods. Note that if the number of channels cannot be divided by 
the number of parts, the results will be different when using inverted distribution, since the odd 
channels will end up in the last part. Also, the order in which the channels are selected is the order in 
which they are distributed. 
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Live Effects  
Press EFFECT to open Live Effects. This is where you can view and edit the parameters of all running 
effect playbacks in the screens. In the consoles you can control the same parameters in the Main 
Display over the parameter wheels.  

 

Things to think about in this view 

• Use arrow keys to navigate.  
• Press MODIFY to get a drop down choice for a cell.  
• Hold SELECT and use arrow keys to select several cells for data entry.  
• Select effect with # EFFECT and set levels in live (A) with level wheel & functions.  
• Depending on the Play Setting (Attributes) Attribute Editor Default - all entries directly in 

cells with # MODIFY will be treated as Absolute OR Palettes. The same goes for drop down 
choices (MODIFY). Hold C/ALT to get the alternate data when pressing MODIFY. See Play 
Settings - Attribute. 
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Effect Playbacks  
An effect playback is the control handle for an effect, similar to a channel controlling a moving 
device.  

 

All Effect Playbacks are listed and can be inserted/deleted from the Effect Playbacks list Browser 
>Effects >Effect Playbacks. 

 

Create an Effect Playback  

Effects can be created from the Effect Playbacks list, or as a key command. 

1. Create an Effect Playback 

• Press INSERT in the Effect Playback list  
• Hold INSERT & EFFECT 

2. Select type of Playback (Cannot be changed once inserted, to change you need to delete and 
reinsert the playback).  
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3. Done. You can now control the effect. See Select & Activate Effects. 
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Effect Overview  
The effect overview tab lists all types of data objects that can be involved in creating and editing 
effects. It's opened from the Browser >Effects >Effect Overview. 

• Groups  
• Series  
• Channel Sets  
• Playbacks  
• Chases  
• Dynamic templates 

 

Press MODIFY in any cell to open the corresponding editor. 
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Chase Effects  
This is a step based, defined intensity effect. A chase is what you use when you want lights to chase 
on/off in a specific pattern.  

 

Each step contains channels, step times and step levels. 
 

 

You can define a high level for all channels in a step, and a low level which will be the background 
level of these channels in all steps.  
 
 

 

Components 
To start a Chase effect you need 

• A Chase Object  
• A Chase Effect Playback 

Chase object  
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• Contains the channel list and the high/low intensity levels and timing values.  
• It has a number of steps, with channels, up, dwell and down times.  
• Intensities per step have a Max (high) and Min (low) value.  
• Once a Chase object is programmed it will replay in the exact same way.  

Playback 

• The effect will run as soon as the effect playback intensity is over zero.  
• The intensity level of the effect playback also masters the high level of the output of the 

effect.  
• The intensities will contribute to the Live output on a HTP basis. 

Live Parameters 
A single Chase Effect Playback can be associated with any Chase object. To play back more than one 
Chase object simultaneously you need to insert multiple Chase Effect Playbacks. 

• Change direction (Forward, Backward, Bounce, Random)  
• Change every step time and content  
• Change playback style (Positive, Negative, Build) 

Create a Chase  

Chases are created in the chase channel distribution wizard.  

1. Open the Channel Distribution Wizard. This can be done in two ways. 

• # INSERT & EFFECT.  
• Press INSERT in the Chase List  
• In the Chase List, press MODIFY in the STEPS cell. 
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2. Select channels, parts, name and distribution. See Channel Distribution Wizard. 

3. You can now start the chase, by selecting it and setting a level over zero. See Select & Activate 
Effects. 

It will use the default times and values. These can be edited in the Chase Editor and the Chase Step 
Editor. 

Copy a chase effect 

You can use the COPY function to duplicate a chase effect.  

1. Open the chase editor and select the chase you wish to copy 

2. Press PASTE to create a copy at the end of the chase editor list. 

Control a Chase Effect  

As soon as a Chase Effect playback is selected, you can control it in two ways: 
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• From the console parameter wheels using U1-U3. In Cobalt jr these can be found under the 
Device softkey or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively.  

• From the Live Effects view. 

Live Effects looks like this: 
 

 

Press MODIFY to get a dropdown to change chase, or enter a number and press MODIFY. 

NOTE 
When you press MODIFY or enter a number it will be an absolute value or a 
Palette value - depending on the setting in Attribute Settings. See Play 
Settings - Attribute. 

Chase Tap Tempo  

When you select a Chase Playback, you will have two parameters, Chase # and Rate/Tap.  

Press the Rate/Tap parameter key in the main display of the console to set a Rate/Tap. You can also 
edit this parameter in the Live Effects view. 

Chase Beat Boss  

You can assign a Beat Boss to a Chase and Content effect. It will scale the rate of the effect through a 
master rate that can be shared with other Chase and Content effects. The BPM will be set to 120 with 
the fader at 50%, 240 at the top and 0 at the bottom. To tap a BB on a fader set the FLASH key to 
TAP manually. 

There are 9 Beat Bosses and they can be assigned to a master (see Masters - Beat Boss) and run in the 
Beat Boss tab(See Tab - Beat Boss). 
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The related Beat Boss is added as a parameter in All/U3 tabs when effects with active Beat Boss is 
selected. 

 



Cobalt 8.1 - 20181029 

697 

 

Chase Effect Parameters  
A Chase object is never adjusted live - it is defined in two editors 

• The Chase Editor  
• The Chase Step Editor 

CHASE EDITOR PARAMETERS 
Its possible to edit a symmetrical Chase object from the Editor, without opening the Chase Step editor. 
However, if you want to edit the steps, or the individual step timing, you need to open the Chase Step 
Editor. 

Direction 
Sets the direction in which the steps are played back.  

• Forward  
• Backward  
• Bounce  
• Random 

Style 
The style decides the starting level. 

• Positive (channels go from Low int to High int)  
• Negative (channels go from High int to Low int)  
• Build (channels go from Low int to High int and stay at High int until all steps have been 

executed) 

Loop Time 
This time will force a value to all Step Times = Loop Time/Steps. See Step Time further down. 

In, Dwell & Out times 
These times will force a value to all individual In, Dwell & Out times of the Chase Steps. See In, 
Dwell & Out times further down. 

Rate Min & Rate Max 
RateMin and RateMax work together to set the playback rate of the chase. When these values are the 
same, the chase is adjusted evenly. When these rates differ, the chase will play back randomly using 
rate values between the Min and Max value. This is a good way to create more organic chases for 
things like lightning and water reflections.   

CHASE STEP EDITOR PARAMETERS 
If you need to edit individual step times, or channels, you do this in the Chase Step Editor. 

Step Time 
This is when this step will execute in relation to the previous Step.  

In, Dwell & Out times 
These are the times for each Step. 
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NOTE 
If the Step time is shorter than the sum of In+Dwell+Out you will get a 
"ripple" effect. 

High & Low 
Each Step has a High intensity and a Low intensity that is used by the Chase.  

Chase Editor  

The chase editor is a summary and editor of all chases. You can create (INSERT) and edit chases here. 

• Press the soft key CHASE in the EFFECTS soft key menu  
• Press MODIFY in the Browser node Browser >Effects >Chase. 
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Chase Editor - Functions 

The Chase can only be edited from the Chase Editor and the Chase Step Editor. This ensures that a 
Chase will always play back in the way it is defined.   
Column  Action Feedback 

Chase No Input The number of this chase, cannot be edited. 

Text [MODIFY] Enter a label. 

Steps [MODIFY] Shows the number of steps, press MODIFY 
to open the Channel Distribution Wizard. 

Direction [MODIFY] Choose between forward, backward, bounce 
and random. 

Style [MODIFY] Choose between positive, negative and 
build. 

Loop Time [#] [MODIFY] Sets a total Loop time * 

In [#] [MODIFY] Sets an In time for all steps** 

Dwell [#] [MODIFY] Sets a Dwell time for all steps** 

Out [#] [MODIFY] Sets an Out time for all steps** 

RateMin [#] [MODIFY] Defines a random minimum variation for 
Step times*** 

RateMax [#] [MODIFY] Defines a random maximum variation for 
Step times *** 
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*The Default times are applied until you define a different time in the Chase Steps Editor. 
**Loop Time = the amount of time it takes to pass through all the steps of the chase once. Edit the 
loop time and all step times will be adjusted to evenly fit within this time value.. 
***RateMin and RateMax work together to set the playback rate of the chase. When these values are 
the same, the chase is adjusted evenly. When these rates differ, the chase will play back randomly 
using rate values between the Min and Max value. This is a good way to create more organic chases 
for things like lightning and water reflections. 

Chase Step Editor  

The Chase Step Editor allows you to edit channels, levels and times for each step separately. 

• Press MODIFY in the STEPS cell of the Chase Editor. 
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Chase Step Editor - Functions  

The Chase can only be edited from the Chase Editor and the Chase Step Editor. This ensures that a 
Chase will always play back in the way it is defined. Timing information on a step level overrides 
timing information on the Chase Editor top level.  

Column  Action Feedback 

Step  Shows the number of each steps. 

Step time [#] [MODIFY] Sets a Step time. 

In [#] [MODIFY] Sets an In time for all steps* 

Dwell [#] [MODIFY] Sets a Dwell time for all steps* 

Out [#] [MODIFY] Sets a Out time for all steps* 

High [#] [MODIFY] Sets the High level for this step, which 
is applied to all channels when the step 
is active. 

Low [#] [MODIFY] Sets the Low level for this step, which is 
applied to all channels when the step is 
active. 

Channels   Displays the channels in this step. 

*Times set from the Chase Editor top level are edited per step here. 
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Content Effects 
Content effects are simply speaking simply a series of steps containing show content like palettes and 
presets or even raw parameter levels that you can apply to any existing group (or set) in your show. 

 

The simplest form of content effect is the intensity series (on/off) that is created automatically when 
you make a new play. By applying this to a group of channels you can create chase, ripple and 
pulsating intensity effects on the fly. There is a default intensity content effect when you create a new 
play from v6.0. 

Try this 

1. Open Demo_Tour  
2. Open the Files >Training project >Demo Tour  
3. Select Effect 2 (2 EFFECT)  
4. In the Device Control tab set the following paramters 

ChSource = Group 
Group = G:1 VL Spot 
GrpParts = Parts 6 
Series = Intensity  

5. Bring the level wheel to full - Channels 51-56 should be performing an intensity chase now.  
6. Change Group to G:2  VL Wash - Channels 57-60 should be perfomring the same chase now. 

 
To record press RECORD and create a preset.  

 

A more complex example of a content effect could be "set all devices in the target group that have a 
color mix to blue, then pop to white two by two from sides to center" and it's easy to add two lines of 
code to the series to make them "fly out when they pop to white". 

General 
The content effect separates the channel source (group or channel set) from the actions within the 
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effect (series). Actions are defined using steps that can contain palettes, presets or parameters. Content 
effects can switch channel lists and/or series of steps independently and can be run in three different 
modes to change how the channel lists and steps interact with each other. 

 

Content effects can be run in three different modes to change how the channel source and Series 
interact with each other.  

• Break  
• Continuous  
• Build 

See Content Effect Modes. 

Components 
To start a Content effect you need 

• A channel source (a Group or Channel Set)  
• A Series  
• An Effect Playback 

 Playback 

• All parameters can be controlled live, similar to how a device is controlled  
• The effect is applied to any predefined set or group of channels.  
• The effect will run as soon as the effect playback intensity is over zero.  
• The intensities will contribute to the Live output on a HTP basis.  
• Attributes will replay on an LTP basis with the rest of the playbacks. 

Live Parameters 

• Change channels (set/group)  
• Change distribution of groups (parts, symmetrical, interlaced, random)  
• Change Part direction (forward, reverse)  
• Change Play mode (Stop, Pause, Play forward, Random etc)  
• Change Mode (Continuous, Break, Build)  
• Change Rate plus times (attack, release, step, etc)   
• Change Rate with the wheel or with tap 
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Create a Content Effect Playback  

1. Create a Content Effect Playback. This can be done in two ways. 

• # INSERT & EFFECT and select Content .  
• Press INSERT in the Effect Playbacks List, and select Content . 

Now that the effect playback is created you can apply it to any channel group, or you can create 
channel sets and select them. You have to have a Series defined, since it is the engine of the content 
effects.  

2. You can now start the effect, by selecting it and setting a level over zero. See Activate & Control 
Effects. 

NOTE 
The Effect playback is controlled similar to how a moving device channel is 
controlled. A level above 0 starts the non-intensity content and the intensity 
level of the playback masters the intensity levels within the effect.  

Control Content Effects  

As soon as a Content Effect playback is selected, you can control it in three ways: 

• From the Device Controls tab- this is the absolutely easiest way.  

 

• From the console parameter wheels using U1-U3 (In Congo Jr/Kid these are found in the 
Effect soft key page, or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively).  

 

• From the Live Effects view (if editing is enabled). <Press EFFECT. 
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Step around with arrow keys, press MODIFY to get a dropdown, or enter a number and press 
MODIFY. 

NOTE 
When you press MODIFY or enter a number it will be an absolute value or a 
Palette value - depending on the setting in Attribute Settings. See Play 
Settings - Attribute. 

Content Effect Parameters  

Besides the necessary channel source (Group or Channel Set) and Series, a number of parameters 
are combined to define the result of a Content effect. You can adjust all of them live by selecting the 
Effect Playback.  

The Parameters are divided into two main groups: 

• Content & Play Mode  
• Timing 

CONTENT & PLAY MODE PARAMETERS 

Channel Source 
The Channel Source that the effect is applied to can be a Set or a Group. See Channel Sets and 
Groups.  

• The advantage with a Set is that you can define any type of custom channel distribution over 
the parts, and they will always replay in the same way.  

• The advantage with Groups is that you can reuse all Groups you have already recorded, and 
create distribution and number of parts on the fly with the GrpParts and GrpDistri 
parameters.  
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Set/Group 
Select a Set or Group as the Channel Source. 

NOTE: There is a special option named Groups (Auto) which will set the number of parts to a 
selected group to the number of channels in this group - allowing for a single step chase effect.  

GrpParts 
If you have selected a Group as the Channel Source, this parameter defines how many parts the Group 
is divided into. 

NOTE: There is a special option named Groups (Auto) which will set the number of parts to a 
selected group to the number of channels in this group - allowing for a single step chase effect.  

GrpDistri 
If you have selected Groups as the Channel Source, this parameter defines the channel distribution 
over the Group Parts. The options are the same that are available in the Channel Distribution Wizard 
used to create Sets. See Channel Distribution Wizard. 

PartDirec 
Allows you to run the Set or Group parts Forward or Backward.   

Series 
A list of steps that execute specific kinds of play content or parameter settings. Each step may have 4 
kinds of content - Intensity + three variable slots that can contain palettes, presets or direct parameter 
data. Each of those four pieces of content may have their own "Attack" (fade) time within the step. 

Play Mode 
There are a number of play modes: 

• Stop  
• Pause  
• Play Forward  
• Play Reverse  
• Bounce  
• Random 

The Play mode generally refers to the way the Series gets played back, so between PartDirec and 
PlayMode you can change the direction of the channel source but have the steps play back as written, 
or vice versa. 

Mode 
Content Effect can play back it's Series in three modes, Continous, Break and Build. The result 
differs quite a lot. Some Series are set to a default mode, because they are designed to be played back 
this way. 

• In a Continuous mode content effect, parts are always executing a step. In a three color Red-
Green-Blue effect, all channels would be in one of those three colors all the time the effect is 
running.  

• In a Build mode content effect, all parts execute step 1 before they execute step 2. Using the 
same series as above, all parts would become red using the step and attack times until all 
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channels are red, then they would each step into green until all are green, then they would 
start stepping into blue.  

• In a Break mode content effect, assuming you have more parts than steps, then part 1 will 
execute the "active" portion of the series and when done it will fade into the Background 
state (step 0) and wait there (take a "break") until all the other parts have executed the active 
steps in the series. When using Break mode, the "sustain" and "release" times on the active 
steps come into play - if you think about the stadium "wave" phenomenon at football matches 
you'll know what I mean - the active step is to "Stand up and raise your arms" and the 
background state is "sit down". The attack time is how long it takes you to stand up, the 
sustain time is how long you remain standing, and the release time is how long it takes  you 
to sit back down again. The background state has no timing of its own, as it is used when the 
channel is not doing anything else. 
 
As you see in the example, the step time will control if each step goes into the background 
between steps. 
 

 
 

 

  

 

TIMING PARAMETERS 

Loop Time 
This time equals how long it takes all the parts to run through the effect once. If you lengthen this 
time, you will impose a gap before the next pass through the effect begins. If you shorten this time, 
you will cause the next pass to start before the first pass is completed. 

Rate/Tap 
Use this value to scale the whole timing scheme faster or slower. Tapping the wheel key will adjust 
the timing of the effect to match your tapped in rate. Fade times will scale appropriately when you use 
tap.  

Entry 
The Entry mode decides how channels will enter into the effect. 
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Step Time 
The tempo of the effect - this time determines when each step will be executed.. 

Attack Time 
The fade time of the associated step or individual piece of content.. 

Sustain & Release times (Break mode only) 
This time determines how long a step remains active before starting the  release to the background 
state. If a break mode effect has more than one active step, each step may execute a sustain and release 
to the background only if the step time is greater than the combined attack+sustain+decay times of the 
step, otherwise you will only see attack times executed until the last active step. 

. 

Content Effect Beat Boss  

You can assign a Beat Boss to a Chase and/or Content effect.  

A Beat Boss provides a base tempo value that can be scaled by the TapRate parameter of the effect 
playback. Effect playbacks may share a Beat Boss, providing a way to synchronize different effects. It 
is not recommended to group chase and content effect playbacks together onto the same Beat Boss. 

 

There are 9 Beat Bosses and they can be assigned to a master (see Masters - Beat Boss) and run in the 
Beat Boss tab(See Tab - Beat Boss). 

The related Beat Boss is added as a parameter in All/U3 tabs when effects with active Beat Boss is 
selected. 
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Content Effect Return To Parameter  

There is a Return To parameter in the Device Controls tab to specify a specific position that the effect 
should return when it fades out.  

 

Select  

• Master 1-80  
• Main Playback field A  
• Main Playback field B  

When the effect handle fades out to zero, the corresponding preset will be executed with 0 time. To 
generate a differently timed exit from the effect in a sequence, use channel times or delay times to 
craft the specific behavior you need. 
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Series List  
The engine of a content effects is a Series. Browser >Effects >Content Effect >Series.  

• You can think of a series as a number of place holders for parameter and intensity data.  
• Each place holder has timing data that applies when it is called upon.  
• There is a special place holder called background, that is used when effects are played back 

in Break mode.  
• The place holders are general, and can be applied to any type of channel or moving device 

with the same parameters. 

This is the Series List, press INSERT to create a new one. 
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Series List - Functions  

Column  Action Feedback 

Series No Input This item can not be 
changed. 

Text [MODIFY] Label for this Series. 

Steps No Input Shows the number of steps. 

Def. Mode [MODIFY] Opens A dropdown where 
you can choose default 
mode Continuous, Break or 
Build* 

Def. StepTime [#] [MODIFY] Sets a top level Step Time 
for all Serie Steps** 

Def. AttackTime [#] [MODIFY] Sets a top level Attack 
Time for all Serie Steps** 

Def. SustainTime [#] [MODIFY] Sets a top level Sustain 
Time for all Serie Steps** 

Def. ReleaseTime [#] [MODIFY] Sets a top level Release 
Time for all Serie Steps** 

*Often Series are written that will be used most often in a specific mode. The Default mode is applied 
within the Content Effect Playback automatically when the series is selected. The mode can be 
changed within the playback as needed.  

**The Default times are applied until you define a different time in the Series Steps Editor. 
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Series Step Editor  
The Series Step Editor is opened by pressing MODIFY in the Series or Steps cell of the Series List 
(above). 

 

NOTE  
When Palettes/Presets are used as content, the values will reference only to 
the numbers of these Palettes/Presets (not the names) - this is so that you can 
reuse the same series in other plays easily.  

If you are doing a lot of series creation, the Groups/Palettes Overview tab is a 
good way to know what you have already recorded.. 
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Series Step Editor - Functions  

Column  Action Feedback 

Step No Input This item can not be changed. 

Text [MODIFY] Enter a Step Text. 

Step Time [#] [MODIFY] This is the Step Time* 

Intensity [#] [MODIFY] Set an intensity level 0-100 or nothing. A 
hard 0 is indicated with "M". 

Attack [#] [MODIFY] Sets an Attack time for Intensity in this 
Step* 

1. Content [MODIFY] Opens a dropdown where you can select the 
first content type for this step 

Attack [#] [MODIFY] Sets an Attack time for this Content in this 
Step* 

2. Content [MODIFY] Opens a dropdown where you can select the 
second content type for this step** 

Attack [#] [MODIFY] Sets an Attack time for this Content in this 
Step* 

3. Content [MODIFY] Opens a dropdown where you can select the 
third content type for this step** 

Attack [#] [MODIFY] Sets an Attack time for this Content in this 
Step* 

*All Step timing is set to 100% of the Default times in the Series (one level up). 
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Content Effect Modes  
A Content Effect can play back its Series in three different modes: 

• Break  
• Continuous  
• Build 

In the Series Editor you can define a default mode that is set every time the Series is activated. It's 
possible to change this mode on the fly when you edit the Effect Playback parameters. See Series List. 

What mode do I use? 

The modes allow you to get completely different results, using the same Series. The beauty of the 
Content Effect is that it allows you to get very specific results with little programming effort. We can 
provide some examples, but the whole idea is that you create your own unique effects using this 
powerful tool. 

EXAMPLES OF APPLICATIONS 

"All in blue, then pop to white one by one" 
This can be done with a Content Effect in Break mode, with just a Background state (blue) and one 
step (white).  

 

In this example color palettes 1 (blue) & 2 (white) were used. It could have 
been absolute values for Cyan, Magenta and Yellow as well.  

"A fly out" 
This can be done with a Content Effect in Break mode with a starting point (usually pointing down 
with no intensity and two steps, 1) to turn the intensity on and move to the "away" position and 2) to 
turn the channels off again before they return to the background state. 
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A fly out can be done with a Dynamic Effect, but you have no control over the 
specific start and end points for each device. Here this is easy to change at 
any time by re-recording either of the two focus palettes used.. 

"An RGB chase" 
This can be done with a Content Effect in Continuous mode with three steps, (color palettes "red", 
"green", "blue").  

 

In this example Color Palettes are used, although we could have used 
absolute values for CMY just as well. 

"An intensity ripple chase" 
This can be done with a Content Effect in Break mode, with just a Background state (intensity = 0) 
and one step (intensity = full).   
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It is the combination of the parts distribution and the step timing that creates 
the overlapping ripple behavior. If the Attack+Sustain+Decay time is greater 
than the step time, you get ripple (overlapping) behavior. The number of 
Parts in the Channel Source will define how "wide" the ripple is. 

Content Effect Times  

Timing information is set in two levels 

• In the Series List  
• In the Series Step Editor 

In the Series list, the default times are 

• Default Step Time  
• Default Attack Time  
• Default Sustain Time (Break mode only)  
• Default Release Time (Break mode only) 

 

See Series List. 

In the Series Step editor, the times are 

• Step Time  
• Attack Time (separate for Intensity and each content 1-3 in each step)  
• Sustain Time (Break mode only) per step  
• Release Time (Break mode only) per step 

See Series Step Editor. 
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Dynamic Effect  
A dynamic effect is a relative effect that uses a dynamic template which applies wave-forms around a 
base point to create a movement, for example a circle or ballyhoo. In the same way as the content 
effect, it is applied to any group or set. 

 

Components 
To start a Dynamic effect you need 

• A Group or a Channel Set  
• A Dynamic Template (many are supplied default)  
• An Effect Playback 

Playback 

• All parameters can be controlled live, similar to how a device is controlled  
• Once programmed you can also change the Dynamic Template (circle, ballyhoo) or create 

your own.  
• The effect is applied to any predefined set or group of channels.  
• The effect will run as soon as the effect playback intensity is over zero.  
• The intensities will contribute to the Live output on a HTP basis.  
• Attributes will replay on an LTP basis with the rest of the playbacks.  

Live Parameters 

• Change channels (set/group)  
• Change distribution (offset, delay, distribution)  
• Change Rate & Size  
• Store and recall all settings into palettes and presets, similar to how any device is controlled. 

A number of common Dynamic Effect Templates are included in the Effect Library of the Browser. It 
is possible to create new ones as well. If you are acquainted with SmartFade effects, you will find that 
SFML style tables and effects have been added to the library. 

Waveforms - Dynamic Templates & Tables 

Dynamics are a way of creating effects by assigning waveforms (sinus, saw etc) to intensity, color, 
movement or any other parameter. you can define custom tables. See Dynamic - Tables. 
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Examples: 

  

The waveform will "run" the parameter it is assigned to, but you can still move the "base value" of the 
parameter that the Dynamic is working with.  

NOTE 
To create a movement, like a "Circle" for a moving Device, two sinus waves 
are applied to pan and tilt, and one of them is offset 25%.  

Create a Dynamic Effect Playback  

1. Create a Dynamic Effect Playback. This can be done in two ways. 

• # INSERT & EFFECT and select Dynamic.  
• Press INSERT in the Effect Playbacks List, and select Dynamic. 

Now that the effect playback is created you can apply all existing Dynamic templates to any channel 
group, or you can create channel sets and select them. The Effect playback is controlled similar to 
how a moving device is controlled. Select the effect and use the parameter wheels or the Live Effects 
editor. 

2. Select the Effect, to start is set a level over zero. See Select & Activate Effects. 

Control a Dynamic Effect  

As soon as a Dynamic Effect playback is selected, you can control it in two ways: 

• From the console parameter wheels using U1-U3. On Cobalt jr these can be found under the 
Device softkey or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively.  

• From the Live Effects view. 
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Live Effects looks like this: 
 

 

Step around with arrow keys, press MODIFY to get a dropdown, or enter a number and press 
MODIFY. 

NOTE 
When you press MODIFY or enter a number it will be an absolute value or a 
Palette value - depending on the setting in Attribute Settings. See Play 
Settings - Attribute. 

  

Dynamic Effect Parameters 

A number of parameters are combined to define the result of applying a Dynamic Template to a 
channel Set or Group. You can trim all of them live by selecting the Effect Playback. 

Channel Source 
This can be a Set or a Group. See Channel Sets and Groups. 

Set/Group 
Select which Set or Group. 

Dynamic Template 
Templates are pre-defined in the Dynamic Templates editor. You can create your own as well. See 
Dynamic Templates. 

Size and Rate  
The Size relates to how much the values will vary in relation to the base point. Rate defines fast the 
result is. See Dynamics - Size & Rate. 
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Offset 
The offset parameter distributes the channels along the waveform. See the example with 5 channels on 
a sine wave. See Dynamics - Relations & Distance. 

 

Delay Relation & Distance  
The Delay Relation defines when each channel starts in relation to the next. The Distance defines how 
long each channel will travel before the next is started. These two work together. If Delay Relation is 
set to ALL there will be no change, since distance needs at least two parts. See Dynamics - Relations 
& Distance. 
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Dynamic Templates 
Dynamic Templates are definitions of waveforms applied to parameters used for Dynamic Effects. 

Open from the Browser >Effects >Dynamic Effect > Dynamic Templates. 

 

Dynamic Effect Library - Columns & Functions 

Column  Input Function 

Effect [MODIFY] Starts the selected Effect for the currently selected 
channel(s). 

Text [MODIFY] Press MODIFY to activate and end text input. 

Parameters [MODIFY] Opens the Dynamic Template editor. See Dynamic 
Template Editor - Create. 

OffsRel [MODIFY] See Relations & Distance 

DelayRel [MODIFY] See Relations & Distance 

Distance [#] 

[MODIFY] 

See Relations & Distance 

Dynamic Template Editor - Create 

1. Open the Effect Library from the Browser >Effects >Dynamic Effect > Dynamic Templates 

2. Go to the last step using the arrow keys. 

3. Press INSERT to create a new Template. 
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4. Go to TEXT and press MODIFY to enter a name. Press MODIFY again to confirm. 

5. Go to Parameters and press MODIFY to open the Template Editor. 

6. Press INSERT to create a step. Each step contains the settings for a single parameter - for example, 
a pan/tilt effect would have two steps. 

 

See Dynamic Template Editor - Functions. 

Dynamic Template Editor - Functions 

Column  Input Function 

Ch.Index [#] 

[MODIFY] 

0 means all selected channels are affected by this step. 
For numbers >0 only channels that match this index 
number will be activated. For example "2" means that 
only every second channel will be affected (of the 
selected channels). 

Parameter [MODIFY] Opens a dropdown. Select which parameter this step shall 
affect. 

Table [MODIFY] Opens a dropdown. Select which table this step should 
apply. See Dynamics - Tables. 

Delay [MODIFY] A delay in % before the step starts to move 

Offset [MODIFY] An Offset in % where in the table this step starts 

Size [#] 

[MODIFY] 

See Size & Rate 

Rate [#] 

[MODIFY] 

See Size & Rate 

Wait [#] 

[MODIFY] 

A wait time, in percent (1- 1000%) for this step before it 
is repeated. The Wait time is  relative to all other steps. 
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Dynamic Tables 
The basic element of a Dynamic effect is a wave-form, or "table", that is assigned to the intensity or 
any other attribute parameter of a channel.  

A Sine wave, for example, will fade a parameter up/down continuously over/under the current Base 
Value.  

By changing the Rate and Size of this Sine Wave, you will affect the speed and value range of the 
result.  

Although the idea of tables is very technical, it really requires little technical understanding: most 
designers prefer to experiment with different tables and parameters to understand - the effect of a Sine 
Wave is too different on a color parameter, compared to pan or intensity, to explain in detail here. 

These are the tables 

Table  Description 

Stop A "Stop Dynamics" table 

Sine A normal sinus wave 

Step An "on-off" wave 

Sawtooth A linear "fade up - fade down" wave 

Ramp A "fade up-cut down" wave 

RampInv A "cut up - fade down" wave 

MarkOn "On-longer-than-off" used for fly-in or fly- outs 

MarkOff "Off-longer-than-on" used for fly-in or fly- outs 

Spiral A sinus wave with varying amplitude 

Tangent A sinus wave with a "sharp top" 

Random1 Random curve 1 

Random2 Random curve 2 

Random3 Random curve 3 

NOTE  
If you are used to working with for example WholeHog (tm) Tables, a Sine + 
90 degrees is a Sine with an offset of 25% here. 

Table Editor  

Press INSERT to create new tables at the end  of the table list in the Browser, but not delete existing 
ones since this would mess up the indexing of existing tables used by effects. 
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Browser >Effects >Dynamic Effects >Dynamic Table List 

  

Pressing MODIFY on a table opens the Dynamic Table Editor where you can insert and delete table 
values. You cannot have more than 64 points in a table.  

This is the Dynamic Table editor with a Step table. 
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Live Dynamics (old) 
This tab is used with the old Dynamic Effects package from Congo. See Dynamics (old). 

All parameters of running Dynamic Effects can be edited in the Live Dynamic Effects tab. This tab 
can be opened from the Browser (Browser >Live Dynamic Effects). 

The top right corner shows a pan/tilt monitor with a dot representing each channel. This is a 
visualisation for the Offset Relation, Delay Relation and Distance values. 

 

NOTE 
If you start to select channels in Live Dynamics, you will get a popup if you 
want the selection to affect the running effect or not. Once you have said yes 
to this, all channel selection will update the running effect until you close and 
reopen Live Dynamics. 

RECORD and UPDATE cannot be used when this tab is focused. Select 
LIVE to use them. 
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Live Dynamic Effects - Columns 

Column  Input Function 

Library [MODIFY] Opens a dropdown to select a Dynamic 
Effect from the Effect Library. 

Status No input Running status. Cannot be edited. 

Channels No input The amount of channels assigned to this 
Dynamic Effect.  

Size [#] [MODIFY] Set the size from 1-1000%. See Size & 
Rate 

Size Channel [#] [MODIFY] Assign a size channel. See Size & Rate 

Rate [#] [MODIFY] Set the rate from 1-1000%. See Size & 
Rate 

Rate Channel [#] [MODIFY] Assign a rate channel. See Size & Rate 

Offset Relation [MODIFY] See Relations & Distance 

Delay Relation [MODIFY] See Relations & Distance 

Distance [MODIFY] See Relations & Distance 

Text [MODIFY] Press MODIFY to activate and end text 
input.  

Fade [MODIFY] See Fade 

Loop Count [#] [MODIFY] See Loop Count 

Form [MODIFY] See Form 
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Old Dynamic Effects 

The old Dynamic Effects prior to Cobalt v5 are still compatible and work in 
the same way. They are much more limited, so we recommend you to use the 
new ones unless you are importing an older Play.  

This chapter contains the following sections 

• Dynamics - Base Value  
• Dynamics - Start  
• Dynamics - Control  
• Dynamics - Stop  
• Dynamics - Record  
• Dynamics - Preset Dynamics  
• Dynamics - Size & Rate  
• Dynamics - Relations &Distance  
• Dynamics - Loop Count  
• Dynamics - Fade  
• Dynamics - Form  
• Dynamics - Fetch from A Preset  
• Dynamics - Playing Back  
• Dynamics - Store Running 
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Dynamics - Base Value 
When a Dynamic Effect is activated, it will run with the current position of the corresponding attribute 
or intensity as a Base Value.  

If you change this Base Value, the Dynamic Effect will follow. If you run a Preset with a Dynamic 
Effect and then run another Preset with a new base value, the default action is for the Dynamic Effect 
to fade out. Use the Keep Dynamics setting to allow the Dynamic Effect to play through Presets. See 
Record Keep Dynamics. 

If a pan/tilt effect such as Circle is running for a moving Device, you can change the Base Value by 
moving Pan and Tilt, or by selecting a Focus Palette. 

NOTE 
If the Base Value is too small, some effects will not be visible, for example 
color mix and intensity effects. Set the Base Value to 50% for maximum 
effect. 
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Dynamics - Start 
Dynamics are activated for the currently selected channel(s). The current attribute and intensity values 
are used as the Base Value for the Dynamic Effect.  

A "D" will appear in the top right corner of the channel symbol. 

 

NOTE 
Activating a Dynamic Effect will "lock" the attributes and intensities of the 
selected channels to the Dynamic Effect.  
See Dynamics - Stop. 

Start Dynamics By Number 

Function  Key Feedback 

Start Dynamic Effect # [#] [DYN_EFFECT] Dynamic Effect # is 
activated for the currently 
selected channel(s).  

Start Dynamics From The Effect Library Tab 

Action  Key Feedback 

1. Open Effect Library [MODIFY] & 

[DYN_EFFECT] 

The Effect Library tab is 
opened. 

2. Select Effect Arrow Keys Up/Down The selected Effect is 
highlighted. 

3. Start Effect [MODIFY] The selected Effect is 
activated for the currently 
selected channel(s).  

4. Exit Effect Library [ESC] The Effect Library tab is 
closed. 



Cobalt 8.1 - 20181029 

730 

 

Start Dynamics From The Effect Library Node  

Action  Key Feedback 

1. Select the Browser [BROWSER] The Browser is selected 
and highlighted. If it was 
already selected it is closed. 
Press again to open. 

2. Go to the Effect Library 
node 

Arrow keys Up/Down The Effect Library node is 
highlighted. 

3. Open the Effect Library 
node 

Right arrow The Effect Library node is 
opened. 

4. Select an Effect Down arrow The selected Effect is 
highlighted 

5. Start the Effect [LOAD] The selected Effect is 
activated for the currently 
selected channel(s).  

Start Dynamics From The Direct Selects 

Action  Key Feedback 

1. Select Dynamics for a 
section 

[TYPE] & 

[Dynamics] 

When TYPE is held you 
can select Dynamics for a 
section. The first ten 
dynamics are displayed in 
the section immediately. 

2. Activate a Dynamic Section keys 1-10 The selected Effect is 
activated for the currently 
selected channel(s).  

See Direct Selects. 

Start Dynamics With Direct Mode 

1. Hold DYN EFFECT (don't let go until the Dynamics are started). 

- When this is held, the first 40 Dynamic Effects in the Effect Library are displayed on the Direct 
Select keys.  

2. Activate a Dynamic by pressing the corresponding key 

3. Let go of DYN EFFECT. 
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Dynamics - Control 
The Dynamics Soft Key Page in the Main Display of the console facepanel is opened by pressing 
DYNAMICS in the Effects soft key page. 

      

It has the following functions for controlling live Dynamics 

• Clear Dynamics Soft Keys  
• Dynamic Wheels  
• Delete Selected Dynamics in Display List (soft key)  
• Keep Dynamics in next Preset (soft key)  
• Set Distance in % (soft key) 

Clear Dynamics Soft Keys 

The Clear Dynamics soft keys are used to clear and/or stop running Dynamics.  

• Select All active Dynamics (SELECT ALL)  
• Clear all Selected Dynamics (CLEAR SELECT)  
• Delete All running Dynamics (DELETE ALL) 

See Dynamics - Stop. 
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Dynamic Wheels - Size, Rate, Offset & Delay 

Wheels 1 and 2 are used to set Size and Rate for Live Dynamics. See Dynamics - Size & Rate. 

• Select channels and set values.  
• Set numerical values with # and Wheel Key.  

Wheels 3 and 4 are used to set Offset and Delay relations. See Dynamics - Relations & Distance. 

• Hold the key and use the wheel.  

Keep Dynamics In Next Preset 

The KEEP DYNAM soft key is used to record a new base position for a running Dynamic Effect. See 
Record Keep Dynamics (New Base Value).  

Set Distance In % 

The DISTANCE soft key is used to set the Distance % parameter for the selected running Dynamics 
directly. See Dynamics - Relations & Distance.  
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Dynamics - Stop 
Dynamic Effects can be stopped in the following ways. 

• Stop Dynamics manually  
• Activate A Dynamic Stop Table  
• Delete the Dynamic from Live Dynamic Effects  
• Delete the Dynamic using the Dynamics display  
• Fade in a Preset in the Main Playback  
• Load a new Sequence to the Main Playback* 

*Providing the Auto-Stop parameter in the System Settings is set to ON. See System Settings. 

Moving Device attributes are stopped automatically when a new value is played back from any 
Playback or Master. Intensity Dynamics can only be stopped with the Stop Dynamics table of the 
manual stop functions.  

NOTE 
Dynamics act like Attributes - they are executed in A or B depending on the 
GoOnGo or GoInB flag of the step.  
See Device Play back - GoOnGo or GoInB. 

There is also an option in Settings to have them always start on GO. See 
Settings - Crossfade. 

Stop Dynamics Manually 

Action  Key Feedback 

1. Select channels Channel functions The selected channels are 
highlighted in the Channel 
View 

2. Stop Dynamics [C/Alt] & 

[DYN_EFFECT] 

All Dynamics are cleared 
for the selected channel(s) 

This is a shortcut to select all channels with Dynamics assigned to them. 

Function  Key Feedback 

Select all channels with 
dynamics 

[CHANNEL] & 

[DYN_EFFECT] 

All selected channels are 
highlighted in the Channel 
View 
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Activate A Dynamic Stop Table 

Intensity Dynamics can only be stopped by assigning a Stop Intensity Table. There is a STOP I 
Dynamic in the Effect Library for this.  

1. Select the channels 

2. Assign the "STOP I" Effect (See Dynamics - Start) 

You can record this to the Preset in the A field of the Main Playback.When the Preset with this Stop 
Table is activated, the Intensities will fade the size of the Dynamic Effect using the IN time of this 
Preset.  

Delete A Dynamic From Running Dynamics 

1. Open the Live Dynamic Effects Tab from the Browser. 

 

2. Select a Dynamic effect with the arrow keys 

3. Press DELETE to stop (a popup will ask for confirmation) 



Cobalt 8.1 - 20181029 

735 

 

 

4. Press MODIFY to confirm. 

Fade In A Preset In The Main Playback 

When a Preset with new attribute values is faded in the Main Playback, any active Dynamics for those 
attributes will be stopped. 

Load a new Sequence to the Main Playback  

When a new Sequence is loaded to the Main Playback, all running Dynamics are stopped the next 
time GO is pressed.  
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Dynamics - Record 
Dynamic Effects are recorded in Presets for playback.  

• Only Dynamics that have changed or are started since you last pressed RECORD will be 
stored.  

• Record Mode should be set to AUTOMATIC for attributes.  
• A "Keep Dynamic" flag can be set to a Preset. This will allow the Dynamic to move to new 

base values without stopping the Dynamic. 

Record Changed Dynamics 

Function  Key Feedback 

Record* Dynamics to 
Preset # 

[#] [RECORD] All channels are recorded 
including all running 
Dynamics to Preset # 

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes. 

Record Dynamics To Another Preset 

Function  Key Feedback 

Record* Dynamics to 
Preset # 

[#] [RECORD] & 

[DYN_EFFECT] 

All changed and/or selected 
channels are recorded with 
running Dynamics to Preset 
# 

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes. 

Record Dynamics To A Master 

Function  Key Feedback 

Record* Dynamics to 
Master # 

[RECORD] & 

[Master_Key] 

Selected channels are 
recorded including running 
Dynamics to Master # as 
the next free Preset. 

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes. 
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Record Keep Dynamics (New Base Value) 

Keep Dynamics will set a Keep Dynamics flag to an existing Preset. When this Preset is played back 
in a Sequence it will change the Base Values for a running Dynamic Effect without stopping it. 

There are two ways of setting this. From a checkbox in the Recording Popup, or from the Dynamics 
Soft Key page (described below). See The Recording Popup. 

1. Select the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing 
DYNAMICS in the top menu. 

      

2. Press KEEP DYNAM.  

The Currently running dynamics are stored with a Keep Dynamics flag in the Preset active in the A 
field of the Main Playback. Keep dynamics is shown with a waved line under the value in the Preset 
Attribute Editor. 

You can store to a different Preset by entering a number before Keep Dynam. The Preset has to be 
recorded first. 

NOTE 
You can set a Keep Dynamics flag for a parameter group (Focus, Color, 
Beam) by holding KEEP DYNAM and pressing either of these keys. 
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Dynamics - Preset Dynamics Editor 
The Preset Dynamics Editor is identical to the Live Dynamics Editor. All editing functions are the 
same. See Dynamics - Edit Live Dynamic Effects . 

 

Function  Key Feedback 

Open Preset Dynamics 
Editor for Preset # 

[#] [PRESET] & 

[DYN_EFFECT] 

Dynamic Editor for Preset 
# is opened. 

Open Preset Dynamics 
Editor for the Preset in A 

[PRESET] & 

[DYN_EFFECT] 

Dynamic Editor for the 
Preset in A is opened 

Open Preset Dynamics 
Editor for the Preset in A 

[DYN_EFFECT] & [A] Dynamic Editor for the 
Preset in A is opened 

Open Preset Dynamics 
Editor for the Preset in B 

[DYN_EFFECT] & [B] Dynamic Editor for the 
Preset in B is opened (4.2) 

NOTE 
You can open this editor in two more ways 

• Double-click on "Dyn:#" in the Sequence Playback View  
• Press MODIFY in the Dynamics Column of a Preset List 
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Dynamics - Size & Rate 
Each Dynamic Effect has a Size (amplitude) and Rate (frequency) value. It is possible to assign an 
intensity channel to each of them. 

You can set Size and Rate for running Dynamic Effects with the wheels in the Dynamics Soft Key 
Page. See Dynamics - Control. 

NOTE 
From 4.2 it is no longer possible to modulate the size or rate of a dynamic 
effect using another intensity dynamic effect on the size/rate channel. This 
may change the behaviour of existing plays if this rare feature has been 
programmed. 

Size 

Sets the size (amplitude) of the waveforms in a Dynamic Effect. It is set from 0-1000%.  

 

This can be set with the first parameter wheel in the Dynamics Soft Key Page of the Main Display in 
the Cobalt facepanel. (DYNAMICS softkey) 

It can also be set in the Preset- and Live Dynamic Effects tabs.  
See Live Dynamic Effects and  Preset Dynamic Effects 

Size Channel 

Any channel can be set to control the Size of a Dynamic Effect. At 50% it does not affect the 
programmed Size at all. At 0% the Effect is stopped, and at 100% the Size is doubled. 

 

The channel is marked with SIZE in the Channel Views.  
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Rate 

Sets the rate (frequency) of the waveforms in a Dynamic Effect. It is set from 0-1000%.  

 

You can also change this parameter with the second parameter wheel in the Dynamics Soft Key Page 
(press DYNAMICS in the Index Page). 

It can also be set in the Preset- and Live Dynamic Effects tabs.  
See Live Dynamic Effects and  Preset Dynamic Effects 

Rate Channel 

Any channel can be set to control the Rate of a Dynamic Effect. At 50% it does not affect the Rate at 
all. At 0% the Effect is stopped, and at 100% the Rate is doubled. 

 

The channel is marked with RATE in the Channel Views.  
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Dynamics - Relations & Distance 
Offset Relation, Delay Relation and Distance set all channels to perform a Dynamic one after the 
other, or overlapping.  

These parameters can be set in the Live Attribute editor and from the Dynamic Display soft key page. 

Offset Relation 

Specifies when channels start in relation to the table assigned to them 

 

Offset is set in the Dynamic Effect views (Live and Preset). Press MODIFY in either for a dropdown 
with the following options 

Action  Description 

All All devices start at the same point in the table. 

Evenly Spread The starting point (offset) is evenly spread. 

1:2-1:9 The selected devices are divided in # groups (1:#). 

Offset Relation - Dynamics Display 

In the Dynamics Display the Offset Relation for the selected Dynamic Effect is mapped to wheel 3. 

Activate the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing 
DYNAMICS in the top menu. 

1. Hold wheel key 3 to get a list of Offset Relations in the display. 

2. Select a relation using the wheel. 
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3. Let go of the Key to activate the current selection. 

Delay Relation & Distance 

Specify when channels start in relation to each other. 

 

Delay Relation and Distance are set in the Dynamic Effect views (Live and Preset). Press MODIFY in 
Delay Relation for a dropdown with the following options 

Action  Description 

All All devices start at the same time. 

Evenly Spread The starting time is evenly delayed. 

1:2-1:9 The selected devices are divided in # groups (1:#). 

Distance specifies the time (in percent) between the starting point of each channel when the Delay 
Relation is used. 

Delay Relation & Distance - Dynamics Display 

In the Dynamics Display the Delay Relation is mapped to wheel 4. There is a soft key for setting the 
Distance parameter directly with a numeric value. 

Activate the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing 
DYNAMICS in the top menu. 

1. Hold wheel key 4 to get a list of Delay Relations in the display. 

2. Select a relation using the wheel. 

3. Let go of the key to activate the current selection. 

Enter a number and press DISTANCE to set the Distance value 0-100%. 
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Dynamics - Loop Count 
A Dynamic Effect can be set to run a specific number of loops and then stop automatically. If set to 0 
it will run forever.  

This is done in the Loop Count column of the Dynamic Effects tabs. 

 

See Dynamics - Live Dynamic Effects and  Dynamics - Preset Dynamic Effects 
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Dynamics - Fade 
A Dynamic Effect can fade in size, rate or both when played back in a Sequence. When faded 
manually in a Master Playback, size will follow the fader (0-100%).  

The Fade parameter is set in the Live and Preset Dynamic Effect tabs in the Fade column. 

 

Action  Key Feedback 

Size (default) [MODIFY] Size will fade in (and out) on the 
time for the corresponding attribute. 

Rate [MODIFY] Rate will fade in (and out) on the 
time for the corresponding attribute. 

S & R [MODIFY] Size & Rate will fade in (and out) 
on the time for the corresponding 
attribute. 

None [MODIFY] Size and Rate will snap directly to 
the values of the dynamic effect. 
Activating a new attribute value 
will stop a corresponding dynamic 
directly. 

Intensity Dynamics 

When a Stop Table is activated, the Dynamic Effect will fade out on the in time of the corresponding 
sequence step. If the Stop Table is assigned manually, the effect will snap out. 

Attribute Dynamics 

When new attribute values are played back from the Sequence, they will fade from the Dynamic in the 
attribute time of that Sequence Step. When they reach zero the Dynamic is deleted automatically.  

See Dynamics - Live Dynamic Effects 
See Dynamics - Preset Dynamic Effects 
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Dynamics - Form 
Form specifies the relation between the size for the Pan and Tilt parameters. It is used to control the 
behaviour of Pan/Tilt combinations like a Circle. 

Normal value is 100 (displayed as "F:F") which means that both Pan and Tilt are equal in size. 

• If you enter a value between 0 and 99, this will be used as the size for the Pan parameter 
showed as "0:F" to "99:F".  

• If you enter a value between 101 and 200, this will be used as the size for the Tilt parameter 
showed as "F:99" to "F:0". 

Think of it as a continuous scale from a vertical movement through the full circle to a horizontal 
movement. 

This is done in the Form column of the Live- and Preset Dynamic Effects tab. 

 

See Dynamics - Live Dynamic Effects 
See Dynamics - Preset Dynamic Effects 
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Dynamics - Fetch From A Preset 
Dynamics can be copied from any Preset. All channels with Dynamics in that Preset will be copied. 

Function  Key Feedback 

Fetch Dynamics from 
Preset # 

[#] [ON/FETCH] & 

[DYN_EFFECT] 

Dynamics in Preset # are 
activated. A "D" will 
appear next to the involved 
channels in the Channel 
View. 
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Dynamics - Playing Back 
A Preset with Dynamic Effects can be played back in any of these ways: 

• The Preset is faded in on a Sequence Step  
• A Master with the Preset is faded up (size follows the Master fader).  
• A Master with the Preset is Flashed 

General Facts 

• When activated, Dynamic Effects fade to the initial value including the Offset.  
• If the attributes are masked, the Dynamic will start anyhow.  
• Dynamics run until Deleted or Size is set to zero.  
• Device Dynamics will stop if new attributes are faded in a Sequence Step.  
• IMPORTANT SETTING: Always Start Dyn On Go (Crossfade Settings) => When activated 

from a Sequence Step, dynamic effects are always started on Go regardless of the GoOnGo 
setting for the sequence step. 

See Dynamics - Stop. 
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Dynamics - Store Running To Library 
Running Dynamics can be stored as a Dynamic Template in the Effect Library and be reused with 
different channels.  

1. Open the Dynamic Effect Library by holding MODIFY and pressing DYN EFFECT, or from the 
Browser (Browser >Effects >Dynamic Effects >Dynamic Templates) 

 

2. Go to the end of the list (arrow keys). 

3. Press INSERT. You will get the question "Record running dynamics as a Dynamic Template?".  

 

If you answer OK, the dynamics for the currently selected channels (in the selection order) will be 
used as a base for creating the new Dynamic Template. 

If you answer CANCEL you will get an empty Dynamic Template. 

4. Enter a name in the text column (press MODIFY to activate, enter text and press MODIFY to 
confirm). 

5. Exit by pressing ESC. 
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Image Effects 
Image effects allow you to map a text an image (jpg/gif) or an animation (supplied) to the intensity or 
color of a predefined effect layout of channels. This can be used to create abstract or absolute patterns. 

 

The result of mapping an image, animation or text will depend on the resolution of your effect layout.  

Image mapped to intensity and then color in a 10x10 layout. 

 

Text effect with the letter "E" mapped to intensity and then color in a 10x10 layout 

 

There are controls for adjusting the playback of the image or text live. You can position, scroll, rotate 
and change colors. You can map to intensity, color mix, iris or zoom. 

Effect Layout 
The effect layout is a "pixel map" of channels in your rig that the effect is applied to. You can define it 
up to 128x128. 

Effect Types 
The effect types are image, animation (gif) or text. A library of animations are loaded when you 
create a new play. 

Components 
To start an image effect you need 

• An image or text  
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• An effect layout  
• An Image effect playback 

Create an image effect playback 

Creating an image effect playback can be done in two ways. 

• # INSERT & EFFECT and select Image.  
• Press INSERT in the Effect Playbacks List, and select Image. 

Now that the effect playback is created you need an Effect Layout to apply it to. 

Control image effects 

As soon as an Image effect is selected, you can control it in two ways: 

• From the console parameter wheels using U1-U3.  
• From the Live Effects view. 

Image effects look like this in Live Effects 

 

If you unlock the spreadsheet for screen editing (SETUP & TAB) you can step around with arrow 
keys, press MODIFY to get a dropdown, or enter a number and press MODIFY. 

NOTE 
When you press MODIFY or enter a number it will be an absolute value or a 
Palette value - depending on the setting in Attribute Settings. See Play 
Settings - Attribute. 
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Image effect parameters 

These are the image effect parameters divided into Content, Position, Color & Effect. 

  

CONTENT 
The content can be image, animation or text. It needs a layout to be mapped to, and you have to set if 
it is applied to intensity, color mix, iris or zoom. 
 
Layout 
Layouts are created in the Effect Layout editor. This is the "projection screen" of an image effect. 

Type 
Choose between image, animation or text. 

Index 
This is the index number of the image, animation or text chosen. 

MapTo 
The image, animation or text can be mapped to intensity, color mix, iris or zoom of the channels in 
the effect layout. 

  

POSITION   
The position of the content defines where it is placed and how in the effect layout. 

X-pos & Y-pos 
The default position is "middle" of the effect layout. You can offset this +/- 128 increments. 

Scale 
The size of the content can be scaled from 0-1000. 100 is "normal". 

Aspect 
The aspect will adjust the shape of the content by adjusting X size against Y size. 

Rotation 
Rotates the content.  

Speed 
Sets the speed of an animation. 

  

COLOR & EFFECT 
Both color and effect are "filters" applied on top of the content and all previous parameters. 

Red, green & Blue 
Colorization. 
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Effect. size and speed 
The effect parameter allows you to scroll, shake and scale the content. You can adjust size and speed 
of the applied effect. Size and speed 50% is stopped and normal. 

The effects are 

• None  
• Scroll X  
• Scroll X ><  
• Scroll Y  
• Scroll Y <>  
• Rotation  
• Scale  
• Aspect  
• Shake 

Animation effects 

Animation effects are great for creating abstract intensity or color patterns, similar to old school video 
effect generators. A number of digital animations are supplied with Cobalt. These are a few. 
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Effect layouts (8.0) 
An effect layout is the "projection screen" for an image effect. It defines the number of channels in the 
layout. The layout is in turn set as target to a Pixel Grid in a Magic Sheet that determines how pixels 
from a source image will apply to these channels. See Magic Sheets.  

This is what a 10 x 10 Pixel Grid will look like with 100 channels in it.  

 

Create a new effect layout (8.0) 

1. Open the effect layout editor (Browser >Effects >Image Effects >Effect Layouts...). 

 

2. Press INSERT. You will get a popup where you can define the width and height in "pixels". One 
pixel is the smallest possible resolution, and usually a single light source. 



Cobalt 8.1 - 20181029 

754 

 

 

3. You have now created the layout. Go to the Magic Sheet editor to set this as a target for a Pixel 
Grid. See Magic Sheets.  

Copy an effect layout 

You can copy effect layouts to make alternative versions. 

1. Open the effect layout list (Browser >Effects >Image Effects >Effect Layouts...) 

2. Select the layout you want to copy and press COPY/CUT. 

3. Press PASTE. 

Connect an Effect Layout with a Pixel Grid (8.0) 

This is a step by step example of how you can connect an Effect layout to a Pixel Grid in a Magic 
Sheet, to be able to use and display image effects connected to, for example, intensity. 

1. Open the Effect Layout list (Browser >Effects >Image Effects >Effect Layouts...). 

2. Press INSERT to insert a new layout, set width and height to 10 pixels.  

 

3. Go to a Live tab (press LIVE). 



Cobalt 8.1 - 20181029 

755 

 

4. Insert a new Magic Sheet (# FORMAT). 

 

5. Activate editing and select the LED pixel object 

 

6. Set target to Channel and Start number 1, increment 1 

 

7. Place first pixel 



Cobalt 8.1 - 20181029 

756 

 

 

8. Open grid tool and set to 10x10 and spacing 2, press OK 

 

9. The pixels are laid out. Selext the pixels (drag left over them) and set a fill to white and connect to 
intensity. If they are att 100% this is what they will look like - otherwise they will be black inside.  
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10. Now it is time to connect to a pixel grid. Set target to Pixel Grid and Start number 1. 

 

11. Insert the Pixel Grid object in the middle of the grid of pixels.  
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12. Resize sides of the Pixel Grid so they align with the pixels on the sides (see two small arrows on 
outside above). Make sure that the pixel grid object is at the back of all RGB-pixels so it won't be 
selected by default when clicking on it.  

14. Close the Magic Sheet editor (click on the arrow on the side bar). You are done! 

 

You can now create an image effect playback and assign it to the intensity of this pixel grid and use 
text, images and movies to play back over the grid.See Image effects.   
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Effect Images 
Effect images are jpg or gif images that you can create with the Image tool, or import from a USB 
memory.  

They are mapped pixel by pixel to the effect layout when selected. In other words, if the effect layout 
consists of 100 light sources that are aligned 10x10 - you can create an image that is 10x10 to fit 
exactly, or 128x128 if you want to be able to scale and zoom in the image. 

Simple black & white image mapped to intensities, and color in a 10x10 effect layout 
 

 

Create a new image 

1. Open the Effect Images tool (Browser >Effects >Image Effects >Effect Images...) 

 



Cobalt 8.1 - 20181029 

760 

 

2. Press INSERT to create a new image. You will get a popup 

 

3. Enter the size of the image. The size is relevant to the size of the effect layout it will be applied to. 
We recommend 128x128 which you can scale to a lot of layouts. 

4. Press MODIFY in the Image column of the new image. This opens the layout editor tool.  
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Edit an image 

The Effect Image Editor can be used to create new images and to edit imported images. It offers 
some simple drawing tools. All of them are mouse operated. 

Drawing tools 

  
The drawing tools are the pen and the select tool. The pen will draw with the selected colors and the 
select tool can be used to select an area and drag it to a different location. 

Zoom tool 

 
Click on the zoom tools to zoom in/out. 

Color tools  
There are two ways to select color: 

Color picker (click on a color to select) 

 

Color sampler (click in image to sample) 

 

Kaleidoscope tool  

 

Anything you draw is mirrored on the other side of the lines. Makes it easy to make symmetrical 
patterns. 
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Copy an effect image 

You can copy effect images to make alternative versions. 

1. Open the effect image list (Browser >Effects >Image Effects >Effect images...) 

2. Select the image you want to copy and press COPY/CUT. 

3. Press PASTE. 
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Effect Texts 
You can create a text and apply it to an effect layout with the image effect. The text can be applied to 
intensity, color mix, iris or zoom.  

This is an example of the letter "E" applied to intensity and then color mix in a 10x10 effect layout. 
 

 

Create an effect text 

1. Open the Effect Text tool (Browser >Effects >Image Effect >Effect Texts...) 

 

2. Press INSERT to create a new text. 

3. Press MODIFY in the Text column, write a text and press MODIFY to confirm. 
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Import Effect Images 
You can import images (jpg/bmp/gif) from a USB memory. 

1. Connect the USB memory to Cobalt 

2. Open the Import Effect Images function (Browser >Effects >Image Effects >Import Effect Image). 
This will open the import image popup where you can select the image you want to import. 

 

3 Press MODIFY. You will get a popup 

 

4. Enter the target size of the image. The size is relevant to the size of the effect layout it will be 
applied to. We recommend 128x128 which you can scale to a lot of layouts. 

5. Press MODIFY in the Image column of the new image. This opens the layout editor tool.  

Once the image is imported you can access it from the Image Effect controls. 
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Channel Sets  
A Channel Set is a defined set of channels distributed into a number of parts so that you can distribute 
effects over a rig in a specific order, regardless if it is symmetrical or not.  

Sets can be used as an alternative to groups, in both content and dynamic effects. The advantage of a 
Channel Set compared to a group is that you can create very specific distribution models. See Channel 
Distribution Wizard. 

The Channels Sets editor can be opened in two ways. 

• SET (soft key in the Effects Soft Key menu)  
• Browser >Effects > Channel Sets 
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Create a Set  

Sets are created in the Channel Sets editor. You can use the Channel Distribution Wizard, or create 
them one by one using all channel selection and Group features in Cobalt as a help. 

1. Open the Channel Sets Editor. See above. 

Column  Action Feedback 

Channel set No Input The number of this Set. 
Can't be changed. 

Text [MODIFY] Opens the text cell for 
labeling. 

Parts [MODIFY] Opens the Channel 
Distribution Wizard. 

2. Press INSERT in the Channel Sets List  to create a new set. Name it if you want to.  

3. Press MODIFY in the Parts cell to open the Channel Distribution Wizard. 
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4. Select channels, parts and distribution. See Channel Distribution Wizard. 

NOTE 
Helpful hint: Groups can be used to enter channel selections within parts, if 
desired. If you are making a very complicated Channel Set distribution, it 
may be easier to first create a Group that corresponds to the contents of each 
individual Part, and then use the Groups on masters or Direct Selects to 
simplify the entry of the channels in each part. .  

You can now use this set in any Content or Dynamic Effect Playback.  

Edit a Set 

Select the set using arrow keys. The channels and parts are shown in the top of the editor. 

Function  Keys Feedback 

Select a Part [NEXT] [LAST] The channels will be 
selected and the number of 
the part is indicated in red 
over the channels. 

Edit a Part [NEXT] [LAST] Select/deslect channels. No 
save or record required. To 
add a new part select the 
last EMPTY one and select 
channels. 

Delete a Part [DELETE] Press DELETE to delete 
the selected part. 
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Main Playback 
The Main Playback is a "theatre style" playback for sequences.  

  

Main Playback Node 

 

This chapter contains the following sections 

• Main Playback - Introduction  
• Main Playback - Functions  
• Playback View  
• Sequence Editor  
• Load Sequence  
• Goto List 
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Main Playback - Introduction 
The Main Playback is the theatrical playback section of Cobalt. You can play back any of the 999 
sequences, or any of the 9999.999 presets in random order.  
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Main Playback - Functions 
The Main Playback can play back a Sequence in normal/chase mode, or random presets. While a 
crossfade is being executed the "Playback" status at the lower right corner of all screens will be red. 

 

The main playback has the following controls. 

1. GO TO (live) and JUMP TO B (blind) will accept a numeric argument for going directly to 
any part of the sequence.  

2. REFRESH to refresh values to those of the Playback.  
3. PLAYBACK for assigning sequences and selecting the Main Playback Tab.  
4. A/B buttons for direct acces to the CURRENT (A) and NEXT (B) parts of the playback.  
5. Seq +/- for stepping without times  
6. Manual crossfaders  
7. Split speed controls for in and outgoing channels.  
8. Transport keys for timed fades with default or pre-programmed times.  
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Main Playback - Transport Keys 

These are the transport keys of the Main Playback. 

  

  

 

Function Key 

Start a crossfade* [GO]

Start a new crossfade during an ongoing crossfade [GO]

Pause a crossfade [PAUSE]

Crossfade to the previous step [GO_BACK]

Reverse an ongoing crossfade by making a crossfade to 
the previous step 

[GO_BACK]

Step (without times) to the next step [SEQ+]

Step (without times) to the previous step [SEQ-]

Open the GOTO list** [GOTO]

Crossfade to any recorded preset on the stored or default 
times 

[#] [GOTO]

Relocate the sequence from preset # in B (Next) [#] [JUMP_TO_B] 

*When a crossfade is completed there is a beep.Turn this off in the System Settings - System. 
**See The Goto List 
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NOTE 
Device parameters are executed as LTP, independent of the playback that 
once started them. This means that you cannot use (for example) PAUSE to 
stop attributes. 
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Main Playback - Manual Crossfades 
Move the crossfaders from the down position to the up position to perform a manual crossfade. When 
both reach the top position the crossfade is terminated and the next sequence step is advanced. (See 
Main Playback - Introduction). 

 

General Facts 

• Take over timed fades manually.  
• Press GO during a manual fade.  
• Set the crossfaders to fade in both directions in the Settings for the Playback (Hold SETUP 

and press PLAYBACK).  
• When you make a manual crossfade to a step with attributes, the attribute values that are 

GoOnGo will follow the movement of the B-fader.  
• You can record the actual manual movement of the crossfaders using a Crossfade Profile. See 

Sequences - Crossfade Profiles 
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Main Playback - Edit Keys 
A, B and PLAYBACK are the main editing keys of the Main Playback, they can be used in 
conjunction with numerical entries and other prefix keys. 

   

Function Key 

Connect the Active (A) field to the channel 
controls, and open the A Tab 

[A]

Connect the Next (B) field to the channel 
controls, and open the B Tab 

[B]

Load Preset # to A. [#] [PRESET] & [A]

Load Preset # to B. [#] [PRESET] & [B]

Load a sequence to the Main Playback [#] [SEQ] & [PLAYBACK] 

Clear the Main Playback  [C/Alt] & [PLAYBACK]

Activating the Playback Tab connects the A 
field to the channel controls and selects the 
Playback tab. 

[PLAYBACK]
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Main Playback - Time Settings 
Hold SETUP and press TIME to open the Settings.  

 

Setting  Feedback 

Set times to Times are set to the step in B (default). You can set 
them to the step in A as well. 

Time: Use % as default Times for FCB will be set in % of the main fade 
time. 

Default Go time The default time that is only used if no time is set, is 
set to 5 seconds.  

Default Go Back time The default time is set to 2 seconds.  

Default Out/In time The default out/in time will be set and stored as # 
seconds.  
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Main Playback - Default Settings 
Hold SETUP and press PLAYBACK to open these settings. 

 

These are the default settings for the functions of the Main Playback. 

Setting  Feedback 

Modify Sequence When active, this mode will suppress all wait times 
and master links. 

Build Sequence When active (default) all presets recorded in A 
(Live) will be added to the sequence. 

Followon Wait times will be treated as Followon times, 
counting from GO instead of from the completion of 
the last fade. 

GOTO jumps to The default is PRESET, you can set it to STEP.  

Crossfade both ways The default setting for a manual crossfade 
is upwards. You can set it both ways.  

Don't Advance Playback When this is checked, the sequence in the main 
playback will not advance automatically.  
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Main Playback - Refresh Functions 
The REFRESH key in the Main Playback can be used to refresh any part of a channel to the resulting 
state of the current Sequence Step in the Main Playback. 

 

Function Key 

Everything [REFRESH]

Attributes of all device(s) [REFRESH] & [ATTRIB] 

Levels of all device(s) and channel(s) [REFRESH] & [@LEVEL] 

Focus parameters of the selected device(s) [REFRESH] & [FOCUS] 

Color parameters of the selected device(s) [REFRESH] & [COLOR] 

Beam parameters of the selected device(s) [REFRESH] & [BEAM] 

Wheel parameters of the selected device(s) [REFRESH] & [Wheel_key] 

U1-U3 of the selected device(s) [REFRESH] & [U1-U3] 

Intensities AND attributes for the 
selected device(s).  

[REFRESH] & [CHANNEL] 

NOTE 
The changed flags are cleared for what you refresh. 

The Refresh function will take the currently focused channel into account if 
you are using NEXT/LAST. 
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Playback View 
Press PLAYBACK in the Main Playback section to open the Playback tab. The Playback views 
normally have a packed format like this. There is an unpacked format as well (see below). 

 

 

1. Current sequence step, on stage.  
2. Next sequence step to be faded in.  
3. A graphical representation of the times in the next step to be faded in. 
4. Notes are shown with a yellow flag and displayed to the left of the graphical view for the next step. 
There are progress bars for A/B at the top. 
5. Sequence step number. 
6. Preset number in this step. 
7. Sequence or Preset text. 
8. Times 
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Standard Times are described like this 
Out: # 
In: # 
Time (In=Out): #  
Delay In: # (with a "d", for example d2 >3) 
Delay Out: # (with a "d", for example d2 >3) 
TimeCode: ##.##.##.## 
Channel Times - are summarised as ChT: #. The # indicates how many different time groups there are 
in a step. 

9. Header box, showing information about the currently loaded sequence (click to change) 
10. On screen transport keys 
11. Settings. 
12. Mode indicators. 
13. Extras in this sequence step.  

Devices - are summarised as Dev: #. The # indicates how many moving devices are affected by the 
step. 
Master Links - are indicated as ML: #. The # indicates how many Masters are linked to the step. 
Master Pages - are indicated as MP: #. The # indicates which Master Page is linked to the step. 
Effects - are indicated as Eff:#. The # indicates the number of effects linked to the step. 

NOTE 
Touch and mouse functionality: You can click on many objects in the 
Playback View to open the corresponding editor directly. For example 
PRESET or DEV or MASTER LINK. 

Sequence Playback Views - The Graphical Representation 

The graphical representation of the next crossfade shows the in and outgoing fade times as arrows, and 
FCB times and channel times as progress bars. 

 

You can toggle this view on/off at the settings (12) or by holding FORMAT and pressing the UP or 
DOWN arrow. 
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Sequence Playback Views - Column Format 

It is possible to show the information in the Playback view in a traditional columnised format, instead 
of the packed default format. 

 

You can toggle this view on/off by holding FORMAT and pressing the RIGHT or LEFT arrow. 

Delay Times 
An < or > character points to the time that will be delayed. If there are two delay times, the out delay 
is shown and < > characters indicate that there are two delay times defined. 
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Sequence Editor 
Hold MODIFY and press PLAYBACK in the Main Playback section to open the Sequence Editor for 
the sequence in the Main Playback. See Sequences - Sequence List.  

 &  
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Load Sequence  
The node Browser >Main Playback >Load Sequence opens a dialogue that allows you to load any 
recorded Sequence to the Main Playback. Tap or press MODIFY to activate. 

 

You can also touch or click on the Playback view in the top left part, where the number of the 
currently loaded sequence is displayed.  
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Goto List 
The node Browser >Main Playback >Goto List opens a dialogue that allows you to crossfade 
directly (Goto) any recorded Sequence step in the Main Playback by selecting a step with arrow keys 
or some other way, and pressing MODIFY.  

 

You can also right click on any step of the sequence in the Playback tab and open the context menu 
that allows you to Goto that step.  
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Masters 
There are 80 Master Playbacks that can be used to playback any type of 
content such as channels, groups, effects, presets, sequences or console keys, 
macros and moving device parameters.  

  

Masters Node 

 

This chapter contains the following sections 

• Masters - Introduction  
• Masters - Functions  
• Master View  
• Master List  
• Master Pages 
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Masters - Introduction 
The masters are incredibly flexible and powerful. You can set them up individually in a number of 
different modes and play back virtually any type of content that can be programmed in Cobalt. 

All of the 80 master playbacks can be controlled virtually by number. Physically you can access them 
depending on your choice of hardware.  

 

1. Master screens - shared for each section of controls  
2. Endless RGB pot master, with Master key and part of display  
3. Fader modes  
4. Fader functions  
5. Master Playback with two Master keys and part of display  
6. Expanded Master/Effect/Sequence mode   
7. Master Playback controls (assignable to any playback) 

Important master control keys 

There are three categories of keys that apply to master playbacks. 

Fader keys 
The two master keys belonging to each fader can be set up to control playback functions related to the 
type of content loaded to the master.  

Master Playback 
You can connect any master to the Master Playback controls. This gives you functions like GO, GO 
BACK, STEP and TAP. 

• In the Cobalt console this is done with the Master Playback  
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• In the Congo Jr console, this is done with the Main Playback 

Additional keys 
Other keys that control important functions for the masters are: 

• MASTER = Opens the master view and selects masters  
• FADER MODE = Select operational mode for the faders  
• RANGE = Select which range of master playbacks the faders control  
• SWAP = Swaps upper/lower master row  
• CH ONLY MOD = Turns masters and console into channel handles for a single scene 

console  
• PAGE = Control Master pages  
• FLASH MODE = Configurates master buttons  
• START = Can be used to start fades  
• SETUP = Used in combination with the Master key to open individual settings  
• MODIFY = Used in combination with the Master key to open the Master Editor  
• CLEAR = Used in combination to clear content. 
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Masters - Functions 
These are the master functions.  

This chapter contains the following sections 

• Masters - Playback Keys  
• Masters - Settings  
• Masters - Commands  
• Masters - Clear  
• Masters - Times  
• Masters - Channels  
• Masters - Presets  
• Masters - Groups  
• Masters - Effects  
• Masters - Palettes  
• Masters - Sequences  
• Masters - Chase mode sequence  
• Masters - Dynamics  
• Masters - Magic Sheets  
• Masters - Attribute parameters  
• Masters - Console keys  
• Masters - Macros  
• Masters - Drag and Drop  
• Masters - Two Scene Masters  
• Masters - Swap upper/lower  
• Masters - Select Playback Range  
• Masters - Fader Modes  
• Masters - Beat Boss 
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Master Playback - Functions 

These are the transport keys for the Master Playback in the masters section. 

 

Function Key Feedback 

Start a chase (or 
crossfade) 

[GO] Starts a stopped Chase or a 
Crossfade for a Sequence 

Start a crossfade from 
step # 

[#] [GO] Starts a Crossfade to step # 

Pause a chase (or 
crossfade) 

[PAUSE] Pauses a running Chase or 
Crossfade 

Reverse a fade [STOP] This key is the equivalent of GO 
BACK to the previous step of the 
Main Playback 

Step without times << or >> These keys are the equivalent of 
SEQ+ and SEQ- in the Main 
Playback. 

Change Chase direction << or >> The currently connected Chase 
will change direction 

Connect a Master 
Playback (7.2) 

[#] [CONNECT]

or 

[CONNECT] & 

[Master_Key] 

The Chase or Sequence in this 
Master is connected to the 
Playback keys. Also, the Master 
Playback tab is focused. 

Disconnect a Master 
Playback (7.2) 

[0] [CONNECT] The Master is disconencted from 
the Playback keys. 

Set a tap tempo to a 
Master Playback or 
Page. 

[TAP] & 

[Master_Key] 

Hold TAP and press at least twice 
on a Master or Page key to set a 
BPM tempo. 
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Masters - Settings 
You can define master settings from the Master Settings popup or directly from the console if you 
have the full wing or big Cobalt.  

 &  

See Master Settings from the console. All settings for masters are individual per master.  

You can define behaviours for the 

• Fader  
• Flash key  
• Master key  
• Contribution to the Live output  
• Contribution to recording functions  
• Priorities against other playbacks 

Master settings are described per content type in this chapter.  

Reset Master Settings 
To reset Master settings to default hold C and press the Master key twice. 

Open Master Settings 
Hold SETUP and press a master key for a fader.  

• To open settings for several masters select the first master (# MASTER) and add master 
with + and THRU, then hold SETUP & press MASTER.  

• To open settings for a specific master enter the master number, then hold SETUP and press 
MASTER. 

The dialog has three tabs: Basic, Buttons and Faders.  
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Master Mode 

These are the main modes that define the basic behaviour of a master playback.   
Mode  Screen Feedback 

Exclusive Blue level Blackout, 
GrandMaster, Capture or any 
other channel function will not 
affect this channel(s). 

Inclusive No indication Works as an additional Master 
Playback 

Inhibit Red level Is an Inhibit Master - works as 
a Grand Master for the selected 
channel(s).* 

*If you have several Independent Functions set to Inhibit and they have overlapping channels, the 
highest Special Function will be in control. The result on stage can be recorded. 

NOTE 
When you are in "exclusive" mode, the attributes will still be "stolen" back 
by any function calling them from the rest of the console, even if the intensity 
is "exclusive". If you wish to stop this from happening enable Active 
Parameter Lock. See Master fader settings.  



Cobalt 8.1 - 20181029 

791 

 

Exclude Int From Record 

This setting (see image in previous post) excludes the contribution of this master to the live output, 
from recording functions. This is useful for worklights and effects that are on, but you don't want to 
include in new presets. 

Master button 

The master button is the single key in all master modules that is used to assign content to the master. 
The different modes apply to specific content types - which is described closer in the sections of these 
contents. 
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Mode  Applies to Feedback 

Select Channels All content Selects the channels in this master 
as a group 

GO Chase, sequence Start the next crossfade 

GO/PAUSE Chase, sequence Start/pause  

Start Ch, group, preset, 
effect, palette, chase, 
Sequence 

Sets fader to full or a level   

Tap Chase  Sets tap tempo 

Execute Attributes Preset, effect, palette Sets if attributes are executed by the 
button 

Flash Ch, group, preset, 
effect, chase, Sequence

Sets to function like a momentary 
flash key 

Seq + Sequence Sets to function like Seq + 

Seq - Sequence Sets to function like Seq - 

Go Back Sequence Sets to function like GoBACK 

Master Editor Ch, group, preset, 
effect, chase, Sequence

Opens the corresponding editor for 
the master content 
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Master fader settings 

The fader settings define the behaviour of intensities and attributes for the fader. The different modes 
apply to specific content types - which is described closer in the sections of these contents. 
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Mode  Applies to Feedback 

Fader type Ch, group, preset, 
effect 

Add = Intensities are piled (HTP) 
on top of the output. Attributes are 
LTP. 
 
Solo = The content of this fader 
replaces all other master faders, but 
does not affect levels coming from 
the Main Playback. 

Fader intensity Ch, group, preset, 
effect, chase, Sequence

Disabled = intensity is not affected 
by moving the fader 
 
Follow manual fader = Intensities 
will follow the fader 
 
Follow master time = follows 
master times 

Fader Attributes Preset, effect, palette  Disabled = attributes are not 
affected by moving the fader 
 
Follow manual fader = Attributes 
will follow the fader 
 
Execute at #% = attributes are 
executed when the fader passes #%. 

Active parameter 
lock 

Preset, effect Attributes cannot be stolen by 
another master or the Main 
Playback. Manual control is still 
possible. 

Return to (FCB) Preset, effect Defines what attributes will return 
to at fade down. 
 
None  
Previous = last LTP values 
Preset = a specified preset 
Main Pb = sequence step in A 

Preset Preset, effect Return to preset (see above) 

NOTE 
If several masters have Fade type = Solo, the last Solo master that leaves its 
0% position will have priority over the other Solo masters. To take control 
with another Solo master, move it down to 0% and up again. 
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Flash settings  

The flash button is the lower key in all master modules. Some modules and the large Cobalt only have 
flash keys for the lower row of faders.  

 

The different modes apply to specific content types - which is described in greater detail in the tables 
below. 

Flash Button 

Mode  Applies to Feedback 

Off  -  Flash button is disabled 

Momentary Ch, group, preset, 
effect, chase, Sequence

Sets the fader to full or the defined 
flash level when pressed and returns 
the fader to zero when the key is 
released. 

Latching Ch, group, preset, 
effect, chase, Sequence

Toggles the fader to full or the 
defined flash level when pressed, 
leaving the fader at that level until 
the flash key is pressed again 

GoBack Chase, Sequence GoBack to previous step 

Tap Chase  Sets tap tempo 
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Flash type 

Mode  Applies to Feedback 

Add Ch, group, preset, 
effect 

Intensities are piled (HTP) on top of 
the output. Attributes are LTP. 

Solo (7.3) Ch, group, preset, 
effect 

The content of this fader replaces 
all other master faders and returns 
other faders based on the 
Momentary/Latching mode setting. 
 
NOTE: From 7.3 there is a check 
box to allow this function to affect 
also the Main Playback.  See Master 
Settings.  

Flash mode 

Mode  Applies to Feedback 

All Preset, effect, chase, 
Sequence 

Flash executes intensity and 
attributes 

Intensity Ch, group, preset, 
effect, chase, Sequence

Flash executes intensities only 

Attributes Preset, effect, palette Flash executes attributes only 

Flash time and level 

Mode  Applies to Feedback 

Flash: Use time Ch, group, preset, 
effect, chase, Sequence

Flash functions will use in-wait-out 
times 

Flash level Ch, group, preset, 
effect, palette, chase, 
Sequence 

Target level for  flash functions  

Disable Flash Keys 

The top area of all screens will indicate that flash is disabled by showing the Flash disabled indicator 
pictured below. 
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Hold C/ALT and press FLASH MODE. Repeat to toggle on/off. 

The top of the monitor screens will indicate the Flash is Disabled like this 

 

Master Settings From the Console 

Hold FLASH MODE and use the page keys to step through the settings per master. 

 

Use the Master key to toggle the settings per master. 

 

You can check and set master settings directly from the Cobalt console or Congo Jr Master Playback 
Wing. Universal Fader Wings and Congo Kid do not support this feature.  
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Masters - Commands 
Enter the number of a master and press MASTER to control this master on the level wheel. This will 
open the Master view - and this view has to be open for all the master commands to work.  

 

You can select a group of masters and set levels numerically from the keypad, similar to how 
channels, effects and groups can be selected.  

Select masters and set levels 

It is possible to select masters and set levels with the MASTER key providing a Master View is open 
and active (selected).  
 
Keyboard shortcut = F8.  

Function  Keys Feedback 

Open the Master view [MASTER] The Master View is 
opened. 

Select a Master [#] [MASTER] Master # is selected and 
highlighted in the Master 
View. 

Add   [#] [+] Master # is added to the 
selection. 

Add a range   [#] [THRU] Up to Master # are added to 
the selection. 

Subtract   [#] [-] Master # is subtracted. 

Set a level   [#] [@LEVEL] The levels are set to #. 

Set a level   [Wheel] The levels are set to #. 

Deselect all [0] [MASTER] All are deselected. 

Master single field editor 

Hold MODIFY and press aMaster key to open a single field master editor for channel intensities. All 
channel functions plus UPDATE are available. 
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NOTE 
Adjustments made in this field are live if the master's fader is above zero. 
When there is an unsaved change the grey title bar will be purple and you 
will get an option of saving before closing or leaving this tab 

To edit attributes in this tab, press ATTRIB. If the master level is above 0%, the changes in the 
attribute view will be executed on stage (7.2) 

Select channels in a master  

Press a Master key to select all channels in the Ch, Preset, Effect or Group of that Master.  

Function  Keys Feedback 

Select channels  [Master_Key] All channels in Master # 
are selected in the Channel 
Control. 

Select channels in with a 
level  

[ALL] & 

[Master_Key] 

All channels in Master # 
with a level in the Channel 
Control are selected. 

Add channels  [+] & [Master_Key] All channels in Master # 
are added to the selection in 
the Channel Control. 

Subtract channels  [-] & [Master_Key] All channels in Master # 
are subtracted from the 
selection in the Channel 
Control. 
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Mask in masters 

A mask is either set up from the Master List in the Mask column, or by copying the global Mask to a 
master by holding MASK and pressing the Master key.  

   

Every master has a mask that you can define per parameter. The mask will inhibit the playback of 
those parameters from that master. The same content on a different unmasked master will play back 
all of its content. You can use playback masks to reuse content for different purposes, or to keep 
parameters from playing back, without having to edit those parameters out of the content. 

You can also assign any user mask from the Mask list by entering # holding MASK and pressing the 
Master Key. See Device Control - Mask.  

The mask is indicated in the master display and the Masters tab . 

 

Masters - Clear 

Hold C/ALT and press a Master Key to clear its content.  

 &  
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These are more functions to clear content and fader levels in master playbacks. 

Function  Keys Feedback 

Clear  [C/Alt & [Master_Key] The content of the Master 
Playback is cleared.  

Clear all  [C/Alt & [PAGE] The Master Playbacks are 
cleared.  

Set all to zero [C/Alt & [MASTER]

OR 
[C/Alt & [LIVE] 

[LIVE] 

All Master Playbacks are 
set to zero, no content is 
cleared.  

Clear settings [C/Alt & [Master_key]

[Master_key] 

Master conent is cleared 
AND settings are reset to 
default. 
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Masters - Times 
Masters can have In, wait and out times. These times can be used by  

• Flash on time  
• Master Links  
• The START function  
• Manual fades  

Set In-Wait-Out times for a Master 

In times can be set with a key shortcut. Wait and out times are set from the master editor.  

In Time 

Function  Keys Feedback 

Set In time  [#] [TIME] & 

[Master_Key] 

The time # is assigned to 
the Master as an In time. 

In, Wait and Out time 
These times can only be assigned from the Master List. 

1. Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList. 

2. Set In, Wait and Out times. 

Master settings for times 

These are the settings you can set individually for master times.  

Hold SETUP and press the Master key to open the settings. See Masters - Settings. 

These are the settings that affect times, and only for content where times apply. 

Function  Function 

Fader Intensity With "Follow Master Time" Fader will never fade 
faster than the fade time 

Flash: Use time Flash will use master time 
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Flash On Time 

When Flash On Time is activated, the Master Playbacks will flash on the time assigned to each 
playback. See Master Playbacks - Times. 

Function  Keys Feedback 

1. Open the Master Setup [SETUP] & 

[Master_Key] 

The Master Settings are 
opened 

2. Select Flash On Time  Arrow keys Flash On Time box is 
highlighted 

3. Activate [MODIFY] Flash On Time box is 
checked 

4. Exit Settings [MODIFY] Settings are closed 
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Masters - Channels 
Hold CHANNEL and press a Master Key to load and play back single channels (Ch#) so several 
masters starting from the first pressed, or GROUP and Master key to load a group of channels 
(Chs)  to any master playback. They are stored in the current Master Page. 
 

  

Once a channel is loaded to a master you can 

• Use the master fader to set the level  
• Use the flash key to flash the channel  
• Use the master key to select the channel 

Load channels to masters 

These functions are used to load channels (with levels) to masters. 

Function  Keys Feedback 

Channels   [GROUP] & 

[Master_Key] 

The selected channel(s) are 
loaded with current level to 
the Master, which is set to 
full to avoid a Black Out of 
these channels on stage.The 
channel levels are also 
cleared from A. 

Single channels  [CHANNEL] & 

[Master_Key] 

The selected channel(s) are 
loaded at 100% to the 
Master Playbacks, starting 
at the one pressed. The 
master level will be set to 
the level from stage and 
this level will be cleared 
from the A field.  

Ch # at 100%  [#] [CHANNEL] & 

[Master_Key] 

Channel # is loaded at 
100% to the Master. 
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Master Settings for channels 

These are the settings you can change for masters with channel content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the ch's 
Exclusive = fader "owns" channel intensities 

Exclude Int From Record Excludes intensity from recording. 

Master button Default = Select channels in master as group 
Start = Toggles fader to full/zero 
Flash = Flashes the content  

Include intensity Playback will control intensities   

Attributes follow fader Not used 

Fader type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Not used 

Preset Not used 

Active Parameter Lock Not used 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 

Flash type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Flash mode Intensity = Intensities only 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 
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Masters - Presets 
Enter the number, hold PRESET and press a Master Key to load to that Master.  

  

You can record, load and play back presets from master playbacks. Since these are the most common 
type of content they are displayed only with the number in the master displays. 

Once a preset is loaded to a master you can 

• Use the master fader to set the level  
• Use the flash key to flash the preset  
• Use the master key to select the channels in the preset 

A preset can contain device and effect attributes. These can be set to 

• Follow the fader up  
• Follow the fader down (rubberband)  
• Have a defined return status (previous, main pb, preset #)  
• Not follow the fader at all  
• Be activated on flash 

See Master settings for presets. 

NOTE 
If a change is made to a Preset or Group that is loaded to a Master which is 
active - the change will be pending until the Master is brought to zero and 
back up. Pending content indicated with inverted colors on the master LCD. 
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Load a preset to a master 

These functions are used to load presets to masters. 

Function  Keys Feedback 

Load a preset  [#] [PRESET] & 

[Master_Key] 

Preset # is loaded. The 
number and name is shown 
in the master display 

Load several presets [#] [PRESET] & 

[Master_Keys] 

Hold Preset and keep 
pressing new Master keys 
to load the next stored 
Preset 

Record a preset to a master 

Recording a preset to a master you will be able to choose to record the current channel selection or all 
channels on stage (if no channel is selected).  

There are a three options when you record a preset. 

• Record as a preset  
• Record as a return to preset  
• Record as a preset in a sequence 

  

Record a preset to a master 

1. Select channels (selection) or select none (all) to record.  
OPTION: Enter a preset number. If you don't the next free last used for masters will be suggested. 

2. Hold RECORD & Master key.  
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3. Enter a preset text (optional) and press RECORD again. The return to preset is shown in the master 
display and master view. 

  

Record a return preset to a master 

1. Select channels (selection) or select none (all) to record.  
OPTION: Enter a preset number. If you don't the next free last used for masters will be suggested. 

2. Hold RECORD & Master key. Use the right arrow to select Return To. 



Cobalt 8.1 - 20181029 

810 

 

 

3. Enter a preset text (optional) and press RECORD again. 

  

Record a preset to a sequence in a master 

1. Select channels (selection) or select none (all) to record.  
OPTION: Enter a preset number. If you don't the next free last used for masters will be suggested. 

2. Hold RECORD & Master key. Use the right arrow to select Sequence. 
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3. Enter a preset text, Sequence name, and step text (optional) and press RECORD again. 

Master settings for presets 

These are the settings you can change for masters with preset content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the preset ch's 
Exclusive = fader "owns" preset intensities 

Exclude Int from Record Excludes intensity from this master from recording 

Master button Default = Select channels in preset as group 
Start = Toggles fader to full/zero 
Execute Attributes = Only executes attributes 
Flash = Flashes the content  

Include intensity Playback will control intensities   

Attributes follow fader Playback fader will control attributes 

Fader type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Specifies where attributes return to when the fader is 
faded down 

Off = No return target 
Previous = Status before the fade 
Preset = To a specified preset 
MainPB = To the preset in A of the main playback 

Preset Return to preset, if selected in previous choice 

Active Parameter Lock Attributes can not be stolen by any other playback. 
Manual override is possible. 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 

Flash type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Flash mode All = Intensities and attributes 
Intensity = Intensities only 
Attributes = Attributes only 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 
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Masters - Groups 
Enter the number, hold GROUP and press a Master Key to load to that Master. 

  

You can load and play back groups from master playbacks. They are displayed with a "Gr" before 
the number in the master displays. 
Once a group is loaded to a master you can 

• Use the master fader to set the level  
• Use the flash key to flash the group (if it has levels)  
• Use the master key to select the channels in the group 

NOTE 
If a change is made to a Preset or Group that is loaded to a Master which is 
active - the change will be pending until the Master is brought to zero and 
back up. Pending content indicated with inverted colors on the master LCD. 

Load a group to a master 

These functions are used to load groups to masters. 

Function  Keys Feedback 

Load a group  [#] [GROUP] & 

[Master_Key] 

Group # is loaded. The 
number and name are 
shown in the master display 

Load several groups [#] [GROUP] & 

[Master_Keys] 

Hold Group and keep 
pressing Master keys to 
load the next stored 
Groups  

Master settings for groups 

These are the settings you can change for masters with group content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the group 
Exclusive = fader "owns" group intensities 

Exclude Int. from 
Record 

Excludes intensity from this master from recording 

Master button Default = Select channels in master as group 
Start = Toggles fader to full/zero 
Flash = Flashes the content  

Include intensity Playback will control intensities   

Attributes follow fader Not used 

Fader type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Not used 

Preset Not used 

Active Parameter Lock Not used 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 

Flash type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Flash mode Intensity = Intensities only 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 
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Masters - Effects 
Enter the number, hold EFFECT and press a Master Key to load to that Master. 

  

You can load and play back effects from master playbacks. They are displayed with a "E" before 
the number in the master displays. 

Once an effect is loaded to a master you can 

• Use the master fader to set the level  
• Use the flash key to flash the group (if it has levels)  
• Use the master key to select the effect 

An effect contains effect attributes. These will always be dependent upon the last played back settings 
for that Effect Playback, or manual control.  

The Effect Playback on the Master does not contain any recorded settings at all but If the effect is 
stored to a preset that is assigned to a master, the effect attributes can be set to 

• Follow the fader up  
• Follow the fader down (rubberband)  
• Have a defined return status (previous, main pb, preset #)  
• Not follow the fader at all  
• Be activated on flash 

See Master settings for effects. 

Load an effect to a master 

These functions are used to load effects to masters. 

Function  Keys Feedback 

Load an effect [#] [EFFECT] & 

[Master_Key] 

Effect # is loaded. The 
number and name are 
shown in the master display 

Load several effects [CHANNEL] & 

[Master_Keys] 

This loads the selected 
effects into Masters one-
by-one at current 
intensities. 
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Master settings for effects 

These are the settings you can change for masters with effect content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the preset ch's 
Exclusive = fader "owns" preset intensities 

Exclude Int from Record Excludes intensity from this master from recording. 

Master button Default = Select effect channel as a group 
Start = Toggles fader to full/zero 
Execute Attributes = Only executes attributes 
Flash = Flashes the content  

Include intensity Playback will control intensity   

Attributes follow fader Not used 

Fader type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Not used 

Preset Not used 

Active Parameter Lock Not used 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 

Flash type Add = Adds intensities HTP 
Solo = Replaces the content of all other masters 

Flash mode All = Intensities and attributes 
Intensity = Intensities only 
Attributes = Attributes only 
Tap = Tap tempo for the effect 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 
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Masters - Palettes 
Enter the number, hold FOCUS, COLOR, BEAM, PALETTE and press a Master Key to load to that 
Master. 

 

You can load and activate palettes from master playbacks. They are displayed with a "Fo,Co, Be, Pa" 
before the number in the master displays. 

Once a palette is loaded onto a master you can use the master to activate the palette for selected 
channels:  

• Use the master fader to fade manually to the palettes levels  
• Use the master key to snap to the palettes levels  
• Use #, then press the Master Key to fade to the palette's levels in # seconds  
• Hold MODIFY and press the master key to open the Palette Editor 

NOTE 
The fader will fade the attributes of the selected channels to the palette values 
when moved up. What happens when you move the fader down depends on 
the setting of Return To in the Master Settings.  

Load palettes to masters 

This are the functions for loading palettes to masters. 

Function  Keys Feedback 

Load Palette  [#] [FOCUS] & 

[Master_Key] 

Focus Palette # is loaded 
with name and number. 
You can do the same with 
COLOR, BEAM and ALL 
PALETTE's. 

Load several Palettes [#] [FOCUS] & 

[Master_Keys] 

Hold FOCUS and keep 
pressing master keys to 
load all existing of the 
same type. You can do the 
same with COLOR, BEAM 
and ALL PALETTE's. 
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Play back palettes from a master 

Palettes are activated with the master key or the fader, for the currently selected channel(s). 

Function  Keys Feedback 

Fade into palette Fader Selected channel(s) are faded 
into the palette 

Activate Palette  [Master_Key] The Palette is activated for the 
selected channel(s) 

Activate Palette on time  [#] [Master_Key] The Palette is activated for the 
selected channel(s) in # seconds 
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Masters - Sequences 
Enter the number, hold SEQUENCE and press a Master Key to load to that Master. 

  

You can record, load and play back sequences from master playbacks. They are displayed with an "S" 
before the number in the master displays. 
 
Once a sequence is loaded to a master you can 

• Use the master fader to control the output level  
• Use the flash key to flash the sequence  
• Use the master key as a GO or Go/Pause key  
• Use the flash key as a GoBack key  
• Hold MODIFY and press the master key to open the sequence editor 

Attributes are executed only when the fader is over zero. 

Load a sequence to a master  

These functions are used to load sequences to masters.. 

Function  Keys Feedback 

Load a sequence  [#] [SEQ] & 

[Master_Key] 

Sequence # is loaded. The 
number and name is shown 
in the master display. If the 
sequence doesn't exist it is 
created. 

Load several sequences  [#] [SEQ] & 

[Master_Keys] 

Hold SEQ and keep 
pressing new Master keys 
to load the next stored 
Sequences.  

NOTE 
You can load a Sequence directly from the Sequences List as well. See 
Sequences List - Insert/Delete/Load. 
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Record a sequence to a master 

When you record a second step to a master, or if a sequence is loaded to a master - you will get the 
option to continue to record to that sequence using the same recording logic as when you record to the 
sequence in the Main Playback. 

Record a preset to a sequence in a master 

1. Select channels (selection) or select none (all) to record.  
OPTION: Enter a preset or cue number. If you don't the next free last used for masters will be 
suggested. 

2. Hold RECORD & Master key. Use the right arrow to select Sequence. 

 

3. Enter a preset (or cue) text, Sequence name, and step text (optional) and press RECORD again. 

In "Use master as general rrecording target" you have the option of selecting this master as the 
general recording target, which means that all new presets or cues recorded in the Live tab will be 
added to the sequence in this master.  

Master settings for sequences  

These are the settings you can change for masters with sequence content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the group 
Exclusive = fader "owns" intensities 

Exclude Int from Record Excludes Intensity from this master from recording 

Master button Default = Select channels in current step as group 
GO = Same as GO in the main playback 
GO/Pause = Go and Pause 
Start = Toggles fader to full/zero 
Flash = Flashes the content  

Include intensity Playback will control intensities   

Attributes follow fader Not used 

Fader type Add = Adds intensities HTP 
Solo = Not used 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Not used 

Preset Not used 

Active Parameter Lock Not used 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 
GoBack = Same as Go Back in the main playback 

Flash type Add = Adds intensities HTP 
Solo = Not used 

Flash mode Intensity = Intensities only 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 

Dual Fader mode for Sequences 

When this mode is active, there are two modes involving two masters for controlling the 
sequence loaded to the first master, and there are more configurable buttons for controlling the 
sequence. 

Setting a master pair to A/B mode 
To be able to access these settings a sequence has to be loaded to the master. Hold SETUP and press 
the Master Key. This will open Master Settings with this option: 
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You can select the following options 

A+B 
The sequence master and the next higher master will control the sequence as an A/B playback 
providing a crossfader pair, just like when a sequence is controlled from the Main Playback. 

Int + A/B  
The first master controls the intensity of the sequence, and the second is a combined A/B crossfader. 

The default button settings (press MODIFY on "Button settings for dual fader mode) are those listed 
in the dialog above. 

The Master View will change to show these button settings and some more information for the A/B 
pair like this: 
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Simpler master wing displays: The linked A/B master shows the sequence number in parenthesis to 
indicate that the master is occupied. 

NOTE 
The Dual Fader mode setting can be selected also in the Master List (Browser 
>Masters >Master List).   
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Masters - Chase mode sequences 
Enter the number, hold SEQUENCE and press a Master Key to load to that Master. 

  

You can load and play back sequences in "chase" mode from master playbacks. They are displayed 
with a "C" before the number in the master displays. 

Once a chase is loaded to a master you can 

• Use the master fader to control the output level  
• Use the flash key to flash the chase  
• Use the master key as a GO or Go/Pause key  
• Use the flash key as a GoBack key 

Attributes are executed only when the fader is over zero. The Chase will start from the first step every 
time the fader is brought over 0%.  

Time Master 
A special feature available for sequences in chase mode is a Time Master. By creating a time master 
you can control the speed of a chase. 

A Time Master can only be assigned from the Master List. 

1. Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList. 

2. Set "Content Type" to "Time Master" 

3. Set "Content" to the number of the chase you wish to control. 
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Load a chase sequence to a master 

These functions are used to load chase mode sequences to masters. 
Function  Keys Feedback 

Load a chase  [#] [SEQ] & 

[Master_Key] 

Chase # is loaded to the 
Master Playback. The 
number and name are 
shown in the master 
display. 

   

Load several chases 

[#] [SEQ] & 

[Master_Keys] 

Hold SEQ and keep 
pressing new Master keys 
to load the next stored 
Sequence/Chase.  

NOTE 
You can load a Chase directly from the Sequences List as well. See Sequences 
List - Insert/Delete/Load. 

NOTE 
Connect a Master to the Master Playback controls to get more control over 
the Chase. See Master Playback. 

Master settings for chase mode sequences 

These are the settings you can change for masters with sequence content.  

Hold SETUP and press the Master key to open the settings.  
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Please note that some settings will make other settings invalid - for example, if you set a master to 
Inhibit, the main function will be inhibit. 

Function  Function 

Mode Inclusive = playback interacts with other playbacks 
Inhibit = fader limits the output of the group 
Exclusive = fader "owns" intensities 

Exclude Int. from 
Record 

Excludes intensity from this master from recording 

Master button Default = Select channels in current step as group 
GO = Same as GO in the main playback 
GO/Pause = Go and Pause 
Start = Toggles fader to full/zero 
Flash = Flashes the content  

Include intensity Playback will control intensities   

Attributes follow fader Not used 

Fader type Add = Adds intensities HTP 
Solo = Not used 

Fader: Use time Fader will never fade faster than the fade time 

Return to (FCB) Not used 

Preset Not used 

Active Parameter Lock Not used 

Flash button Off = No function 
Momentary = Flash when pressed 
Latching = Toggles flash off/on 
GoBack = Same as Go Back in the main playback 
Tap = Tap mode for the chase Bpm 

Flash type Add = Adds intensities HTP 
Solo = Not used 

Flash mode Intensity = Intensities only 

Flash: Use time Flash will use master time 

Flash Level Sets the target level for flash 
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Masters - Dynamics  
Enter the number, hold DYN EFFECT and press a Master Key to load to that Master. 

 

You can load and activate dynamic templates direct  from master playbacks. These are temporary data 
stored in the current Master Page. They are displayed with an "Dy" before the number in the master 
displays. 

Once a dynamic template is loaded to a master you can 

• Use the master key to activate the dynamic effect for the currently selected channel(s). 

NOTE 
This is an old version of dynamic effects in Cobalt. We recommend you to use 
the new Dynamic Effect playback instead, since it offers much more control. 

Load a dynamic template to a master 

These functions are used to load dynamic effect templates to masters. 

Function  Keys Feedback 

Load a dynamic [#] [DYN_EFFECT] & 

[Master_Key] 

The number and name are 
shown in the master display 

   

Load several dynamics 

[#] [DYN_EFFECT] & 

[Master_Keys] 

Hold DYN EFFECT and 
keep pressing new Master 
keys to load the next 
dynamic template.  
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Masters - Magic Sheets (8.0) 
From the CONTENT column in the Master List (Browser) you can load a Magic Sheet to a Master to 
be able to select it from the Master button. 

  

You can load and activate Magic Sheets direct  from master playbacks. These are temporary data 
stored in the current Master Page. They are displayed with an "La" before the number in the master 
displays. 

Once a Magic Sheet is loaded to a master you can 

• Use the master key to activate it for the currently selected  channel view. 

Load a Magic Sheet to a master 

Magic Sheets can only be assigned from the Master List. 

1. Open the master list (Browser >Masters >MasterList). 

 

2. Set "Content Type" to "Layout" 

3. Set "Content" to the number of the layout you wish to assign. 
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Masters - Attribute parameters 
Hold a Wheel Parameter key and press a Master Key to load to that Master. 

  

You can load and activate attribute parameters from master playbacks. This is very useful for 
parameters that map well to faders, like iris, focus, shutters and color mixing.  

Once an attribute parameter is loaded to a master, and depending on the nature of the parameter, you 
can 

• Use the master fader as the "parameter wheel"   
• Use the master key as the "parameter wheel key"  
• Hold the Master key and use the level wheel to change the value relatively 

The result is applied to the selected channel(s). 

Load a parameter to a master 

To load a parameter to master select a device with that parameter, hold the parameter wheel key and 
press a master key. 

To be able to do this you must have a device selected that has the parameter you wish to load, and the 
parameter page (Focus, Color, Beam) has to be selected so the parameter is active on one of the 
wheels.  

To remove a parameter from a master, hold C and press the master or potentiometer key.  
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Masters - Console keys 
From the CONTENT column in the Master List (Browser) you can load any console key to a Master. 

 

You can assign any console key to a master playback. This is useful if there is a soft key you are using 
a lot like "select 2nd" or "DATA", so you have fast access to it. Console keys are displayed with a 
"Ke" and the key function, in the master displays. 

Once a console key is loaded to a master you can 

• Use the master key as the console key 

NOTE 
You cannot clear a console key from a master by holding C and pressing the 
master key - since C is used in combination with console keys. To clear, go to 
the Master List.  
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Load a console key to a master 

Console keys can only be assigned from the Master List. 

1.Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList. 

 

2. Set "Content Type" to "key" 

3. Set "Content" to the key of your choice.  
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Masters - Macros 
From the CONTENT column in the Master List (Browser) you can load a Macro to a Master. 

 

You can assign a macro key to a master playback so you have fast access to it. Macro keys are 
displayed with a "Ma" and its text, in the master displays. 
 
Once a macro key is loaded to a master you can 

• Use the master key as the macro key 

Load a macro to a master 

Macros can only be assigned from the Master List. 

1. Open the master list (Browser >Masters >MasterList). 

 

2. Set "Content Type" to "Macro" 

3. Set "Content" to the macro number of your choice.  
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Masters - Drag and Drop Data 

There are many ways of moving around data between masters. Drag and drop is one of them. It can be 
useful if you want to reorganize the content of your masters.  

• You can drag a channel selection from any channel view to a master.  
• You can drag any type of object that can be loaded to a master from the Browser  
• You can move content between masters. Note that all master settings will be moved along 

with the content. 

  

If there is content in a master field, you will get a dialogue for overwriting: 
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Drag and Drop Master Links 

You can create a master link in a sequence by dragging the master from the master view to the 
sequence step.  

The master will be linked with a target level or 100% if it is over 50% when linked, and a target level 
of 0% if it is under 50% when linked. You can double-click the master link in the Playback view to 
edit it.  

See Sequence Step Links - Master Playbacks. 
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Masters - Swap upper/lower 
Press SWAP to interchange the content and levels of the upper row of master faders with the lower 
row.  

 

Playback content and fader levels are matched with the motorized faders. Press again to swap back. 
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Masters - Select Playback Range  
Press and hold RANGE to be able to select which bank, or range of master playbacks you wish to 
control from the physical faders and pots. There are 80 master playbacks available at all times in the 
system. 

 

You can also enter the number of a master, hold RANGE and press MASTER to assign this range to 
the master faders.  

The principle of Fader Ranges:  

 

 

You can press the keys above/under the displays. 
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Masters - Fader Modes 
Press and hold FADER MODE to be able to select different operational modes for the master section.  

 

 

You can press the keys above/under the displays.  

These are the modes available: 

• Masters (default operation)  
• Two Scene (for busking)  
• Expanded Masters  
• Expanded Effects  (all/active)  
• Expanded Sequence (all/active) 
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Fader Mode - Masters 
Press FADER MODE to select default Masters mode. You can press the keys above/under the 
displays. 

 

 

In Masters mode the lower row of motorized faders control masters 1-20, and the upper row of pots 
control masters 21-40.  
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Fader Mode - Two Scene Masters 
Hold FADER MODE and select TWO SCENE to activate Two Scene Masters. You can press the keys 
above/under the displays. 

   

 

Two scene masters takes old school improvisation where channels could be preset blind and then 
faded onto stage to a new level.  

• The top twenty master faders are blind (1)  
• The lower twenty masters are live (2) 

You can set up and record anything on the top masters, and then fade on your choice of fade time into 
these settings. Once the fade is complete, all settings in the top masters have been loaded to the lower 
masters - which means that you have live control of them.  
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Fading Two Scene Masters 

To fade the settings and content of the top row of masters (blind) into the bottom row of masters (live) 
press START or GO on the Masters Playback. 

You can enter a time before pressing START or GO. This time will continue to be used until a new 
time is entered. 

NOTE 
Any changes you make to content in the top masters will be loaded to the 
bottom live masters, but ONLY if the fader of the master is over zero %. 

It is possible to modify the Live masters at all times except when there is a 
crossfade running between Live and Blind because of the dipless calculation. 

In Cobalt 10: Press RANGE to the other upper/lower bank.  

Create new looks in Blind and record to masters 

One way of improvising on the fly in two-scene masters mode is to use the Blind field to create new 
looks, record them to the top masters and fade into them.  

1. Press BLIND to activate the blind tab. 

2. Select the channels and moving devices you want to modify blind, and use the parameter wheels 
and palette functions to create a look.  
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3. Hold RECORD and press a Master key for a master in the top row to record to that master. A 
popup will ask you to confirm. 

4. Bring up the master fader to activate the look. Press START to fade into that look and load it to 
the corresponding master in the lower "live" row.  
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Fader Mode - Expanded Masters 
Hold FADER MODE and select EXPANDED MASTERS to activate. You can press the keys 
above/under the displays. 

   

 

Expanded Masters will use the whole "strip of controls" for one master playback - providing expanded 
control for 20 masters at a time. See Masters - Introducion. 
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In Expanded Masters mode you can set the buttons and faders and pots to the functions of your choice. 
See Masters - Settings. 
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Fader Mode - Expanded Effects 
Hold FADER MODE and select EXPANDED EFFECTS to activate. You can press the keys 
above/under the displays. 

   

Select ALL for all effect playbacks and ACTIVE for all active effect playbacks at the moment of 
selecting this mode. 

 

Expanded Effects will use the whole "strip of controls" for one master playback - providing expanded 
control for 20 masters at a time. . See Masters - Introducion. 
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In Expanded Effects mode you get more buttons and faders and pots to control the functions of your 
choice (fixed).  

These are the settings: 

• Pot  = rate  
• Pot click = tap tempo  
• Button over display = Source  
• Button under display = Set/Group (source target)  
• Flash button = Flash 
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Fader Mode - Expanded Sequences 
Hold FADER MODE and select EXPANDED SEQUENCES to activate. You can press the keys 
above/under the displays. 

   

Select ALL for all sequence playbacks and ACTIVE for all active sequence playbacks at the moment 
of selecting this mode. 

 

Expanded Sequences will use the whole "strip of controls" for one master playback - providing 
expanded control for 20 masters at a time. . See Masters - Introducion. 
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In Expanded Sequences mode you can set the buttons and faders and pots to the functions of your 
choice. See Masters - Settings. 
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Masters - Beat Boss  
In the Master List (Browser>Masters>Master List) open the Content Type and select Beat Boss and 
Content number 1-9. Beat Bosses can be applied to Chase and Content effects. The top row of masters 
in Cobalt hardware with the potentiometers is by far the best control surface for a Beat Boss. See 
Chase Beat Boss and Content Effect Beat Boss. 

  

When a master is assigned a Beat Boss, the slider or potentiometer will change the value. To tap a BB 
on a fader set the FLASH key to TAP manually. 

• The BPM will be set to 120 with the fader at 50%, 240 at the top and 0 at the bottom.  
• Chase/Content effects: Added Beat Boss parameter that links an effect to a beat boss.  
• Current beat boss BPM values are stored in the show file. 

When a Beat Boss is assigned to several effects and runs on a master, you can select all effects by 
pressing the master key.  
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Master View  
Press MASTER to open the Master View tab. The Master View is a graphical view of the content in 
the master playbacks. It has several formats and is zoomable. (Browser >Masters >Master View) 

  

 

1. Indication of Master View mode (see 3)   
2. Context menu for viewing format  
3. Master View settings and view modes  
4. Master Page name and number  
5. Master Page keys  
6. Master symbol  
7. Context menu for master symbol 

NOTE 
Master Views can be opened in any screen area as a tab content. 
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Using a mouse or trackball 

Function  Keys Feedback 

Using a mouse click Click to select and hold 
right key and move to set 
levels. Click to add more, 
double-click to deselect all 
but the last clicked. 

Open the Master Editor [MODIFY] & click The Master Editor is 
opened. 

Master View - Formats 

You can toggle between viewing formats by pressing FORMAT 

• All Masters  
• Selected Masters  
• Active Masters  
• Masters with content 

You can toggle what is shown for a sequence or chase by holding FORMAT and pressing right/left 
arrows 

• Preset/text 
• Preset/time 
• Text 

You can zoom the level of detail by holding FORMAT and pressing the up/down arrows. 
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You can zoom the size of the masters by holding FORMAT and using the level wheel. 

The currently selected format is indicated in the top right corner of each Master View. 

NOTE 
In the All format there is a header bar visible for each row of masters that 
shows information about the currently selected master page. 
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Master List  
Hold MODIFY and press MASTER to open the Master List, a spreadsheet editor for all master fields 
where you can change settings and assign content to several fields at the same time. (Browser 
>Masters >Master List) 

 &  
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Master list - Columns & Functions (8.0) 

All of these are explained per content type in Masters - Functions. 

Column  Input Function 

Master   The number of this Master, cannot be 
edited.  

Content Type [MODIFY] Press MODIFY to open a dropdown 
with choices of content.  
See Masters - Content  

Content [#] [MODIFY] Sets the number # for the content type. 

In [#] [MODIFY] Used by START, Flash on time, Use 
Master Times and Master links. If only 
an In time is set, it will function as an 
Out time as well. 

Wait [#] [MODIFY] Used by START and Master links. It is 
how long the master will stay up before 
the Out time fades out. 

Out [#] [MODIFY] Used by START and Master links. It is 
how fast the master fade out after a Wait 
time. 

Mode  [MODIFY] Set Master Mode Inclusive, Inhibit or 
Exclusive. See Masters - Modes. 

Master Button [MODIFY] Set behavior for the Master Button - 
choose from dropdown. See Master 
Button. 

Fader Type [MODIFY] Toggles Add (default) and Solo mode. 
See Solo Mode. 

Fader Intensity 
Mode 

[MODIFY] Set behavior for controlling intensities 
(Disabled, Follow Manual Fader, 
Follow Time). See Master Fader 
Settings.  

Fader Attribute 
Mode 

[MODIFY] Set behavior for controlling 
attributes(Disabled, Follow Manual 
Fader, Execute at #%). See Master 
Fader Settings.  

Return to (FCB) [MODIFY] Set behavior for Return to FCB (Off, 
Previous, Preset, Main Pb). See Master 
Fader Settings.  

Preset [MODIFY] Set Preset for Return to FCB. See 
Master Fader Settings.  

Active Parameter 
Lock 

[MODIFY] Attributes are locked to fader. See 
Master Fader Settings.  

Flash Button [MODIFY] Sets behavior for Flash button. See 
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Column  Input Function 

Flash Settings. 

Flash mode [MODIFY] Toggles between 
All/Intensities/Attributes. See Flash 
Settings. 

Flash use time [MODIFY] Toggles if flash uses time. See Flash 
Settings. 

Flash level [#] [MODIFY] Sets flash level #. See Flash Settings. 

Exclude Record [MODIFY] Toggles Exclude intensity from 
recording. See Exclude Int From 
Record. 

Dual Fader Mode [MODIFY] Sets dual fader mode setup for this 
master. See Dual Fader Mode For 
Sequences.  

Mask [MODIFY] Assigns a Mask. See Mask in masters. 

Page Time   Shows the Master Page time that affects 
all In-Wait-Out times set in %. See 
Master Page Times - Page Time. 

 
NOTE 
Times can be set in % or in seconds. This is selected in the Settings Attributes 
- you can always toggle this by holding C before pressing MODIFY in the 
In/Wait/Out columns 
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Masters - Content  

You can play back almost any kind of content from a Master Playback. The content can be loaded 
directly or from the Master Editor. See Load/Clear & Master Editor. 

Content Function 

Prs Play back Preset from fader, select channels with Master 
key. Flash with Flash key. 

Chs Single channels or several channels as a temporary 
selection (previously called Grp). 

Device Single devices can be loaded and selected. 

Seq Play back Sequences. The Master key is Go. The fader is 
a Grand Master for that Sequence. Connect to the Master 
Playback for more functions. 

Chases (old) Play back Sequences in Chase mode. The Master key is 
Go. The fader is a Grand Master for that Sequence. 
Connect to the Master Playback for more functions. 

Focus, Color, Beam, 
Pal. 

Activate any kind of Palette (F, C, B, All) for the 
selected channels. 

Macro Assign a Macro to activate with the master key. 

Dynamic Activate a Dynamic Effect for the selected channels. 

Mask (obsolete) This feature is obsolete - it is still visible to be backwards 
compatible.  

Key  A master can be set as any console key. The master key 
will function as this key. 

Group Play back Groups from fader, select channels with 
Master key. Flash with Flash key. 

Layout Any MAgic Sheet can be assigned to a Master Playback 
with this feature. 

Parameter Any parameter of a moving device can be assigned to a 
Master Playback* 

Time Master Any Master can be assigned as a Time Master for a 
Sequence in Chase mode. See Chases (old). 

Beat Boss  Any master can be a control for a Beat Boss 1-9. See 
Masters - Beat Boss . 

*Can be assigned by holding a Parameter key and pressing the Master key, or from the Master List. 
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Master Pages 
Master Pages store all content for 20 masters and can be used used in any 
row of 20 Master Playback Faders, eg the upper (21-40) or lower (1-20) rows. 

This chapter contains the following sections 

• Master Pages - Introduction  
• Master Pages - Record  
• Master Pages - Functions  
• Master Pages - List  
• Master Pages - Editor  
• Master Pages - Times  
• Master Pages - Auto-update Mode  
• Master Pages - Display List 
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Master Pages - Introduction 
You can store all content of 20 Master Playbacks into a Master Page. Master Pages can be stepped 
through, or loaded. 

General Functionality 

• Master Pages are stored for 20 Master Playbacks.  
• Page 1 & 2 are automatically loaded when creating a new Play.  
• You can store up to 999 Master Pages.  
• Each Page can have a text label.  
• A Page can be Transparent - meaning empty Master Playbacks are not cleared when this page 

is loaded.  
• Each Page can have a Time and BPM affecting all chasers, presets and palettes.  

NOTE 
Loading a new Master Page puts the new content in a pending state  if the 
master is above 0%. When the Master is faded to 0% the new information is 
loaded.  
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Master Pages - Record (8.0) 
All content changes in the affected Master Range (1-20 or 21-40) are automatically recorded. They 
can be recorded manually to the same Page or to another Page as well. 

Function   Key Feedback 

Record to the currently 
loaded Master Page in 
masters 1-21. 

[RECORD] & [PAGE] You will get a confirmation 
in the message window at 
the bottom of the screens. 

Record what is in masters 
1-21 to Master Page # 

[#] [RECORD] & 

[PAGE] 

You will get a confirmation 
in the message bar at the 
bottom of the screens. 

NOTE 
In Congo Jr and Kid you can record to a Master Page using the Page #-# 
buttons in the Soft Key Displays. 
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Master Pages - Functions 
It is possible to load and change Master Pages separately to any bank (1-20, 21-40, 41-60, 61-80) of 
Master Playbacks. When a new play is created Page 1-4 are automatically loaded. 

Press PAGE to activate the page direct select keys in the master displays.  

  

 

 

More ways to use the PAGE key: 

Function  Key Feedback 

Load Master Page # [#] [PAGE] 

[Master_Key] 

Master Page # is loaded* to 
the row of masters of the 
Master Key (upper/lower) 

Step to next Master Page 
for the lower bank. 

[PAGE] & [+] Loads the next Master 
Page. 

Step to previous Master 
Page for the lower bank. 

[PAGE] & [-] Loads the previous Master 
Page.  

*The corresponding Masters are cleared. If the Page does not exist it will be created 

NOTE 
PENDING - If a master fader is over 0% when new content is loaded - it will 
load the new content after fading to 0%. 
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Master Pages - List 
You can view, edit and create Master Pages directly in the Master Page List (BROWSER >Masters 
>Master Pages). 

 

NOTE 
The system always creates 10 empty Master Pages when a new Play is 
opened. 

Master Pages List - Columns 

Column  Input Function 

Page No input The number of this Page - 
cannot be edited. 

Text ABCDE... Press MODIFY to activate 
and end text input.  

Transparent [MODIFY] When ON this Master Page 
will only load the stored 
masters. 

Time [MODIFY] This time can be set to 
affect all percent times in 
this Master Page. See 
Master Page Times. 

BPM [MODIFY] This value can be set to 
affect all chase rates in this 
Master Page. See Master 
Page Times. 
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Master Pages List - Functions 

These are the functions in the Master Pages List  

Function   Key   Feedback 

Insert a Master Page [INSERT] Inserts a new Master Page 
with the next free number 

Insert Master Page # [#] [INSERT] Inserts a new Master Page 
# 

Delete the selected Master 
Page 

[DELETE] Deletes the selected Master 
Page. Cannot be undone. 
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Master Pages - Editor  
In the Master Page Editor you can view and edit the content and times of Master Pages. Open in 
Browser> Masters >Master Pages> Master Page #. 

You can use copy and paste to make a copy of an existing master page. 

 

Master Page - Columns 

Column  Input Function 

Master   The number of this Master, cannot be 
edited.  

Content Type * [MODIFY] Press MODIFY to open a dropdown 
with choices of content.  
See Masters - Content  

Content [#] [MODIFY] Sets the number # for the content type. 

In [#] [MODIFY] Used by START, Flash on time, Use 
Master Times and Master links. If only 
an In time is set, it will function as an 
Out time as well. 

Wait [#] [MODIFY] Used by START and Master links. It is 
how long the master will stay up before 
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Column  Input Function 

the Out time fades out. 

Out [#] [MODIFY] Used by START and Master links. It is 
how fast the master fade out after a Wait 
time. 

Mode  [MODIFY] Set Master Mode Inclusive, Inhibit or 
Exclusive. See Masters - Modes. 

Master Button [MODIFY] Set behavior for the Master Button - 
choose from dropdown. See Master 
Button. 

Fader Type [MODIFY] Toggles Add (default) and Solo mode. 
See Solo Mode. 

Fader Intensity 
Mode 

[MODIFY] Set behavior for controlling intensities 
(Disabled, Follow Manual Fader, 
Follow Time). See Master Fader 
Settings.  

Fader Attribute 
Mode 

[MODIFY] Set behavior for controlling 
attributes(Disabled, Follow Manual 
Fader, Execute at #%). See Master 
Fader Settings.  

Return to (FCB) [MODIFY] Set behavior for Return to FCB (Off, 
Previous, Preset, Main Pb). See Master 
Fader Settings.  

Preset [MODIFY] Set Preset for Return to FCB. See 
Master Fader Settings.  

Active Parameter 
Lock 

[MODIFY] Attributes are locked to fader. See 
Master Fader Settings.  

Flash Button [MODIFY] Sets behavior for Flash button. See 
Flash Settings. 

Flash mode [MODIFY] Toggles between 
All/Intensities/Attributes. See Flash 
Settings. 

Flash use time [MODIFY] Toggles if flash uses time. See Flash 
Settings. 

Flash level [#] [MODIFY] Sets flash level #. See Flash Settings. 

Exclude Record [MODIFY] Toggles Exclude intensity from 
recording. See Exclude Int From 
Record. 

Dual Fader Mode [MODIFY] Sets dual fader mode setup for this 
master. See Dual Fader Mode For 
Sequences.  

Mask [MODIFY] Assigns a Mask. See Mask in masters. 
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Column  Input Function 

Page Time   Shows the Master Page time that affects 
all In-Wait-Out times set in %. See 
Master Page Times - Page Time. 

*Content dropdown 
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Master Pages - Times 
Master Playback times can be stored in Master Pages. Times are set from 0.1seconds to 49.59 minutes 
(0.1- 4959). 

General Facts 

• A Master Playback can have an in/wait/out time.  
• A Master Page can have a general time used for all Palettes and Presets.  
• A Master Page can have a BPM time for all Chases. 

Master Page Times - In, Out, Wait 

Fade times for a Master Playback can be stored in a Master Page.  

The times are activated in the following situations 

• When the master is linked from a Sequence Step.  
• When you hold START and press the Master Key.  
• When Flash On Time is active (SETUP & Master Key). 

Function  Keys Feedback 

1. Activate the Master 
Pages List 

Browser >Master 
Pages 

The Master Pages List is 
opened. 

2. Activate a Master Page 
List 

Arrow keys The Master Page List is 
opened. 

3. Go to In-Wait-Out Times Arrow keys Each selected cell is 
highlighted 

4. Set a time* [#] [MODIFY] A time of # is set. 

Master Page Times - Page Time 

The Master Page Time is used for Palettes (content= palette) and Presets with In times set in %. 

Function  Keys Feedback 

Set Master Page Time* [#] [TIME] & 

[PAGE] 

A Master Page Time # is 
set to the currently loaded 
Master Page. 

*The Master Page Time can be set from the Master Page List as well. 
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Master Page Times - BPM 

The Master Page BPM will affect all chasers running in that Master Page.  

Function  Keys Feedback 

Set Master Page BPM* [TAP] & [PAGE] Tap at least two times to set 
a BPM. You can edit it in 
the Master Page List. 

*If chases have a rate, it will be scaled by the BPM. 
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Independents 
The independents are potentiometers and keys that can be set up to control 
lights that you want to separate from the main controls - such as houselights, 
work lights etc.  

  

Independents Node 

  

This chapter contains the following sections 

• Independents - Introduction  
• Using the Independents  
• Independent Modes  
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Independents - Introduction 
The Independents offer a control surface for potentiometers and keys to which you can assign 
channels that can be excluded from normal control and recording. 

 

In Cobalt there are six independent potentiometers. These can be used for  

• Adding light (inclusive mode)  
• Removing light (inhibit mode)  
• Independent lights (Exclusive mode) 

There are three independent keys. These can be used as toggle or flash for  

• Houselights  
• Smoke machines  
• Relays 
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Using the Independents 

Action Console Feedback 

1. Open the Setup* Hold Setup and move 
the potentiometer or 
press a key** 

A popup will appear with a 
channel view*** 

2. Set channels, levels and 
attributes 

   

3. Select Mode [MODIFY] See Independent Modes 

4. Select Execute Arrow key Execute is highlighted 

5. Store [MODIFY] The popup is closed 

*The Setup can be opened from the Browser as well (Browser >Independents) 
**Keys have the option to be toggling on/off. 
***The Independent popup 
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Independent Modes 

Mode  Screen Feedback 

Exclusive Blue level Blackout, 
GrandMaster, Capture or 
any other channel function 
will not affect this 
channel(s). 

Inclusive No indication Works as an additional 
Master Playback 

Inhibit Red level Is an Inhibit Master - works 
as a Grand Master for the 
selected channel(s).* 

*If you have several Independent Functions set to Inhibit and they have overlapping channels, the 
highest Special Function will be in control. The result on stage can be recorded. 

NOTE 
Only Intensities can be Exclusive. Attributes remain LTP, and thus may be 
'stolen' back by the rest of the console. 
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Independents Tab  
Independents allow you to set up houselights and other show content that you wish to control 
separately. 

Symbol in the Tab Selector 

 

The Independents tab 

 

It is possible to select Independents and set levels from the tab with the MASTER key.    

Function  Keys Feedback 

Select an Independent [#] [MASTER] Independent # is selected 
and highlighted. 

Add   [#] [+] Independent # is added. 

Add a range   [#] [THRU] Up to Independent # are 
added. 

Subtract   [#] [-] Independent # is 
subtracted. 

Set a level   [#] [@LEVEL] The Independent levels are 
set to #. 

Set a level   [Wheel] The Independent levels are 
set to #. 

Step to next/previous [+] [-] Steps to next/previous 

Using a mouse or trackball 
Click to select and hold right key and move to set levels. Click to add more, double-click to deselect 
all but the last clicked. 
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Remote Controls 

There are different remote control systems for Cobalt. Each one has it's own 
working field. This is where you can set/edit and clear these fields, and 
rename the remotes.  

  

Remote Controls node 

 

This chapter contains the following sections 

• Clear Remotes  
• Remote Control List 

All different types of remote controls are described in Accessories - Remote Control. 

Clear Remotes  

Select this node and press MODIFY to clear all intensities set in remote fields.  

 

This function is available in the Misc Soft Key Menu as well.  
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Remote Control List  

Open from BROWSER >Remote Controls >Remotes List. This editor shows all active remote 
controls.  

You have the possibility to give names to each Remote control (currently only possible on Net3 RFR 
devices) and disable the contribution from specific remotes. In Settings: System, you can set all 
remote input to off. See Play Settings - System. 

• If you press MODIFY in the Clear Levels column, you can quickly clear all levels from that 
remote.  

• The channels and levels in each remote field can be edited directly in the channel view in the 
top of the editor.  

• The Online column is just an indicator for network RFR's.  
• To set this remote to work in A instead of it's unique remote field activate this cell. 
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CONSOLE KEYS 
This Chapter is about the console key functions, keyboard equivalents and 
shortcuts. Its a very useful chapter. 

This chapter contains the following sections  

• Console Key Quick Help  
• Console Key Shortcuts 
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Console Key Quick Help  

These are all console keys with a short explanation and a summary of 
functions, in alphabetical order.   

• This text is linked to each key in the console and opens if you hold [?] and press a key. 
• There are links to the corresponding chapters of the manual.  
• The keyboard equivalent in an alphanumeric keyboard is listed. 

Console Key - ?  

This is the HELP function. It activates the online help system, which is a complete electronic copy of 
the user manual.  

• [HELP] - Activates Help.  
• [HELP] & [KEY] - Activates help for that key.  
• [HELP] - after opening an editor or list opens help for that editor. 

For more information see  This Manual.   

Keyboard equivalent: [F1] 

Console Key - <-- (Disp Mode) 

Press this key to move one level up in the main display soft key menus of the console.  

For more information see Main Playback - Edit Keys. 

No keyboard equivalent 

Console Key - @LEVEL  

This key is used to set levels to channels. It can also be used in combination with other keys for 
specific level functions.  

• [#]  [@LEVEL] - Set level # to the currently selected channels.  
• [@LEVEL] = 70%  
• [@LEVEL] [@LEVEL] = 100%  
• [@LEVEL] [@LEVEL] [@LEVEL] = 0%  
• [CHANNEL] & [@LEVEL] - Sets a temporary ID level 0-100% to the currently selected 

channels.  
• [SETUP] & [@LEVEL] - Opens the level settings.  
• [ON/FETCH]&[@LEVEL] - Revert (undo) changes to channel level. 
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NOTE  
If the console is set to operate in At Mode this key has a slightly different syntax. See Channels - 
Command Syntax . 

For more information see Set Channel levels.  

Keyboard equivalent: [+] 

Console Key - A 

Opens the channel view for the A field of the Main Playback. The channel control will be connected 
to the A field. 

• [A] - Opens and selects the A tab.  
• [TIME] & [A] - Forces the setting "Times to A" 

For more information see Main Playback - Edit Keys. 

Keyboard equivalent: [A] 

Console Key - ALIGN 

This key is used to align device parameters to the one currently selected with NEXT/LAST.  

• [ALIGN] & [parameter key] (CYAN, or FOCUS for example) - Aligns these parameters. 

For more information see Device Control - Align. 

Keyboard equivalent: [Alt] & [A] 

Console Key - ALL  

The ALL key is used for selecting channels with levels over 0% in different targets. 

• [ALL] - Selects all channels with a level over 0% in any channel view.  
• [ALL] [ALL] - In the Live view the first press will select all channels over 0% in A, the 

second press will select channels in all Master Playbacks as well.   
• [ALL] & [PALETTE KEY] - Hold ALL and press a Direct Select key for a palette to select 

all channels with an intensity over 0% using that palette. 

For more information see Select Channels. 

Keyboard equivalent: [SHIFT] & [-] 
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Console Key - Arrow Keys  

The arrow keys are a vital part of all navigating functions, and are used a lot in combination with the 
silver colored navigating keys, and the level wheel. 

• [Arrow keys] - Move in the direct of that key in the Browser, or a spreadsheet view. In 
dialogue boxes the side arrows will move between tabs, and up and down will select input 
areas. In the Browser the right arrow will open the current node, and the left arrow will close 
and jump to the top of any list.  

• [Arrow key] & [level wheel] - Speed scroll in any list view.  
• [TAB] & [side arrows] - Moves the current tab to the next screen.  
• [TAB] & [down arrow] - Splits the screens, the same command with the up arrow will undo 

the current split.  
• [FORMAT] & [down arrow] - Opens more detailed information when available.  
• [FORMAT] & [up arrow] - Selects less detailed information when available. 

For more information see Navigating - The Arrow Keys. 

Keyboard equivalent: [Arrow keys]  

Left Arrow 

Scroll to top of this page.  

Right Arrow 

Scroll to top of this page.  

Up Arrow 

Scroll to top of this page.  

Console Key - ATTRIB 

The ATTRIB key is used to record, edit and view attributes for moving devices. 

• [ATTRIB] - Opens the Live Attribute view.  
• [#] [RECORD] & [ATTRIB] - Record all attributes for the currently selected channels to 

preset #.  
• [#] [PRESET] & [ATTRIB] - Opens the attribute editor for that preset.  
• [SETUP] & [ATTRIB] - Opens the attribute settings. 

For more information see Device Views - Live,  Device Views - Presets, Record All Attributes For 
Selected Channels 
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Keyboard equivalent: [I] 

Console Key - B 

This key opens the channel view for the B field of the Main Playback. The channel control will be 
connected to the B field. 

• [B] - Opens and selects the B tab.  
• [TIME] & [B] - Forces the setting "Times to B" 

For more information see Main Playback - Edit Keys. 

Keyboard equivalent: [B] 

Console Key - BALANCE 

The BALANCE key is a soft key in the CHANNELS menu of the console main display. It is used to 
mute all channel intensities except the current selection, temporarily. 

• [BALANCE] - Temporarily mutes all channel intensities except the current selection. Press 
again to return.  

• [SETUP] & [REM DIM] - Opens the dialogue to set this key as BALANCE. 

For more information see Channels - Balance Mode. 

There is no keyboard equivalent.  

Console Key - BANK 

The BANK key is used to change bank of data in the Direct Select key sections. 

Hold [BANK] - When this key is held, you can use the direct select keys to select a bank (1-10, 11-20 
etc) for each section of direct select keys. 

For more information see Direct Select - Content. 

There is no keyboard equivalent. 

Console Key - BEAM 

This key is used to record and recall Beam palettes for moving devices.  

• [RECORD] & [BEAM] - Record the next free palette for the currently selected devices.  
• [#] [RECORD] & [BEAM] - Record a new palette for the currently selected devices.  
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• [#] [BEAM] - Recall a recorded palette for the currently selected devices.  
• [MODIFY] & [BEAM] - Open the Beam palette list.  
• Hold [BEAM] - When BEAM is held, all existing palettes 1-40 can be accessed from the 

direct select keys. 

For more information see Devices - Palettes, Record A Beam Palette, Device Palettes - Direct Mode. 

Keyboard equivalent: [ALT] & [B]  

Console Key - BLIND  

The BLIND key is used to edit and load content to the blind editing field. You can edit and record 
channels in BLIND independently from all other fields. 

• [BLIND] - Open the Blind view, and set channel control to this field.  
• [LIVE] & [BLIND] - Move the values of the current channels over 0% into BLIND.  
• [BLIND] & [A] or a [master key] - Move the values of the currently selected channels from 

BLIND to that field.  
• [BLIND] & [level wheel] - Fade the content of BLIND into the output of the console. 

For more information see Blind - Blind Tab. 

Keyboard equivalent: [F3]  

Console Key - BROWSER 

The Browser is a fundamental part of the Cobalt system. This is where all functions are located, all 
data can be viewed, and where you can access settings, files and the Help system. 

• [BROWSER] - Select the Browser. If it is already selected, it will be closed. Press again to 
open.  
- Use the [up/down arrows] to navigate, and in combination with the level wheel to speed 
scroll.  
- Use the [right arrow] to open an item.  
- Use the [left arrow] to jump to the top of the current item and close it.  
- Press [MODIFY] to open the editor for an item.  
- Press [LOAD] to activate items like Groups, Palettes etc.  

For more information see Navigating - Browser, Dock Areas. 

Keyboard equivalent: [F10] 

Console Key - C/ALT 

This key is used to clear numeric entries. When it is held it can be combined with other keys for 
clearing information, and for Macro style functions like channel check mode. 
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• [C/Alt] - Clear the last numeric entry.  
• [C/Alt] [C/Alt] - Deselect all channels.  
• [C/Alt] & [CHANNEL] - Clear the current channel selection and levels in the selected 

channel view.  
• [C/Alt] & [master key] - Clear that field.  
• [C/Alt] & [PLAYBACK] - Clear the A field.  
• [C/Alt] & [PAGE] - Clear the current master page.  
• [C/Alt] & [+%] - Set 100%.   
• [C/Alt] & [-%] - Set 0%.  
• [C/Alt] & [+] or [-] - Activate channel check mode with the current level.  
• [ESC] & [C/Alt] - Lock/Unlock the console. 

For more information see Channels - Clear Functions, Master Playbacks - Load/Clear/Modify. 

Keyboard equivalent: [Backspace]  

Console Key - CAPTURE 

This key is used to activate Capture mode, in which any channel that is manually altered will be 
Captured, and cannot be controlled from any other function until it is released from Capture mode. 
Captured channels are indicated with a red background in the channel views. When you record a 
captured channel, the captured levels are stored. 

• [CAPTURE] [CAPTURE] - Activate and deactivate Capture mode.  
• [#] [CAPTURE] & [CHANNEL] - Capture that channel without activating Capture mode.  
• [CAPTURE] & [ATTRIB] - Capture all attributes for the selected channel(s).  
• [CAPTURE] & [parameter key] - Capture that attribute for the selected channel(s). 

For more information see Channels - Capture Mode. 

Keyboard equivalent: [C] 

Console Key - CH ONLY MODE 

The CH ONLY MODE key is used to activate the Channels Only Mode for the console, providing a 
single scene single channel control for simple hands on. The patch is active.  

• [CH_ONLY_MODE] - Toggles Channels Only Mode on/off.  

For more information see Channels - Ch Only Mode. 

Keyboard equivalent: [-] & [+] on the numerical keypad 
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Console Key - CHANNEL 

The CHANNEL key is used to select channels, and in combination with other keys for additional 
channel functions. 

• [#] [CHANNEL] - Select that channel (if you are operating in At Mode, this key is not used 
in the same way).  

• [C/Alt] & [CHANNEL] - Clear levels and channel selection in the selected channel view.  
• [CHANNEL] & [up/down arrow] - Scroll in the selected channel view.  
• [CHANNEL] & [@LEVEL] - Set the levels of the selected channel(s) temporarily to 100% 

for identifying.  
• [#] [CHANNEL] & [TIME] - Record a channel time for the selected channel(s).  
• [#] [CHANNEL] & [DELAY] - Record a channel Delay for the selected channel(s).  
• [ON/FETCH]&[CHANNEL] - Revert (undo) level changes back to value at initial selection. 

For more information see Select Channels. 

Keyboard equivalent: [-] 

Console Key - CHANNEL SET 

The CHANNEL SET soft key in the EFFECTS soft key menu, is used to open the Channel Set editor 
for effects.   

• [CHANNEL SET] - Opens the Channel Set editor. 

For more information see Channel Sets 

There is no keyboard equivalent 

Console Key - CHAN DELAY 

CH DELAYT is a soft key in the TIME menu of the console main display. It is used to record 
individual channel delay times. Times are recorded to the Sequence Step in A or B depending on the 
setting of Times.  

• [#] [CH DELAY] - Record that time to the currently selected channel(s).  

For more information see Sequence Times - Channel Times. 

There is no keyboard equivalent. 

Console Key - CHAN TIME 

CH TIME is a soft key in the TIME menu of the console main display. It is used to record individual 
channel times. Times are recorded to the Sequence Step in A or B depending on the setting of Times.  
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• [#] [CH TIME] - Record that time to the currently selected channel(s).  

For more information see Sequence Times - Channel Times. 

There is no keyboard equivalent. 

Console Key - CHASE 

The CHASE soft key in the EFFECTS soft key menu, is used to open the editor for chase effects.   

• [CHASE] - Opens the CHASE editor. 
• [#] [CHASE] - Opens the CHASE editor focused at chase #. 

For more information see Chase Effects 

There is no keyboard equivalent 

Console Key - CHECK + 

The CHECK + key is used for the Channel Check function. 

• [CHECK +] - Make a channel check to the next channel with the current level.  

No keyboard equivalent 

Console Key - CHECK - 

The CHECK - key is used for the Channel Check function. 

• [CHECK -] - Make a channel check to the previous channel with the current level.  

No keyboard equivalent 

Console Key - CLEAR CHANGED 

CLEAR CHANGED is a soft key in the DEVICE menu of the console main display. It is used 
together with the attribute record setting "Changed" to clear the Set Changed flag on parameters that 
have been changed, so they will not be recorded. 

• [SET CHANGED] & [PALETTE] - Set all parameters for the selected channels to not 
changed.  

• [SET CHANGED] & [FOCUS] - Set Focus parameters for the selected channels to not 
changed.  
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• [SET CHANGED] & [COLOR] - Set Colorparameters for the selected channels to not 
changed.  

• [SET CHANGED] & [BEAM] - Set Beam parameters for the selected channels to not 
changed.  

• [SET CHANGED] & [wheel parameter key] - Set this parameter for the selected channels to 
changed. 

For more information see Devices - Recording. 

There is no keyboard equivalent. 

Console Key - Cobalt Encoder 

The COBALT ENCODER keys are endless encoders that allow you to set values AND there is a click 
in them that sets the field/parameter to zero/full or a value (#) similar to the Parameter Wheel Keys. 

• [ENCODER]  (press) - set to 100/zero. 
• [ENCODER]  (turn) - set value. 
• [#] [ENCODER]  (press) - set to value. 

For more information see Masters - Introduction 

There is no keyboard equivalent 

Console Key - COLOR 

This key is used to record and recall Color palettes for moving devices.  

• [RECORD] & [COLOR] - Record the next free palette for the currently selected devices.  
• [#] [RECORD] & [COLOR] - Record a new palette for the currently selected devices.  
• [#] [COLOR] - Recall a recorded palette for the currently selected devices.  
• [MODIFY] & [COLOR] - Open the Color palette list.  
• Hold [COLOR] - When COLOR is held, all existing palettes 1-40 can be accessed from the 

direct select keys. 

For more information see Devices - Palettes, Record A Color Palette, Device Palettes - Direct Mode. 

Keyboard equivalent: [ALT] & [C/Alt  

Console Key - COLUMN 

The COLUMN key is used for various functions in spreadsheet views. 

• [COLUMN] - Select all cells downward in the current column.  
• [COLUMN] & [level wheel] - Resize a column.  
• [COLUMN] & [up/down arrows] - Sort the spreadsheet by the content of this column.  
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• [COLUMN] & [right/left arrows] - Move a column. 

For more information see Navigating - Lists, Change The List View, Sort By Column. 

Keyboard equivalent: [F9]  

Console Key - COMPARE 

COMPARE is a soft key in the CHANNELS menu of the console main display. It is used to compare 
the intensities in a channel view with any other Preset. It is a mode that has to be exited before 
returning to normal operation. 

• [COMPARE] - Load the last recorded preset that was loaded to this channel view. Press 
again to return.  

• [#] [COMPARE] - Load that preset to this channel view. Press again to return. 

For more information see Presets - Compare Mode. 

There is no keyboard equivalent.  

Console key - CONNECT 

The CONNECT key is used to connect a Master with a Sequence to the Master Playback controls of 
the console frontpanel. A Playback tab will be opened for this master. If the master is empty a 
dialogue will open for choosing to create a Preset or Cue Sequence. 

• [CONNECT] & [master key] - Connect.  
• # [CONNECT] - Connects master #  
• 0 [CONNECT] - Disconnects currently connected master  
• [CONNECT] - Opens the playback view for the currently connected master 

For more information see Master Playback - Playback Keys. 

There is no keyboard equivalent 

Console Key - COPY/CUT 

The COPY/CUT key is used to copy and cut information for pasting. Information that can be copied, 
cut and pasted is Text, Sequence Steps (Sequence List), Groups (Group List), Presets (Preset List), 
Device Templates (Device Template List) and Attributes in the Preset List. 

• [COPY/CUT] - Copy the selected object.  
• [COPY/CUT] [COPY/CUT] - Cut the selected object. 

For more information see Copy, Cut & Paste. 
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Keyboard equivalent: [CTRL] & [C/Alt 

Console Key - CURSOR 

The CURSOR key is only available in the big Cobalt console to set the built in trackball to mouse 
mode.  

• [CURSOR] - Set the trackball to mouse mode. Trackball will be red.  

For more information see Facepanel - Trackball. 

There is no keyboard equivalent 

Console Key - DATA 

The DATA key is a soft key in the CHANNELS menu of the console main display. It is used to set 
toggle how attribute data is displayed in the channel views and the console displays.  

When DATA is active absolute data is shown, for example Pan 50%. 
When DATA is off, referenced data is shown, for example F1 (focus palette 1) 

• [DATA] - Toggle Data on/off..  

Keyboard equivalent: none 

Console Key - DELAY 

The DELAY key is used to set delay times to the sequence step in the A or B field of the Main 
Playback (depending on the Time Settings). 

• [DELAY] & [IN] - Set a Delay In time.  
• [#] [DELAY] & [OUT] - Set a Delay out time.  
• [#] [CHANNEL] & [DELAY] - Set a channel delay time to the selected channel(s).  
• [#] [DELAY] & [FOCUS] - Set an attribute delay time for the selected channel(s).  
• [#] [DELAY] & [COLOR] - Set an attribute delay time for the selected channel(s).  
• [#] [DELAY] & [BEAM] - Set an attribute delay time for the selected channel(s). 

For more information see Sequences - Times, Sequence Times - Set To A or B. 

Keyboard equivalent: [CTRL] & [D]  

Console Key - DELETE 

The DELETE key is used to delete data permanently in lists. 
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• [DELETE] - Delete the selected object in any list. 

For more information see Editing In Lists. 

Keyboard equivalent: [DEL]  

Console key - DEVICE 

The DEVICE key is used to activate Device Mode, and to open the Device List, where you can edit 
the settings for all moving devices. 

• [DEVICE] - Activate Device Mode for the pots.  
• [SETUP] & [DEVICE] - Open the Device Mode settings.  
• [MODIFY] & [DEVICE] - Open the Device List settings. 

For more information see Device Control - Device Mode, Patch - Device List. 

Keyboard equivalent: [D]   

Console Key - Direct Select Pages 

The five Direct Select Page keys will activate a user setup that is auto-stored for the Direct Selects. 

• Press any of the five keys to access that page. 

For more information see Direct Select - User Setups. 

There is no keyboard equivalent 

Console Key - EFFECT 

The EFFECT key is used to operate the effect playbacks for chase, content, image and dynamic 
effects.   
NOTE that the command syntax for effects is different when operating in At Mode. See Effects - 
Command Syntax. 

• [EFFECT] - Open the Live Effects tab.  
• [#] [EFFECT] - Select effect playback #.  
• [INSERT] & [EFFECT] - Insert a new effect playback.  
• [#] [EFFECT] & [CHANNEL] - Select all channels in effect #.  
• [EFFECT] & [ALL] - Select all effects over zero %. 

For more information see Effects. 

Example: Build a Chase effect. 
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Keyboard equivalent: [E] 

Console Key - EFFECT OVERVI 

The EFFECT OVERVI soft key in the EFFECTS soft key menu, is used to open the Effects Overview 
tab with a summary of all data available to use for effects.   

• [EFFECT OVERVI] - Opens the Effects Overview tab. 

For more information see Effect Overview 

There is no keyboard equivalent 

Console Key - ESC 

The ESC key is used to close and exit all tabs and dialogues. 

• [ESC] - Exit the current dialogue.  
• [ESC] - Close the currently selected tab.  
• [ESC] & [C/Alt] - Lock/Unlock the console. 

For more information see Navigating The Tabs. 

Keyboard equivalent: [ESC]  

Console Key - FADER MODE 

The FADER MODE key is used to change mode for the Master Playbacks. 

• [FADER_MODE] (held) - toggles the master display so that the master keys above/under the 
displays can be used to select fader mode.  

No keyboard equivalent 

Console Key - FAN 

The FAN key is used to fan (distribute around a centre point) attributes and times. The distribution can 
be set to U, V and S shape in the Fan Settings. 

• [FAN] & [level wheel] - Select devices, use NEXT/LAST to set the centre point. Then hold 
FAN and move the wheel of the parameter you wish to fan. Attribute times are fanned with a 
wizard that opens when you select an attribute time or delay in an attribute view and press 
WIZARD. 
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For more information see Device Control - Fan, Device Times - Fan Times. 

Keyboard equivalent: [CTRL] & [F] 

Console Key - FCB DELAY 

The FCB DELAYsoft key in the Times soft key page, is used to set a delay time to FCB for the 
moving device channels. 

• [#] [FCB_Delay] - Sets the FCB times to # for the moving device channels, in the A or B 
field of the main playback depending on the settings for times. 

For more information see Sequence Times - FCB Times. 

There is no keyboard equivalent 

Console Key - FCB TIME 

The FCB TIME soft key in the Times soft key page, is used to set a time to FCB for the moving 
device channels. 

• [#] [FCB_Time] - Sets the FCB times to # for the moving device channels, in the A or B field 
of the main playback depending on the settings for times. 

For more information see Sequence Times - FCB Times. 

There is no keyboard equivalent 

Console Key - FLASH  

The lower row of masters in the Cobalt console and the large fader wing of the Congo Jr are equipped 
with two keys per master. The top key is the master key used to load content, and the lower key is a 
flash key. The flash key can be set to different modes and levels. 

• [Flash key] - Flash the content of a master.  
• [SETUP] & [flash key] - Open settings for a master.  
• [#] [FLASH MODE] & [flash key] - Set a flash level for a master.  

For more information see Master Playbacks - Flash Keys. 

There is no keyboard equivalent 
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Console Key - FLASH MODE 

The lower row of masters in the Cobalt console and the Congo Jr Master Playback Wing, the 
Universal wings and Congo Kid masters are equipped with two keys per master. The top key is the 
master key used to load content, and the lower key is a flash key. The flash key can be set to different 
modes and levels. 

• [FLASH MODE] (held)  - Shows master settings in console display, use page +/- to step 
through and press the Master Key to toggle settings.  

• [#] [FLASH MODE] & [flash key] - Set a flash level for a master.  
• [C/Alt] & [FLASH MODE] - Disable flash mode (toggles) 

For more information see Master Playbacks - Flash Keys. 

Keyboard equivalent: [F]  

Console Key - FLIP 

The FLIP key will flip the pan and tilt values of the selected moving devices. 

• [FLIP] - Flips pan and tilt. 

For more information see Device Control - Flip. 

Keyboard equivalent: None 

Console Key - FOCUS 

This key is used to record and recall Focus palettes for moving devices.  

• [RECORD] & [FOCUS] - Record the next free palette for the currently selected devices.  
• [#] [RECORD] & [FOCUS] - Record a new palette for the currently selected devices.  
• [#] [FOCUS] - Recall a recorded palette for the currently selected devices.  
• [MODIFY] & [FOCUS] - Open the Focus palette list.  
• Hold [FOCUS] - When FOCUS is held, all existing palettes 1-40 can be accessed from the 

direct select keys. 

For more information see Devices - Palettes, See Record A Focus Palette, Device Palettes - Direct 
Mode. 

Keyboard equivalent: [ALT] & [F]  

Console Key - FOCUS MODE 

The Focus Mode soft key in the Device Soft key page is used activate a specific focus mode for 
quickly adjusting palettes. 
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• [FOCUS_MODE] - Enters Focus mode. 

For more information see Device Palettes - Focusing Mode. 

There is no keyboard equivalent. 

Console Key - FORMAT 

The FORMAT key is a vital part of controlling what is shown in all views except spreadsheets (lists). 
It is used a lot in combination with the arrow keys, and the level wheel. 

• [FORMAT] - Change channel sorting (all channels, non-zero channels etc) for the current 
channel view.  

• [FORMAT] & [level wheel] - Zoom in channel and attribute views.  
• [FORMAT] & [up/down arrows] -  Compress/expand information in a view. 

For more information see Navigating - Channel Views. 

Keyboard equivalent: [F4] 

Console Key - GO 

The GO key starts the next crossfade in the Main Playback. 

• [GO] - Start a crossfade in the Main Playback. Press GO during an ongoing crossfade in the 
Main Playback to start the next one.  

• [SETUP] & [GO] -Change default times and crossfade settings. 

For more information see Main Playback - Transport Keys. 

Keyboard equivalent: [CTRL] & [G] 

Console Key - GO (Master Playback) 

This GO key in the Master Playback starts the next crossfade in the master/sequence connected to the 
Master Playback. 

• [GO] - Start a crossfade in the connected master. Press GO during an ongoing crossfade in 
the connected master to start the next one.  

For more information see Master Playback - Playback Keys. 

There is no keyboard equivalent 
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Console Key - GO BACK 

The GO BACK key starts a crossfade to the previous sequence step in the Main Playback. 

• [GO BACK] - Start a crossfade to the previous sequence step in the Main Playback. Press 
GO BACK during an ongoing crossfade to reverse it.  

• [SETUP] & [GO BACK] - Change default times. 

For more information see Main Playback - Transport Keys. 

Keyboard equivalent: [CTRL] & [B] 

Console Key - GO BACK (Master Playback) 

The GO BACK key starts a crossfade to the previous sequence step in the master/sequence connected 
to the Master Playback. 

• [GO BACK] - Start a crossfade to the previous sequence step in the connected master. Press 
GO BACK during an ongoing crossfade to reverse it.  

For more information see Master Playback - Playback Keys. 

No keyboard equivalent 

Console Key - GOTO 

The GOTO key is used to crossfade into any existing preset in the Main Playback. 

• [#] [GOTO] - Start a crossfade to that preset. If the preset exists in the current sequence, the 
step times will be used.  

• [SETUP] & [GOTO] - Change settings. 

For more information see Main Playback - Transport Keys and the Goto List. 

Keyboard equivalent: [CTRL] & [G] 

Console Key - GROUP 

The GROUP key is used to store and recall channel selections stored into Groups. 
NOTE that the command syntax for selecting groups is different when operating in At Mode. See 
Groups - Select channels. 

• [RECORD] & [GROUP] - Record the currently selected channels and levels into the next 
free group.  
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• [#] [RECORD] & [GROUP] - Record the currently selected channels and levels to that 
group.  

• [#] [GROUP] - Select the channels of that group.  
• [#] [GROUP] & [level wheel] - Fade the channels of that group in proportionally.  
• [GROUP], or [MODIFY] & [GROUP] - Open the Group List. 

For more information see Groups - Select Channels. 

Keyboard equivalent: [ALT] & [G] 

Console Key - GROUP WHEEL MODE 

GROUP WHEEL MODE is a soft key in the Channels menu of the console main display. In Group 
Wheel Mode you can assign a channel group to each wheel under the Main Display 

• [GROUP WHEEL MODE] - Activate Group Wheel Mode.  

For more information see Channels - Group Wheel Mode. 

There is no keyboard equivalent 

Console Key - HIGHLIGHT 

The HIGHLIGHT key will activate highlight mode for the currently selected devices. 

• [HIGHLIGHT] -  Toggles Highlight mode. 

For more information see Device Control - Highlight Mode. 

Keyboard equivalent: [Alt] [H] 

Console Key - HOME ATTRIB 

The HOME ATTRIB key will set all or some parameters for the currently selected devices to their 
default home position. The home position can be re-recorded at any time.  

• [HOME ATTRIB] [HOME ATTRIB] - Home all parameters for the selected devices.  
• [HOME ATTRIB] & [FOCUS, COLOR, BEAM] - Home these parameters.  
• [HOME ATTRIB] & [wheel parameter key] - Home only this parameter.  
• [RECORD] & [HOME ATTRIB] - Record the current values as the new HOME position for 

the selected devices.  
• [C/Alt] & [HOME ATTRIB] - Home all parameters for all devices.  
• [C/Alt] & [HOME ATTRIB] [HOME ATTRIB] - Home all parameters for all devices and set 

intensities to zero.  

For more information see Device Control - Home positioning. 
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Keyboard equivalent: [F5] 

Console Key - ID 

The ID key is used to set a temporary ID level to the selected channel(s). 

• [ID] - Set the levels of the selected channel(s) temporarily to 100% for identifying.  
• [#] [ID] - Set 100% to channel # 

For more information see Select Channels. 

Keyboard equivalent: [-] & [+] on the numerical keypad 

Console Key - IN 

The IN key is used to set In times to the sequence step in the A or B field of the Main Playback 
(depending on the Time Settings). 

• [#] [IN] - Set an in time.  
• [#] [DELAY ] & [IN] - Set a Delay In time. 

For more information see Sequences - Times, Sequence Times - Set To A or B 

Keyboard equivalent: [CTRL] & [I] 

Console Key - INDEPENDENTS 7,8,9 

The three keys and potentiometers in the Independents area of the consoles are used to control lights 
outside the main functionality of the console - for example houselights or worklights. They can 
operate in three modes: Inclusive, Inhibit and Exclusive. 

• [SETUP] & [independent key] - Open the settings.  
• [SETUP] & [independent pot] - Hold SETUP, then move and let go of an independent 

potentiometer to open the settings.  

For more information see Independents. 

There is no keyboard equivalent  

Console Key - INSERT 

The INSERT key is used to insert new data in a list. In some lists a number is required, in some not. A 
new item is usually inserted after the current item. 
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• [INSERT] - Insert a new item in a list.  
• [#] [INSERT] - Insert a new item with this number in a list.  
• [INSERT] & [Master Key]  - Insert that master as a master link in the sequence in the main 

playback. 

For more information see Editing In Lists. 

Keyboard equivalent: [INS] 

Console Key - INV GROUP 

The INV GROUP key is used to invert the current channel selection and select all other channels with 
a level over 0% in a channel view. 

• [INV GROUP] - Invert the current channel selection.  

For more information see Select Channels. 

Keyboard equivalent: [H] 

Console Key - JUMP TO B 

The JUMP TO B key is used to reposition the sequence in the main playback blindly to continue from 
a different sequence step. 

• [#] [JUMP TO B] - Enter the number of a preset or sequence step (depending on the settings 
for this function) and press JUMP TO B to move that item to the B field of the Main 
Playback.  

For more information see Main Playback - Transport Keys, Crossfade Settings. 

Keyboard equivalent: [SHIFT] & [/]  

Console Key - LAMP CONTROL 

The LAMP CONTROL key is used to activate the soft keys menu for lamp control functions. 

• [LAMP_CONTROL] - activates the soft key page. You can now press the lamp control keys, 
in Cobalt there is no need to hold Enable - in older hardware there is. 

For more information see Device Control - Lamp Control 

No keyboard equivalent 
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Console Key - LAST 

The LAST key is used to select the previous channel within the current channel selection. This is 
useful for adjusting single moving devices within a selection, and also for selecting a specific device 
as reference point for the Fan and Align functions. 

• [LAST] - Press LAST with more than one channel selected to activate Next/Last mode. Press 
SELECT ALL to exit. 

For more information see Device Control - Next & Last Mode. 

Keyboard equivalent: [L] 

Console Key - LEARN ALERT 

LEARN ALERT is a soft key in the TIMES >LEARN soft key menu of the console main display. It is 
used to activate Learn Alert mode in which alert times are auto-stored when a sequence is played 
back.  

• [LEARN ALERT] - toggles learn alert mode.  

For more information see Sequence Times - WFA Alert Times. 

There is no keyboard equivalent. 

Console Key - LEARN MACRO 

The LEARN MACRO soft key in the Misc soft key page, is used to record Macros. 

• [#] [Learn_Macro] - Starts recording a new macro, click with mouse in top right corner of the 
screen on "Recording Macro" to stop. 

For more information see Macros - Record & Playback. 

There is no keyboard equivalent 

Console Key - LEARN PROFILE 

LEARN PROFILE is a soft key in the TIMES soft key menu of the console main display. It is used 
to activate Learn Profile mode in which the actual fader movement is stored during a manual 
crossfade in the main playback.  

• [LEARN PROFILE] - activates learn profile mode. 

For more information see Sequences - Crossfade Profiles 
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There is no keyboard equivalent. 

Console Key - LEFT 

The Left key, in the big Cobalt only, is the left mouse key of the trackball. 

• [LEFT] - Activate a mouse click in cursor mode (red). 

For more information see Facepanel - Trackball. 

Keyboard equivalent: [Mouse left key] 

Console Key - LIVE 

The LIVE key is fundamental. It selects the Live tab and sets the channel control to the live output, 
through the A field of the Main Playback.  

• [LIVE] - Select the Live tab.  
• [LIVE] & [BLIND] - Move the channel levels from LIVE to BLIND.  
• [C/Alt] & [LIVE] - Bring all channel levels from Live (A) to zero.  
• [C/Alt] & [LIVE]  [LIVE] - First press of LIVE takes out A, second press takes out Masters. 

For more information see Live. 

Keyboard equivalent: [F2] 

Console Key - LOAD 

The LOAD key activates items in the Browser, like Groups, Palettes & Effects. This is an older 
function key and is only available on the frontpanel of the Congo Jr, Kid and Sr, however it can be set 
up in a Magic Sheet or on a master. All the organizer functions are available from the ORGANIZER 
key in other hardwares. See Organizer. 

• [LOAD] - Select an object in the Browser and press LOAD to activate. See 
Browser Functions  

• [LOAD] - Select an object in a list and open in the Organizer  
• [LOAD] & [SEQ] - Open Sequences in Organizer   
• [LOAD] & [PRESET] - Open Presets in Organizer   
• [LOAD] & [GROUP] - Open Groups in Organizer   
• [LOAD] & [FOCUS] - Open Focus Palettes in Organizer   
• [LOAD] & [COLOR] - Open Color Palettes in Organizer   
• [LOAD] & [BEAM] - Open Beam Palettes in Organizer   
• [LOAD] & [PALETTE] - Open All Palettes in Organizer  

For more information see Browser Functions and Organizer. 
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Keyboard equivalent: None 

Console Key - LOCAL MENU 

The LOCAL MENU key is used to open the Local Menu for the currently selected area/object on the 
screens. 

• [LOCAL_MENU] - opens the Local Menu for the currently selected area/object on the 
screens..   

• [LOCAL_MENU] &  [TOUCH] - opens the Local Menu for that area on screen.  

For more information see Context Menus 

Keyboard equivalent: [LOCAL MENU] (sometimes a symbol) 

Console Key - LOCK 

The LOCK key is used to lock the console frontpanel, so no key input will work.  

• [LOCK] - Opens the Lock dialog.  
• SETUP & [LOCK] to setup PIN  
• ESC & C/ALT locks older Congo consoles 

For more information see Lock Console. 

Keyboard equivalent: None 

Console Key - MACRO 

The MACRO key in the MISC soft key page is used to activate macros. 

• [#] [MACRO] - Enter the number of a macro and press MACRO to activate. 

For more information see Macro List. 

There is no keyboard equivalent. 

Console Key - MARK 

MARK is a soft key in the CHANNELS menu of the console main display. It is used to set a "mark" 
level (less than 1%) to the selected device(s) to enforce a move command without having intensities. 

• [MARK] - Sets a mark intensity level to the selected device(s).  
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For more information see Active Mode & Mark. 

There is no keyboard equivalent. 

Console Key - MASK 

The MASK key is used in combination with other keys to toggle the mask functions that mask device 
parameters from recording.  

• [MASK] - Activate the mask.  
• [MASK] & [FOCUS, COLOR, BEAM] - Toggle these parameter groups on/off.  
• [MASK] & [wheel parameter key] - Toggle this specific parameter on/off.  
• [MODIFY] & [MASK] - Open the Mask editor.  
• [RECORD] & [MASK] - Records the next free user mask 
• [#] [RECORD] & [MASK] - Records user mask #  
• [#] & [MASK] - Recalls the settings of Mask # to the global mask 
• [MASK] & [Master_key] - Assign global mask to a master.  

For more information see Device Control - Mask. 

Keyboard equivalent: [K] 

Console Key - MASTER 

The MASTER key is used to open the Master List editor where you can see and control the master 
fields.  

• [MASTER] - Open the Master view. When the Master view is open, you can enter a number 
and press MASTER to control that master with the level wheel.  

• [SETUP] & [MASTER] - Opens settings for this key.  
• [MODIFY] & [MASTER] - Opens the master list. 

For more information see Master View - Select And Set Levels. 

Keyboard equivalent: [ALT] & [M] 

Console Key - MASTER KEYS 

Every master has a master key that is used to load content to the master, and for some settings.  

• [#] [PRESET] & [master key] - Load this content to master #.  
• [#] [GROUP] & [master key] - Load this content to master #.  
• [#] [CHANNEL] & [master key] - Load this content to master #.  
• [#] [SEQ] & [master key] - Load this content to master #.  
• [#] [FOCUS] & [master key] - Load this content to master #.  
• [#] [COLOR] & [master key] - Load this content to master #.  
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• [#] [BEAM] & [master key] - Load this content to master #.  
• [#] [PALETTE] & [master key] - Load this content to master #.  
• [C/Alt] & [master key] - Clear the contents of that master (with the exception of console key 

functions).  
• [MODIFY] & [master key] - Open the master editor.  
• [SETUP] & [master key] - Opens the master settings.  
• [master key] - Select the channels in the group or preset loaded to that master. 

For more information see Master Playbacks - Load/Clear/Modify. 

Keyboard equivalent: [1]-[9] and [0] over the letter keys correspond to master keys 1-10 

Console Key - MASTER PAGE 

The MASTER PAGE key (Congo hardware only) is used to load a page of 20 masters to a master 
row. 

• [#] [MASTER PAGE ] - Load this page.  
• [C/Alt] & [MASTER PAGE] - Clear the masters. 

For more information see Master Pages. 

Keyboard equivalent: [M] (upper row) [CTRL] & [M] (lower row) 

Console Key - MINUS 

The MINUS key (-) is part of the channel select keys. It is used to subtract a channel from the current 
selection. It is also used for the Channel Check function. 

• [#] [-] - Deselect the channel,(if the console is set to operate in At Mode press MINUS and 
then enter the number).  

• [C/Alt] & [-] - Make a channel check to the previous channel with the current level.  
• Hold [-] & [master key] - Subtract the channels in that master from the current selection.  
• [#] [GROUP] & [-] - Subtract the channels in that Group from the current selection  
• [#] [PRESET] & [-] - Subtract the channels in that Preset from the current selection  

For more information see Select Channels. 

Keyboard equivalent: [CTRL] & [<] 

Console Key - MINUS PERCENT (-%) 

The MINUS PERCENT key (-%) is part of the channel level keys. It is used to subtract 5% (default) 
from the current selection. It is also used for setting a selection to zero in combination with the C/ALT 
key. 
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• [-%] - Subtract 5% from the current channel selection..  
• [#] [-%] - Select a channel and subtract 5%.  
• [C/Alt] & [-%] - Flash the current selection to 0%  (master content will not be affected).  
• [#] [.] & [-%] - Subtract that level from the current channel selection.  
• [SETUP] & [-%] - Change the default level. 

For more information see Set Channel levels. 

Keyboard equivalent: [CTRL] & [MINUS]  

Console Key - MODIFY 

The MODIFY key is central for a lot of functions. It is both the equivalent of an ENTER key and part 
of a syntax in combination with other keys. 

• [MODIFY] - Answer dialogues, activate choices, enter numbers, open lists, activate text 
input in text cells.  

• [MODIFY] & [PRESET] - Opens the Preset List.  
• [MODIFY] & [GROUP] - Opens the Group List.  
• [MODIFY] & [SEQ] - Opens the Sequences List.  
• [MODIFY] & [DYN EFFECT] - Opens the Effect List.  
• [MODIFY] & [FOCUS] - Opens the Focus Palette List.  
• [MODIFY] & [COLOR] - Opens the Color Palette List.  
• [MODIFY] & [BEAM] - Opens the Beam Palette List.  
• [MODIFY] & [PALETTE] - Opens the All Palette List.  
• [MODIFY] & [U1-U3] - Opens the Wheel Parameter Lists. 
• [MODIFY] & [PARK] - Opens the Park List. 
• [MODIFY] & [NOTE] - Opens the Notes List. 
• [MODIFY] & [master key] - Opens the Master Editor. 

This key is so fundamental it is described everywhere in this manual.  

Keyboard equivalent: [ENTER] 

Console Key - MODIFY SEQ 

The MODIFY SEQ key is a soft key in the MISC menu of the main display. It is used to toggle the 
Modify Sequence mode on or off (default). When Modify Sequence is on, you can advance the 
sequence in the main playback without triggering auto times or wait times and master links. 

• [MODIFY SEQ] - Toggle this mode on/off. 

For more information see Sequences - Build & Modify Modes. 

There is no keyboard equivalent  



Cobalt 8.1 - 20181029 

909 

 

Console Key - MUTE 

The MUTE key is used to inhibit the output of a Master Playback. 

• [MUTE] & [master key] - Temporarily mutes the output of that master playback.   

For more information see Mute & Solo - Mute. 

Keyboard equivalent: None 

Console Key - NEXT 

The NEXT key is used to select the next channel within the current channel selection. This is useful 
for adjusting single moving devices within a selection, and also for selecting a specific device as 
reference point for the Fan and Align functions. 

• [NEXT] - Press NEXT with more than one channel selected to activate Next/Last mode. 
Press SELECT ALL to exit. 

For more information see Device Control - Next & Last Mode. 

Keyboard equivalent: [N] 

Console Key - NOTE 

The NOTE key is used to set a note for the selected item in some lists and the Playback view. It can 
also be used to store favorites for the HELP system. 

• [NOTE] - Press NOTE in a list or the playback view to set a note to the selected item.  
• [NOTE] - Press NOTE in the help system to create a favorite.  
• [MODIFY] & [NOTE] - Opens the Notes list. 

For more information see Notes Editor. 

Keyboard equivalent: none 

Console Key - Numerical Keypad 

The numerical keypad is where numbers are input. This is also where you have the decimal point, and 
the C/ALT key (clear numerical entry). The C/ALT key is also a prefix key for clearing Playbacks, 
and for some console Macros. 

NOTE that in an alphanumerical keyboard, the number keys 1-9 and 0 over the keys are master keys, 
and cannot be used to enter numbers. In a notebook computer the numerical keypad is integrated into 
the alphanumerical keyboard, and you have to activate the NUM LOCK function to access it.  
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Keyboard equivalent: [Numerical keypad]  

Console Key - ON/FETCH 

The ON/FETCH key is used to set channels on at the last used level, and to fetch levels for intensities 
or attributes for the selected channels from any presets.  

• [ON/FETCH] - Set the last recorded level to the current channel selection.  
• [ON/FETCH]&[@LEVEL] - Revert (undo) changes to channel level.  
• [#] [ON/FETCH] -  Fetch the level from Preset # to the current channel selection.  
• [#] [ON/FETCH] & [ATTRIB] - fetch attribute information from Preset # to the current 

channel selection.  
• [#] [ON/FETCH] & [parameter key] - fetch attribute information from Preset # to the current 

channel selection.  

For more information see Presets - Fetch Intensities, Device Control - Fetch/Copy. 

Keyboard equivalent: [CTRL] & [+] 

Console Key - ORGANIZER 

The ORGANIZER key is used to open the Organizer editor. 

• [ORGANIZER] - opens the Organizer editor.  

For more information see Organizer (1 tab) 

Keyboard equivalent: [F6] 

Console Key - OUT 

The OUT key is used to set Out times to the sequence step in the A or B field of the Main Playback 
(depending on the Time Settings). 

• [#] [OUT] - Set an in time.  
• [#] [DELAY ] & [OUT] - Set a Delay Out time.  

For more information see Sequences - Times, Sequence Times - Set To A or B. 

Keyboard equivalent: [CTRL] & [U] 
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Console Key - OUTPUT 

The OUTPUT key is used to select outputs directly, regardless if they are patched or not. It will open 
the Output editor where it is possible to patch by channel or output. 

• [#] [OUTPUT] - Open the Output editor, and select that output. Use the level wheel to set a 
level.  

• [MODIFY] & [OUTPUT] - Open the Output editor with no output selected. 

For more information see Patch - Output Editor. 

Example: Patch by Output, Patch by Channel. 

Keyboard equivalent: [O] 

Console Key - PAGE 

The PAGE key in Cobalt is used to load a page of 20 masters to a master row.  

• [#] [PAGE ]  - Load this page to masters 1-20  
• [#] [PAGE ] & [Assign] - Load this page to the row of masters the assign key belongs to.  
• [C/Alt] & [PAGE] - Clear masters 1-20  
• [TAP] & [PAGE ] - Set a Master Page BPM.  
• [#] [TIME] & [PAGE ] - Set a Master Page Time.  

For more information see Master Pages. 

Keyboard equivalent: None 

Console Key - Page+ 

The PAGE+ key is used to load the next page of 20 masters to a master row. 

• [PAGE+] - Load the next page. 

For more information see Master Pages. 

There is no keyboard equivalent.  

Console Key - Page- 

The PAGE- key is used to load the previous page of 20 masters to a master row. 

• [PAGE-] - Load the previous page. 



Cobalt 8.1 - 20181029 

912 

 

For more information see Master Pages. 

There is no keyboard equivalent.  

Console Key - PAUSE 

The PAUSE key is used to pause an ongoing crossfade in the Main Playback. 

• [PAUSE] - Pauses the ongoing crossfade (intensities and attributes) in the main playback. 

For more information see Main Playback - Transport Keys. 

Keyboard equivalent: [CTRL] & [P] 

Console Key - PAUSE (in Master Playback) 

The PAUSE key is used to pause an ongoing crossfade in the Master Playback. 

• [PAUSE] - Pauses the ongoing crossfade in the connected master playback. 

For more information see Master Playback - Playback Keys. 

There is no keyboard equivalent 

Console Key - PALETTE (Alt P) 

The PALETTE key is used for recording and recalling All Palettes, containing information from all 
parameters in a device. 

• [RECORD] & [PALETTE] - Record the next free palette for the currently selected devices.  
• [#] [RECORD] & [PALETTE] - Record a new palette for the currently selected devices.  
• [#] [PALETTE] - Recall a recorded palette for the currently selected devices.  
• [MODIFY] & [PALETTE] - Open the All palette list.  
• Hold [PALETTE] - When PALETTE is held, all existing palettes 1-40 can be accessed from 

the direct select keys. 

For more information see Devices - Palettes, Record An All Palette, Device Palettes - Direct Mode. 

Keyboard equivalent: [ALT] & [P] 

Console Key - PARAMETER 

The PARAMETER key in the big Cobalt console is used to set the trackball to Parameter mode, 
controlling pan & tilt. 
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• [PARAMETER]  - Set the trackball to parameter mode. Trackball will be blue.  

For more information see Facepanel - Trackball. 

There is no keyboard equivalent 

Console Key - PARK 

The PARK key is used to park a channel or part of a channel.  

• [PARK] & [CHANNEL] - Parks intensity and attributes of the selected channel(s).   
• [PARK] & [@LEVEL] - Parks intensity of the selected channel(s).   
• [PARK] & [ATTRIB] - Parks attributes of the selected channel(s).   
• [PARK] & [FOCUS] - Parks focus attributes of the selected channel(s).   
• [PARK] & [COLOR] - Parks color attributes of the selected channel(s).   
• [PARK] & [BEAM] - Parks beam attributes of the selected channel(s).   
• [PARK] & [Wheel_Key] - Parks the attribute of the selected channel(s).   
• [MODIFY] & [PARK] - Opens the Park list 

For more information see Park - Parked values. 

Keyboard equivalent: None 

Console Key - PASTE 

 The PASTE key is used to paste information that has been copied or cut. Information that can be 
copied, cut and pasted is Text, Sequence Steps (Sequence List), Groups (Group List), Presets (Preset 
List), Device Templates (Device Template List) and Attributes in the Preset List. 

• [PASTE] - Paste the last copied or cut object. In the Preset List a numerical argument is 
needed first. 

For more information see Copy, Cut & Paste. 

Keyboard equivalent: [CTRL] & [V] 

Console Key - PLAYBACK 

The PLAYBACK key selects the Playback tab and sets the channel control to the live output, through 
the A field of the Main Playback.  

• [PLAYBACK] - Select the Playback tab.  
• [#] [SEQ ] & [PLAYBACK ] - Load a sequence to the Main Playback.  
• [MODIFY] & [PLAYBACK ] - Open the Sequence editor for the sequence in the Main 

Playback.  
• [C/Alt] & [PLAYBACK ] - Bring all channel levels from the Playback (A and B) to zero.  
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• [#] [PLAYBACK] - Open the Sequence editor for the sequence in the Main Playback at 
Preset/Step #.  

• [#] [MODIFY] [PLAYBACK] - Open the Sequence editor for the sequence in the Main 
Playback at Preset/Step #. 

For more information see Live. 

Keyboard equivalent: [X] 

Console Key - PLAYLIST 

The PLAYLIST key is used to activate the Playlist for the Main Playback.  

• [PLAYLIST] - toggles the Playlist on/off.   

For more information see Playlist. 

Keyboard equivalent: None 

Console Key - PLUS 

The PLUS key (+) is part of the channel select keys. It is used to add a channel to the current 
selection. It is also used for the Channel Check function. 

• [#] [+] - Add the channel to the current selection, (if the console is set to operate in At Mode 
press MINUS and then enter the number).  

• [C/Alt] & [+] - Make a channel check to the next channel with the current level.  
• Hold [+] & [master key] - Add the channels in that master from the current selection.  
• [#] [GROUP] & [+] - Add the channels in that Group from the current selection  
• [#] [PRESET] & [+] - Add the channels in that Preset from the current selection  

For more information see Select Channels. 

Keyboard equivalent: [CTRL] & [>] 

Console Key - PLUS PERCENT (+%) 

The PLUS PERCENT key (+%) is part of the channel level keys. It is used to add 5% (default) from 
the current selection. It is also used for setting a selection to full in combination with the C/ALT key. 

• [+%] - Add 5% from the current channel selection..  
• [#] [+%] - Select a channel and add 5%.  
• [C/Alt] & [+%] - Flash the current selection to 100% (master content will not be affected).  
• [#] [.] & [+%] - Add that level from the current channel selection.  
• [SETUP] & [+%] - Change the default level. 
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For more information see Set Channel levels. 

Keyboard equivalent: [CTRL] & [UP]  

Console Key - PRESET 

The PRESET key is used to store and recall channel levels and moving device attributes. Presets are 
fundamental building blocks and can be played back in masters, in sequences and randomly in the 
main playback using GOTO. Every Sequence Step uses a Preset to hold the level and attribute 
information for that step. The same Preset can be repeated any number of times in any playback or 
sequence. 

IMPORTANT: For moving devices there are different recording modes. All, Active or Changed. This 
will decide what is stored in a preset. Also, there is a difference between recording to the main 
playback and to a master.  

• [PRESET] - Open the Preset list.  
• [#] [PRESET] - Select the channels in Preset #.  
• [#] [PRESET] & [CHANNEL] - Select the channels and levels in Preset #.  
• [#] [PRESET] & [master key] - Load preset # to that master. 

For more information see Presets - Load To Playbacks. 

Keyboard equivalent: [P]  

Console Key - PRINT SCREEN 

The PRINT SCREEN Soft Key (Misc) is used to Print the selected Tab.  
•  [PRINT SCREEN] - Prints the selected tab to a jpg file in the Printout node of the Browser >Files 
>Print... >Printouts.   

For more information see Print. 

Keyboard equivalent: None 

Console Key - RANDOM 

The RANDOM key in the Selects Soft key page allows you to randomize the order of the channels 
within the current selection. 

• [RANDOM] & [SELECT_2nd] - Selects every 2nd random channel  
• [RANDOM] & [SELECT_3rd] - Selects every 3rd random channel  
• [RANDOM] & [SELECT_Nth - Selects every Nth random channel  

For more information see Channels - Random Select. 
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There is no keyboard equivalent. 

Console Key - RANGE  

Hold the RANGE key and select which part of the fader range 1-80 you want to control with the 
master playbacks, from the keys over and under the display.  

• [RANGE] (held) - allows you to select which bank from the fader range 1-80 yo wish to 
assig to the physcial faders.  

• [#] [RANGE] & [Master key] - assigns the range in which this master exists.   

For more information see Masters - Select Playback Range 

No keyboard equivalent 

Console Key - REM DIM  

The REM DIM key is part of the channel select and level keys. It is used to set all channels in the A 
field to zero except the current selection. It can be set to perform the BALANCE function as well 
which holds the cleared levels in a temporary memory bank. 

• [REM DIM] - Set all channels except the current selection to zero.  
• [SETUP] & [REM DIM] - Opens settings for this key. 

If set to Balance Mode:  
Press REM DIM to activate Balance mode and set all channels except the current selection to zero. 
Press REM DIM again to bring them back at their previous levels. 

For more information see Channels - Rem Dim, Channels - Balance Mode. 

There is no keyboard equivalent 

Console Key - RECORD  

The RECORD key is fundamental in that it is used for recording all types of data into Presets, Groups 
and Palettes.What is recorded depends on your Settings, where you are recording, and what your 
record target is. 

In Live: 

• [RECORD] - Opens the recording dialogue to record the current look on stage into the next 
free Preset.  

• [#] [RECORD] - Opens the recording dialogue to record the current look on stage into that 
Preset..  

• [RECORD] [ATTRIB] - Record all attributes for the currently selected channels to the Preset 
in the A field of the main playback.   
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• [#] [RECORD] & [ATTRIB] - Record all attributes for the currently selected channels to 
Preset #.   

• [RECORD] & [FOCUS, COLOR, BEAM or PALETTE] - Record the next free palette for 
the currently selected channels.   

• [#] [RECORD] & [FOCUS, COLOR, BEAM or PALETTE] - Record palette # for the 
currently selected channels.     

• [RECORD] & [CHANNEL] - Record all attributes and levels for the currently selected 
channels.  

• [#] [RECORD] & [CHANNEL] - Record all attributes and levels for the currently selected 
channels to Preset #. 

Anywhere: 

• [RECORD] & [master key] - Record all data for the currently selected channels to that 
master as the next free 800-Preset.  

• [#] [RECORD] & [master key] - Record all data for the currently selected channels to that 
master as Preset #.  

• [RECORD] & [GROUP] - Record the currently selected channels as the next free Group.  
• [#] [RECORD] & [GROUP] - Record the currently selected channels as Group #.  
• [SETUP] & [RECORD] - Opens the Record Settings dialogue.  
• [C/ALT] & [RECORD] - Sets the Record Target to the default Main Playback (7.3) 

  

For more information see Presets - Record, Device - Recording, Groups - Record, Device Palettes - 
Record. 

Keyboard equivalent: [R] 

Console Key - REFRESH 

The REFRESH key is used to refresh channels that have been manually adjusted since the last 
crossfade in the main playback back to the intensity and parameter values of the previous crossfade.  

• [REFRESH] - Refresh the content in A to the last crossfaded levels.  
• [REFRESH] & [@LEVEL] - Refresh intensities only.  
• [REFRESH] & [FOCUS, COLOR, BEAM] - Refresh these values only.  
• [REFRESH] & [ATTRIB] - Refresh all parameter values.  
• [REFRESH] & [CHANNEL] - Refresh all intensities and parameter values  
• [REFRESH] & [Parameter_Key] - Refresh that parameter value 
• [REFRESH] & [Master_Key] - Refresh all intensities and parameter values that are manually 

changed and not updated on that master in the currently loaded Preset or Sequence Step. 

For more information see Main Playback - Refresh Functions. 

Keyboard equivalent: [CTRL] & [Y] 
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Console Key - RELEASE 

The RELEASE key is used to release channels that have been Captured. Captured channels are 
indicated with a red background in the channel views.. 

• [RELEASE] - Release the currently selected channels.  
• [RELEASE] [RELEASE] - Release all captured channels.  

For more information see Channels - Capture Mode. 

Keyboard equivalent: [CTRL] & [R]  

Console Key - RIGHT (DispSel) 

The Right key, in the big Cobalt only, is the right mouse key of the trackball. 

• [RIGHT] - Activate a mouse right click in cursor mode (red). 

For more information see Facepanel - Trackball. 

Keyboard equivalent: [Mouse right key] 

Console Key - SAVE 

The SAVE key is used to save the current play. 

• [SAVE] - opens the save play dialog.  

For more information see Save & Save As... 

Keyboard equivalent: [BACKSPACE] & [R] and [Ctrl] & [S] 

Console Key - SAVE COPY 

The SAVE COPY key is used to save a copy of the current play to a USB memory stick or File 
Server.  

• [SAVE_COPY] - opens the save copy dialog.  

For more information see Save & Save As... 

No keyboard equivalent 
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Console Key - SCALE 

SCALE is a soft key in the CHANNELS menu of the console main display. It is used to scale 
the output level of the selected channel(s)  

• [SCALE] (held) - activates temporary scale mode.  
• [MODIFY] & [SCALE] - activates scale mode.  

For more information see Channels - Scale channel levels. 

There is no keyboard equivalent. 

Console Key - SELECT 

 The SELECT key is used to select more than one cell for editing in spreadsheet views. 

• [SELECT] & [down/right arrow keys] - Select multiple cells. 

For more information see Navigating - Lists. 

Keyboard equivalent: [SHIFT] 

Console Key - SELECT 2ND 

The SELECT 2ND key in the Selects Soft key page allows you select every 2nd channel within the 
current selection. 

• [SELECT_2nd] - Selects every 2nd channel  
• [RANDOM] & [SELECT_2nd] - Selects every 2nd random channel  

For more information see Shortcuts - Select Nth Functions. 

There is no keyboard equivalent. 

Console Key - SELECT 3RD 

The SELECT 3RD key in the Selects Soft key page allows you select every 3rd channel within the 
current selection. 

• [SELECT_3rd] - Selects every 3rd random channel  

For more information see Shortcuts - Select Nth Functions. 

There is no keyboard equivalent. 
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Console Key - SELECT ALL 

The SELECT ALL key is used to return to the current channel selection after using NEXT or LAST. 

• [SELECT ALL] - Reselects all channels after using NEXT or LAST. 

For more information see Device Control - Next & Last Mode. 

Keyboard equivalent: [F7], [CTRL] & [N] or [CTRL] & [L] 

Console Key - SELECT CHANGE 

The SELECT CHANGE key in the Select soft key page is used to select all device channels that have 
manually changed attributes other than intensity since the current Preset was loaded to the A field.. 

• [Select_Change] - Selects all changed device channels.  

For more information see Select - Change (softkey). 

Keyboard equivalent: None 

Console Key - SELECT NTH 

The SELECT NTH key in the Selects Soft key page allows you select every Nth channel within the 
current selection. 

• [#] [SELECT_NTH] - Selects every NTH random channel  

For more information see Channels - Select Functions. 

There is no keyboard equivalent. 

Console Key - SERIES 

The SERIES soft key in the EFFECTS soft key menu, is used to open the Series editor for Content 
effects.   

• [SERIES] - Opens the SERIES editor. 

For more information see Content Effects 

There is no keyboard equivalent 
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Console Key - SETUP 

The SETUP key is used to open the system settings summary tab, or in combination with keys to open 
the settings for that key. 

• [SETUP] - Open system settings.  
• Hold [SETUP] and press a key to open the settings for that key  

 
A 
ATTRIB 
B 
CHANNEL  
GO 
MASTER PAGE 
RECORD 
TIME 
PLAYBACK 

For more information see System Settings. 

Keyboard equivalent: [F11] 

Console Key - SET CHANGED 

SET CHANGED is a soft key in the DEVICE menu of the console main display. It is used together 
with the attribute record setting "Changed" to force the Set Changed flag on parameters that have not 
been changed, so they will be recorded. 

• [SET CHANGED] & [PALETTE] - Set all parameters for the selected channels to changed.  
• [SET CHANGED] & [FOCUS] - Set Focus parameters for the selected channels to changed.  
• [SET CHANGED] & [COLOR] - Set Colorparameters for the selected channels to changed.  
• [SET CHANGED] & [BEAM] - Set Beam parameters for the selected channels to changed.  
• [SET CHANGED] & [wheel parameter key] - Set this parameter for the selected channels to 

changed. 

For more information see Devices - Recording. 

There is no keyboard equivalent. 

Console Key - SEQ 

The SEQ key is used to load and administrate Sequences and Chases. 

• [SEQ] - Open the Sequences list.  
• [#] [SEQ] - Open that Sequence editor.  
• [#] [MODIFY] [SEQ] - Open that Sequence editor.  
• [#] [SEQ] [PLAYBACK] - Load Sequence # to the main playback.  
• [#] [SEQ] [master key] - Load Sequence # to the master.  
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For more information see Sequences - List, Sequences - Sequence List, Sequences - Load. 

Keyboard equivalent: [S] 

Console Key - SEQ + 

The SEQ + key is used to step to the next step in the sequence of the main playback, without using 
times. 

• [SEQ +] - Step to the next step.  

For more information see Main Playback - Transport Keys. 

Keyboard equivalent: [X] & [down arrow] 

Console Key - SEQ - 

The SEQ - key is used to step to the previous step in the sequence of the main playback, without using 
times. 

• [SEQ -] - Step to the previous step.  

For more information see Main Playback - Transport Keys. 

Keyboard equivalent: [X] & [up arrow] 

Console Key - >> (Master Playback) 

The >> key in the master playback is used to step to the next step in the connected sequence, without 
using times. 

• [>>] - Step to the next step.  

For more information see Main Playback - Transport Keys. 

There is no keyboard equivalent 

Console Key - << (Master Playback) 

The << key in the master playback is used to step to the previous step in the connected sequence, 
without using times. 

• [<<] - Step to the previous step.  
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For more information see Main Playback - Transport Keys. 

There is no keyboard equivalent 

Console Key - SOLO 

The SOLO key is used to solo the output of a playback, temporarily muting the rest.  

• [SOLO] & [PLAYBACK] - Toggles solo mode for the main playback.   
• [SOLO] & [MasterKey] - Toggles solo mode for a master playback.   

For more information see Mute & Solo - Solo. 

Keyboard equivalent: None 

Console Key - START 

The START key is used to start fades in any master playback. 

• [#] [START] - Fade master # to full.  
• [#] [START] & [master key] - Fade to this level.  
• [START] & [master key] - Fade this master to full or zero. 

For more information see Master Playbacks - Start Fades. 

There is no keyboard equivalent 

Console Key - SWAP 

Press the SWAP key to swap the top row with the lower row.  

• [SWAP] - swaps fader content and levels between the upper and lower row.  

For more information see Masters - Swap Upper/Lower. 

No keyboard equivalent 

Console Key - TAB 

The TAB key is a fundamental part of the Cobalt  navigation. All views are opened in tabs, and the tab 
key is used to select, move, organize and record these. 

• [TAB] - Step between all open tabs.  
• [#] [TAB] - Select this tab.  
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• [TAB] & [down arrow] - Split the screen vertically, press again to split horizontally. Hold 
TAB and press the up arrow to exit the split.  

• [TAB] & [right/left arrow] - Move the selected tab to the next screen.  
• [TAB] & [level wheel] - Resize the lower part of a spreadsheet view.  
• [SETUP] & [TAB] - Open a dialogue to park a tab so it can't be closed with ESC.  
• [C/Alt] & [TAB] - Reset all Tabs to default (Live and Playback). 

For more information see Navigating - Tabs. 

Keyboard equivalent: [TAB] 

Console Key - TAP 

The TAP key is used to set a tempo to an effect. 

• [TAP] & [master key] [master key] - Hold [TAP] and press a [master key] twice to set a 
tempo to a chase in that master. 

For more information see Master Playback - Playback Keys. 

There is no keyboard equivalent 

Console Key - TEXT 

The TEXT key is used to set text labels to items. 

• [TEXT] - Open the text input for the sequence step in the A field of the main playback.  
• [TEXT] & [master key] - Activate text input for the content for that master playback.   
• [TEXT] & [direct select key] - Activate text input for the content for that direct select key.  

For more information see Entering Texts. 

Keyboard equivalent: [ALT] & [T] 

Console Key - THRU 

The THRU key is used to select a range of channels, and in combination with other keys for additional 
channel functions. 

• [#] [CHANNEL] [#] [THRU] - Select all channels between # and #.  
 
NOTE 
If you are operating in At Mode the syntax is "ch  number - THRU - ch number". 

For more information see Select Channels. 
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Keyboard equivalent: [/] 

Console Key - TIME 

The TIME key is used to set In/Out times to the sequence step in the A or B field of the Main 
Playback (depending on the Time Settings). 

• [#] [TIME] - Set an In/Out time to the next fade in the main playback.  
• [#] [CHANNEL] & [TIME] - Set a channel time to the selected channel(s).  
• [#] [TIME] & [FOCUS] - Set a parameter time.  
• [#] [TIME] & [COLOR] - Set a parameter time.  
• [#] [TIME] & [BEAM] - Set a parameter time.  
• [#] [TIME] & [wheel parameter key] - Set a parameter time.  
• [MODIFY] & [TIME] - Open the Time Editor for the step in A or B of the main playback. 

Enter a number to open for a specific sequence step.  
• [TIME] & [A] - Forces the setting "Times to A"  
• [TIME] & [B] - Forces the setting "Times to B"  
• [#] [TIME] & [Master_Key] - Set an In time to a Preset in that master.  

For more information see Sequences - Times, Sequence Times - Set To A or B, Master Playbacks - 
Times, The Time Editor Popup. 

Keyboard equivalent: [T] 

Console Key - TRACK 

The TRACK key is used to open the Track list for the selected channel(s). It is used in combination 
with RECORD and UPDATE for track recording. 

• [TRACK] - Open the Track list for the selected channels. You can change the channel 
selection. Use FORMAT & FOCUS, COLOR, BEAM to open parameter columns.  

• [TRACK] & [GROUP] - Track the current selection in all Groups.  
• [TRACK] & [PRESET] - Track the current selection in all Presets.  
• [TRACK] & [SEQ] - Track the current selection in all Sequences.  
• [TRACK] & [PALETTE, FOCUS, COLOR, BEAM] - Track the current selection in all 

corresponding palettes.  
• TRACK] & [CHANNEL] - Track the current selection in the whole show. 

For more information see Track List . 

In the Browser and Organizer: 

• [TRACK] - Tracks the selected preset or palette in the Sequence loaded to the Main 
Playback.. 

For more information see Navigate - Browser and Organizer. 
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Keyboard equivalent: [F12]  

Console Key - TYPE 

The TYPE key is used to change type of data in the Direct Select key sections. 

• Hold [TYPE] - When this key is held, you can use the direct select keys to select a type 
(Group, Focus, Color, Beam, Auto Group, Screens, etc) for each section of direct select keys. 

For more information see Direct Select - Content. 

There is no keyboard equivalent. 

Console Key - U1-U3 

The U1-U3 soft keys in the EFFECTS soft key menu, and in the frontpanel of Cobalt, are used to 
select user parameters for the selected channels or effects.   

• [U1-U3] - Selects this parameter set.  
• [MODIFY] & [U1-U3] - Opens the parameter editor for U1-U3.  
• [C/Alt] & [FOCUS - COLOR - BEAM] - selects U1-U3 in Congo Jr. 

For more information see Device Control - U1-U2-U3 

There is no keyboard equivalent 

Console Key - UNPARK 

UNPARK is used to unpark a channel or part of a channel.  

• [UNPARK] & [CHANNEL] - Unparks intensity and attributes of the selected channel(s).   
• [UNPARK] & [@LEVEL] - Unparks intensity of the selected channel(s).   
• [UNPARK] & [ATTRIB] - Unparks attributes of the selected channel(s).   
• [UNPARK] & [FOCUS] - Unparks focus attributes of the selected channel(s).   
• [UNPARK] & [COLOR] - Unparks color attributes of the selected channel(s).   
• [UNPARK] & [BEAM] - Unparks beam attributes of the selected channel(s).   
• [UNPARK] & [Wheel_Key] - Unparks the attribute of the selected channel(s). 

For more information see Park- Un-parking values. 

Keyboard equivalent: None 
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Console Key - UPDATE 

The UPDATE key is used to quickly update Presets, Groups and Palettes without a numeric entry. 

• [UPDATE to open the update dialogue for the Preset loaded to the A field of the main 
playback.  

• [UPDATE] & [direct select key] - Update a Palette or Group.  
• [UPDATE] & [@LEVEL] - Open the intensity tracking dialogue.  
• [UPDATE] & [ATTRIB] - Open the attributes tracking dialogue. 

For more information see Presets - Update, Track - Track Editing. 

Keyboard equivalent: [U] 

Console Key - UPDATE PALETTE 

The UPDATE PALETTE key is used to quickly update all currently active palettes for the selected 
channel(s). 

• [UPDATE_PALETTE] - Updates all active palettes for the selected channel(s).  

For more information see Device Palettes - Update. 

Keyboard equivalent: None 

Console Key - WAIT 

The WAIT soft key in the Times soft key menu, is used to set Wait times to the sequence step in the A 
or B field of the Main Playback (depending on the Time Settings). 

• [#] [WAIT] - Set a Wait time. 

For more information see Sequences - Times, Sequence Times - Set To A or B, The Time Editor 
Popup. 

There is no keyboard equivalent 

Console Key - WIZARD 

The WIZARD key is used to activate the Wizard function (if appropriate) for the current editor.  

• See Channel Editor Wizard.  
• See Import Wizard.  
• See Patch Wizard.  
• See Scroller Item Wizard.  
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• See Text Wizard.  
• See Track To Wizard.  
• See Template Range Wizard.  

Keyboard equivalent: [W] 

Soft Key Menu - Channels 

The CHANNELS soft key, is used to open the Channels soft key page with channel tools. 

• [Channels] - Opens the Channels soft key page. 

For more information see Channels - Soft key page . 

There is no keyboard equivalent 

Soft Key Menu - Device 

The DEVICE soft key, is used to open the Device soft key page with device tools for control and 
editing. 

• [Device] - Opens the Device soft key page. 

For more information see Devices - Functions. 

There is no keyboard equivalent 

Soft Key Menu - Effect 

The EFFECT soft key, is used to open the Effect soft key page with tools for editing effects. 

• [Effect] - Opens the Effect soft key page. 

For more information see Effect Soft Key Page . 

There is no keyboard equivalent 

Soft Key Menu - Learn 

The LEARN soft key, is used to open the Learn soft key page with tools for learning times and fade 
profiles. 

• [Learn] - Opens the Learn soft key page. 
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For more information see The Times Soft Key Page. 

There is no keyboard equivalent 

Soft Key Menu - Misc 

The Misc soft key, is used to open the Miscellaneous soft key page. 

• [Misc] - Opens the Miscellaneous soft key page. 

For more information see Misc Soft Key Page. 

There is no keyboard equivalent 

Soft Key Menu - Select 

The SELECT soft key, is used to open the Select soft key page with tools for selecting a sub-set of 
channels from the current selection. 

• [Select] - Opens the Select soft key page. 

For more information see Select - Sub-selection Functions. 

There is no keyboard equivalent 

Soft Key Menu - Times 

The Times soft key, is used to open the Times soft key page. 

• [Times] - Opens the Times soft key page. 

For more information see Sequences - Times. 

There is no keyboard equivalent 

Soft Key Menu - Wheel Keys 

The wheel keys are used together with parameter control on the wheels. 

• [Wheel_Key] - toggles the parameter value 0/100% 
• [#] [Wheel_Key] - sets a value to the parameter 
• [Wheel_Key] & [Master_key] - assigns the parameter to the master key 

For more information see Moving Device Controls - Explanation. 
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There is no keyboard equivalent 

Console Key - FIND 

The FIND key is used to to open the SEARCH feature in a focuse Help Tab.  

[FIND] - Open free text search. 

For more information see This Manual - Using The Help System. 

There is no keyboard equivalent 
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Console Key Shortcuts 

This is a summary of all keys and shortcuts, organised by the type of 
function.  

This chapter contains the following sections 

• Shortcuts - Select Channels  
• Shortcuts - Channel Levels  
• Shortcuts - Channel Modes  
• Shortcuts - Select Nth Functions  
• Shortcuts - Channel Views  
• Shortcuts - Dynamics  
• Shortcuts - HELP  
• Shortcuts - Channels Only Mode  
• Shortcuts - General Editing Keys  
• Shortcuts - Navigation Keys  
• Shortcuts - Master Playbacks  
• Shortcuts - Masters & Channels  
• Shortcuts - Master Pages  
• Shortcuts - Devices To Home Position  
• Shortcuts - Device Attribute Editors  
• Shortcuts - Device Masking  
• Shortcuts - Device Palette Recording  
• Shortcuts - Device Palette Activating  
• Shortcuts - Device Palette Specials  
• Shortcuts - Device Palette Views  
• Shortcuts - Device Palettes In Masters  
• Shortcuts - Device Align & Fetch  
• Shortcuts - Patch & Outputs  
• Shortcuts - Main Display, General  
• Shortcuts - Times  
• Shortcuts - Track  
• Shortcuts - Presets  
• Shortcuts - Groups  
• Shortcuts - Live & blind  
• Shortcuts - Record Functions  
• Shortcuts - Update Functions  
• Shortcuts - Channel Text Wizard  
• Shortcuts - Main Playback  
• Shortcuts - Sequence Editor  
• Shortcuts - Direct Selects  
• Shortcuts - Notes 
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Shortcuts - Select Channels 

These are the keys and shortcuts for selecting channels. Some of them assume the Command Syntax is 
set to RPN - see Channels - Command Syntax.  

DESCRIPTION SYNTAX 

Select a channel [#] [CHANNEL] 

Add channel to the channel selection [#] [+]

Subtract channel from the channel selection [#] [-]

Select a range of channels [#] [THRU]

Step to the next channel [+]

Step to the previous channel [-]

Select all channels with a level in the Main Playback. [ALL]

Select all channels with a level in any Playback. [ALL] [ALL]

Deselect all channels [C/Alt] [C/Alt]

Invert the channel selection [INV_GROUP]

Invert the channel selection [C/Alt] & [THRU] 

Enter Next/Last mode for the next channel within the 
channel selection 

[NEXT]

Enter Next/Last mode for the previous channel within 
the channel selection 

[LAST]

Leaves Next/Last mode and focuses all selected 
channels 

[ALL_CHANNELS] 

Open the Channel Select wizard [WIZARD] & 

[CHANNEL] 

Set all channels in all playbacks to zero [C/Alt] & [LIVE] 

[LIVE] 
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Shortcuts - Channel Levels 

These are keys and shortcuts for setting levels to the currently selected channels. Some of them 
assume the Command Syntax is set to RPN - see Channels - Command Syntax. 

DESCRIPTION SYNTAX 

Set the selected channels to 70%, second press sets 
100% 

[@LEVEL]

Set a level to the selected channels  [#] [@LEVEL]

Clear and deselect the selected channels [C/Alt] & [@LEVEL] 

Set 100% [C/Alt] & [+%] 

Set 0% [C/Alt] & [-%] 

Increase the level of selected channels 5% [+%]

Decrease the level of selected channels 5% [-%]

Increase the level of channel # with 5% [#] [+%]

Decrease the level of channel # with 5% [#] [-%]

Increase the level of selected channels #% [#] [.] [+%]

Decrease the level of selected channels #% [#] [.] [-%]

Set level in internal resolution (0-255) [#] [.] & 

[@LEVEL] 

Fetch values to the selected channels from a preset [#] [ON/FETCH] 

Increase level in 1 bit steps [.] & [+%]

Decrease level in 1 bit steps [.] & [-%]

Set the last recorded level for the selected channel(s). [ON/FETCH]
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Shortcuts - Channel Modes 

Functions for checking, balancing & comparing channels. 

DESCRIPTION SYNTAX 

Compare* the light in the Channel Control with its recorded 
version 

[COMPARE]  

Compare* the light in the Channel Control with preset # [#] 

[COMPARE] 

Toggle Balance* mode on/off [BALANCE] 

Step with Check mode to the next channel [C/Alt] & [+] 

Step with Check mode to the previous channel [C/Alt] & [-] 

*COMPARE and BALANCE are soft keys in the Channels Soft Key Page of the Main Display of the 
console. BALANCE can be set instead of REM DIM in the console settings. See Channels - Compare 
Mode and Channels - Balance Mode. 

Shortcuts - Select Nth Functions 

Functions for selecting every Nth channels from the current channel selection. All these functions 
are Soft Keys in the Channels - Random Select Soft Key Page of the Main Display in the console. 

DESCRIPTION SYNTAX 

Select the SELECT Soft Key Page in the Main 
Display 

[SELECT]

Select every # nth channel  [#] [Select_Nth]

Select every 2nd channel  [Select_2nd]

Select every 3rd channel  [Select_3rd]

Select every 2nd channel randomly  [RANDOM] & 

[Select_2nd] 

Select every 3rd channel randomly  [RANDOM] & 

[Select_3rd] 

Select every Nth channel randomly  [RANDOM] & 

[Select_Nth] 

Select devices that have changed. [SELECT_CHANGE]
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Shortcuts - Channel Views 

These shortcuts control the channel views.  

DESCRIPTION SYNTAX 

Scroll in the active channel view [CHANNEL] & [Arrow_Keys]

Scroll in the active channel view [CHANNEL] & Wheel

Toggles Channel View formats. [FORMAT]

Selects Channel Layout #. [#] [FORMAT]

Zooms the Channel View. [FORMAT] & Wheel

Show temporary Captured format. [FORMAT] & [CAPTURE]

Show temporary Parked format. [FORMAT] & [PARK]

Select All Channels format. [FORMAT] & [ALL]

Select non-zero channel format [FORMAT] & [CHANNEL]

Shortcuts - HELP 

These are the keys and shortcuts used for the online HELP function. 

DESCRIPTION SYNTAX 

Open the help index. If a menu or editor is open it will open 
help for that. 

[?]

Opens help for that key [?] & 

[Any_Key] 

Open the free text Search Function [TEXT]

Navigating in the help pages 

DESCRIPTION SYNTAX 

Next page [Down_Arrow]

Page before this page [Up_Arrow]

Last visited page [Left_Arrow]

Previously visited page [Right_Arrow]
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Creating a Favourite 

DESCRIPTION SYNTAX 

Create a Favourite from a HELP tab [NOTE]

Delete a Favourite from the Browser [DELETE]

Shortcuts - Channels Only Mode 

Channels Only Mode is activated by the three position Fader Mode switch in the top middle of the 
console. It turns the console into a single field manual desk.  

DESCRIPTION SYNTAX 

Switch Direct Ch mode on/off. Fader Mode Switch 

Select a channel range for the manual 
faders 

The master keys over and under the 
displays. 
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Shortcuts - General Editing Keys 

These keys are central in the general editing functions of the console. They are mostly used in 
combination with the navigation keys. 

DESCRIPTION SYNTAX 

Closes popups and tabs without executing.  [ESC] 

Clears numerical input, and is used in combination with other keys as 
an ALT key. 

[C/Alt] 

Works as an ENTER key for popups and in spreadsheet cells. Is used 
in combination with a lot of keys to open editors. 

[MODIFY] 

Shortcuts - Spreadsheet Editing 

These functions are for editing in Spreadsheets. 

DESCRIPTION SYNTAX 

The arrow keys are used to navigate in a spreadsheet or 
list, but also in combination with all the other navigation 
keys for different functions. 

Arrow Keys 

Will insert a new entry in most spreadsheet lists [INSERT]

Will insert the entry # in most spreadsheet lists [#] [INSERT] 

Will delete the focused entry in most window lists [DELETE]

Selects all items (down) in the column of a spreadsheet. [COLUMN]

Scrolls the size of a column. [COLUMN] & Wheel 

Sorts by the content of a column. [COLUMN] & 

[Up/Down_Arrow] 

Moves a column. [COLUMN] & 

[Left/Right_Arrow] 

Select cells to the right of the current cell [SELECT] & 

[Right__Arrow] 

Select cells below the current cell(s) [SELECT] & 

[Down_Arrow] 
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Shortcuts - Navigation Keys (8.0) 

The top four Navigation keys are central in the Navigating functions of the console. They are mostly 
used in combination with the General Editing keys. 

DESCRIPTION SYNTAX 

Opens the Browser. If the Browser is already 
focused, it will be closed. 

[BROWSER]

Toggles through all open tabs.  [TAB]

Focuses Tab #.  [#] [TAB]

Moves the focused tab to the next/last screen or split 
area. 

[TAB] & [Right_Arrow] 

Moves the focused tab to the next/last screen or split 
area. 

[TAB] & [Left_Arrow] 

Shortcuts - Master Playbacks 

These are the main keys and shortcuts for managing content in the Master Playbacks. See also 
Shortcuts - Recording Functions. 

Basic loading and clearing of content 

DESCRIPTION SYNTAX 

Load Preset # to a master [#] [PRESET] & [Master_Key] 

Load Sequence # to a master [#] [SEQ] & [Master_Key]

Load Group # to a master [#] [GROUP] & [Master_Key] 

Load Focus Palette # to a master [#] [FOCUS] & [Master_Key] 

Load Color Palette # to a master [#] [COLOR] & [Master_Key] 

Load Beam Palette # to a master [#] [BEAM] & [Master_Key] 

Load All Palette # to a master [#] [PALETTE] & [Master_Key] 

Load Dynamic Effect # to a master [#] [DYN_EFFECT] & [Master_Key] 

Load a Parameter to a master [Wheel_Key] & [Master_Key] 

Clear a master [C/Alt] & [Master_Key]

Clear all Master Levels [C/Alt] & [LIVE] [LIVE]

Set text to preset or group in a master field [TEXT] & [Master_Key]

Set a Time # to a Master with a Preset [#] [TIME] & [Master_Key] 
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Master control functions 

DESCRIPTION SYNTAX 

Activate the Master View* [MASTER]

Open the Master Editor. [MODIFY] & [Master_Key] 

Set an individual flash level (in flash mode) [#] [FLASH_MODE] & 

[Master_Key] 

Toggle a master on/off [START] & [Master_Key] 

Toggle master # on/off [#] [START]

Fade a master to a specific level [#] [START] & [Master_Key] 

Hold FLASH MODE and press master keys to 
toggle modes. Use PAGE +/- to select 
functions. 

[FLASH_MODE] & 

[Master_Key] 

Connect a master playback to the Master 
playback 

[CONNECT] & [Master_Key] 

Tap tempo for sequence on a master (hold tap 
and tap Master key). 

[TAP] & [Master_Key]

*You can also click on the Master View node in the Browser. 

Shortcuts - Masters & Channels 

Functions for selecting channels to and from Master Playbacks. 

DESCRIPTION SYNTAX 

Select the channels of a Preset/Group in a 
Master Playback. 

[Master_Key]

Add channels of a Preset/Group in a Master 
Playback to the channel selection 

[+] & [Master_Key]

Subtract channels of a Preset/Group in a Master 
Playback from the channel selection 

[-] & [Master_Key]

Select channels of a Preset/Group in a Master 
Playback which are active on stage 

[ALL] & [Master_Key]

Load the selected channels and levels one by 
one to Master Playbacks. 

[CHANNEL] & [Master_Key] 

Load the selected channels and levels as a 
group to a Master Playback. 

[GROUP] & [Master_Key] 
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Shortcuts - Master Pages (8.0) 

Main keys and shortcuts for handling Master Pages. Master pages are recorded/loaded separately for 
masters in banks of 20. The functions of the PAGE key are default routed to masters 1-20. 

DESCRIPTION SYNTAX 

Load a Master Page # to masters 1-20 [#] [PAGE]

Load a Master Page # to masters 21-40 [#] [PAGE] & [Master_key] 

Clear masters 1-20 [C/Alt] & [PAGE]

Record changes to current Master Page* [RECORD] & [PAGE]

Record master content to Master Page # [#] [RECORD] & [PAGE] 

Load next Master Page [PAGE] & [+]

Load previous Master Page [PAGE] & [-]

Tap tempo for a Master Page [TAP] & [PAGE]

Set a Master Page time [#] [TIME] & [PAGE]

Next Page [PAGE_+]

Previous Page [PAGE_-]

*This function is valid for all consoles except Cobalt 10/20/Programming Wing. It also depends on 
the Master Page Settings. See System Settings - Master. 
**It is also possible to hold DISPLAY LIST and press the Direct Select key Mast Page. 
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Shortcuts - Devices To Home Position 

Functions for recording & setting Home positions to the selected Devices. 

DESCRIPTION SYNTAX 

Set Home All  [HOME_ATTRIB] 

[HOME_ATTRIB]  

Set Home All (shortcut) [C/Alt] & [ATTRIBUTE] 

Set Home Focus [HOME_ATTRIB] & 

[FOCUS] 

Set Home Color [HOME_ATTRIB] & 

[COLOR] 

Set Home Beam [HOME_ATTRIB] & 

[BEAM] 

Set Home Focus [0] [FOCUS]

Set Home Color [0] [COLOR]

Set Home Beam [0] [BEAM]

Set Home All [0] [PALETTE]

Set Home to a Parameter [HOME_ATTRIB] & 

[Wheel_Key] 

Record current attribute values as the home position 
for the selected channels 

[RECORD] & 

[HOME_ATTRIB] 

Shortcuts - Device Attribute Editors 

Keys and shortcuts for opening Attribute Editors for Devices. 

DESCRIPTION SYNTAX 

Open Live Attribute Editor for the selected tab [ATTRIB]

Open Attribute Editor for the Preset in field A [ATTRIB] & [A]

Open Attribute Editor for the Preset in field A [PRESET] & [ATTRIB] 

Open Attribute Editor for the Preset in field B [ATTRIB] & [B]

Open Attribute Editor for a Preset on a Master [ATTRIB] & [Master_Key] 

Open Attribute Editor for Preset # [#] [PRESET] & [ATTRIB] 
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Formats 
Keys and shortcuts for toggling information on/off in the Attribute Editors 

DESCRIPTION SYNTAX 

Toggle Focus information [FORMAT] & [FOCUS]

Toggle Color information [FORMAT] & [COLOR]

Toggle Beam information [FORMAT] & [BEAM]

Toggle Time information [FORMAT] & up/down_arrows

Toggle Single Parameter  [FORMAT] & wheel_key

Zoom [FORMAT] & wheel

Shortcuts - Device Masking 

Keys and shortcuts for masking Device Attributes from recording. 

DESCRIPTION SYNTAX 

Clear global Mask [C/Alt] & [MASK]

Toggle global Mask on/off [MASK]

Toggle Focus parameters in global Mask [MASK] & [FOCUS]

Toggle Color parameters in global Mask [MASK] & [COLOR]

Toggle Beam parameters in global Mask [MASK] & [BEAM]

Toggle single parameter in global Mask [MASK] & [Wheel_Key] 

Open the Mask Editor tab [MODIFY] & [MASK]

Save the current mask to a Direct Select [RECORD] & [Direct_Sel] 

Recall a mask setting from a Direct Select [Direct_Sel]

Record the current mask to a master [MASK] & [Master_Key] 
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Shortcuts - Device Palette Recording 

Keys and shortcuts for handling Device Palettes. 

DESCRIPTION SYNTAX 

Record selected Devices to the first free Focus 
Palette 

[RECORD] & [FOCUS] 

Record selected Devices to the first free Color 
Palette 

[RECORD] & [COLOR] 

Record selected Devices to the first free Beam 
Palette 

[RECORD] & [BEAM] 

Record selected Devices to the first free All 
Palette 

[RECORD] & [PALETTE] 

Record selected Devices to Focus Palette # [#] [RECORD] & [FOCUS] 

Record selected Devices to Color Palette # [#] [RECORD] & [COLOR] 

Record selected Devices to Beam Palette # [#] [RECORD] & [BEAM] 

Record selected Devices to All Palette # [#] [RECORD] & 

[PALETTE] 

Record Palette # from the Direct Selects [RECORD] & [direct_select] 
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Shortcuts - Device Palette Activating 

Keys and shortcuts for activating values in Device Palettes for the currently selected device(s). 

DESCRIPTION SYNTAX 

Activate values from a Focus palette [#] [FOCUS]

Activate values from a Color palette [#] [COLOR]

Activate values from a Beam palette [#] [BEAM]

Activate values from an All palette [#] [PALETTE]

Activate a single parameter from a Focus 
palette 

[#] [FOCUS] & [Wheel_Key] 

Activate a single parameter from a Color 
palette 

[#] [COLOR] & [Wheel_Key] 

Activate a single parameter from a Beam 
palette 

[#] [BEAM] & [Wheel_Key] 

Activate a single parameter from an All palette [#] [PALETTE] & 

[Wheel_Key] 

Activate a Palette from a Direct select [Direct_Select_Key]

Activate a Palette from a Direct select on time 
# 

[#] [Direct_Select_Key]

Activate a Palette from a Master [Master_Key]

Activate a Palette from a Master on time # [#] [Master_Key]

Shortcuts - Device Palette Updating 

Keys and shortcuts for updating Device Palettes. Some of these keys are softkeys in the Device soft 
key page of the Main Display.  

DESCRIPTION SYNTAX 

Toggle Focusing mode on/off (soft key) [FOCUSING_MODE] 

Select Palette in Display List [Right__Click] 

Step to the next channel in palette selection [NEXT]

Step to the previous channel in palette selection [LAST]

Update the current palettes for the selected channel(s) (soft 
key) 

[UPDATE_PAL] 

Toggle Highlight mode on/off [HIGHLIGHT] 
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Shortcuts - Device Palette Specials 

Keys and shortcuts for special Device Palette functions. 

DESCRIPTION SYNTAX 

Select channels recorded in a Focus palette [#] [CHANNEL] & [FOCUS] 

Select channels recorded in a Color palette [#] [CHANNEL] & [COLOR] 

Select channels recorded in a Beam palette [#] [CHANNEL] & [BEAM] 

Select channels recorded in an All palette [#] [CHANNEL] & [PALETTE] 

Direct Select mode for Focus Palettes  
(as long as the key is held) 

[FOCUS]

Direct Select mode for Color Palettes  
(as long as the key is held) 

[COLOR]

Direct Select mode for Beam Palettes  
(as long as the key is held) 

[BEAM]

Direct Select mode for All Palettes  
(as long as the key is held) 

[PALETTE]

Shortcuts - Device Palette Views (8.0) 

Keys and shortcuts for Device Palettes views and lists. 

DESCRIPTION SYNTAX 

Open the Focus Palette Editor  [MODIFY] & [FOCUS]

Open the Color Palette Editor  [MODIFY] & [COLOR]

Open the Beam Palette Editor  [MODIFY] & [BEAM]

Open the All Palette Editor  [MODIFY] & [PALETTE]
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Shortcuts - Device Palettes In Masters 

Keys and shortcuts for handling Device Palettes in Master Playbacks. 

DESCRIPTION SYNTAX 

Load a Focus palette to a master* [#] [FOCUS] & [Master_Key]

Load a Color palette to a master* [#] [COLOR] & [Master_Key]

Load a Beam palette to a master* [#] [BEAM] & [Master_Key]

Load an All palette to a master* [#] [PALETTE] & [Master_Key] 

*If you keep the Palette key pressed and continue pressing Master keys, you will continue loading the 
next recorded Palette of each kind to the following Masters. 

Shortcuts - Device Align & Fetch 

Functions for aligning & fetching values for the selected Devices. Align uses the first selected Device, 
or the Device focused with NEXT/LAST as the argument. 

DESCRIPTION SYNTAX 

Align parameters for Focus [ALIGN] & [FOCUS]

Align parameters for Color [ALIGN] & [COLOR]

Align parameters for Beam [ALIGN] & [BEAM]

Align a single Parameter [ALIGN] & [Wheel_Key]

Fetch Focus values from a preset [#] [ON/FETCH] & [FOCUS]

Fetch Color values from a preset [#] [ON/FETCH] & [COLOR] 

Fetch Beam values from a preset [#] [ON/FETCH] & [BEAM]

Fetch Parameter values from a preset [#] [ON/FETCH] & [Wheel_Key] 

Fetch all attributes from a preset [#] [ON/FETCH] & [ATTRIB] 
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Shortcuts - Patch & Outputs 

Keys and shortcuts for patch and output functions. 

Select outputs and open Patch lists 

DESCRIPTION SYNTAX 

Select an output for temporary direct control - opening 
the Output Editor. 

[#] [OUTPUT]

Add an output to the current selection [#] [OUTPUT] [+] 

Subtract an output from the current selection [#] [OUTPUT] [-] 

Add an Output range to the current selection [#] [OUTPUT] [THRU] 

Open the Channel List  [MODIFY] & 

[CHANNEL] 

Open the Device List  [MODIFY] & [DEVICE] 

Open the Output Editor [MODIFY] & [OUTPUT] 

Toggle level information the Output Editor [FORMAT] & Up-Down 

arrows 

Patching in the Output Editor 
It is possible to patch multiple outputs and channels directly in the Output Editor (only in default 
Cobalt Commans syntax, RPN, mode). 

DESCRIPTION SYNTAX 

Patch output # to channel # [#] [OUTPUT] [#] [MODIFY]

Patch outputs # - # to, or from, 
channel # (popup) 

[#] [OUTPUT] [#] [THRU] [#] 

[MODIFY] 

Patch outputs consecutively to 
channels # - # from output # 
(popup) 

[#] [CHANNEL] [#] [THRU] [#] 

[MODIFY] 
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Shortcuts - Track 

Track is applied to the current channel selection. See Select Channels. 

DESCRIPTION  SYNTAX 

Track in the Sequence of the Main Playback. [TRACK]

Track in all Sequences [TRACK] & [SEQ]

Track in the Sequence of a Master Playback. [TRACK] & [Master_Key] 

Track in Presets. [TRACK] & [PRESET] 

Track in Groups. [TRACK] & [GROUP] 

Track in Focus Palettes. [TRACK] & [FOCUS] 

Track in Color Palettes. [TRACK] & [COLOR] 

Track in Beam Palettes. [TRACK] & [BEAM]

Track in All Palettes. [TRACK] & [PALETTE] 

Track in All Play Data. [TRACK] & [CHANNEL] 

Track Preset and Palette in Main Playback 
In the Browser and Organizer you can track the selected preset or palette in the sequence loaded to the 
Main Playback. 

DESCRIPTION SYNTAX 

Track selected preset or palette [TRACK]       

Formats 
Keys and shortcuts for toggling information on/off in the Track lists with attributes. 

DESCRIPTION SYNTAX 

Toggle Focus information [FORMAT] & [FOCUS]

Toggle Color information [FORMAT] & [COLOR]

Toggle Beam information [FORMAT] & [BEAM]

Toggle Parameter information [FORMAT] & [Wheel_Key]

Toggle Intensity information [FORMAT] & [@LEVEL]
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Shortcuts - Presets 

Presets can be loaded and recorded in many ways. There are shortcuts also for selecting all channels in 
a Preset, or fetching the levels. 

DESCRIPTION SYNTAX 

Record a Preset in a Channel View [RECORD]

Record a Preset directly to a Master Playback [RECORD] & [Master_Key] 

Select all channels in Preset # [#] [PRESET]

Fetch levels from a Preset # for the selected 
channels 

[#] [ON/FETCH]

Add channels from Preset # [#] [PRESET] & [+] 

Subtract channels from Preset # [#] [PRESET] & [-] 

Add a range of Presets until Preset # [#] [PRESET] & [THRU] 

Levels from Preset # are fetched [#] [PRESET] & [@LEVEL] 

Bring Preset in proportionately on the wheel  [#] [PRESET] & Wheel 

Load Preset # to LIVE, clearing all previous 
light 

[#] [PRESET] & [LIVE] 

Add Preset  # to BLIND [#] [PRESET] & [BLIND] 

Load Preset # to a Master Playback  [#] [PRESET] & 

[Master_Key] 

Open the Preset List [PRESET]

Open Preset List focused at Preset # [#] [MODIFY] & [PRESET] 
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Shortcuts - Groups 

Groups can be loaded and recorded in many ways. There are shortcuts also for selecting all channels 
in a Group, or fetching the levels. See also Shortcuts - Recording Functions. 

DESCRIPTION SYNTAX 

Record a Group in a Channel View [#] [GROUP] & [RECORD] 

Select all channels in a Group [#] [GROUP]

Fetch levels from a Group [#] [ON/FETCH] & [GROUP] 

Add channels from Group [#] [GROUP] & [+]

Subtract channels from Group [#] [GROUP] & [-]

Add a range of Groups [#] [GROUP] & [THRU] 

Levels from Group are fetched [#] [GROUP] & [@LEVEL] 

Load selection to master [GROUP] & [Master_Key] 

Bring Group in proportionately on the wheel  [#] [GROUP] & Wheel

Add  Group # to LIVE [#] [GROUP] & [LIVE]

Add Group # to BLIND [#] [GROUP] & [BLIND] 

Load Group # to a Master Playback  [#] [GROUP] & [Master_Key] 

Open the Group List [GROUP]

Temporary Direct Select mode [GROUP] held down

Open Group List focused at Group # [#] [MODIFY] & [GROUP] 
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Shortcuts - Live & Blind 

These are keys and shortcuts for loading and clearing the content of Live and Blind.  

DESCRIPTION SYNTAX 

Sets the Channel Control to the A field of the Main 
Playback, and focuses the Live tab. 

[LIVE]

Sets the Channel Control to the Blind field and focuses the 
Blind Tab. 

[BLIND]

Clear all channels and levels in Live [C/Alt] & 

[CHANNEL] 

Clear all channels and levels in Live [C/Alt] & [LIVE] 

Clear all channels and levels in Blind [C/Alt] & [BLIND] 

Copy Live to Blind [LIVE] & [BLIND] 

Copy Blind to Live  [BLIND] & [LIVE] 

Load Preset # in Live  [#] [PRESET] & 

[LIVE] 

Add Preset # to Blind  [#] [PRESET] & 

[BLIND] 

Add Group # to Live  [#] [GROUP] & 

[LIVE] 

Add Group # to Blind [#] [GROUP] & 

[BLIND] 

Adds the content of the Blind field to the total output.  [BLIND] & Wheel 
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Shortcuts - Record Functions 

These are shortcuts for recording Presets, Groups and master pages. 

DESCRIPTION SYNTAX 

Record the next free preset in a Channel View [RECORD]

Record the preset # in a Channel View [#] [RECORD]

Record current channel selection to a Master [RECORD] & 

[Master_Key] 

Record current Master Page content to a different 
Master Page 

[#] [RECORD] & 

[PAGE] 

Record all attributes in this Preset for the selected 
channel(s) 

[RECORD] & [ATTRIB] 

Record attributes for selected channels to Preset # [#] [RECORD] & 

[ATTRIB] 

Record current channel selection as the next 
free Group 

[RECORD] & [GROUP] 

Record current channel selection as Group #  [#] [RECORD] & 

[GROUP] 

Record only Captured channels to Preset #  [#] [RECORD] & 

[CAPTURE] 

Shortcuts - Update Functions 

These are shortcuts for updating Presets. 

DESCRIPTION SYNTAX 

Update changes in the Preset loaded to this 
Channel View 

[UPDATE]

Update Palette # in a Direct Select [UPDATE] & 

[Direct_Select__Key] 

Update level changes tracking [UPDATE] & [@LEVEL] 

Update attributes at source [UPDATE] & [ATTRIB] 
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Shortcuts - Channel Text Wizard 

This is the shortcut for opening the Channel Text Wizard that sets texts to the Channel Database 
directly from a Channel View. 

DESCRIPTION SYNTAX 

Open the Channel Text Wizard for the current channel 
selection. 

[CHANNEL] & 

[TEXT] 

Shortcuts - Main Playback 

These are shortcuts for the Sequence in the Main Playback. 

DESCRIPTION SYNTAX 

Load/Create Sequence # [#] [SEQ] & 

[PLAYBACK] 

Load Preset # to A [#] [PRESET] & [A] 

Load Preset # to B [#] [PRESET] & [B] 

Focus the Main Playback TAB and connect the 
Channel Control to Live  

[PLAYBACK]

Goto Preset #  [#] [GOTO] 

Goto Preset # in B [#] [JUMP_TO_B]  

Step to the next Preset in Sequence [SEQ+] 

Step to the previous Preset in Sequence [SEQ-] 

Start the next crossfade [GO] 

Start the next crossfade during an ongoing fade [GO] 

Insert a Master Link to the current Step [INSERT] &

[Master_Key]  

Insert a Master Link with Target # to the current Step [#] [INSERT] & 

[Master_Key]  

Open the Sequence List at the current step [MODIFY] [PLAYBACK]  

Open the Sequence List at step # [#] [MODIFY] 

[PLAYBACK]  

Refresh functions 
The Refresh Functions are used to reset any intensity or attribute that has been altered since the last 
crossfade in the Main Playback - back to where it would have been if the sequence had been run from 
the start. 
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DESCRIPTION SYNTAX 

Refresh all channels [REFRESH]

Refresh the intensity of selected channel(s) [REFRESH] & [@LEVEL] 

Refresh the attributes of all or selected channel(s) [REFRESH] & [ATTRIB] 

Refresh a parameter of all or selected channel(s) [REFRESH] & [Wheel_key] 

Refresh Focus Parameters of selected channel(s) [REFRESH] & [FOCUS] 

Refresh Color Parameters of selected channel(s) [REFRESH] & [COLOR] 

Refresh Beam Parameters of selected channel(s) [REFRESH] & [BEAM] 

Shortcuts - Sequence Editor 

These are shortcut in the Sequence List that will set times directly to the focused step 

DESCRIPTION SYNTAX 

Set an In/Out Time [#] [TIME]

Set an In Time [#] [IN]

Set an Out Time [#] [OUT]

Shortcuts - Direct Selects 

DESCRIPTION SYNTAX 

Select Type of content (hold key) [TYPE] & [Direct_Key]

Select Bank of content (hold key) [BANK] & [Direct_Key]

Record a Palette directly [RECORD] & [Direct_Key] 

Update a Palette directly [UPDATE] & [Direct_Key] 

Change User Setup User Setup key 1-5 

Record a Screen Setting [TAB] & [Direct_Key]

Activate a Palette in time # [#] [Direct_Key]

Select all channels in a Palette [CHANNEL] & [Direct_Key] 

Select all channels with an intensity over zero, 
that are set to a Palette 

[ALL] & [Direct_Key]
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Shortcuts - Notes 

You can set a Note directly to the current Sequence Step or the focused step in a spreadsheet. 

DESCRIPTION SYNTAX 

Create a Note for the current sequence step when in the Main 
Playback or Live tab 

[NOTE]

Create a Note for a focused item in a spreadsheet [NOTE]

Open the NOTE Editor directly [MODIFY] & 

[NOTE] 

Shortcuts - Capture & Release 

Functions for capturing & releasing channels. 

Capture functions 

DESCRIPTION SYNTAX 

Activate permanent Capture mode [CAPTURE]

Capture intensity and attributes for the selected channel 
in Capture mode 

Wheel

Capture intensity and attributes for the selected 
channel(s) 

[CAPTURE] & 

[CHANNEL] 

Capture the intensity of selected channel(s) [CAPTURE] & 

[@LEVEL] 

Capture the attributes of selected channel(s) [CAPTURE] & 

[ATTRIB] 

Capture a parameter of selected channel(s) [CAPTURE] & 

[Wheel_key] 

Capture Focus Parameters of selected channel(s) [CAPTURE] & 

[FOCUS] 

Capture Color Parameters of selected channel(s) [CAPTURE] & 

[COLOR] 

Capture Beam Parameters of selected channel(s) [CAPTURE] & [BEAM] 
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Release functions 

DESCRIPTION SYNTAX 

Releases the selected ch from Capture Mode [RELEASE]

Release all Captured channels [RELEASE] [RELEASE] 

Release all Captured in # seconds [#] [RELEASE]

Release intensity and attributes for the selected 
channel(s) 

[RELEASE] & 

[CHANNEL] 

Release the intensity of selected channel(s) [RELEASE] & [@LEVEL] 

Release the attributes of selected channel(s) [RELEASE] & [ATTRIB] 

Capture a parameter of selected channel(s) [RELEASE] & 

[Wheel_key] 

Release Focus Parameters of selected channel(s) [RELEASE] & [FOCUS] 

Release Color Parameters of selected channel(s) [RELEASE] & [COLOR] 

Release Beam Parameters of selected channel(s) [RELEASE] & [BEAM] 
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Shortcuts - Dynamics (old) 

These Dynamics functions can be used to start/stop and control older Dynamic Effects. Many of them 
are soft keys in the Dynamics Soft Key Page. See Dynamics - Control. 

Start and stop Dynamics 

DESCRIPTION SYNTAX 

Activate an Dynamic Template for the selected 
channels 

[#] [DYN_EFFECT]

Open the Live Dynamics List [DYN_EFFECT]

Select the DYNAMICS Soft Key Page in the Main 
Display (softkey) 

[DYNAMICS]

Activate the Dynamic Template or Dynamic Table 
list. 

[DISPLAY_LIST] & 

[DYN_EFFECT] 

Select all channels with a running dynamic 
(softkey) 

[SELECT_ALL]

Select all channels with a running dynamic [CHANNEL] & 

[DYN_EFFECT] 

Clear running dynamics for the selected channels 
(softkey) 

[CLEAR_SELECTED]

Clear running dynamics for the selected channels [C/Alt] & [DYN_EFFECT] 

Load a Dynamic Template to a master [#] [DYN_EFFECT] & 

[Master_key] 

Delete the selected Dynamic from the Live 
Dynamic Effect  Display List (softkey) 

[DELETE_DYNAM]

Delete all running Dynamics (softkey) [DELETE_ALL]

Delete all running Dynamics (softkey) [ALL] & [DELETE_DYNAM] 

Activate Direct Select for Dynamics (hold key for 
2secs to get display) 

[DYN_EFFECT]

Open the Dynamic Effect List [MODIFY] & 

[DYN_EFFECT] 
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Record and edit Dynamic Effects  

DESCRIPTION SYNTAX 

Record running Dynamics to the current Preset in 
A 

[RECORD] & [DYN_EFFECT] 

Record running Dynamics for the selected 
channels to Preset # 

[#] [RECORD] & 

[DYN_EFFECT] 

Fetch dynamics for the selected channels from a 
preset* 

[#] [ON/FETCH] & 

[DYN_EFFECT] 

Open the Dynamics Editor for the current preset [PRESET] & [DYN_EFFECT] 

Keep the Dynamics in the next Preset (softkey) [KEEP_DYNAM]

*Dynamics are always fetched for all channels in the target Preset, even if only one is selected. 
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Shortcuts - Times 

Keys and shortcuts for setting times. Times are set to the Active Sequence Step (in A) or the Next 
Sequence Step (in B) depending on the Time Settings. See System Settings - Crossfade. 

DESCRIPTION SYNTAX 

Set an In/Out time  [#] [TIME]

Set an In time [#] [IN]

Set an Out time [#] [OUT]

Set a Delay In time [#] [DELAY] & [IN]

Set a Delay Out time [#] [DELAY] & [OUT]

Set a Channel time  
(to the selected channels) 

[#] [CHANNEL] & [TIME]

Set a Parameter time [#] [TIME] & [Wheel_key]

Set a Channel Delay time  
(to the selected channels) 

[#] [CHANNEL] & [DELAY]

Set a FOCUS time [#] [TIME] & [FOCUS]

Set a COLOR time [#] [TIME] & [COLOR]

Set a BEAM time [#] [TIME] & [BEAM]

Set a FOCUS Delay time [#] [DELAY] & [FOCUS]

Set a COLOR Delay time [#] [DELAY] & [COLOR]

Set a BEAM Delay time [#] [DELAY] & [BEAM]

Set a Parameter delay time [#] [DELAY] & [Wheel_key]

Set an FCB time [#] [TIME] & [ATTRIB]

Set an FCB Delay time [#] [DELAY] & [ATTRIB]
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ACCESSORIES 
This Chapter is about accessories and options, such as remote control, 
networking, printer, fader wing panel, keyboard etc. 

This chapter contains the following sections  

• Accessories - Keyboard  
• Accessories - Mouse Or Trackball  
• Accessories - Printer  
• Accessories - Remote Control  
• Accessories - Visualisation Software  
• Accessories - Cobalt ETCnomad - Server & Client  
• Accessories - Cobalt Programming Wing  
• Accessories - Net3 Remote Video Interface  
• Accessories - X-keys  
• Accessories - Cobalt LS 
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Accessories - Keyboard 

An external keyboard will simulate most keys of the console. See the Console 
Functions Table below.  

This is simple to work with, since the keyboard works exactly like the console. For example pressing 
R is the same as pressing RECORD, and pressing 1 is the same as pressing Master key 1. 

WARNING 
Multi-media keyboards may have special keys, for example SLEEP - which 
puts CONGO - to sleep. Avoid using these keyboards, they will trigger 
functions that you most probably do NOT want.  

Keyboard - Numerical Input on a Notebook 

If you are running the offline editor in a notebook without a numerical keypad, you can access 
numbers and basic channel and level functions using CTRL.  

CTRL & 1-9 = Numerical input 
CTRL & F1 = CH 
CTRL & F2 = CH+ 
CTRL & F2 = CH- 
CTRL & F4 = THRU 
CTRL & F5 = LEVEL 
CTRL & F6 = ALL 

NOTE 
The CTRL & F-commands may not work in a Mac notebook, depending on 
the setup of F-keys.   

Keyboard - Standard Functions 

Standard keyboard functions available in all situations are: 

ESC = Escape, closes open tabs and exits dialogs. 
INSERT = Inserts data in all lists (in Mac computers use CTRL & DELETE) 
DELETE = Deletes data in all lists. 
NUMBERS (in the numeric keypad) = Numeric entries. 
HOME = Jumps to the first line of the list or editor. 
END = Jumps to the last line of the list or editor. 
ARROW KEYS = Arrow keys. 
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Console Keys in a Keyboard - Hotkeys (8.0) 

These are the keyboard equivalents of the console keys. If you are using an offline editor they allow 
you to access most of the functionality directly, as if you had a console.  

NOTE 
Mac Note, especially MacBook users: Apple offers many different keyboards 
on their products. On Macs with a CONTROL key, this key often takes the 
place of the key shown above. To use the keyboard shortcuts in the best 
possible way, an external expanded keyboard is required. On the MacBook 
this reduces the conflicts with the many features associated with the Function 
keys (F1-F12).  
 
The external keyboard will control Cobalt regardless of Exposé/Spaces 
settings while the internal keyboard will continue to perform special 
functions like brightness/volume/etc. Additionally, the expanded DELETE 
key (not Backspace) is required for the INSERT command in Cobalt and the 
numeric keypad is required for channel selection and level setting.  
 
If you are using a desktop or a laptop without an external keyboard, please 
adjust your Keyboard settings to use Function keys as normal function keys 
(not special functions) and use the Console Mimic tab. 
 
We recommend Apple-compatible keyboards with Apple symbols/layout and 
the expanded arrow/navigation keys and numeric keypad.   

Console Key  PC Equivalent Mac Equivalent 

- Ctrl Left Arrow or 
Keypad Ctrl * 

Keypad Cmd * 

+ Ctrl Right Arrow or 
Keypad * 

Keypad * 

-% Ctrl Down Arrow   

+% Ctrl Up Arrow   

A A  A 

ALIGN Ctrl A Ctrl A  

ALL Ctrl F6 Ctrl F6  

AT LEVEL Ctrl L or Keypad + Ctrl L or Keypad + 

ATTRIBUTE I I 

B B B 

BEAM (B) Alt B Option B 

BLIND F3 F3 

BROWSER F10 F10 

C/ALT Backspace Backspace 

CAPTURE C C 



Cobalt 8.1 - 20181029 

963 

 

Console Key  PC Equivalent Mac Equivalent 

CH Ctrl H or Keypad - Ctrl H or Keypad - 

COLOR (C) Alt C Option C 

COLUMN F9 F9 

COPY Ctrl C Ctrl C 

CUT Ctrl X Ctrl B 

DELAY Ctrl D Ctrl D 

DELETE DELETE DELETE (not 
backspace) 

DEVICE D D 

DISPLAY LIST J J 

EFFECT E E 

ESC ESC ESC 

EXIT Cobalt Alt X Option X 

FAN Ctrl F Ctrl F 

FOCUS (F) Alt F Option F 

FETCH/ON F or Keypad Ctrl + F or Keypad Ctrl + 

FORMAT F4 F4 

GO Ctrl G Ctrl G 

GO BACK Ctrl B Ctrl B 

GOTO G G 

GROUP F7 or Alt G Ctrl G 

HELP (?) F1 F1 

HIGHLIGHT Alt H Option H 

HOME ATTR  F5 F5 

IN Ctrl I Ctrl I 

IND 7 Ctrl F7 N/A 

IND 8 Ctrl F8 N/A 

IND 9 Ctrl F9 Ctrl F9 

INSERT INSERT Ctrl DELETE 

JUMP TO B N/A N/A 

LAST L L  

LIVE F2 F2 

LOAD F6 F6 
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Console Key  PC Equivalent Mac Equivalent 

MACRO Q Q 

MASK K K 

MASTER F8 F8 

Master Keys 1- 10 1-0 along top of 
keyboard 

1-0 along top of 
keyboard 

MODIFY ENTER RETURN 

MUTE Y Y 

NEXT N N 

NOTE Alt N Option N 

Number input Ctrl 1-0 or keypad Ctrl 1-0 or keypad 

OUT Ctrl O Ctrl O 

OUTPUT O O 

PAGE (M1-20) M M 

PAGE (M21-40) Ctrl M Ctrl M 

PALETTE Alt P Option P 

PARK P P 

PASTE Ctrl V Ctrl V 

PAUSE Ctrl P Ctrl P 

PLAYBACK X X 

PRESET P P 

RECORD R R 

REFRESH V V 

RELEASE Ctrl R Ctrl R 

SAVE Backspace U Backspace U 

SELECT Shift Shift 

SELECT ALL Ctrl N Ctrl N 

SEQ S S 

SEQ - X Up arrow X Up arrow 

SEQ + X Down arrow X Down arrow 

SETUP F11 F11 

START N/A N/A 

TAB TAB TAB 

TEXT Alt T Option T 
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Console Key  PC Equivalent Mac Equivalent 

THRU Ctrl T or Keypad / Ctrl T or Keypad / 

TIME T T 

TRACK F12 F12 

U1 N/A N/A 

U2 N/A N/A 

U3 N/A N/A 

UPDATE U U 

WIZARD W W 

Keyboard - Level Wheel 

You can use a mouse wheel (or right click held) to emulate the level wheel for setting levels and 
navigating. See Ext. Mouse Or Trackball. 

Keyboard - CH Step  

You can hold CTRL and use the left/right arrows to emulate CH+ and CH-. 
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Accessories - Mouse or Trackball 

You can use an external USB mouse or trackball in the same way as the built 
in trackball. Connect it to the USB port.  

Cobalt is designed to be used without a mouse as button pressing is faster and does not force you to 
look at the screen cursor. However, there are a lot of useful mouse functions for situations where you 
find it practical. For example, working in a workstation without a console facepanel, or while using an 
offline editor. 

Here is some of the mouse functionality: 

Function  Key Feedback 

All Views: 
Context Menu 

Right click Opens the context menu 

All Views: 
Drag and drop 

Left click, hold and 
drag 

Drags and drops content 

Channel Views: 
Select channels 

Left click Selects and deselects 
channels 

Channel Views: 
Set channel levels 

Mouse wheel Same as the Level wheel of 
Cobalt 

Channel Views: 
Set channel levels 

Right click and mouse Same as the Level wheel of 
Cobalt 

Browser: 
Open Browser objects 

Left doubleclick Opens the corresponding 
editor tab 

Spreadsheet Lists:  
Select a cell in a list for 
editing 

Left click Selects the cell for editing 

Spreadsheet Lists:  
Select a column 

Left click on column 
header 

Selects the whole column 

Spreadsheet Lists:  
Toggle sort order 

Double-click on 
column header  

Toggles sort order for the 
column 

Spreadsheet Lists:  
Resize column 

Left click, hold and 
drag column header 

Resizes column 

Playback views:   
Open editors. 

Right click or double 
click 

Opens the context menu to 
open the editor. Try doing 
this on a step, time, device 
link etc.  
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Accessories - Remote Control 

This system can connect optional remote controls for controlling channels 
and levels. Note that each remote control has its own working field. Also see 
Remote Controls. 

This chapter contains the following sections 

• Remote Control - Introduction  
• Remote Control - RFR Radio Remote   
• Remote Control - Phone Remote   
• Remote Control - iRFR  
• Remote Control - cRRFU Radio Remote 
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Remote Control - Introduction 
There are a number of options for remote controlling a Cobalt system. 

There are three main kinds of wireless remote controls.  

RFR  Phone Remote iRFR 

  

  

  

The RFR Radio/USB 
Remote is equipped with 
a display and bi-
directional 
communication. 

A wireless phone can be 
connected to the RJ11 
connector in the back and 
be used for basic remote 
functions. 

iRFR is a software for 
iPhone and iPod that 
provides bi-directional 
communication over a 
wireless LAN. 

 

NOTE 
To clear input from the Remote Fields go to the Clear Remote Fields node in 
the Remote Controls Node.  
See Remote Controls. 
 
Remote Control are enabled in the System Settings for remotes to work. 
There is a specific setting to enable recording from the Remotes. Both are ON 
by default. 
See System Settings - System.  

Remote Controls and at mode 

If your console is set to operate channels in at mode, the remote will also function in at mode. See 
System Settings - General and Channels - Command Syntax.  

HINTS 

• 100%/0%/+%/-% will now complete pending at mode operations.  
• C will abort pending two-digit level entries.  
• Decimal point will complete pending at mode operations without pressing @. 
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Remote Control - RFR Radio Remote 

The RFR Radio Remote provides bi-directional remote control with a 
hardware designed for stage environment. All of the RFR functions are the 
same for iRFR. 

 

The RFR works within its own field and this field can be cleared from the console. All channel 
intensity levels generated by the remote can only be recorded into targets from the remote control 
itself. 

Connecting the RFR 

It's possible to connect the RFR in the following ways to a Cobalt. 

• Directly with USB  
• To a base station connected with USB  
• To a base station connected with Net3, which requires ACN protocol to be turned on. 

Hold the decimal point when starting the RFR to get a choice of connection methods.  

Group and frequency can be changed if necessary or if you have multiple units. The HF (frequency) 
and Network ID (group) are changed in the remote from the remote menu, and in the base station from 
the system settings. See System Settings - RFR. 

RFR - General Functionality  

The upper display line shows information about the selected channel(s). The labels for the soft buttons 
are on the two lower rows of the display. In all displays the wheel controls the level of selected 
channels - except in the parameter controls display where the two encoders control the displayed two 
parameters (like pan/tilt, etc...) 
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Top Level 
Soft1-6 give direct access to basic channel functionality. Pressing MORE SK will always return to 
this level. Pressing MORE SK from the Top Level will show the other menus. 

All  100% Check+ 

Group  0% Check- 

In all displays, the wheel controls the level of the selected channel(s).  

RFR Channel functionality 

The most common channel functions can be used to select channels and set levels (At Mode 
Command Syntax is supported from v5.1). This includes the console shortcut C & CHANNEL to 
clear all channels in A.  

• CH  
• +  
• -  
• THRU  
• @LEVEL 

RFR Group List  

Press MORE SK and then GROUP to get a list of recorded Groups to select from. Use the wheel(s) to 
focus the item you want and click the wheel button to activate it. # GROUP selects the item directly 
without showing the list.  

Normally the wheel scrolls one step per click. If you hold the wheel button and scroll, it will step in 
complete pages instead for faster navigation. 
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Pressing MORE SK will display the other available display pages.  

Device Playback Patch 

Palette Focusing CalibScr 

RFR Devices  

Press MORE SK and then DEVICE to enter the Device sub menu. When you have selected the Device 
sub menu, pressing ParamF/ParamC/ParamB will select the parameter pages for the selected devices. 
Two parameters at a time will be displayed in the middle of the display and controlled by the two 
wheels. Press a wheel to toggle between coarse and fine for parameters.  

Last  SelAll Next  

ParamF ParamC ParamB 

Next, Last and Select All functions are used to step within the current selection, Select All will return 
to the original selection. 

ParamF, ParamC and ParamB keys are used like Focus, Color and Beam keys on the console. These 
will cycle thru the available parameter pages for the selected device(s). Use the wheels to adjust 
parameter values. Clicking the wheel will toggle coarse/fine mode on the wheels. Fine mode is 
indicated with a "-" symbol before the parameter value. 
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RFR Playback 

Playback 
Press MORE SK and then PLAYBACK to enter the Playback sub menu. The Playback functions are 

Go Goto  Record  

GoBack  Preset  Update  

Function  Key Feedback 

GO [Go] Next crossfade is started 

GO Back [GoBack] Crossfades back to the 
previous step 

Goto preset/step [#] [Goto] Crossfades to preset # or 
step # (depending on the  
GOTO jumps to setting in 
Setup) 

Record preset [#] [Record] Records Preset # into the 
Preset List. Only the levels 
set from the remote are 
recorded 

Update preset [Update] The selected preset 
(indicated as "Prs:#" on the 
display) is updated with 
levels from the remote field 

Select Preset and levels [#] [Preset] Levels from Preset # are 
loaded into the remote field 
and channels of Preset # are 
selected 

Select Preset and levels [Preset] Shows a list of Presets. Use 
encoder to focus a Preset 
and click the encoder to 
select Preset and load 
levels into the remote field. 

When recording or updating a preset a confirmation message is shown on the RFR display. 

To enable recording/updating from remote, check the setup option "Allow recording from remote" 
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RFR Patch 

Press MORE SK and then PATCH to enter the Patch sub menu.  

Output  Goto  Patch 

Universe  Preset  DvAddr 

The Patch functions are 

Function  Key Feedback 

Select channel [#] [Chan] Channel # is selected 

Select output [#] [Output] Output # is selected 

Select output universe [#] [Univ.] Universe # is selected 

Patch channel to output [#] [Chan] [#] 

[Patch] 

Channel # is patched to 
output # 

Patch output to channel [#] [Output] [#] 

[Patch] 

Output # is patched to 
channel # 

Re-patch a device [#] [Chan] [#] 

[DvAddr] 

Device on channel # is 
patched to output # 
 
Note: Existing devices may 
be repatched. No new 
devices may be patched 
from the RFR. 

• Outputs can be selected in address.universe format. For example [10.3] [Output] will select 
output 10 on universe 3.  

• Use the left wheel to jump to next output and the right wheel to set a level to the selected 
output.  

• Use a number and the @ button to set a channel or output level directly (instead of the right 
wheel).  

• Use +/- to step outputs as well as channels.  

RFR Palettes 

Press MORE SK and then PALETTE to enter the Palette sub menu.  

Focus Color Beam 

      

• The FCB buttons can be pressed without a number to present a palette list or with a number 
to select a palette directly.  
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• In the palette list, use one of the wheels to scroll and press the wheel to select the focused 
palette.  

• Entering 0 and selecting a palette type will home the values of this palette type. 

RFR Focus Mode  

Focus mode is intended for updating palettes, mainly Focus palettes.  
See Device Palettes - Focusing mode. 

Press MORE SK and then FOCUSING to enter focusing mode.  

Focus Color Beam 

    Update 

1. Select a palette from the FCB list buttons. This will enter channel/parameter mode.  
2. Use Next/Last/SelAll buttons to select channels. Use ParamFCB buttons to select the 

parameter. Use wheels to change.  
3. Press the Mode button to go back to palette select/update screen.  
4. Use Update to update the palette or select a new palette with the FCB palette list buttons.  
5. Press MORE SK will leave focusing mode. 

RFR Scroller Calibration  

Press MORE SK and then CALIBSCR to enter Scroller calibration mode. In Scroller Calibration you 
can calibrate each scroller roll individually, like on the console. Also see Scroller rolls. 

1. First, turn on the channels for which you wish to calibrate the scrollers, so you can see when 
the scroller is in full frame.  

2. When pressing CALIBSCR a list of channels with scrollers is shown. Select a channel to 
calibrate it's scroller.  

3. A list of the colors in the scroller is shown on the display. Use the left wheel to focus a color 
and use the right wheel to adjust the value so that the whole frame is shown. Changes are 
updated automatically (values are kept within the current frame).  

4. Use the MORE SK button to exit Scroller Calibration. 
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Remote Control - Phone Remote  

The Phone Remote option allows you to use a standard phone - without a 
phone line - to remote control channels and levels.  

 

Connect the base station of a standard wireless phone directly to get a low-level remote control 
solution. Activate the handset for an internal call (depends on the system how this is done) and use the 
numeric keypad to control channels and levels directly. 

Phone Remote - Functions 

The handset has two available commands for each key on the unit. Numbers are accessed directly. The 
*-key is used as Shift to access the functions. Press the *-key first (do not press and hold) and then 
press the function. The #-key when pressed once is decimal point and when pressed twice clears the 
number input. 

These are the basic functions you can access from the phone remote. 

 
  
In the table below # means a numbers input, while [#] equals the key # on the handset. 



Cobalt 8.1 - 20181029 

976 

 

Key  Function Feedback 

Select a channel # [SHIFT] 

[CHANNEL] 

Channel is selected 

Add channels # [SHIFT] [THRU] Channels are added to 
selection 

Select a group # [#] [SHIFT] 

[CHANNEL] 

Channels in Group # are 
selected 

Select All [SHIFT] [ALL] Selects all channels with a 
level that were set from the 
remote 

Set to Full [SHIFT] [100%] Levels for the selected 
channels are set to full 

Set to 0% [SHIFT] [0%] Levels for the selected 
channels are set to zero 

Set to level # # [SHIFT] [@LEVEL] Level # is set for selected 
channels 

Check mode [SHIFT] [CHECK+]

[SHIFT] [CHECK-] 

Steps to the Next/Last 
channel using level. 

Load levels from Preset # # [SHIFT] [PRESET] Levels from Preset # are 
loaded 

Clear number input [#] [#] Clears number input 

Decimal point [#] Decimal point 

GO [SHIFT] [Goto/Go] Next crossfade is started 

Goto preset/step # [SHIFT] [Goto/Go] Crossfades to preset # or 
step # (depending on the  
GOTO jumps to setting in 
Setup) 

Record preset # [SHIFT] [Record] Records Preset # into the 
Preset List. Only the levels 
set from the remote are 
recorded 

Examples 

 
Turn on channels 2 thru 5 at Full. 

[2] [SHIFT] [CHANNEL] [5] [SHIFT] [THRU] [SHIFT] [100%] 

Using the decimal point it is also possible to select and turn on channels recorded in groups. 

To set Group 1 at Full 
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[1] [#] [SHIFT] [CHANNEL] [SHIFT] [100%] 

If a console is set to work in At Mode, channel selection functions on the remote behave differently. 
For example: 

Set channels 1 thru 5 to 55% 

[1] [SHIFT] [THRU] [5] [SHIFT] [@Level] [5] [5] 

Set channels 1 thru 6 at full 

[1] [SHIFT] [THRU] [6] [SHIFT] [100%]  

Note: When recording from the remote, only levels set from the remote are recorded, not the whole 
stage output. 
  
Note: To enable recording from remote, check the setup option "Allow recording from remote" 
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Remote Control - iRFR 

The iRFR Remote option allows you to use an iPhone or an iPod Touch with 
a wireless network as a remote for Cobalt. 

  

The iRFR works within its own field and this field can be cleared from the console. All channel 
intensity levels generated by the remote can only be recorded into targets from the remote control 
itself. 

Requirements: iPhone or iPod touch and a wireless network.  
More information online:  
http://www.etcconnect.com/product.overview.aspx?ID=22011 

Using the iRFR 

This is how you launch the application. How to set up and configure the network is described below. 

At the Welcome screen, select Virtual RFR. 
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The functionality of iRFR is the same as RFR. See Remote Control RFR Radio Remote. 

Tip 1 
To turn the encoder wheels, simply drag with your finger.  To press the encoder wheels, one quick tap 
will do the trick. 

Tip 2 
Tap the Virtual RFR screen to cycle through different interface layouts.  (You can also lock the layout 
in the Settings screen) 

 

iRFR Color Picker 

With the iRFR Color Picker you can select colors for your color mixing devices. Select the Color 
Picker button at the top of the Virtual RFR screen to open the Color Picker screen.  You can return to 
the Virtual RFR anytime by pressing the Virtual RFR button in the top left corner. 
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The current color for the first selected channel is displayed by a small rotating indicator. Press 
anywhere on the color wheel to change the color, and the indicator will then move to the new color. 

iRFR Settings 

These are the settings you can define in the iRFR. 

Settings 

• Quick Start: when this is turned ON, the iRFR skips past the splash screens and attempts to 
connect to the console automatically.  If a connection is made, it goes straight into the Virtual 
RFR screen.  

• Sounds: when this is turned ON, you will hear various sound effects (button presses, wheel 
turns, encoder ticks, etc...)  

• Lock RFR Layout: when this is turned ON, you cannot cycle through the RFR interface 
layouts.  Instead it remains locked on the chosen layout, and you will see a small padlock 
icon indicating that the lock is enabled.  

• Sleep Disabled: when this is turned ON, your iPhone/iPod will not automatically go to sleep 
after a period of inactivity.  (This may decrease battery life) 

Flashlight 
At the Welcome screen, select the Flashlight for some quick light. Tap the screen to reveal 2 sliders 
which control the hue & brightness of the screen. 

About 
Here you will find a link to the charity's website, a link to the iRFR Wiki, and the version of your 
iRFR app. 

Network configuration for iRFR 

The iRFR requires that your console be on a wireless network.  Below are a couple examples of how 
you may choose to configure your wireless network. If you are using a wireless router, make sure you 
connect to the WAN port. 
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Default Static IP Addresses  

Cobalt  Congo Jr Cobalt Light Server 

IP Address 
10.101.80.101 

IP Address 
10.101.81.101 

IP Address 
10.101.82.101 

Subnet Mask 
255.255.0.0 

Subnet Mask 
255.255.0.0 

Subnet Mask 
255.255.0.0 

IP Gateway 
10.101.80.101 

IP Gateway 
10.101.81.101 

IP Gateway 
10.101.82.101 

RVI  Wireless Router/AP iPhone/iPod 

IP Address 
10.101.85.101 

IP Address 
10.101.124.101 

IP Address 
10.101.125.101 

Subnet Mask 
255.255.0.0 

Subnet Mask 
255.255.0.0 

Subnet Mask 
255.255.0.0 

IP Gateway 
10.101.85.101 

IP Gateway 
10.101.124.101 

IP Gateway 
10.101.125.101 

iPhone and iPod Configuration 

Once your wireless network is setup, you must configure your iPhone/iPod to connect to it: 

1. On your iPhone/iPod press the Settings icon. 
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2. At the Settings screen, select Wi-Fi. 
 

 

3. At the Wi-Fi Networks screen, find the wireless network your console is on and select it.  Once 
connected, you will see a check mark to the left of the network name. Now press the round blue arrow 
button to configure your network settings. 
 

 

4. Now you must configure your iPhone/iPod's network settings so that it can connect to the console.  
The reccomended IP address is as follows for a standard static network configuration. 
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Testing iRFR network connectivity 

Once your iPhone/iPod is configured to be on the same wireless network as your console, here's a 
quick test to make sure the iRFR and your console can talk. 

1. Launch the iRFR app on your iPhone/iPod. 

2. At the Welcome screen, click Settings. 
 

 

3. Fill in the Host field with the IP address of your console (see the tip below if you don't know how to 
locate your console's IP address). 
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4. Now, press the magnifying glass to test communication between your iPhone/iPod and the console.  
You will see either a green checkmark for YES or a red circle with a line through it for NO. 

 

5. If the communication test FAILS, double-check that you have entered the correct IP address of your 
console in the Host field at the Settings screen.  If the test still fails, exit the iPhone/iPod home screen 
and verify that you are still connected to your console's WiFi network. 

You can find the IP address of your console in Browser >About >About Cobalt and in System 
Settings >Network. 
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Connecting iRFR to your console 

If you have tested your network you are ready to connect to Cobalt. 

1. You need to have Remote Controls and ACN enabled in your Cobalt. No other settings or protocols 
need to be turned on for the iRFR to work. 
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2. Launch the iRFR app on your iPhone/iPod.  At the Welcome screen, select Settings. 

 

3. At the Settings screen, enter your console's IP address in the Host field (this is different for Cobalt, 
Jr and Light Server, see above). If you do not see a green checkmark after entering the IP, you won't 
be able to connect.  That means you have either entered the wrong IP address or there is a problem 
with your wireless network configuration. The Password is not used with Cobalt and CobaltJr 
consoles. Only with Eos/Ion/Element. Leave the Password field blank. 
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4. Press the Welcome button at the top left to return to the Welcome screen, and then press Connect. 

 

5. Once connected, you will see a that you are connected to a Cobalt, and the version of software it is 
running.  The Virtual RFR menu item will also become available. 
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Remote Control - cRRFU Radio Remote 
All instructions for connecting and operating the older, compatible ETC CRRFU Radio Remote 
control are packaged and delivered with this unit.  

 

Crrfu Remote Functions 

The transmitter has two available commands for each key on the unit.  

Direct commands are displayed above each key. To access the commands that are displayed vertically 
to the left of each key, press the [FUNC] key first (do not press and hold [FUNC]).  

An example of mixing direct and [FUNC] commands to record channels 1-5 at 75% into Preset 5 
follows: 

[1] [CHAN] [5] [THRU] [7][5] [@ LEVEL] [5] [FUNC] [RECORD] 

Function  Key Feedback 

Select a channel [#] 

[CHANNEL] 

Channel is selected 

Add channels [#] [THRU]

[#] [FUNC] 

[+] 

Channels are added to selection 

Subtract channels [#] [FUNC] 

[-] 

Channels are subtracted from selection 

Select Group [#] [FUNC] 

[Group] 

Channels in Group # are selected 

Select All [FUNC] [All] Selects all channels with a level that were 
set from the remote 

Set to Full [FUNC] Levels for the selected channels are set to 
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Function  Key Feedback 

[100%] full 

Set to 0% [FUNC] [0%] Levels for the selected channels are set to 
zero 

Set to level [#] 

[@Level] 

Level # is set for selected channels 

Increase/decrease 
levels 

[FUNC] [+%]

[FUNC] [-%]

Levels for the selected channels are changed 
up/down. Hold the [+%] or [-%] keys to 
have the channel fade up/down. 

Check mode [FUNC] 

[Check+] 

[FUNC] 

[Check-] 

Steps to the next/last channel using the level 

See Check mode (add link to "Channels - 
Check Mode" chapter) 

GO [FUNC] 

[Go/Goto] 

Next crossfade is started 

GO Back [FUNC] [Go 

Back] 

Crossfades to the previous step 

GOTO a 
preset/step 

[#] [FUNC] 

[Go/Goto] 

Crossfades to preset # or step # (depending 
on the  GOTO jumps to setting in Setup) 

Record preset [#] [FUNC] 

[Record] 

Records Preset # into the Preset List. Only 
the levels set from the remote are recorded 

Update [Update] Updates the preset that was last activated 
from the remote 

Load levels from 
Preset 

[#] [FUNC] 

[Preset] 

Levels from Preset # are loaded into A 

Clear number input [C/Alt Clears numbers input 

Clear remote field [FUNC] [All] 

[FUNC]  

[0%] 

Clears all channels turned on from remote 

Using Check mode from channel 1 onward:  

[1] [FUNC] [100%] then [FUNC] [Check+] then [FUNC] [Check+] 

At Mode 
If a console is set to work in At Mode, channel selection functions on the remote behave differently. 
For example: 

• Set channels 1 thru 5 to 55%: [1] [THRU] [5] [@Level] [5] [5]  
• Set channels 11 thru 14 at full: [11] [THRU] [14] [FUNC] [100%] 
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Number entry after [@Level] is a two digit entry. If you only enter one number, you can press [C/Alt 
to end level entry. 

NOTE 
When RECORDING only levels from the remote are recorded, not the whole 
stage output. 

Transmitter Setup 

The transmitter unit has a slide switch (on/off) and 16 keys for console commands. The unit has a 
“sleep” feature that helps to conserve battery life when the switch is left in the “on” position. Set the 
switch to the “off” position to guard against accidental key presses. 

The keys of the transmitter unit are illuminated. The keys are brightly lit while keys are pressed and 
the unit is transmitting. After the key is released, the keys remain dimly lit for a period of time before 
the unit sleeps. The sleep delay can be programmed at the transmitter unit as described below. 
  
Set the transmitter unit sleep delay 
  
Step 1: Move the slide switch to the “off” position. 
  
Step 2: Press and hold 

• [FUNC] for a 5 second sleep delay. 
• [THRU] for a 12 second sleep delay. 
• [Ch] for a 25 second sleep delay. 
• [@ Level] for no sleep delay (the unit does not turn off). 

Step 3: While pressing one of the keys above, slide the switch to the “on” position and wait until the 
keys are blinking (about 5 seconds). 
  
Step 4: Release the key you are pressing. The sleep delay time is now programmed to the setting you 
selected above. 

Replacing the transmitter battery 

The transmitter unit requires a single 9V alkaline battery (provided) for power. This battery should 
provide approximately one year of normal usage before requiring replacement. To replace the battery, 
remove the two M3x4mm screws at the bottom of the unit to access the battery compartment and 
replace with a 9V alkaline battery. Replace the lid and secure it with the same two screws. Dispose of 
the old battery as is appropriate in your local area.  
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Accessories - Connecting Cobalt to a Visualizer  
These are the Cobalt Family Console Settings including ETCnomad. 
 
Supported protocols 
Cobalt Family consoles can output Net2 (EDMX), Net3 (sACN/E1.31), and ArtNet levels via 
Ethernet. Computers running Cobalt ETCnomad (PC or Mac) can output Net3 (sACN/E1.31) or 
ArtNet.   

To change settings: 
1. Ensure the correct network is enabled in System Settings 

 

2. If your PC has multiple network cards, you will also need to select the correct network card in 
System Settings. This must match your choice in the visualization software.  

 

3. Enable the correct Output Protocol for your visualizer. If you are using Capture, ensure that sACN 
is enabled. (Note: ETCnomad does not support Net2 and this choice is not visible on devices running 
ETCnomad.) 
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4. The enabled Ethernet protocol(s) and the IP address(es) are shown top-right of the Welcome 
screen.    

 

Visualization - WYSIWYG 

WYSIWYG can receive Net2 (EDMX) levels via ethernet. 

In the Options menu of Wysiwyg, select Application Options and then navigate to the ETC Interface 
tab. Ensure that "Allow EDMX reception" is ticked, and that the ETCNet2 Version is set to V4. Note: 
You must restart Wysiwyg after making this change. You also must be an Administrator on the 
computer. 
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You may need to run an application called NICPicker, which may or may not be packed with 
Wysiwyg. This application sets which of your network adaptors is used for Net2 traffic. It is available 
as part of the free download of Network Configuration Editor (NCE) from ETC. 

Note: There are ETCNet2 devices in the Device Manager in Wysiwyg, but these do not function. 
Allow EDMX reception as shown above to see EDMX levels. 

WYWISYG Link: You can send the patch in WYSIWYT to Cobalt. Make sure you have imported the 
templates involved first. Clear patch clears the dimmer patch as well as the device patch. 

Visualization - Capture 

Capture can receive many protocols including Net2 (EDMX) and Net3 (sACN/E1.31) levels via 
ethernet.  
Capture Polar and Capture Argo receive "ratified" sACN/E1.31. 

In the Tools menu of Capture, select Options. Navigate to the Connectivity tab, and select your 
network interface card if required. Note that depending upon your PC's configuration, a setting of 
Automatic may not work; in this case select the appropriate adapter. 
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In Capture Argo, each protocol can have its own IP address selection. Be sure to set the proper IP 
address for each of the protocols that you are using. 

 

A valid network link is required to receive sACN, even if the source is another application on the 
same PC.  
This means a standalone PC will require either an active connection to an ethernet switch or the 
"Loopback Adapter" to be installed. 

Following a restart, open your existing project or start a new one. 

In the Project Window, you will see a tab showing Universes. You should see both BSR E1.31 and 
ETCNet2 Universes, assuming you have any dimmers patched on your console. 
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Capture executable (presentation) files should also receive these network levels. Note that you may 
need to install the Capture application in order to use its network adaptor selection tools.  

Example - getting started 

1. Start Capture and open the demo play Sketching. 

2. Open the demo play Sketching in Cobalt. 

NOTE 
There is a plug-in for Training Projects powered by Capture. See Media - 
Training Projects. 

Capture can be downloaded from www.capturesweden.com 

Visualisation - Other Visualizers 

Any visualizer that can receive the supported network protocols listed above should be compatible. 
The visualizer program that you choose may also support receiving DMX via a DMX-USB converter, 
though computers running Eos ETCnomad or Cobalt ETCnomad will only transmit DMX via an ETC 
Gadget DMX-USB interface.  

Consult your visualizer's documentation for supported receiving devices. 
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Accessories - Cobalt ETCnomad - Server & Client 
Using the same graphic displays as the Cobalt console, the Cobalt ETCnomad software provides an 
operating environment identical to the console itself. With a complete set of alphanumeric-keyboard 
shortcuts for commonly used commands, Cobalt ETCnomad can be used to view console data or to 
interact with your Cobalt console. See Network - Client. 

 
 
Cobalt ETCnomad software can be run on a PC with the Windows® XP or Windows® 7 operating 
system. A dongle is required to connect to the Cobalt console over an Ethernet network. When not 
connected to the network, or without the dongle attached, the system can be used as a Cobalt Offline 
Editor workstation or as a live server/backup. 

We recommend the use of X-keys. See X-keys. 
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Using ETCnomad Puck  
When you launch ETCnomad Puck software for the first time, you will need to choose between two 
console operating modes: Eos and Cobalt. Your computer will remember your selection for all 
subsequent launches.When choosing the Eos family mode, you will subsequently need to select either 
the Eos or Element console platform. 

Changing console operating modes 

From Cobalt to Eos 

• From the Cobalt login screen, select {System Settings}. The “System Settings” dialog will 
display. 

• Locate and select the {Switch to Eos} button from within the “System settings” dialog. 
“Enable Eos Mode” will display along with a new screen display. 

• Click the green check mark in the bottom right hand corner of the screen to commit to the 
change or click the red X to cancel the operation. When you have committed to the change, 
the ETCnomad Puck will reboot to the newly selected operating mode. 

 
From Eos to Cobalt 

• From the Eos Configuration Utility start up screen, select {Settings}. System settings dialog 
displays. 

• Select the {Maintenance} button from the options on the right side of the dialog. A complete 
list of maintenance options will display. 

• Locate and select the {Switch to Cobalt Client} button from within the maintenance dialog. 
The Cobalt logo will display in a new dialog and you will be requested to confirm whether 
you would like to “Enable Cobalt Mode”. 

• Click the green check mark in the bottom right hand corner of the dialog to commit to the 
change or click the red X to cancel the operation. When you have committed to the change, 
the ETCnomad Puck will reboot to the newly selected operating mode. 
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Accessories - Cobalt Programming Wings  
The Cobalt Programming Wing provides a portable base allowing you to travel with a physical control 
surface to supplement a ETCnomad Puck or PC/Mac-based system.  

The Programming Wing has the same programming layout as the Cobalt 10 face panels, so users can 
transition without altering workflows or hunting for keys. Each wing contains playback and fader 
controls, parameter encoders and level and rate controls, along with DMX512-A/RDM and MIDI 
In/Out outputs, a Contact Closure Trigger, and Littllite connectors. 

 

Wings are VESA-mountable for temporary or permanent installation backstage, in a rack or on a tech 
table. It measures approximately 50cm x 36cm and weighs 4.3kg. 

Motorized Fader Wing 

The Motorized Fader Wing has the same layout as the Cobalt 10 and 20. A single Motorized Fader 
Wing can be used as a playback surface with with ETCnomad systems running under MacOSX or 
Window 7, 8 and 10. The Motorized Fader Wing can also be used with Cobalt Remote Video (RVI 
and RVI3) and Cobalt Light Server hardware. The wing provides power sensing and automatically 
turns on when both an active USB data connection and mains power are provided via the external 12V 
power supply. 
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Any Cobalt system will support up to 80 Master Playbacks.  

Examples 
Cobalt 10 has 20 Master Playbacks, you can add an additional 60 Master Playbacks in any 
combination of wings. 
Cobalt 20 has 40 Master Playbacks, you can add an additional 40 Master Playbacks in any 
combination of wings. 
With Congo jr and ETCnomad youcan add an additional 80 Master Playbacks in any combination of 
wings. 

Order of connection and SWAP 
When using SWAP with connected wings, each wing will swap in the order it was connected to the 
system. This order can be determined by the daisy chain order when wings are connected one to the 
next. The console swaps first, then the first connected wing, then the wing next in line, and so on. If 
wings are connected to a hub and then connected to a console, the wings will swap in their enumerated 
order. This order can be determined by the masters numbering on startup of the system. 
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Accessories - Net3 Remote Video Interface 
The Remote Video Interface – a 2U 19” rack mount device - provides remote video and local 
programming functions for Cobalt and Cobalt jr. control systems. 

 

Controls on the front of the unit include the power switch, USB port and 20 buttons for commonly 
used functions. These buttons have default mapping – specific to the Cobalt product line, reflecting 
commonly used features for the designer or assistant designer.   

 
 
The RVI also supports a dual video output for two DVI/SVGA high-resolution monitors.  
 
An alpha-numeric keyboard and/or pointing devices can be connected to the RVI to provide remote 
programming capability using the Cobalt keyboard shortcuts. X-Keys can also be attached via USB.  

See X-Keys. 
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Accessories - X-keys 
ETC recommends the use of PI Engineering's X-Keys® panel with Cobalt Client software. X-Keys is 
a panel of user-definable keys.  

 

We have provided a file that defines the X-Keys Professional 58-key panel with the Cobalt hotkey 
shortcuts most used in offline programming and editing. The X-Keys Professional 58-key panel is 
very similar to the layout of the Cobalt keypad, so frequently used functions appear in relative 
positions between the actual console and the offline editor.  

See www.etcconnect.com/Cobalt for more details. 



Cobalt 8.1 - 20181029 

1002 

 

Facepanel - Cobalt LS 
The Cobalt Light Server’s 19”-design packs the identical features, channel and output counts as the 
Cobalt console into a stand-alone, rack-mountable enclosure suitable for permanently installed 
applications. Running Cobalt’s operating software, the Cobalt Light Server is a fully independent 
lighting playback controller or a convenient back-up option. There are twenty keys with a shift 
function in the front panel that make it possible to run a lot of functions. An external mouse is 
supplied and recommended.  

  

Button functions - unshifted 

1 2 3 4 5 6 7 8 9 0 

Ch Thru All + @ Output Master Point C Shift 

Button functions - shifted 

Esc Up Modify Insert Live Format Tab Browser Macro Load 
Play 

Left Down Right Delete Goto GO Pause Go Back Record Shift 

We recommend the use of X-keys. See X-keys. 
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APPENDIX 
The Appendix contains information about control interfaces, fuses, key 
shortcuts etc. 

This chapter contains the following sections 

• Connectors  
• MIDI  
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Connectors  

These are the connectors in the back of the console.  

 

This chapter contains the following sections 

• Connector - DMX512  
• Connector - DVI/sVGA Monitor  
• Connector - Phone remote  
• Connector - MIDI  
• Connector - External Trig 1-9  
• Connector - Ethernet  
• Connector - Keyboard, Printer & Mouse  
• Connector - Desk Light   

Connector - DMX512 

There are two DMX512A/RDM ports  

Pin 1 Gnd 
Pin 2 Data- 
Pin 3 Data+ 

  

Connector - DVI/sVGA Monitor 

These connectors support DVI/sVGA external displays (1280x1024 minimum resolution) with 
optional single or multi-touch screen control. 
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Connector - Phone Remote 

Pin 4 Data+ 
Pin 5 Data -  

 

The Remote Control Setting must be turned on for the remote to work. See Settings - System. 

Connector - MIDI 

MIDI in/out (MIDI timecode, MIDI notes, MIDI Show Control (MSC). (MIDI timecode, MIDI Show 
Control through Net3 Gateway, SMPTE timecode through Net3 Gateway). 

MIDI In 

Pin 4 Data + 
Pin 5 Data -  

MIDI Out, Thru 

Pin 2 Gnd 
Pin 4 Data + 
Pin 5 Data -  
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Connector - External Trig 1-9 

The external trig can be used for any console function by assigning appropriate Triggers in Event 
Lists. 

The external trig also allows the following functions directly. 

1: Go 
2: Pause 
3: Go Back 
4: Toggles Master 40 On/Off. 

The Remote Control Setting must be turned on for the remote to work. See Settings - System. 

 

 

Connector - Ethernet 

Two individually configurable Ethernet ports, 802.3af compliant PoE. Transmitting ETCNet2™, 
Net3™ (powered by ACN), sACN and ArtNet 
output protocols  

Pin 1 TX+ 
Pin 2 TX- 
Pin 3 RX+ 
Pin 4 NC  
Pin 5 NC  
Pin 6 RX- 
Pin 7 NC 
Pin 8 NC 
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Connector - USB Multipurpose 

There are 11 USB multipurpose ports for keyboard and mouse. They are located in the drawer of 
Cobalt20, in the back and on the frontpanel, under the power switch. 

 

Connector - Desk Light 

You can connect a standard desk light to the connectors in the top corners of Cobalt. 
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MIDI 
MIDI allows you to interface with Time Code and other MIDI equipment.  

This chapter contains the following sections 

• MIDI - Introduction  
• MIDI - Standard MIDI  
• MIDI - MIDI Show Control  
• MIDI - Time Code  
• MIDI - Implementation Chart 
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MIDI - Introduction 
MIDI stands for Musical Instrument Digital Interface. The reason you can find it in a lighting console 
is that MIDI today is being used for a lot more than having synthesizers to speak to each other as was 
intended originally.  
 
Basically MIDI is a standard for transmitting notes 0—127 (on/off) with velocity (how hard they are 
played) and continuous controllers such as faders (volume for example). There are more parameters 
but these are the basic ones. In Cobalt all keys correspond to a note and all faders to a controller.  
 
MIDI is transmitted serially in up to 16 individual MIDI channels in one three-lead cable. The 
communication is unidirectional, which means there is no feedback or intelligent bi- directional 
contact between MIDI units (DMX512 is also unidirectional, while a pair of walkie talkies (for 
example) are bi- directional, allowing communication both ways). 

There is support for three sorts of MIDI. 

Standard MIDI  
Send and receive Notes,Controllers and Program Change. 

MIDI Show Control  
A standard set of commands is supported. 

MIDI Time Code 
Trig Sequence Steps by time code. There is a Learn Mode. 

Once you have connected a MIDI Device to the Cobalt with the MIDI connectors in the back of the 
console, you have to set up the console to receive and/or transmit MIDI, and define which MIDI 
commands it will recognize. 

There is a MIDI Setup where you can configure how the console will function with MIDI. See 
System Settings - MIDI. 
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MIDI - Standard MIDI 
All MIDI functions need to be activated in the MIDI Setup. See System Settings - MIDI.  

MIDI NOTES & CONTROLLERS 
All keys and faders can send notes and controllers when this is activated in the MIDI Settings.You can 
use MIDI notes and controllers to remote control any key or fader of the Console. If you connect a 
MIDI Sequencer you can record all key presses and fader movements in real time and play back in 
real time.  

PROGRAM CHANGE 
The Cobalt can be set to activate a specific crossfade when receiving a Program Change command 
through MIDI. When the Program Change parameter (in MIDI Settings)is set to "On" the board will 
activate a crossfade to step 0-127 when receiving Program Change 0-127.   

NOTE 
You have to have a Sequence Step recorded in the board to be able to jump to 
it. 

You have to send both ON and OFF for notes. 
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MIDI - MIDI Show Control 
Cobalt supports sending and receiving of MIDI Show Control (MSC) commands. GO 
and Pause/Resume are commands that Cobalt sends when MIDI Show Control is enabled in the setup. 
GO, Stop, Resume and Set commands can be sent to Cobalt from other devices to control playback 
actions. 

Enable MSC and Device ID settings 
In the Show Control setup there are parameters for turning MSC on/off and setting the device ID. See 
Play Settings - Show Control. 
When MSC is enabled Cobalt both sends and can receive MSC commands. Device IDs 00-7E (0-126 
in decimal) are for individual receivers and Device ID 7F (127 in decimal) is meant for all recievers. 
The default setting for Device ID is 1 (01 in hexadecimal). 

Cobalt supports reception of the following MSC commands. All example command strings are 
shown in hexadecimal values. 

GO 
Executes the next crossfade in the same way as pressing GO in the console. If GO is pressed in the 
console, the number of the Preset is automatically transmitted as well. This is sent automatically when 
GO is pressed and MSC is active. 

Preset numbers in the GO command are encoded using ASCII and 2E is the decimal point. For 
example preset 10 equals 31 30. 

GO (Main Playback): 
F0 7F 01 02 01 01 F7 

GOTO preset 105: 
F0 7F 01 02 01 01 31 30 35 F7 

GOTO preset 86.4: 
F0 7F 01 02 01 01 38 36 2E 34 F7 

NOTE 
MSC GO commands in Cobalt support only one decimal number. Presets 
with more then one decimal number will not send an MSC GO command and 
these presets cannot be triggered with MSC from other sources. 

STOP 
Pauses the current crossfade. This is sent automatically when PAUSE is pressed and MSC is active. 

Stop/Pause (Main Playback): 
F0 7F 01 02 01 02 F7 

RESUME 
Resumes the current crossfade. This is sent automatically when PAUSE is pressed after PAUSE and 
MSC is active. 
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Resume (Main Playback): 
F0 7F 01 02 01 03 F7 

SET 
The SET command allows setting Cobalt's faders to specific levels. An MSC SET command packet 
looks like this: 

 

Where <cc> <cc> defines the Controller number and <vv> <vv> defines the level. These are both 14-
bit values, a combination of two 7-bit values. Both in <cc> <cc> and <vv> <vv>  the first value is the 
LSB and the second value is the MSB. For <vv> <vv> fader values Cobalt uses the most significant 8-
bits of the 14-bit value for the level, giving a resolution of 256 steps. 

Some examples of how percent value convert to <vv> <vv> values in Cobalt: 

Percent Level <vv> <vv> Value 

0% 00 00 

10% 00 0D 

20% 7F 19 

30% 7F 26 

40% 00 33 

50% 00 40 

60% 7F 4C 

70% 7F 59 

80% 00 66 

90% 00 73 

100% 7F 7F 
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The <cc> <cc> Controller numbers used in Cobalt are: 

Fader <cc> <cc> Value 

Master 1 00 00 

Master 2 01 00 

Master 3 02 00 

...  

Master 39 26 00 

Master 40 27 00 

Grandmaster 7E 03 

Examples 

Master 1 at 100% 
F0 7F 01 02 01 06 00 00 7F 7F F7 

Master 20 at 50% 
F0 7F 01 02 01 06 13 00 00 40 F7 

Master 33 at 0% 
F0 7F 01 02 01 06 20 00 00 00 F7 

Grandmaster at 20% 
F0 7F 01 02 01 06 7E 03 7F 19 F7 

  

NOTE 
For more info about MIDI, MSC and other Show Control commands a good 
book to have is Control Systems for Live Entertainment by John Huntington 
(ISBN: 978-0-240-80937-3)  
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MIDI - Time Code 
Every sequence step can be triggered both manually, and by a specific MIDI Time Code time on the 
MIDI port. 

In the Sequence Editor, this time can be set or edited in a column to the far right. It is possible to enter 
a time code timestamp for each sequence step. When the specific time code position is reached, the 
sequence step will be executed providing Time Code is set to on. See System Settings - MIDI.  

• Time Code is edited from the keyboard (display or external) in all Cobalt consoles. In the 
bigger Cobalt it can be edited from the numerical console keypad as well.  

• If there is MIDI Time Code coming into the system, the running time will be shown on top of 
the monitor instead of the normal date and time.  

Manual and Time Code trig 
You can combine sequence steps with Time Code times with normal manual or automatic crossfade. 
The Time Code time is just an additional trigger that can activate a sequence step. If there is a problem 
with the MIDI Time Code input, you can always start the crossfade by pressing GO. 

Time Code On/Off 
There is an overall parameter "Read MIDI Time Code" that switches on or off time code in general. 
See System Settings - MIDI.  

Time Code Format 
Time code must be entered in this format: hh.mm.ss.ff. 

Time code is shown in the Playback view like this 
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Learn mode 
Each time GO is pressed, the current time code timestamp will be recorded in the current sequence 
step. See System Settings - MIDI.  

Trig in B or Auto Mode 
Normally, only Sequence steps that are in the B field will be triggered by incoming MIDI Time Code. 
Other Steps will not be trigged, even if the times match.  

It is also possible to run the system so that any Sequence Step matching a specific Time Code time is 
run automatically regardless if it is in the B field or not.If the "Auto- locate step" parameter is set to 
"On", any step that is matching the incoming MIDI Time Code will be executed. See System Settings 
- MIDI.  

Edit time code in the sequence list 

When you press MODIFY in the Time Code column, you will be presented with a Time Code Editor. 
In this editor you can Set, Add and Subtract time code values. All sequence steps that are selected 
before you open the Time Code Editor will be affected by the change. Also see Sequences - Sequence 
List. 

 

It is possible to enter timecode in a short form format. Entered digits will be assigned from right-to-
left to frames, seconds, minutes and hours. Leading 0’s can be omitted. Example: 123 would be 
00.00.01.23. 
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MIDI - Implementation Chart 
All MIDI messages described below can be sent or received on any 
MIDI Channel between 1 and 16. 

The values shown in parenthesis (like this = 144) all refer to MIDI 
channel 1. To be able to use other MIDI channels, you have to add 
the channel number and subtract 1. 

Example 
NOTE ON on channel 4 = 144 + 4 — 1 = 147. 
  
Keys 
All keys are transmitted as Note On and Note Off messages. 

When a key is pressed, the following MIDI Message will be transmitted: 
NOTE ON (=144), Key number, 64 

When a key is released, the following MIDI Message will be transmitted: 
NOTE OFF (=128), Key number, 64 

By sending the corresponding command to the MIDI In port, the Cobalt will execute the key. 

Since standard MIDI Notes only can accept a maximum of 127 individual notes and the Cobalt uses 
far more buttons than that, a special coding had to be introduced for the buttons above 127. 

In the table below, these are shown as x, y. The first value is used as the note number and the second 
value is used for the velocity. 

Example 
Sending the Align key would look like this:  
144, 125, 98 (key pressed) followed by 128, 125, 98 (key released). 

Console Keys - MIDI Chart 

Key  MIDI Code (Hex) MIDI Code (Dec) 

-% 3C 60 

[] 75 117 

|| 79 121 

+% 3D 61 

<------ 7D, 21 125, 33 

<< 7E, 5C 126, 92 

> 73 115 
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Key  MIDI Code (Hex) MIDI Code (Dec) 

>> 7E, 5D 126, 93 

0 01 1 

1 02 2 

2 03 3 

3 04 4 

4 05 5 

5 06 6 

6 07 7 

7 08 8 

8 09 9 

9 0A 10 

A 0B 11 

Align 7D, 62 125, 98 

All 0C 12 

AtLevel 22 34 

Attrib 7D, 27 125, 39 

B 23 35 

Bank 7E, 41 126, 65 

Beam 7D, 1C 125, 28 

Blind 7E, 62 126, 98 

Browser 7E, 71 126, 113 

C 24 36 

Capture 7D, 65 125, 101 

Ch 25 37 

Ch— 26 38 

Ch+ 27 39 

Color 7D, 1B 125, 27 

Column 7E, 53 126, 83 

Connect 7E, 55 126, 85 

Copy/Cut 7D, 5A 125, 90 

DecimalPoint 3E 62 

Delay 7D, 22 125, 34 

Delete 51 81 
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Key  MIDI Code (Hex) MIDI Code (Dec) 

Device 7D, 26 125, 38 

Direct Select 1 7D, 6D 125, 109 

Direct Select 40 7E, 1C 126, 28 

Direct Select page 1 7E, 6B 126, 107 

Direct Select page 5 7E, 6F 126, 111 

Down 4D 77 

Esc 2C 44 

Fan 7D, 0A 125, 10 

Fetch 2F 47 

Flash 1 7E, 2D 126, 45 

Flash 20 7E, 40 126, 64 

FlashMode 30 48 

Focus 7D, 1A 125, 26 

Format 7E, 61 126, 97 

GO 31 49 

GoBack 32 50 

Goto 33 51 

Group 7E, 56 126, 86 

Help 34 52 

Highlight 7D, 34 125,  52 

In 7D, 46 125, 70 

Independent 1 7E, 63 126, 99 

Independent 2 7E, 64 126, 100 

Independent 3 7E, 65 126, 101 

Insert 50 80 

Inv Group 7D, 66 125, 102 

Last 7D, 2A 125, 42 

Left 4E 78 

Live 7E, 5E 126, 94 

Load 7E, 74 126, 116 

Macro 35 53 

Mask 7D, 28 125, 40 

Master 7D, 2B 125, 43 
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Key  MIDI Code (Hex) MIDI Code (Dec) 

Master Page- (lower) 7D, 5D 125, 93 

Master Page (upper) 7E, 1D 126, 29 

Master Page- (upper) 7D, 5F 125, 95 

Master Page+ (lower) 7D, 5C 125, 92 

Master Page+ (upper) 7D, 5E 125, 94 

MasterKey1 0E 14 

MasterKey20 21 33 

MasterKey21 56 86 

MasterKey40 69 105 

MasterPage 36 54 

Modify 37 55 

Mute 7E, 47 126, 71 

Next 7D, 29 125, 41 

Note 7E, 45 126, 69 

Out 7D, 45 125, 69 

Output 38 56 

Palette 7D, 23 125, 35 

Park 7E, 46 126, 70 

Paste 7D, 5B 125, 91 

Pause 3B 59 

Playback 6D 109 

Preset 3F 63 

Record 40 64 

Refresh 7D, 33 125, 51 

Release 7E, 70 126, 112 

Rem Dim 7E, 52 126, 82 

Right 4F 79 

Select 7E, 58 126, 88 

Select All 7D, 30 125, 48 

Seq 44 68 

Seq- 6B 107 

Seq+ 6C 108 

Setup 46 70 



Cobalt 8.1 - 20181029 

1021 

 

Key  MIDI Code (Hex) MIDI Code (Dec) 

Solo 7E, 48 126, 72 

Start 45 69 

Tab 7E, 5F 126, 95 

Tap 7E, 54 126, 84 

Text 7D, 64 125, 100 

Thru 47 71 

Time 48 72 

Track 7D, 63 125, 99 

Type 7E, 42 126, 66 

U1 7D, 1D 125, 29 

U2 7D, 1E 125, 30 

U3 7D, 1F 125, 31 

Up 4C 76 

Update 7E, 4F 126, 79 

Wizard 7D, 32 125, 50 

Console Faders - MIDI Chart 

Fader  MIDI Code (Hex) MIDI Code (Dec)  

Lower_1 41 65 

Lower_2 42 66 

Lower_3 43 67 

Lower_4 44 68 

Lower_5 45 69 

Lower_6 46 70 

Lower_7 47 71 

Lower_8 48 72 

Lower_9 49 73 

Lower_10 4A 74 

Lower_11 4B 75 

Lower_12 4C 76 

Lower_13 4D 77 
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Fader  MIDI Code (Hex) MIDI Code (Dec)  

Lower_14 4E 78 

Lower_15 4F 79 

Lower_16 50 80 

Lower_17 51 81 

Lower_18 52 82 

Lower_19 53 83 

Lower_20 54 84 

Upper_1 55 85 

Upper_2 56 86 

Upper_3 57 87 

Upper_4 58 88 

Upper_5 59 89 

Upper_6 5A 90 

Upper_7 5B 91 

Upper_8 5C 92 

Upper_9 5D 93 

Upper_10 5E 94 

Upper_11 5F 95 

Upper_12 60 96 

Upper_13 61 97 

Upper_14 62 98 

Upper_15 63 99 

Upper_16 64 100 

Upper_17 65 101 

Upper_18 66 102 

Upper_19 67 103 

Upper_20 68 104 

AFader 69 105 

BFader 6A 106 

GrandMaster 6C 108 



Cobalt 8.1 - 20181029 

1023 

 

RDM Functionality 
The idea of RDM (Remote Device Management) is to make it possible for devices in a control 
network to communicate with the lighting control system. It can be used to simplify patching, 
addressing, and controlling modes of a device or supervising temperature via embedded sensors (when 
provided). 

There is a setting in Console Settings where you can disable "RDM Discovery" - Browser >General 
Settings >Console Settings. 

 

Cobalt is one of the world's most advanced RDM controllers of today.  

ABOUT RDM 
DMX communicates levels to devices. RDM adds communication back from the devices to allow us 
to remotely observe (sensors) control (setups) and configure (modes) these devices. The level of RDM 
functionality depends on the features of the controller and on the features of the device. It is possible 
that some devices do not support all the features available in Cobalt, or that Cobalt does not yet 
support all the RDM features of a device. RDM data is sent back over the DMX line.  

"It's not in the right mode, it doesn't have the right address, and you don't have to bring out the 
ladder…." 

PINS USED  
The DMX512 specification requires DMX connectors to be a 5-pin XLR type, with only the first 3 
pins being used (pins 4 and 5 were reserved for "future use"). RDM uses the same pins as DMX (pins 
2 and 3) to make it possible for all manufacturers to implement it.  



Cobalt 8.1 - 20181029 

1024 

 

NOTE 
Be aware that for RDM to work every DMX buffer/splitter has to be RDM 
compatible. A "standard" DMX splitter will block all RDM replies from the 
fixtures. 

The rounded "indicators" at the top of the screens always indicate status, 
never settings. 

The "RDM" indicator will appear once any RDM devices has been 
discovered. The number is the count of unpatched RDM devices - devices that 
you haven't patched & linked into your show yet. 

RDM Patching 

These are the basics of working with RDM and Cobalt. These steps assume you have RDM 
functioning, you have hung and cabled all of your devices, and that this is the first time you are 
working with the system: 

1. The outputs of the Net3 ACN DMX/RDM Gateway must have RDM Discovery enabled to allow 
Cobalt to communicate with connected RDM devices. Please consult the Net3 ACN DMX/RDM 
Gateway User Manual for directions on enabling and disabling RDM Discovery. Remember that only 
equipment with RDM will talk back to Cobalt. 

2. As soon as an RDM device is discovered on the network this will be indicated at the top of the 
monitors, with a red "RDM:" and a number. The number indicates the quantity of discovered new 
devices on the network. A new device is one that has not yet been patched in the current show file. 
(Note: if you have already patched all of your RDM devices, you will not see the number again (when 
restarting or reopening this show file). Only unpatched devices are indicated here.  

 

3. SEE LIST: Open the RDM Device List (Browser>Patching>RDM Device List), where you can see 
all discovered devices and their current addresses and settings. They are still not patched to congo - 
only discovered. You now have to actively make some desicions about to which Cobalt channel you 
want to patch them, and with which template. See the RDM Device List section below.  
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4. IDENTIFY: Press MODIFY in the Identify cell to tell the light to "identify itself". Depending on 
the type of device, this may mean the light flashes on and off, or the LCD display may flash its 
backlight. Consult the user manual of the device to see how the device will identify itself using RDM. 

5. PATCH: In the "Patched to channel" column, enter a channel number of Cobalt and press 
MODIFY. You will get a dialogue that will show if the device is known and will match a template in 
Cobalt, or if you wish to force a basic template from the data the device can provide over RDM. At 
most times you will find that the template is known and matched in the extended library of Cobalt. 
The advantage of using the known template is that it (usually) contains additional information, like 
text names for ranges and color calibration data for use with the Color Picker and Gel Picker. If it 
doesn't work the way you want you always have the option of creating a template manually.  

RDM Indicators 

RDM information about mismatches, communication, discovered devices and feedback is shown at 
the top of all screens. It will blink during RDM communication. 

Shows unpatched devices on top "RDM: #" 

 

Error messages will show as a triangle with a number 

 

Mismatch errors will show as "MISMATCH". Mismatch errors include patched settings not matching 
device settings, patch overlaps, and so on. 
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RDM Device List 

The RDM Device List is the main RDM Window. This is a standard list of purely standard RDM 
information. It is the same for all devices.  

This list allows you to identify devices,  change basic settings of the device (like start address, 
personality or mode) patch to Cobalt channels and access deeper settings of devices, if that 
functionality is supported by those devices.  

This list also shows conflict or mismatch states in red. In the case of overlapping device addresses, 
you must solve these overlaps manually by choosing and entering new starting addresses for those 
fixtures. RDM will send the new address setting to the fixture for you. 
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Note that in the Browser there is a command to "Clear offline RDM", use this command to clean up 
the list if you have removed devices, or moved devices from port to port on the Gateway. 

The information displayed is the standard information within the RDM Specification: 

MANUFACTURER: 
MODEL:  
LABEL:  
DMX PERSONALITY: This displays the actual device setting and  will match to a template in 
Cobalt) 
DMX FOOTPRINT: The number of outputs needed 
 
PARAMETERS: This is the number of settings within the device that can be displayed or edited using 
RDM. This is not the same as the DMX controllable parameters (attributes) of the device. 
 
SENSORS: Device Sensors 

SUB DEVICES: If the device has more devices associated with it, for example, you have one RDM-
capable dimmer rack that contains 6 individual dimmers, the rack settings would be found under 
Parameters and individual dimmer settings would be seen in the Sub Devices tab. 
 
SOFTWARE LABEL: Text from the device manufacturer 

RDM Device List Cache 

Normally RDM cache is something you don't have to worry about. In some rare situations you may 
want to force a re-query.  

There is a column that shows cache status. The Cache contains stored information discovered about a 
device over RDM and this indicator shows if Cobalt has cached data about a fixture so Cobalt no 
longer needs to query about the device structure.  

Press MODIFY in this cell to re-query or store the cache (see options below) 

 

Options (press MODIFY to activate) 
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"Querying device structure..."  
- This is a status that a query is going on 
 
"Device structure available. Save to cache?" 
- There is a structure, you can save it to cache manually (it is done at shutdown automatically). It will 
be loaded at the next restart of Cobalt.  
 
"Using cached device structure. Delete cache?" 
- Will delete the cached structure, and allow a re-query. It will be done at the next restart of Cobalt. 

"Restart to use cache" 
- The cache is now stored and att the next restart Cobalt will start using it automatically. 
 
"Restart to re-query" 
- At the next restart of Cobalt, a new query will be performed. 

RDM Device Parameter List 

The Device Parameter List provides access to the settings of each device that can be seen and 
controlled over RDM. This list is only available when there are discovered RDM devices. It is opened 
from the RDM Device List by pressing MODIFY in the Parameter cell of the device you wish to 
adjust. Note that regardless of which device you use to open this tab, it will show all devices of that 
model in the same table. 

All data in this tab is generated by the RDM device and is then displayed by Cobalt. Parameters you 
can edit are shown in white text. Changes you make in this tab are sent directly to the device and are 
not stored in any way by Cobalt. The valid data for a parameter is wholly dependent on the way the 
device manufacturer has developed their RDM functionality. Valid input may be numerical (type the 
new value and press MODIFY) or may be entered using a drop down menu (usually shown in text). 
Consult the user manual for the device to understand the impact of changing parameters in this tab. 
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RDM Device Sensor List 

The Device Sensor List provides access to the sensor information an RDM Device transmits (read-
only). This list is only available when there are discovered RDM devices. It is opened from the RDM 
Device List by pressing MODIFY in the Sensors cell of the device whose sensor data you wish to 
view. Regardless of which device you use to open this tab, it will show all devices of that model in the 
same table. 
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OSC Functionality 
Open Sound Control (OSC) is a content format for messaging among computers, sound synthesizers, 
and other multimedia devices. You can remotely control Cobalt using OSC. You can remotely control 
OSC devices using Cobalt.  

OSC is often used as an alternative to MIDI, when higher performance, higher resolution and a richer 
parameter space is desired. OSC messages are commonly transported across networks using (UDP/IP, 
Ethernet). OSC messages between gestural controllers such as the Wii Remote are usually transmitted 
over serial endpoints of USB by being wrapped in the SLIP protocol. OSC gives developers more 
flexibility in the kinds of data they can send over the wire, enabling new applications that can 
communicate with each other at a high level (Source Wikipedia).  

To explore more about OSC on the www see http://opensoundcontrol.org/introduction-osc. 

EXAMPLE 

• Use OSC to create a remote interface for Cobalt, for example in an iPad, using a standard 
third party OSC software such as TouchOSC.  

• Use third party developer software such as Max or Isadora to integrate Cobalt with other 
OSC devices.  

See also Receive - OSC Input and Transmit - OSC Output.  

NOTE 
Be aware that for OSC to work you need to activate OSC control and 
relevant settings in the Play Settings.  
See Play Settings - Show Control.   

NOTE  
OSC is not intended to be used as remote control for Cobalt over any open 
Internet connection. ETC recommends strongly that lighting networks 
remain separate from the Internet. 

Receive - OSC Input  

To receive OSC commands you have to activate reception of OSC and select the appropriate Port 
number (default 7000)  in Play Settings - Show Control.  
 
The device transmitting OSC needs both this port number and the IP address of your Cobalt system. 
You can check your IP address in Browser >About >About Cobalt. 

About OSC commands 
OSC is primarily used to press and release keys, move faders and adjust parameters. 

An OSC command consists of two parts: 
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1. A command Path. This starts with a "/" and looks similar to a URL web address that you 
would type into your browser. Eg: /cobalt/param/pan/wheel 

2. Zero or more Values. (Sometimes called Parameters or Arguments) Some OSC commands 
have optional values, while others require one, two or even more values. These are shown in 
angle brackets, with the range if applicable: Eg: <palette 1-999> 

How do I use it?  
OSC apps have various different ways to specify the OSC Path and the OSC Value (where 
needed) Be sure to check the manual for your OSC app to see how to type in the Path and the Values. 
 In many OSC applications, the values may be specified as a range. For example, an OSC fader will 
need a Minimum and a Maximum value. If you are having trouble, check with whether you've 
entered the Path and the Value(s) for the command correctly for the software you are using. 

TouchOSC:  
TouchOSC always sends at least one value, set by the Value Range. 

For example, the console [Go] button:  

All Cobalt OSC commands also support the additional press (1.0)/release (0.0) value syntax used by 
TouchOSC buttons. To convert the normal OSC command into this format, move the Values into the 
Path and use Value Range 0.0-1.0. 

Example TouchOSC Buttons: 

• To send the OSC Command "/cobalt/playback/goto" with the value 
3: "/cobalt/playback/goto/3" with Value Range 0.0-1.0 

• To send the OSC Command "/cobalt/chan/at" with the value 75: "/cobalt/chan/at/75" with 
Value Range 0.0-1.0 

• To send the OSC Command "/cobalt/directselect" with the values 1, 2, 
1: "/cobalt/directselect/1/2/1" with Value Range 0.0-1.0 

Example TouchOSC Fader: 

• To send the OSC Command "/cobalt/chan/at" with the values 0-100: "/cobalt/chan/at" with 
Value Range 0.0-100.0 

This is what a GO key will look like in TouchOSC: 
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QLab:  
OSC Commands are entered as a Custom OSC Message of single text string of both the Path and the 
Values (called Arguments in QLab). Values in a QLab custom OSC message are separated by spaces. 

Example QLab Custom OSC Messages: 

• To send the OSC Command "/cobalt/playback/3/level" with the value 
0.5: /cobalt/playback/3/level 0.5 

• To send the OSC Command "/cobalt/param/panTilt" with Pan value 0.5, Tilt value 
0.75: /cobalt/param/panTilt 0.5 0.75 

In the tables below, the example column shows this command syntax. 

 

NOTE (7.3)  
New OSC commands from 7.3 and forward starting with "/cobalt...", added 
below. The old commands are still supported.   

OSC Commands  

Remember that OSC commands may be input differently in different softwares such as TouchOSC, 
Max or Q-Lab, but the principles are the same - there is a path with one or more values, usually 
expressed as numbers.  

Refresh 
A command to force an update of all labels and fader values  
OSC path Value Example 

/refreshstatus  /refreshstatus 

Channels 

OSC Path Value Example 

/cobalt/chan/select <channel #> /cobalt/chan/select 1 

/cobalt/chan/add <channel #> /cobalt/chan/add 2 

/cobalt/chan/subtract  <channel #> /cobalt/chan/subtract 3 

/cobalt/chan/thru  <channel #> /cobalt/chan/thru 5 

/cobalt/chan/at  <level 0-100> /cobalt/chan/at 75 

/cobalt/chan/wheel <increment> /cobalt/chan/wheel -2 
Wheel down by 2 ticks 
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Groups 

OSC Path Value Example 

/cobalt/group/ <group #> /cobalt/group 3 

Masters 
"x" is the Master number 

OSC Path Value Example 

/cobalt/playback/x/level <level 0.0-
1.0> 

/cobalt/playback/2/level 0.50 

/cobalt/playback/x/go  /cobalt/playback/3/go 

/cobalt/playback/x/goto <preset or cue 
####.###> 

cobalt/playback/2/goto 3 

/cobalt/playback/x/jumpto <preset or cue 
####.###> 

cobalt/playback/2/jumpto 4.1 

/cobalt/playbacks/changePage <bank 1-4> 
<increment> 

/cobalt/playbacks/changePage 2 1 
Master Bank 2, up one page 

/cobalt/playbacks/selectPage <bank 1-4> 
<page 1-999> 

/cobalt/playbacks/selectPage 1 5 
Master Bank 1, select page 5 

 
Main Playback 

OSC Path Value Example 

cobalt/playback/go   cobalt/playback/go 

cobalt/playback/pause   cobalt/playback/pause 

cobalt/playback/goback   cobalt/playback/goback 

cobalt/playback/goto <preset or cue 
####.###> 

cobalt/playback/goto 3 

cobalt/playback/jumpto <preset or cue 
####.###> 

cobalt/playback/jumpto 4.1 

Beat Boss 
"x" is the Beat Boss number 

OSC Path Value Example 

/cobalt/beatboss/x/bpm <beat-per-minute> /cobalt/beatboss/3/bpm 120 

/cobalt/beatboss/x/bpm/wheel <increment> /cobalt/beatboss/1/bpm/wheel 
1 

/cobalt/beatboss/x/tap  /cobalt/beatboss/2/tap 
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Parameter and color control 

OSC Path Value Example 

/cobalt/param/panTilt <pan 0-255>  
<tilt 0-255> 

/cobalt/param/panTilt 127 255 

/cobalt/param/pan/wheel  <increment> /cobalt/param/pan/wheel 1 

/cobalt/param/tilt/wheel  <increment> /cobalt/param/tilt/wheel 1 

/cobalt/color/hs <hue 0-360>  
<sat 0-100> 

/cobalt/color/hs 120 100 

/cobalt/color/rgb <red 0-100>  
<green 0-100>  
<blue 0-100> 

/cobalt/color/rgb 30 22 45 

 
Palettes 
All palette commands can have an added press/release value (press = 1, release = 0) 

OSC Path Value Example 

/cobalt/focuspalette <palette 1-999> /cobalt/focuspalette 9 

/cobalt/colorpalette <palette 1-999> /cobalt/colorpalette 11 

/cobalt/beampalette <palette 1-999> /cobalt/beampalette 6 

/cobalt/allpalette <palette 1-999> /cobalt/allpalette 7 

 
Independents 
"x" is the Independents number 

OSC Path Value Example 

/independents/fader/x 
Independents 1-6 

<level 0.0-1.0> /independents/fader/1 0.5 

/independents/key/x 
Independents 7-9 

<level 0/1> /independents/key/7 1 

Direct Selects 

OSC Path Value Example 

/cobalt/directselect <page 1-5>  
<block 1-4>  
<item 1- 100> 

/cobalt/directselect 1 2 1 
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Action Macro  

OSC Path Value Example 

/cobalt/actionmacro <Action Macro string> /cobalt//actionmacro "GO 
PB" 

If your OSC application uses space-separated values, make sure that the whole Action Macro is sent 
as one string parameter. In most cases this means using "" around the Action macro string. 

Console Keys 
All key commands have an optional value for press (1) and release (0). No value means a normal 
press-and-release in a single command.  
 
"x" is the key name, see table below 

OSC Path Value Example 

/cobalt/key/x  /cobalt/key/go 

/cobalt/key/x <press/release 1/0> /cobalt/key/go 1 

Console Key Names 

Key names Key names Key names 

@Level 
+ 
- 
+% 
-% 
. 
0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
A 
Align 
All 
Attrib 
AutoLocatestep 
B 
BackupClockenable 
Balance 
Beam 
Blind 

Dynamics 
Effect 
EffectOverview 
Enable 
End 
Esc 
ExternalClockenable 
FaderMode 
Faders 
Fan 
Fetch 
FFMasterPB 
FlashMode 
FocusFocusingmode 
Format 
Full 
GelPicker 
GO 
GOMasterPB 
GoBack 
GoBackMasterPB 
Goto 
Group 
GroupWheelMode 
GroupsPalettesOverview
Help 

Master32 
Master33 
Master34 
Master35 
Master36 
Master37 
Master38 
Master39 
Master40 
ModifySeq 
Modify 
Mute 
Next 
Note 
Off 
Organizer 
Out 
Output 
Page 
PageDown 
PageUp 
Palette 
Park 
Paste 
Pause 
PauseMasterPB 
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Key names Key names Key names 

Browser 
BuildSeq 
C 
Capture 
ChDelay 
ChTime 
Ch 
ChannelSet 
Chase 
ClearChanged 
ClearRemotes 
Client 
Color 
Column 
Compare 
Connect 
Copy 
Cut 
Data 
Delay 
DelayIn 
DelayOut 
Delete 
Device 
DirectSelectBank 
DirectSelectPage1 
DirectSelectPage2 
DirectSelectPage3 
DirectSelectPage4 
DirectSelectPage5 
DirectSelectType 
DirectSelect1 
DirectSelect2 
DirectSelect3 
DirectSelect4 
DirectSelect5 
DirectSelect6 
DirectSelect7 
DirectSelect8 
DirectSelect9 
DirectSelect10 
DirectSelect11 
DirectSelect12 
DirectSelect13 
DirectSelect14 
DirectSelect15 
DirectSelect16 
DirectSelect17 
DirectSelect18 
DirectSelect19 
DirectSelect20 
DirectSelect21 

Highlight 
HomeAttrib. 
Home 
Id 
In 
Independent7 
Independent8 
Independent9 
Insert 
InternalClockenable 
InternalClockStartStop 
InvertGroup 
JumptoB 
LampOff 
LampOn 
LampReset 
Last 
Layout1 
Layout2 
Layout3 
Layout4 
Layout5 
Layout6 
LearnAlert 
LearnMacro 
LearnProfile 
Left 
Live 
Load 
LocalMenu 
Lock 
Macro 
Mark 
Mask 
MasterMode 
MasterPage 
MasterPage- 
MasterPage+ 
MasterPageupper 
MasterPage-upper 
MasterPage+upper 
Master 
Master1 
Master2 
Master3 
Master4 
Master5 
Master6 
Master7 
Master8 
Master9 
Master10 

PlaybackPlaylist 
Preset 
RangeRate 
Record 
Refresh 
Release 
RemDim 
RemoteCtrls 
ResetInternalClock 
RewMasterPB 
Right 
Scale 
Select2nd 
Select3rd 
SelectAll 
SelectNth 
SelectRandom 
Select 
SetChanged 
Seq 
Seq- 
Seq+ 
Series 
Setup 
SoftL1 
SoftL2 
SoftL3 
SoftR1 
SoftR2 
SoftR3 
SoftmenuChannel 
SoftmenuControl 
SoftmenuDevices 
SoftmenuDynamics 
SoftmenuEffect 
SoftmenuFocusMode 
SoftmenuLearn 
SoftmenuMasters 
SoftmenuMisc 
SoftmenuSelects 
SoftmenuTimes 
Solo 
Start 
Startupper 
Swap 
Tab 
Tap 
Text 
Thru 
Time 
TimecodeLearnmode 
TrackballDisplaymode 
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Key names Key names Key names 

DirectSelect22 
DirectSelect23 
DirectSelect24 
DirectSelect25 
DirectSelect26 
DirectSelect27 
DirectSelect28 
DirectSelect29 
DirectSelect30 
DirectSelect31 
DirectSelect32 
DirectSelect33 
DirectSelect34 
DirectSelect35 
DirectSelect36 
DirectSelect37 
DirectSelect38 
DirectSelect39 
DirectSelect40 
Distance 
Down 

Master11 
Master12 
Master13 
Master14 
Master15 
Master16 
Master17 
Master18 
Master19 
Master20 
Master21 
Master22 
Master23 
Master24 
Master25 
Master26 
Master27 
Master28 
Master29 
Master30 
Master31 

TrackballLeft 
TrackballMousemode 
TrackballParametermode 
TrackballRight 
Tracklist 
U1 
U2 
U3 
Unpark 
Up 
UpdatePalette 
Update 
Wait 
Wheel1 
Wheel2 
Wheel3 
Wheel4 
Wizard 

  

Older (7.2 and earlier) OSC Commands: 

Masters 
/masters/fader/1-80 <0.0-1.0> 
/masters/key/1-80 <0.0-1.0> 
/masters/flash/1-80 <0.0-1.0> 
/masters/pagePlus/1-4 = Page+ for master block (1-4) 
/masters/pageMinus/1-4 = Page- for master block (1-4) 
/masters/page/1-999 = Master page (1-999) 

Main Playback 
/mainplayback/go 
/mainplayback/pause 
/mainplayback/goback 
/mainplayback/seq+ 
/mainplayback/seq- 
/mainplayback/refresh 

Effect Tap/Rate 
/effects/bpm/X 
/effects/tap/X 

Parameter Controls 
/parameter/pan <0.0-1.0> 
/parameter/tilt <0.0-1.0> 
/parameter/hue <0.0-1.0> 
/parameter/saturation <0.0-1.0> 
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/parameter/intensity <0.0-1.0> 
/parameter/pantilt <0.0-1.0> <0.0-1.0> 
/parameter/huesaturation <0.0-1.0> <0.0-1.0> 

Direct Selects 
Only supported on older Congo hardware (not recommended) 
/directselects/page/X, X = 1-5 
/directselects/key/X, X = 1-40 

Transmit - OSC Output 

OSC output can be transmitted from an Action Macro, or from a template. In addition, sequence texts 
and master levels are transmitted to remote devices - see Receive - OSC Input. 

To transmit OSC commands you have to activate transmittion of OSC and select a port (default 8000) 
and IP address(es) of the devices to send to in Play Settings - Show Control. 

Action Macro OSC 
See Cobalt Action Macros. 

Template OSC 
It is possible to define any parameter in a template to send optional OSC data. In the Template editor, 
there is now a new column called OSC. It will open a dialog where OSC parameters can be defined. 
Scaling through Max value is supported.  

Press MODIFY or double-click on OSC 
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Opens 

 

TRANSMIT COMMANDS 

Direct Selects 
Cobalt will send bank labels and direct select labels when they change: 
/directselects/page/label/x  
/directselects/label/x 

Masters 
/masters/fader/X <0.0-1.0> = transmission when a fader value changes 
/masters/label/X <string> = Sends master label changes 
/masters/page/label/X <string> =Sends master page label changes 
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Cobalt in Congo Jr/Kid Hardware (8.0) 
Cobalt 8.0 will run in any Congo Jr and Congo Kid that has two network 
ports. If there is only one network port contact ETC Tech Support for an 
upgrade path. Cobalt 8.0 will not run in the larger old Congo hardwares - 
they support up to version 7.3.1.  

Congo hardware is limited to 3072 channels and up to 12 universes of output, but may be used as a 
client/backup to a Cobalt system, up to the capacity of the console in question (Congo Kid is limited 
to 1024  channels spread over 12 universes). 

The main difference in the hardware compared to Cobalt 20/10 are 

• There are no fader ranges.  
• There are no expanded masters modes.  

These are the chapters about specific hardware issues - other functions are the same as described in the 
complete manual. 

• Congo Jr/Kid - Facepanel  
• Congo Jr/Kid - Main display  
• Congo Jr/Kid - Direct Selects  
• Congo Jr/Kid - Soft key pages  
• Congo Jr/Kid - Mouseless navigation  
• Congo Jr/Kid - Main playback  
• Congo Jr/Kid - Master Display Keyboard  
• Master fader mode switch  
• Congo Jr/Kid - Fader wings 
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Congo Jr/Kid - Facepanel 
NOTE 
Cobalt Kid & Cobalt JR share the exact same layout of the Programming 
Section.  

These two hardwares will allow you to run the Cobalt software under Win 7. If you are using screens 
without touch control you may wish to connect a mouse or trackball for full access to all features. 
There is a main display with keys and wheels that provides access to device parameters, Direct Selects 
and soft keys.  

Congo Jr 

 

Congo Kid 
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General Facts  

• To the right of the numeric keypad there is a column with keys for selecting groups of 
channels, and to the right of that is a column with keys for setting levels in different ways.  

• There are keys for setting times to the sequence in the Main Playback.  
• There are keys for recording and updating the current preset.  
• There are direct keys to open editors for play data (SEQ, PRESET, GROUP etc)  
• The Navigation pad includes the round navigating keys, the arrow keys, the level wheel and 

ESC and MODIFY.  
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Congo Facepanel - Congo Jr 
This is the facepanel. The Master Playbacks is an optional wing. The Master Playback functionality is 
integrated into the Main Playback.  
 
Monitors  
1x DVI-I (DVI or a DVI to VGa adapter) 
1x DVI-D (DVI only) 
1x DisplayPort 
Can use any two. 
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Congo Facepanel - Congo Kid 
The Congo Kid is similar to Congo Jr in facepanel layout and display functionality.  
 
Channels/outputs 
The Kid has a maximum control capacity of 256 channels/devices and 1024 outputs spread across 12 
universes by direct output or Ethernet.  
 
Masters  
The Master Playback functionality is integrated into the Main Playback. The functions of the Master 
Switch are available in the soft key pages. See Master Soft Key page for Jr & Kid  
 
Monitors  
1x DVI-I (DVI or a DVI to VGa adapter) 
1x DVI-D (DVI only) 
1x DisplayPort 
Can use any two. 
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Congo Jr/Kid - Main Display 
This section has different programming functions. 

• The Display has soft key menus with different sets of functions for the keys around it.  
• The wheels can be used for parameters when a device is selected, there is a button in each 

key.  
• The keys to the left activate Direct Selects. 

Main display area 
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Congo Jr/Kid - Direct Selects 

The Direct Selects tab provides extremely fast and hands on access to all 
kinds of data. In the Jr and Kid consoles there are ten Direct Select keys for 
quick access to content in the DS tab. You can also use a touch screen or 
mouse to access these functions directly from the Direct Selects tab. See 
Direct Selects tab. 

  

• Press the Direct Select keys 1-4 to the left to connect DS section 1-4 in the DS tab  
• Hold the Direct Select key to select type of content for that section   
• Hold Bank to select range for the content within each section 

NOTE  
You can exit Direct Select Mode by pressing the same Direct Select key again. 

Type of content (hold TYPE) 

 

When TYPE is held the different types are displayed over each section. Press the key corresponding to 
the Type you want, without letting go of TYPE. Press More to get those that don't fit. You can hold 
the GROUP key and use the level wheel to change levels for this group directly.  

Bank (hold BANK) 

 

When BANK is held the different banks are displayed over each section. Press the key corresponding 
to the Bank you want, without letting go of BANK. 

NOTE  
A bank contains the content that has been stored to those numbers. For 
example Focus Palette 11 is in bank 11-20. 



Cobalt 8.1 - 20181029 

1047 

 

Content Types 

These are the possible Types of content for the Direct Selects and the corresponding keys in the 
Congo Jr/Kid when they are activated for the display. 

Type  Function Read More 

Focus Activates a Focus Palette for 
the selected channel(s)* 

Moving Device - Palettes 

Color Activates a Color Palette for 
the selected channel(s)* 

Moving Device - Palettes 

Beam Activates a Beam Palette for 
the selected channel(s)* 

Moving Device - Palettes 

Pal Activates an all Palette for the 
selected channel(s)* 

Moving Device - Palettes 

Gel Select a Gel color for a 
moving device from the gel 
picker. 

Device Views - Gel Picker  

Group Selects the channels in a 
Group*** 

Groups 

Param Ranges for a parameter (gobo 
wheel) 

First select Param, then press the 
wheel key for a moving device 
parameter to connect that range to 
the Direct Select keys. 

Auto Group Auto Groups generated from 
the Channel Database** 

Channel Database & Auto Groups 

Screen Press to select the stored 
screens 

Screens 

Mast 
(jr/Kid) 

Master keys (1-80) The keys will correspond to master 
keys in a wing. 

Masks Masks User Masks - Functions 

Section Sections Sequences - Section Markers 

*You can enter a time # before pressing a key to activate the change in this time. 
**Auto Groups are sorted by Text Column from the Channel Database. 
***You can hold the GROUP key and use the level wheel to change levels for this group directly 

Direct Selects - Record & Update  

The data in the Direct Selects is loaded as it is recorded, regardless of how it is recorded. It is also 
possible to record and update directly to the direct select keys, which is a very fast working method 
requiring few keystrokes. 
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These content types can be recorded and updated directly holding [RECORD] or [UPDATE]and 
pressing a [direct select key] for that content type. 

• Focus  
• Color  
• Beam  
• Pal (All Palette)  
• Group  
• Screen 
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Congo Jr/Kid - Soft Key Pages 
The Soft Key pages provide direct access to the soft keys to the right of screen 2 in a Cobalt 10/20 or 
Nomad. The Soft Menu exit key (<--) moves one step back up to the top menu level each time it is 
pressed.  

These are the soft menu keys in the top menu 

 

Summary of soft key menus 

Soft Key Menus  Explanation 

Times Shortcuts for setting times.  
See The Times Soft Key Page  

Dynamics Controls for running Dynamics. 
See Dynamics - Control  

Channels Channel functions. 
See  Channels - Balance Mode  
See Channels - Group Wheel Mode 
See Presets - Compare Mode 

Device Device control and special functions. 
See Device Control - Flip  
See Device Palettes - Focusing Mode 
See Only "Changed" are recorded 
See Device Palettes - Update 

Select Select functions. 
See Channels - Select Functions 

Misc Miscellaneous functions. 
See Navigating - Misc Soft Key Page  

Master Soft Key page for Congo Jr/Kid 

Since Cobalt jr and Congo Kid support masters without dedicated paging controls, 
there is a Masters soft key page with master functions. The Masters soft key page is 
selected with the soft key MASTERS in the Main Display of the Cobalt jr and Congo 
Kid. 
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Display 

 

Page keys (PAGE 1-20, PAGE 21-41, PAGE 41-60, PAGE 61-80) 
These keys are the PAGE key for each master section. Master pages may be assigned to banks of 
masters even when no wings are attached to Cobalt jr. Congo Kid has physical faders for masters 1-20 
and 21-40, and masters 41-60 and 61-80 may still be used with the Masters tab or dock and the keypad 
for selection and control. 

• Enter a number and press a Page #-# key to select a page for masters #-#  
• Hold a Page #-# key and press PAGE- or PAGE+ to change page last/next  
• Hold C and press a Page #-# key to clear this section.  
• Hold RECORD and press  a Page #-# to record to this section 

Channels Only mode keys 
These two keys are used to operate Channels Only mode for Cobalt jr when used with Universal Fader 
Wings and Congo Kid. 

• CHAN. ONLY MODE: Toggles Channels Only mode on/off  
• CHAN. RANGE: Steps through all possible channel ranges for the faders. 
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Congo Jr/Kid - Main Playback 
In Congo Jr  & Kid there is only one playback, which serves both the main playback and any of the 
Master playbacks.  

The CONNECT key is used in combination with any Master key to control that playback. Once a 
master is connected, it is sufficient to press CONNECT. 

The PLAYBACK key is used to set the controls to the main playback. 

The main difference for the main playback compared to the large Cobalt console is that there is no 
split rate control for in/outgoing fades. Instead TAP is held together with the wheel to control rates. In 
Jr, this playback is used also as the Master Playback. 
 

 

See Main Playback. 
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Congo Jr/Kid - Master Display Keyboard 

In the Congo Jr/Kid there is a keyboard function layered in the main display of the console. You need 
to use the three keys to the left side of the display to select the desired line of letters to use with the top 
ten keys. Anytime text input is activated the display is converted into a qwerty keyboard. The soft 
keys correspond to the key in the display. 

 

Hold the SHIFT key to get Capital letters. 

 

Some of the Console keys are used in addition to the letters of the display keyboard. 

Function  Key Feedback 

Special characters [SHIFT] & [#] Hold keyboard SHIFT and 
press 1-9 to get special 
characters 

DELETE [DELETE] Console key is part of 
keyboard functions. 

INSERT [INSERT] Console key is part of 
keyboard functions. 

BACKSPACE [C/Alt] Console key is part of 
keyboard functions. 

Numbers Numerical keypad Console keys are part of 
keyboard functions. 

See Accessories - Ext. Keyboard 
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Master Fader Mode Switch (Master Playback Wing) 

The Switch with three positions sets the 80 Master playbacks into one of three modes. 

 

Position Function 

Channels Only Masters 1-80 will control the first 80 intensities in the 
system. Select range of channels with the Direct Selects. 

Masters The normal position. Masters 1-80 are Masters 1-80. 

Jam Two Scene Fader mode for busking shows with different 
functions. See Fader Mode - Two Scene Masters. 
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Congo Jr/Kid - Fader Wings  

A Cobalt system supports up to 80 Master Playbacks. These can be accessed 
physically by connecting fader wings . In Congo Kid you can access all 80 
numerically but you cannot connect a wing for physical control of the last 40. 

There are two kinds of fader wings. 

• Cobalt Master Wing   
• Universal fader wings (additional faders for any Cobalt system) 

Any combination wings may be attached to a system, for a total of up to 80 master playback 
faders. An external power supply, provided, is required when used stand-alone. 
 
See Facepanel - Congo Jr. 

Master Playback Wing 

The Cobalt Master Playback Wing provides physical access to 40 Cobalt Master Playbacks, including 
the LCD displays for labelling and all master, flash and paging keys. Additionally, the Wing can be 
switched into Direct Select Mode, providing access to the 40 direct selects. It also features the 
Channels-Only/Masters/Jam switch, giving the Congo Jr all the flexibility of the Cobalt console in a 
significantly smaller footprint. 

 

The Master Playback Wing is a modular accessory for the Cobalt jr lighting control console. It may be 
connected physically to either side of the Cobalt jr, or it may be used as a stand-alone wing connected 
to the console with a provided USB cable. An external power supply, provided, is required when used 
stand-alone. 

The functionality is the same as in the large Cobalt - since there are only two graphical displays, you 
have to switch between Direct Selects mode and Masters mode. This is done with the 
DIRECT SELECT key to the right.   
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1. Direct Select pages 
2. Displays 
3. BANK and TYPE keys for operating the Direct Selects are incorporated between the displays with 
the PAGE keys. 
4. Function keys - same as in Cobalt plus Direct Select Mode. 
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Universal Fader Wings 

Besides the Cobalt Master Wing, there are three Universal fader wings. They can be connected with a 
USB cable, and with Congo Jr they can be mounted on the sides or top of the console. An external 
power supply, provided, is required when used stand-alone. 

 



Cobalt 8.1 - 20181029 

1057 

 

EXAMPLES 
This is a collection of examples that you can follow step by step with this help tab open.  

• Build a chase effect  
• Patch by output  
• Patch by channel  
• Record in the Main Sequence  
• Clear and Reset Patch  
• Using a Beat Boss for a Chase Effect  
• Select all running effects 
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Example: Build a chase effect 
This is an example of the workflow for building a simple chase effect from the current channel 
selection, and creating an effect playback to run it from. 

1. Select the Live tab by pressing LIVE 
2. Select channels 1-10 (no levels) 

1 CH 10 THRU  
3. Create Effect Playback with these channels 

Hold INSERT and press EFFECT 
4. Check box "Create Chase from selected channels" 

(Use arrow keys and MODIFY or click screen) 
5. Confirm with EXECUTE. 
6. Bring level of effect up with the level wheel 

The chase effect should now be running in Live. All channels will be at full. You can adjust these 
levels in the Chase Effect Editor. You can change the timing with the Rate/tap parameter in the 
Device Controls Tab or with parameter wheel 2. Read more in the chapter Chase Effect Parameters. 
You can set up a Beat Boss, see Using a Beat Boss for a chase effect.  

Quit Example  
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Example: Patch by Output 
This is an example of the workflow for patching by output. 

1. Select the Output tab by pressing OUTPUT 
2. Select output 1  

1 OUTPUT  
3. Patch this output to channel 5 

5 MODIFY 
4. You will get a dialog asking if you patch channel 5 to output 1. You will have the option of 

checking a box to replace the currently patched channel. 
5. Confirm with OK 

You can continue to do this for any other output, and read more about it in Patch Introduction. To 
clear the Patch press WIZARD to open the Patch Wizard. 

Quit Example 



Cobalt 8.1 - 20181029 

1060 

 

Example: Patch by Channel 
This is an example of the workflow for patching by channel. This requires you to be in RPN (default) 
channel command syntax. 

1. Select the Output tab by pressing OUTPUT 
2. Select channel 5  

5 CHANNEL 
3. Patch this output to output 1 

1 MODIFY 
4. You will get a dialog asking if you patch output 1 to channel 5. You will have the option of 

checking a box to replace the currently patched output(s). 
5. Confirm with OK 

You can continue to do this for any other channel, and read more about it in Patch Introduction. To 
clear the Patch press WIZARD to open the Patch Wizard. 

Quit Example 
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Example: Record in the Main Sequence 
This is an example of the workflow for recording a new look in the sequence of the Main Playback. 

1. Select the Live tab by pressing LIVE 
2. Select channels 1-10 (no levels) 

1 CH 10 THRU  
3. Set a level with the level wheel 
4. Press RECORD 

 
This will give you the Record dialogue. The next free preset # will have been chosen 
automatically for you. You can write a text label.  

5. Confirm with RECORD 

Depending on how your system is set up the lights on stage will be recorded in a preset or cue in the 
sequence of the Main Playback.  
 
Press GO BACK to fade to the previous look.  
Press GO to fade back into the look you recorded.   

Quit Example  
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Example: Clear and Reset Patch 
Clear and Reset Patch is done from the Patch Wizard.  

1. Select the Output tab by pressing OUTPUT 
2. Open the Patch Wizard by pressing WIZARD 
3. Select the Set/Clear tab with arrow keys or touch. 
4. Choose action in the Operation dropdown  
5. Check "Apply to all" if you want to affect the whole patch 
6. Confirm with EXECUTE 
7. Confirm the dialogue with OK 
8. Press ESC to exit the dialogue 

You can read more in Patch Introduction.  

Quit Example 
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Example: Using a Beat Boss for a chase effect 
This is an example of the workflow for using a Beat Boss for a simple chase effect. Start by building a 
simple chase effect from the current channel selection. See Build a chase effect. 

1. If you have just built a chase effect in the example link above, it is selected, otherwise select 
it  
# EFFECT 

2. In the Device Controls tab, click on Beat Boss and select Beat Boss 1 

 
3. Start the effect by bringing the level to full 

The chase effect should now be running in live.  

You have the options of changing the Rate/Tap for this chase, or changing the Beat Boss that will 
scale through the local Rate/Tap.  

You can control the Beat Boss from the Beat Boss Tab (See Tab - Beat Boss ) or by setting up a 
master to control the Beat Boss (See Masters - Beat Boss).   

With a single chase effect there is no great advantage to this, but if you have several chase effects and 
you wish them to follow a central rate the Beat Boss will allow you to control them at once.  

Quit Example  
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Example: Select all running effects 
It is easy to select all currently running effects. 

1. Select the Live tab by pressing LIVE 
2. Select all running effects 

Hold ALL and press EFFECT  

You will now have selected all currently running effects and can regulate the intensity with the level 
wheel, or adjust any of the effect parameters in the Device Control tab.   

Quit Example  
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INDEX 
16 Bit Control - Fine Step, 301 

8 bit 256 Step Levels, 461 

8/16 bit control, 299 

About, 130 

ACCESSORIES, 960 

Action Macro, 256 

Action Macros, 247 

Active Mode & Attribute Tracking, 614 

Active Mode & Mark, 614 

Align, 588 

Align & Distribute Objects, 548 

All Attributes, 616 

All Palette, 626 

Animation effects, 752 

Array, 548 

At Mode, 456 

Attribute Editor Times, 647 

Attributes Follow Faders, 653 

Auto Groups, 533 

Auto-create Content Wizard, 443 

AutoMark, 654 

Auto-Save, 356 

B.O. Mode, 119 

Backup, 226 

Balance Mode, 469 

Beam Palette, 625 

Beat Boss, 99, 854 

Blind, 499 

BPM, 408 

Break mode, 707 

Browser, 75 

Bugs, 65 

Build & Modify Modes, 398 

Build mode, 706 

Capture Mode, 462 

Ch Only Mode, 460 

Changed mode, 612 

Channel Check Mode, 266 

Channel Database, 530 

Channel Editor Wizard, 353 

Channel List, 281 

Channel Partitions, 566 
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Channel Sets, 765 

Channel Symbols, 495 

Channel Time Editor, 383 

Channel Times, 382 

Channel View Zoom, 490 

Channel viewing formats, 489 

Channels, 445 

Channels - Clear Functions, 466 

Channels - Select Functions, 482 

Channels - Soft key page, 478 

Channels - Used & Unused, 474 

Channels - Views, 448 

Chase - Wizard, 409 

Chase Beat Boss, 695 

Chase Effects, 692 

Chase Mode, 403 

Chase mode sequences, 828 

Chase Tap Tempo, 695 

Check Mode, 468 

Clear Dynamics Soft Keys, 731 

Clear patch, 272 

Clone Device, 273 

Cobalt ETCnomad, 996 

Cobalt LS, 1002 

Color Palette, 624 

ColorMixer, 89 

Command Syntaxes, 456 

Compare Mode, 358 

Compound Devices, 577 

Congo Jr/Kid, 1040 

Connectors, 1004 

Console Facepanel, 71 

Console Key Names, 1035 

Console Key Quick Help, 883 

Console Key Shortcuts, 931 

CONSOLE KEYS, 882 

Console Keys in a Keyboard, 962 

Console Mimic, 82 

Content Effect Beat Boss, 708 

Content Effect Return To, 709 

Content Effect Times, 716 

Content Effects, 702 

Context Menus, 112 

Continuous mode, 706 

Control Hierarchy, 53 

Copy Log files to USB, 169 
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Copy, Cut & Paste, 120 

Crashes, 65 

Crossfade, 378 

Crossfade Profiles, 390 

Crossfaders And Attributes, 653 

cRRFU Radio Remote, 988 

Cue Only, 619 

Cues, 423 

Data, 609 

Default Play, 158 

Delete Wizard, 441 

Designer Summary, 83 

Desk Light, 1007 

Device Control, 580 

Device Control Tab, 594 

Device Controls, 88 

Device List, 276 

Device Mode, 596 

Device Palettes, 620 

Device Palettes - Renumber, 639 

Device Times, 640 

Device Views, 600 

Devices, 572 

Dialogues, 114 

Dimmer Check Mode, 266 

Dimmer Curve, 312 

Dimmer/Device Feedback, 134 

Direct Mode MIDI, 213 

Direct Selects, 92 

Disable Flash Keys, 796 

Disclaimer, 43 

Displays Lighting, 219 

DMX Input, 182 

DMX Settings, 221 

DMX512, 1004 

Drag and Drop, 106 

Dual Fader mode, 825 

DVI/sVGA Monitor, 1004 

Dynamic Effect, 717 

Dynamics - Size & Rate, 739 

Editing In Blind, 502 

Editing in Live, 493 

Effect Images, 759 

Effect layouts, 753 

Effect Overview, 691 

Effect Playbacks, 689 
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Effect Texts, 763 

Effects, 672 

Effects - Soft Key Page, 683 

ETCnomad Puck, 997 

Ethernet, 1006 

Event List, 245 

Events, 252 

EXAMPLES, 1057 

Excel, 535 

Exclude Int From Record, 791 

Exclusive, 790 

Expanded Effects, 850 

Expanded Masters, 848 

Expanded Sequences, 852 

External Trig 1-9, 1006 

Fade Curves, 435 

Fade With Intensity, 308 

Fader Modes, 843 

Fader Wings, 1054 

Fan, 589 

Fan Times, 650 

FCB Times, 388 

Fetch/Copy, 591 

Files, 136 

Find Highest Level, 485 

Flash On Time, 803 

Flash settings, 795 

Flip, 593 

Focus Palette, 623 

Focusing Mode, 637 

Freeze Mode, 119 

Gel Picker, 658 

GelPicker, 89 

GENERAL FUNCTIONS, 70 

General Info, 45 

General Record Target, 342 

General Settings, 196 

GETTING STARTED, 44 

Goto List, 783 

Grand Master, 118 

Group Wheel Mode, 475 

Groups, 322 

Groups - Fetch Intensities, 328 

Groups/Palettes Overview, 432 

GrpDistri, 706 

GrpParts, 706 
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Help Companion, 38 

Help System, 33 

Highlight Mode, 592 

Home Positioning, 585 

Hotkeys, 962 

Image Effects, 749 

Import from..., 149 

Import Images, 557 

Import Template, 267 

Import Text File Wizard, 533 

Inclusive, 790 

Independents, 873 

Inhibit, 790 

Installation guidelines, 49 

iRFR, 978 

Key Syntaxes, 50 

Keyboard, 961 

Lamp Control, 583 

Layout Toolbar, 550 

LightWright, 534 

Links, 394 

Live, 486 

Live Dynamics (old), 725 

Load a console key to a master, 836 

Load a group to a master, 814 

Load a Magic Sheet to a master, 833 

Load a parameter to a master, 834 

Load a preset to a master, 808 

Load a sequence to a master, 822 

Load an effect to a master, 817 

Load channels to masters, 804 

Load palettes to masters, 820 

Load Sequence, 782 

Lock Console, 125 

Lockfade, 378 

Loop Mode, 428 

Loop Time, 707 

LTP or HTP, 298 

Macro List, 254 

Magic Sheet, 454 

Magic Sheets, 537 

Main Playback, 768 

Main Show Data, 315 

Manual Crossfades, 773 

Mask, 663 

Mask in masters, 800 
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Master button, 791 

Master fader settings, 793 

Master List, 858 

Master Mode, 790 

Master Pages, 862 

Master Playback Wing, 1054 

Master View, 86, 855 

Masters, 784 

Masters - Times, 802 

Merge Or Replace, 629 

MIDI, 211, 1008 

MIDI - Implementation Chart, 1017 

MIDI Show Control, 1011 

Misc Soft Key Page, 126 

Monitor, 183 

Mouse, 966 

Movefade, 378 

Multiconsole Sessions, 228 

Mute, 122 

Net3 Remote Video Interface, 1000 

Net3/ACN Device List, 233 

Network, 174, 222 

Network nodes, 232 

New, 139 

News In This Version, 39 

Next & Last Mode, 480 

Notes Editor, 438 

Numerical Input on a Notebook, 961 

Object Libraries, 554 

Object Target, 545 

Open, 144 

Organizer, 316 

OSC Functionality, 1030 

OSC Output, 1038 

Output Control, 118 

Output Editor, 260 

Output List, 286 

Parameter Definitions, 310 

Parked, 288, 521 

Parking values, 523 

Partitions, 567 

Patch by Channel/Dimmer, 259 

Patch Device, 271 

Patch Wizard, 270 

Patching, 257 

Phone Remote, 975 
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Play Settings, 197 

Playback View, 778 

Playlist, 429 

Power Off, 195 

Power-up, 115 

Presets, 332 

Presets - Fetch Intensities, 352 

Presets - Import & Undo, 362 

Presets - Renumber, 360 

Presets - Times, 357 

Print, 159 

Programming Wings, 998 

Quick-load Presets to Masters, 349 

Range, 842 

Ranges, 303 

Rate, 407 

RDM Functionality, 1023 

Record a preset to a master, 808 

Record Directly To A Master, 341 

Recording Popup, 335 

Refresh Functions, 777 

Releasing Captured Channels, 465 

Rem Dim, 477 

Remote Control, 967 

Remote Controls, 879 

Rename Channels, 284 

Re-record A Palette, 629 

Reset, 68 

RFR Radio Remote, 969 

RPN, 456 

Save & Save as..., 145 

Save Copy to..., 148 

Scale channel levels, 471 

Screens, 73, 234 

Scroller Fan override, 671 

Scroller Rolls, 667 

Section Markers, 419 

Select Active Channels, 635 

Select Changed, 595 

Select Stored Channels, 636 

Selected Live, 85 

Sequence and Preset texts, 377 

Sequence Times - Set To A or B, 380 

Sequences, 366 

Sequences - Block Values, 400 

Sequences - Delete Step, 393 
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Sequences - Insert Step, 391 

Sequences - Times, 380 

Serial COM data, 249 

Series, 710 

Server, 226 

Sessions, 173 

Setup Guide, 47 

Show Control, 215 

Snap or Fade, 302 

Soft Key Pages, 74 

Software & Update, 55 

Solo, 122 

Sound Settings, 220 

Split Fade, 412 

Standard MIDI, 1010 

Swap upper/lower, 841 

System Settings, 170 

Tab Setup and Lock, 81 

Tabs, 78 

Tap Tempo, 408 

Technical Services, 69 

Templates, 290 

Terminology, 42 

TEXT, 121 

Time Code, 87, 1014 

Times (in/out/delay/wait), 381 

Times Soft Key Page, 387 

Track Editing, 518 

Track List, 402, 504 

Track To Wizard, 511 

Trackball, 966 

Training Projects, 161 

Triggers for Events, 253 

Troubleshooting, 62, 69 

Two Scene Masters, 845 

U1-U2-U3, 586 

UDP data, 250 

Unblock Attributes, 520 

Universal Fader Wings, 1056 

Un-parking Values, 526 

Update, 185, 344 

USB RFR, 187 

Used In Play, 453 

User Library, 269 

User List, 242 

User Templates, 309 
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Utilities, 188 

Visualizer, 991 

WAF Alert Times, 388 

Welcome Screen, 193 

Workflow, 56 

X-keys, 1001 
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